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1 Basics of 3D
 Welcome to the Everything 3D course. In this course we will cover most of MicroStation’s 3D tools. These include viewing and visualization tools, as well as those for drawing, or constructing 3D models. All the 2D drawing and viewing tools with which you are familiar can be used in a 3D design file. Additionally, there are a number of 3D specific viewing and drawing or construction tools that simplify working in 3D.
 Before getting on to the drawing or construction side, however, we will first concentrate on the 3D environment and how to maneuver within it. In this lesson we will introduce you to:
 • “General 3D Concepts” on page 1
 • “3D design files” on page 2
 • “View volume” on page 3
 • “Display Depth and Active Depth” on page 4
 • “3D tool boxes” on page 5
 General 3D Concepts
 We live in a three-dimensional world in which we can move and look in any direction. We work on designs for constructing three-dimensional buildings and other items. In the past, we designed these 3D objects in 2D. That is, we represented 3D objects with 2D drawings. Using MicroStation’s 3D tools, we can produce accurate 3D models of our designs. We can view our design from any direction and even move inside the design. Using visualization tools, we can produce images, walkthroughs, or animations of the “finished” construction before it is built.
 With a little effort, we could create very simple 3D models using the 2D tools that we already know. For example, we could create a 3D model using only the Place Block
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
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3D design files
 and Place Shape tools to construct each face of the object. To create a more complex model, however, we would need to use several of the 3D tools.
 Before looking at the construction tools, we have to familiarize ourselves with the 3D modeling environment and the basic viewing tools.
 3D design files
 In 2D MicroStation, you work on a design plane, similar to a sheet of paper. All 2D geometry is drawn within the boundaries of the design plane. Locations on the plane are defined by x- and y- coordinates. You can zoom in or out as required to work on small or large areas. Where necessary, you can rotate the view, which is akin to turning the drawing sheet.
 In 3D MicroStation, the 2D design plane becomes a 3D cube, known as the design cube. All geometry is drawn within this design cube. Locations in the cube are defined by x-, y- and z- coordinates. When working in a 3D design file, we still can use 2D geometry, but it can be placed in any orientation. For example, we can place a block horizontally, vertically, or at any other orientation that is required, within the design cube. Similarly, we can view our design geometry from any direction. You can think of the design cube as a transparent box in which your design is stored. You can rotate the view “cameras” about any axis to let you view your design model from any direction. Additionally, you can place your
 Isometric rendered view of a simple bracket created with 2D tools (left) and a more complex version constructed with 3D tools (right).
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
 1-2

Page 13
                        

View volume
 view camera anywhere inside the design cube to let you work on, or view, specific parts of the model.
 Before we continue: What makes a 3D design file 3D?
 In a 3D design file, where is all design geometry drawn?
 View volume
 Each MicroStation view window (you can have up to eight open simultaneously) lets you look at any portion of the design cube. In a 2D design file, each view window displays an area of the design file. In a 3D design file, each view window displays a volume of the design cube, often referred to as the view volume or display volume. That is, each view window has a display area (as in 2D) and a display depth (the third dimension). This display depth is limited by front and back clipping planes. Any element not contained within the front and back clipping planes of the view, will not display. Many first-time users of MicroStation 3D think that they have accidently deleted elements as no amount of zooming in or out makes them visible. In fact, the elements are outside of the display depth for the view in which they are looking. Later we will look at this feature in more detail and find out how to make those “lost” elements visible in a view, and how to set the display depth to separate out elements in the design.
 2D design plane coordinates are expressed in the form (x,y).
 3D design cube coordinates are expressed in the form (x,y,z).
 A 3D design file contains 4,294,967,296 positional units (UORs) in the x, y, and z directions (this is similar to the 2D design plane, except that 2D has x and y directions only).
 In the 3D seed files, provided with MicroStation, the Global Origin is located at the exact center of the design cube and assigned the coordinates (0,0,0).
 In 3D design files, the coordinate system often is called the Rectangular or Cartesian coordinates system.
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
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Display Depth and Active Depth
 Summing up, the view volume is defined by the size of the view (window area), the front clipping plane and the back clipping plane (defining the display depth).
 Nothing is visible in front of the front clipping plane and nothing is visible behind the back clipping plane. Only elements or parts of elements in between the clipping planes are visible. Just as Window Area lets us select a discrete area of a view, Display Depth lets us select a discrete “slice” or depth of a view.
 Display Depth and Active Depth
 Each MicroStation 3D view has both a display depth and an active depth.
 In each view, the display depth defines how much of the overall depth of the view is displayed. It is controlled by the location of front and back clipping planes. These planes are parallel to the view (your screen) with the front clipping plane nearest to you and the back clipping plane farthest away from you.
 Between these clipping planes is another plane, at the active depth of the view. The active depth defines the depth at which data points are placed by default. That is, if you placed data points in a view, without first snapping to another element, then they would lie on a plane at the active depth value. The active depth plane always is located within the display depth of a view. Its value may change when you Fit the view.
 These concepts will become clearer as you do the exercises shortly.
 View volume with the front and back clipping planes.
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
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3D tool boxes
 3D tool boxes
 MicroStation’s 3D construction and modification tools are contained in the following tool boxes:
 • 3D Main (Tools > 3D Main > 3D Main) — contains tool boxes for construction and modification of solids.
 • Surface Modeling (Tools > Surface Modeling > Surface Modeling) — contains tool boxes for construction and modification of surfaces.
 3D View control tools are contained in:
 • 3D View Control (Tools > View Control > 3D) — contains tools for view manipulations.
 During this course you will be introduced to many of these tools and will experience first hand how they work.
 Before we continue: What is the difference between Display Depth and Active Depth?
 3D Main tool frameand the tool boxes
 contained in it.
 Surface Modelingtool frame and the
 tool boxescontained in it.
 3D View Control tool box.
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2 3D views and view control
 When you work in a 2D design file, in effect you are looking “down” on a flat plane (the design plane). Using the 2D view control tools you can move around the design in a similar fashion to working on a sheet of paper. You can move up, down, left, or right, with the Pan View tool, as well as change the magnification with the Zoom In/Zoom Out and Window Area tools. Additionally, you can rotate the view to work on it at any angle.
 In a 3D design file, you can view your design model (in the design cube) from any direction. You can specify standard views, or you can rotate the view to any other orientation that you require. As well, MicroStation’s 3D view control tools let you view your design from any location within the design cube. For quick setup, there are a number of standard views that you can use. As well you can rotate the view in any direction, or add perspective. In this chapter we will explore:
 • “Standard 3D views” on page 7
 • “View rotation in 3D” on page 9
 • “3D View Control tool box” on page 14
 • “Fitting 3D views” on page 20
 Standard 3D views
 MicroStation has eight standard views — Top, Front, Right, Isometric, Bottom, Back, Left, and Right Isometric. Standard view names describe the orientation of the design cube in the view, relative to the viewer. For example, the standard views:
 • Top and Bottom — displays the design cube as viewed from the top or bottom, respectively. The xy- plane is parallel to the screen, and you view the design along the z-axis.
 • Front and Back — displays the design cube from the front or back, respectively. The xz- plane is parallel to the screen and you view the design along the y-axis.
 • Right and Left — displays the design cube from the right or left, respectively. The yz- plane is parallel to the screen and you view the design along the x-axis.
 • Isometric and Right Isometric — displays the design cube equally inclined from all three axes. You view the design from top left front corner to the bottom right back corner of the design cube (Isometric) or from the top right front corner to the bottom left back corner (Right Isometric).
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
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Standard 3D views
 Only in the Top view, is the design file’s axes aligned exactly with that of the view (or screen). Let’s open a design file and explore these views for ourselves.
 ➤ Prepare for the exercise
 1 Open the design file 3d_views_1.dgn.
 2 Open the 3D View Control tool box (Tools > View Control > 3D).
 3 If necessary, turn on window scroll bars (Window > Scroll Bars).
 This file has been saved with four views open, displaying the Top, Isometric, Front, and Right views of a simple model. Unlike 2D where you would have separate “drawings” for various elevations of the model, each view in this 3D file is displaying the same model, just from different directions.
 Looking at the Isometric view, you can see that each face of the model contains text describing its location. That is, the top face has the word “Top” on it, the right face has the word “Right” and so on. Currently the view display is the default “wireframe.” With wireframe display, we see the edges of surfaces and we can see through the 3D model. For example, in the Top view, not only can you see the word Top on the top face, but you can see the word Bottom (reversed), which is on the bottom face of the model. Of the four views, the Isometric view (View 2) gives us the best idea of what the model is. Later, you will see that the Isometric view, along with AccuDraw, generally is the easiest of the standard views to work with.
 Note that the view title bars display the name of the view. Whenever a standard view is displayed, the view title bar displays its name.
 Standard views can be very useful in orienting yourself in a 3D design file, but they are not the only rotations that you can use, as you will soon discover.
 Four views of thesample model
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
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View rotation in 3D
 View rotation in 3D
 In 2D design files, you work in an xy- plane. Where necessary, you can rotate the view. In effect, visually on the screen, this is like rotating the xy-plane about a perpendicular, or z-axis. When you are working in a 3D design file, you can rotate the view about any axis (that is, the x-, y-, or z-axis). Again, the visual effect on screen is like rotating the design cube. You can rotate any view to a standard view or to any other arbitrary view orientation. Let’s try it.
 ➤ Rotate the Front view
 1 In view 3 (Front View) select the Rotate View view control, with the following settings:
 Method: Dynamic
 Dynamic Display: On
 2 Place a data point at about the center of view 3.
 3 Move the screen pointer to rotate the model interactively.
 4 Place a second data point to complete the rotation (if you enter a Reset, the view returns to its original orientation).
 5 In the tool settings, turn off Dynamic Display.
 6 Place a data point at about the center of view.
 A cube graphic appears. The bold outline represents the orientation of the front plane of the design cube, to give a visual guide when rotating the view.
 7 Move the screen pointer to rotate the cube graphic.
 The original position of the cube graphic displays, as well as the location determined by the screen pointer. Observe also, that the model remains stationary.
 8 Place a further data point to complete the rotation.
 The view updates to display its new orientation.
 Cube graphic withbold outline
 representing the frontplane orientation of
 the design cube.
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View rotation in 3D
 ➤ Return view 3 to a Front view
 1 In view 3, reselect the Rotate View view control with Method set to Front.
 2 Place a data point in view 3.
 View 3 returns to a Front view orientation.
 In a similar fashion, you can rotate any view.
 ➤ Rotate the Top view to Bottom
 1 The Rotate View view control should still be active, so change Method to Bottom.
 2 Place a data point in view 1.
 View 1 updates to display the model from the bottom (as indicated by the word “Bottom” being in the correct orientation and the word “Top” now reversed).
 You may have noticed that the top face of the model slopes downward from left to right. This can be seen clearly in the Front view. Thus, when we view the model from the top, in fact the top face is not parallel with our screen. In a situation like this, where a face of the model does not coincide with any of the orthogonal views, we can use another of the view rotation settings that lets us rotate a view to align with a face of the model. That is, the view will be rotated so that the defined face is parallel to our screen. To define a plane requires a minimum of three points. Therefore, to rotate a view so that a particular plane is parallel to our screen requires that we define three points — the first two define the x-axis, and the third defines the direction of the y-axis.
 ➤ Rotate view 2 to align with the sloping top face of the model
 1 In view 2 (the Isometric view) turn on level 2.
 Level 2 contains location markers to assist with this exercise.
 2 In view 2, select the Rotate View view control with the following setting:
 Method: 3 Points
 3 Snap to and accept with a data point, the top left front corner of the model at location 1.
 This locates the first point on the x-axis for the proposed view.
 4 Snap to and accept with a data point, the top right front corner of the model at location 2.
 This determines the direction of the x-axis for the proposed view. As the screen pointer is moved, graphics display the plane that is being defined.
 5 Snap to the top left back corner of the model at location 3.
 This defines the direction of the y-axis of the rotated view. The graphics displaying the plane now line up with the angled top face of the model.
 6 Accept with a data point.
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View rotation in 3D
 On acceptance of this point, the view updates to show the new orientation.
 7 Use the Fit View view control to fit the view to display the entire model.
 Using this method, you can rotate views so that any plane in the design is aligned exactly to the view. That is, the view is rotated so that it is parallel to the defined plane.
 Another view rotation tool lets you specify the angle that the view is rotated. For example, we can check that the rotation that we just performed has placed the selected plane parallel to our screen. If we now rotated the view 90° about its x- or y- axis, we should see the plane as a horizontal or vertical line respectively. Let’s see it this is so.
 ➤ Rotate the view -90° about the View x-axis
 1 In the 3D View Control tool box, select the Change View Rotation tool with the following settings:
 View: 2
 Axis: View
 2 In the Step field, key in 90.
 3 In the tool settings box, click the - X direction arrow once.
 4 Click Apply.
 The view is rotated -90° about the x-axis. The top face of the model appears horizontal in the view, which confirms that we did have the top face parallel to our view, or screen.
 Left: The Isometric view, with the location points displayed. Right: After rotating the view.
 View 2 after
 rotating it 90°.
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View rotation in 3D
 Rotating relative to view or drawing
 Whenever you look at a MicroStation view on your screen, the view, or screen, axes always are orientated as follows:
 • X — horizontal, positive from left to right of screen.
 • Y — vertical, positive from bottom to top of screen.
 • Z — perpendicular, positive towards you (the viewer).
 These axes may be referred to as the relative axes — relative to the view or screen. Within the view, however, the design file axes can be in any direction depending on how the view has been rotated. Remember, when you rotate a view, in fact you are rotating the view about the design cube. Visually, on screen, it appears that you are rotating the design cube and its contents relative to the view or screen. You are not rotating the model within the design cube. In the real world, if you had a model, you could walk around it to view it from any direction. In the computer model, we rotate the view camera around the “world” of the design (the design cube) to view the model from other directions.
 Using the Change View Rotation tool, you have the option of rotating the view relative to either the View axes or the Drawing axes. A quick exercise will illustrate just what we mean. First, rotate View 1 to be an Isometric view.
 ➤ Rotate View 1 to Isometric
 1 In the 3D View Control tool box, select the Change View Rotation tool with the following settings:
 Std: Iso
 View: 1
 2 Click Apply.
 First, we will rotate the view relative to the Drawing z-axis. The Drawing z-axis is parallel to the vertical edges of this model. In practice, it may be that you want the view of the model rotated so that the Back and Left walls are facing you.
 ➤ Rotate View 1 about Drawing z-axis
 1 In the 3D View Control tool box, select the Change View Rotation tool with the following settings:
 View: 1
 Axis: Drawing
 2 In the Step field, key in 5.
 3 In the tool settings, click the +Z button several times, watching the cube graphic as you do this. Keep clicking until the Back and Left faces of the cube are visible.
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View rotation in 3D
 4 Click Apply.
 ➤ Rotate View 1 about view Z-axis
 1 In the 3D View Control tool box, select the Change View Rotation tool with View set to 1 and Axis set to View.
 2 Leave the Step field set at 5.
 3 In the tool settings, click the +Z button several times, watching the cube graphic as you do this.
 4 Click Apply.
 As you can see, when you select the view z-axis as the axis, the rotation is similar to that of 2D rotation. That is, the view rotates about an axis that is perpendicular to the screen. Time to move on and explore other view settings that you can use.
 Before we continue: What are the eight standard views in MicroStation?
 Which standard view aligns exactly with our screen?
 About which axis, or axes, can you rotate a view in:A: a 2D file?B: a 3D file?
 If you select View as the Axis and rotate about the Z-axis, in which direction will it rotate? (Remember that view axes always have the same orientation.)
 After rotating the View todisplay the Back and Left faces.
 After rotating the Viewabout the View Z-axis.
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3D View Control tool box
 3D View Control tool box
 In the previous exercises you were introduced to the Change View Rotation tool in the 3D View Control tool box. Time now, to look at other tools in this tool box. These include tools for 3D specific view manipulations that let you adjust viewing parameters in a MicroStation 3D design file.
 Zoom In/Out tool
 Previously, you would no doubt have used the Zoom In and Zoom Out view control tools. These let you change the magnification of a view by zooming in or out respectively, by a defined ratio. This tool, the Zoom In/Out tool, lets you increase or decrease the magnification of a 3D view interactively. That is, you first select the part of the view that you want zoomed in or out, then you specify, graphically, how much you want to zoom in or out. The tool uses a similar setting for dynamic display, as that for the Rotate View view control. The following exercise will show you how this tool works in practice.
 ➤ Magnify a view with the Zoom In/Out tool
 1 Open the design file 3d_views_2.dgn.
 To Select in the 3D View Control tool box
 Change the magnification of a view volumeZoom In/Out
 Change the perspective angle of a view (covered later in this course)
 Change View Perspective
 Set a view’s Display Depth graphicallySet Display Depth
 Set a view’s Active Depth by placing a data pointSet Active Depth
 Show the Display Depth setting for a view(s)Show Display Depth
 Show the Active Depth setting for a view(s)Show Active Depth
 Control view rotation using a dialog boxChange View Rotation
 Create a camera view (covered later in this course)Camera Settings
 Render a view(s), the fence contents, or an element(s) (covered later in this course)
 Render
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3D View Control tool box
 2 Select the Zoom In/Out tool with the following setting:
 Dynamic Display: Off
 3 Place a data point at location 1.
 As you move the screen pointer, a cube displays. This defines the part of the view that you want to zoom in or out. As with the view rotation dynamic cube, the front face is shown in a heavier weight line.
 4 Place a data point at location 2.
 The cube is enlarged and placed at the center of the view. As you move the pointer around the view, the cube expands or contracts.
 5 Place a data point at location 3.
 The view is magnified.
 Using the cube graphics may be useful when you are working on a very complex model that may take time to update with dynamic display. For simple models like this, however, it is much better to turn on Dynamic Display.
 ➤ Using the Zoom In/Out tool with Dynamic Display turned on
 1 Select the Zoom In/Out tool with the following setting:
 Dynamic Display: On
 2 Place a data point at location 1.
 As you move the screen pointer, a cube again displays. As before, this defines the part of the view that you want to zoom in or out.
 3 Place a data point at location 2.
 Now, as you move the pointer about the screen, the model appears to expand or contract.
 4 Move the pointer toward the center of the screen to reduce the magnification of the view, or away from the center to increase the magnification.
 5 Place a data point to complete the zoom operation.
 As you can see, with dynamic display turned on, you can check exactly how much the view is being zoomed in or out.
 Set Display Depth tool
 When you work in 2D, everything is drawn on a flat plane. Only those elements within the window area of a view are displayed. To view elements outside this area, you can zoom out.
 These same tools can be used in 3D design files, but there can be a slight complication. In 3D, where you construct the design as it will be built, you can have various parts of
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3D View Control tool box
 the design located behind one another in a view, which can cause a confusion of lines on the screen. We can, however, control the position from which we view the model, and how deeply into the view we look. Earlier, you learned that each MicroStation 3D view displays a particular volume of the design file. That is, each view displays an area with a defined depth of view or display depth. Front and back clipping planes define the depth that is visible in any view. Using the Set Display Depth tool, you can control the position of these clipping planes and, therefore, the display depth of the view. Any elements that are located in front of the front clipping plane are not displayed in the view. Similarly, any elements located behind the back clipping plane are not displayed. Let’s look at a simple example to illustrate this.
 ➤ Prepare for the exercise
 1 Open the design file 3d_views_3.dgn.
 This design file has been saved with four views open — Top, Isometric, Front, and Right. It contains a number of solids. The Top view shows that the objects are set out in three lines. Note, in the Front view (Window 3) in particular, there is a confusion of lines as we can see through the elements in front, to those behind. The Set Display Depth tool lets us change the display depth in the Front view so that, for example, only the yellow solid displays.
 ➤ Change the display depth in the Front view
 1 In the 3D View Control tool box, select the Set Display Depth tool.
 2 Place a data point in the Front view (Window 3).
 The Isometric view displays graphics that indicate the display volume of the selected view. As you move the pointer in any view other than the Front view, observe that the graphics displaying the view volume changes as you have control of the front clipping plane.
 3 In the Top view, place a data point at location 1.
 This defines the front clipping plane for the selected (Front) view. Note now, in the Isometric view, that you have control of the back clipping plane.
 4 In the Top view, place a second data point at location 2.
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
 2-16

Page 27
                        

3D View Control tool box
 The Front view updates to display only the yellow solid.
 Similarly, you can set the display depth of any other view. To complete the exercise, we will change the display depth of the Right view.
 ➤ Change the display depth in the Right view
 1 In the 3D View Control tool box, select the Set Display Depth tool.
 2 Place a data point in the Right view (Window 4).
 3 In the Top view, place a data point at location 3.
 This defines the front clipping plane for the selected (Right) view.
 4 Still in the Top view, place a second data point at location 4.
 The Right view updates to display only those elements, or parts of elements contained within the new display depth.
 Note the two dots in the lower center part of the view. Because we have set the display depth to “cut” the yellow solid, we only see part of it. The two dots are the lines defining the bottom edges of the solid. Because you are looking directly along the lines, they appear as dots.
 While the other elements in the design file have not been deleted, they now do not appear in the Front and Right views. Additionally, they will not reappear when you use
 Left: Before changing the display depth, the yellow solid is lost in the front view’s confusion of lines. Right: After setting the display depth, the yellow solid is plainly visible.
 Left: Before changing the display depth, all objects are displayed in the Right view. Right: After setting the display depth, only those elements within the clipping planes display.
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3D View Control tool box
 the Zoom In, Zoom Out or Window Area view controls. Why? Because the display depth for the view is not altered by these tools. Try it for yourself.
 ➤ Zoom in and out of the Front and Right views
 1 Select the Zoom In view control in the Front View, with the following setting:
 Zoom Ratio: 2
 2 Place a data point at the center of the Front View (window 3).
 3 Select the Zoom Out tool in the Front View.
 4 Place several data points at the center of the Front View.
 5 Repeat the above steps for the Right view (window 4).
 6 Try also, using the Window Area view control to zoom in the views.
 As you can see, the display depth is not changed when you use the Zoom and Window Area tools. Only those elements that are situated between the front and back clipping planes are able to be viewed, no matter what the magnification of the view.
 Similarly, if you rotate the views, the display depth is not changed. With rotation, however, you do see another phenomenon, as the following exercise shows.
 ➤ Rotate the Front view to be Isometric
 1 Open Window 5 (select Window > Open/Close > 5).
 Window 5 displays the Front view with the display depth set as in the earlier exercise.
 2 In Window 5, select the Rotate View view control, with the following setting:
 Method: Isometric
 3 Place a data point in Window 5.
 The Front view is rotated to become an Isometric view.
 Observe in Window 5, that the Isometric view is showing only parts of the elements in the design. The reason for this is that the display depth for the view is quite shallow — it was set up to display the yellow element in a Front view. When you rotate a view,
 Before (Left) and after (Right) rotating the Front view in Window 5.
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3D View Control tool box
 the design cube is rotated through the display depth of the view. The elements have not been altered in any way. Each view displays only those elements, or parts of elements, that are located between the front and back clipping planes of the view. If we could see the views from side on, we would see that, in the Front view, only the yellow element is within the display depth of the view. Similarly, only parts of the elements are within the display depth of the Isometric view.
 In order to again have the missing elements displayed in a view, we can change the display depth — increasing it so that the required elements are once more located within the front and back clipping planes. Another method is to use the Fit View tool with Expand Clipping Planes turned on. This is covered later, when we discuss fitting 3D views.
 Show Display Depth tool
 At any time, you can check the display depth of a view using the Show Display Depth tool. This tool displays, in the status bar, the z values for the front and back clipping planes of the selected view.
 ➤ To view the Display Depth values for a view
 1 Select the Show Display Depth tool.
 2 Place a data point in the required view.
 The display depth values for the view display in the status bar, such as View 2: Display Depth= -18.604, 14.056.
 Display depth values refer to the z-axis of the selected view. For example, in a Front view, the view’s z-axis is aligned exactly with the design file’s y-axis, with the direction
 If we could see the views from side on, we would see that the missing elements, or parts of elements (shown dotted) are not within the view’s display depth.
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Fitting 3D views
 reversed. That is, in a Front view, the design file axis is positive into the screen, while the view’s z-axis is positive out from the screen.
 Before we continue: How do the Zoom In/Out, Window Area and Rotate View tools affect the Display Depth of a view?
 What are the front and back clipping planes in a view?
 Set Active Depth tool
 You know now that, in a 3D design file, each view has a Display Depth. As well, each view has an Active Depth. The Active Depth is a plane, parallel to the view or screen, and always is located within the Display Depth of a view. The Active Depth of a view determines where data points fall by default. That is, if you place a data point in a 3D view, without snapping to an existing element, it falls on the Active Depth plane.
 One tool that relies on the Active Depth is the Rotate View view control. With this tool, the view rotation is performed about the first data point. If you do not snap to an element then, by default, this point is placed at the Active Depth.
 Show Active Depth tool
 At any time, you can check the active depth of a view, using the Show Active Depth tool. This tool displays, in the status bar, the z values for the active depth of the selected view.
 ➤ To view the Active Depth value for a view
 1 Select the Show Active Depth tool.
 2 Place a data point in the required view.
 The active depth value for the view displays in the status bar, such as View 2: Active Depth= 14.500.
 As with display depth values, the active depth value refer to the z-axis of the selected view.
 Fitting 3D views
 In both 2D and 3D design files, the Fit View tool lets you select whether the fitting applies to the Active, Reference, Raster, or All files associated with the view. In 3D design files, however, you have further choices, relating to the clipping planes and the Active Depth.
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Fitting 3D views
 When you fit a view in 2D, the area of the view is altered to display all elements located on the levels currently turned on.
 In 3D design files, you have other options when using the Fit View tool.
 • Expand Clipping Planes — If on, the view's Display Depth is adjusted, along with the view origin and magnification, so that all elements display that are on levels currently turned on for the view.
 • Center Active Depth — If on, centers the Active Depth in the fitted view. (It is recommended that you turn on Center Active Depth when fitting a view you later intend to dynamically rotate, or a view whose perspective you intend to change. Alternatively, where you want to add elements at the current Active Depth, you should turn off this setting.)
 • Center Camera — If on, the view camera is centered in the view.
 Let’s look at an example to see how the Fit View tool works with the Expand Clipping Planes option.
 ➤ Prepare for the exercise
 1 Open the design file 3d_views_4.dgn.
 2 In View 1, select the Fit View view control.
 3 In the Fit View tool settings, turn off Expand Clipping Planes.
 This design file has all elements drawn on level 1. It has been saved with the display depths of the Isometric, Front and Right views set such that only the blue slab is fully displayed. Each view also is zoomed in on the blue slab.
 With the Fit View tool, normally we would expect all the elements to display if we fitted a view. Because we turned off Expand Clipping Planes, however, a fit displays only those elements located within the current front and back clipping planes. This is very useful for when we have set the display depth so that only part of the model displays.
 ➤ Fit each view
 1 In the Isometric view, select the Fit View view control.
 The view updates to display all elements, or parts of elements, that are located within the current clipping planes.
 This design file was saved with Expand Clipping Planes turned off.
 2 Enter further data points in the Front and Right views.
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Fitting 3D views
 Each view updates to display all elements, or parts of elements, that are located within their respective clipping planes.
 To display all elements completely, we can simply turn on Expand Clipping Planes.
 ➤ Turn on Expand Clipping Planes and fit the views
 1 In the Fit View tool settings, turn on Expand Clipping Planes.
 2 Enter data points in the Isometric, Front and Right views.
 Each view updates to display all elements on the currently displayed levels.
 After fitting the views withExpand Clipping Planes
 turned off, only parts of thedesign are displayed.
 With Expand ClippingPlanes turned on, fitting a
 view shifts the clippingplanes so that all elements
 are displayed.
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Fitting 3D views
 Before we continue: What effect does the Expand Clipping Planes option have when fitting a 3D view?
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3 Visualizing a 3D design
 When we draw in 2D, we either leave out any hidden lines or we use a dashed line to indicate that they are hidden. When we work on a 3D model in wireframe display mode, we can see through the model. This is useful when we want to snap to an element that, in real life, would be hidden behind another. As designers, we become accustomed to viewing our designs in wireframe display. When we want to check our design or when discussing it with others, often it is helpful to use one or more of MicroStation’s rendering display modes. These tools let us see our models more realistically and include options for creating perspective views, as well as views with hidden lines removed and rendered images. In this chapter, we will cover the basics of MicroStation visualization tools, including the following:
 • “Render tool” on page 26
 • “Change View Perspective tool” on page 33
 • “Camera Settings tool” on page 35
 • “Navigate Camera view control tool” on page 41
 • “Set View Display Mode tool” on page 49
 Visualization basics
 MicroStation’s 3D View Control tool box contains three tools for visualizing your designs. These are:
 • Change View Perspective — to change the perspective of a view.
 • Camera Settings — to set up a camera view.
 • Render — to render a view, fence contents, or element, in any of a number of display modes.
 As well as these tools, the window border tool bar contains the following view control tools:
 • Change View Perspective — the same as the tool in the 3D View Control tool box, it lets you change the perspective of a view.
 • Change View Display Mode — uses the QuickVisionGL caching system to change the display of a view. This lets you dynamically rotate a view in shaded display mode. Options include Hidden Line and Smooth rendering mode.
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Render tool
 • Navigate Camera — lets you use the keyboard arrow keys or your mouse to move a view camera.
 Render tool
 Rendering lets us view our models more as they would look in real life. It is the process by which MicroStation first decomposes the wireframe model into a polygon mesh (in memory). It then can determine which polygons are behind others, in a view, in order to present the model realistically. With the more complex rendering modes, you can add lighting and material definitions to help make the image look more lifelike. These topics, lighting and material definitions, will be covered later in this course.
 MicroStation’s Render tool provides a number of options for displaying your designs on screen. These screen displays are temporary only. Updating the view returns it to the default view display mode. With the Render tool, you can choose from a number of line or shading modes as you will see in the following discussion and exercises.
 ➤ Prepare for the exercises
 1 Open the design file render_1.dgn.
 2 If necessary, open the 3D View Control tool box (Tools > View Control > 3D).
 This sample design file contains a table and lamp positioned in the corner of a room. It has been saved with four identical views open. We will use these to display the results of the various rendering options in order to compare the results.
 As well as the elements forming the model, a single point light source has been placed in this design file. This will become obvious when we look at the shaded rendering modes.
 Wiremesh render mode
 Not really a rendering mode as such, this option is similar to wireframe mode, except that it displays the model as a polygon mesh, making curved surfaces, in particular, easier to visualize than the standard wireframe display mode.
 ➤ Render Window 2 in Wiremesh render mode
 1 In the 3D View Control tool box, select the Render tool with the following settings:
 Target: View
 Render Mode: Wiremesh
 Shading Type: Normal
 2 Place a data point in Window 2.
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Render tool
 Window 2 updates, displaying the model in Wiremesh render mode.
 Note that the curved surface of the lamp shade now appears as a number of polygons.
 Hidden Line render mode
 This rendering display mode removes lines that would not normally be visible because they are behind other elements in the view. Only parts of elements that would normally be visible are displayed.
 ➤ Render Window 3 using the Hidden Line render mode
 1 Select the Render tool with the following settings:
 Target: View
 Render Mode: Hidden Line
 Shading Type: Normal
 2 Place a data point in Window 3.
 Window 3 updates, displaying the model in Hidden Line render mode.
 Window 2 displaying the viewin Wiremesh render mode.
 Window 3 displaying the viewin Hidden Line render mode.
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Render tool
 Filled Hidden Line render mode
 This option produces a similar output to Hidden Line except that the rendered model is filled with the color of the elements making it up, producing a cartoon-like effect.
 ➤ Render Window 3 using the Filled Hidden Line render mode
 1 Select the Render tool with the following settings:
 Target: View
 Render Mode: Filled Hidden Line
 Shading Type: Normal
 2 Place a data point in Window 4.
 Window 4 updates, displaying the model in Filled Hidden Line render mode.
 Constant render mode
 With this rendering mode, surfaces again display as one or more polygons. Each polygon then is filled with a constant color. Curved surfaces in particular display as a mesh of polygons. The color applied to each polygon of such a mesh is determined by the element’s color attributes, the material definition, and the effect of any lighting.
 ➤ Render Window 1 using the Constant render mode
 1 Select the Render tool with the following settings:
 Target: View
 Render Mode: Constant
 Shading Type: Normal
 2 Place a data point in Window 1.
 Window 4 displaying the view inFilled Hidden Line render mode.
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Render tool
 Window 1 updates, displaying the model in Constant render mode.
 Note how the curved surface of the lamp shade appears tiled. This is due to the model being reduced to a mesh of polygons, with each polygon given a constant color. This is particularly noticeable on the table top, which has been rendered as two triangles (polygons), each with a slightly different (constant) color.
 Smooth render mode
 As with Constant shading, when you render a view with the Smooth option, each element is decomposed into one or more polygons. With Smooth rendering, however, the colors are calculated at the vertices of the polygons and then blended, or smoothed, across the interior of the polygons. This removes the tiled effect that was obvious with Constant shading.
 ➤ Render Window 2 using the Smooth render mode
 1 Select the Render tool with the following settings:
 Target: View
 Render Mode: Smooth
 Shading Type: Normal
 2 Place a data point in Window 2.
 Window 2 updates, displaying the model in Smooth render mode.
 Window 1 displaying the view inConstant render mode.
 Window 2 displaying the view inSmooth render mode.
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Render tool
 Note that the tiled effect, evident with Constant rendering, has now disappeared with the Smooth option.
 Phong render mode
 Phong rendering calculates the color of each pixel in a view, which requires more computation than that for Constant and Smooth rendering. The result is more accurate shading in which the position of light sources can be more easily seen by their reflection in surfaces. Phong rendering optionally can generate shadows from a number of the light sources available, though not from Point light sources like that present in this design file.
 ➤ Render Window 3 using the Phong render mode
 1 Select the Render tool with the following settings:
 Target: View
 Render Mode: Phong
 Shading Type: Normal
 2 Place a data point in Window 3.
 Window 3 updates, showing the model in Phong rendering mode.
 Observe the reflection of the point light source in the walls. Because Phong rendering does not generate shadows from point light sources, the light has “shone through” the lamp shade and the table.
 Ray Trace render mode
 While this rendering mode can take longer than the others, the result usually is worth it. Ray tracing produces much more realistic images than those we have looked at previously. With ray tracing, the image is generated by simulating the reflection of light rays in the selected view. Even with this primitive model, you will see that ray tracing gives a more realistic result, with shadows produced from the point light source in the lamp.
 Window 3 displaying the viewin Phong render mode.
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Rendering used as a design aid
 ➤ Render Window 4 using the Ray Trace render mode
 1 Select the Render tool with the following settings:
 Target: View
 Render Mode: Ray Trace
 Shading Type: Normal
 2 Place a data point in Window 4.
 Window 4 updates, showing the model in Ray Trace rendering mode.
 Radiosity render mode
 This advance rendering option, which is not covered in this course, is very CPU intensive and should be used only for images in which the inter reflection of light between surfaces is important. Radiosity solving is not a rendering method, as such. It creates a lighting solution. That is, it calculates the effect of lighting in the scene, including shadows and reflection of light from surfaces. For example, a white light reflected off a red wall would have a red tinge to it in real-life. Radiosity calculates the coloring of the reflected light. This information then can be used by the Smooth and Ray Trace rendering methods to produce rendered images that include the reflection of light from surfaces. Without a Radiosity solution, the Smooth and Ray Trace rendering methods only show direct reflection of light sources from surfaces.
 Once a radiosity solution has been calculated and stored in memory, ray tracing is very fast. For example, you can rotate the view to create a number of ray traced images very quickly, though the initial radiosity solving may be time-consuming.
 Rendering used as a design aid
 Working in a 3D design file, in wireframe display mode, it is not difficult to get confused as to the orientation of the view. For example, you may be working in close on a particular part of the model. On zooming out you may not be able to determine
 Window 4 displaying the view inRay Trace render mode.
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Rendering used as a design aid
 the correct orientation. In these cases, rendering the view can solve the problem, as the following exercise demonstrates.
 ➤ Open the example file
 1 Open the design file render_2.dgn.
 This design file has been saved with two identical looking views open in Windows 1 and 2. That is, in wireframe display mode, they look identical. Let’s render them to see if that is the case.
 ➤ Render the two views
 1 Select the Render tool with the following settings:
 Target: View
 Render Mode: Smooth
 Shading Type: Normal
 2 Place data points in both views.
 The views update to display Smooth rendered views of the model.
 As you can see, in fact the two views are not identical. In Window 1 we are looking at one side of the flange, and in Window 2 we are looking at it from the other side.
 Sample file with twoidentical looking
 views open.
 After rendering thetwo views, it is
 obvious that they arenot identical.
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Change View Perspective tool
 Before we continue: What are the four shaded rendering modes?
 Change View Perspective tool
 In the previous section, we saw that rendering a view can help us determine the orientation of the view, where it was not possible to do so with wireframe display mode. We do have another option, however, using perspective.
 By default, MicroStation displays views in parallel projection. That is, there is no perspective displayed. Perspective adds depth to a view, whether in wireframe display mode or one of the shaded modes. The Change View Perspective tool is present in both the 3D View Control tool box, and in the window border tool bar. When you are setting the perspective of a view, you can work with a cube graphic, or you can turn on Dynamic Display to work interactively with the model. We will use both options in the following exercise.
 Using the same design file as in the previous section, we can use perspective to help us determine the orientation of the views.
 ➤ Setting perspective dynamically for a view
 1 Select the Change View Perspective tool from either the 3D View Control tool box or from the window border tool bar.
 2 In the tool settings, check that Dynamic Display is turned on.
 3 In Window 1, place a data point at about the center of the view.
 4 Slowly move the pointer away from the first data point, in any direction. As you move further away from the first data point, notice that the model changes perspective. Moving further away increases perspective, while moving back towards the first data point location decreases perspective.
 5 When you are happy with the amount of perspective, place a data point to set it.
 Window 1 aftersetting perspective.
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Change View Perspective tool
 When working with large complicated models, where screen updates are slower, it may be more convenient to work with the cube graphic when setting the perspective.
 ➤ Setting perspective with Dynamic Display turned off
 1 In the Change View Perspective tool settings, turn off Dynamic Display.
 2 In Window 2, place a data point at about the center of the view.
 A cube graphic appears, showing the view orientation and perspective. A heavier line weight differentiates the front face of the cube.
 3 Slowly move the pointer away from the first data point, in any direction. As you move further away from the first data point, notice that a second cube graphic shows how the perspective would be changed. Moving further away increases perspective, while moving back towards the first data point location decreases perspective.
 4 When you are happy with the amount of perspective, place a data point to set it.
 Having set perspective in a view, this setting remains until you change it back again. Try this for yourself, by using the Rotate View tool to rotate the perspective views. With the perspective set, the orientation of the model is much easier to work out.
 Turning perspective off/on in a view
 When you set perspective in a view, in fact you are creating a “camera” view. That is, a view that is more natural looking as you would see it through a camera viewfinder. Having set the perspective in a view, you can toggle it on or off using the Camera settings. To disable perspective, you simply turn off the view camera. This lets you retain your perspective setting for future use, where you simply turn on the camera for the view.
 ✍ You can also turn off perspective by selecting the Change View Perspective tool and placing two data points near the center of the view.
 ➤ Turn off perspective in the two views
 1 In the 3D View Control tool box, select the Camera Settings tool with the following setting:
 Camera Settings: Turn Off
 2 Place data points in view 1 and view 2.
 Views 1 and 2 are returned to the default parallel projection.
 Similarly, you can turn on the view camera and, thereby, the previously defined perspective setting.
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Camera Settings tool
 ➤ Turn on perspective in the two views
 1 Select the Camera Settings tool with the following setting:
 Camera Settings: Turn On
 2 Place data points in view 1 and view 2.
 Views 1 and 2 are again displayed with perspective.
 Camera Settings tool
 So far, we have worked with several view manipulation tools that have let us move around the design cube to view models from various directions. We are ready now to look at the view camera tools. These let you place your eyepoint anywhere in the design cube, looking in any direction. These tools, along with the rendering tools, effectively let us take a “photograph” of any part of our design from any position. Additionally, we can specify the camera lens parameters to duplicate the effect of using a real camera.
 When using this tool, you have options that let you set both the camera position and its target point, or you can move the target or camera positions individually, leaving the other setting as it was. Let’s look at some practical examples.
 ➤ Set up a camera view
 1 Open the design file vwcamera_01.dgn.
 This design file contains a model of a high rise building.
 2 Use the Render tool with Render Mode set to Smooth to shade the Isometric View.
 3 In the 3D View Control tool box, select the Camera Settings tool with the following settings:
 Camera Settings: Set Up
 Image Plane Orientation: Perpendicular
 Rendered Isometric View ofthe high rise building.
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Camera Settings tool
 You are prompted to “Select view.”
 4 Place a data point in the Isometric View to define it as the camera view.
 You now are prompted to “Define Camera Target Point.” At the same time, the Camera Settings for the Angle, Focal Length, and Standard Lens become active.
 5 From the Standard Lens option menu, choose Wide.
 6 In the Top View, place a data point at location 1.
 A graphic appears in each view, displaying the view cone for the camera view. The screen pointer controls the apex of the view cone, which is the camera location.
 You are prompted to “Define Camera Position.”
 7 In the Top View, place a data point at location 2.
 View 2 (the Isometric View) updates to display the camera view.
 8 Use the Render tool to smooth shade the camera view.
 In the foregoing exercise, we used data points in the Top View to define the camera target point and the camera position. That is, with data points we defined the horizontal positions (x- and y-values), while the Active Depth of the view determined their height, or z-value. Where we want to specify different z values for these positions, we can use 3D data points to define both the target and camera positions. 3D data points are placed by holding down the <Alt> key on the keyboard as you press the data button on the mouse.
 3D data points let you define the target and camera positions interactively (by eye). To do this, you need to have at least two orthogonal views open, such as Top and Front views. Each 3D data point requires two inputs in order to define the x-, y-, and z-values. This may sound complicated, but, as you will see in the next exercises, 3D data points are very easy to use. This method of placing 3D data points is an alternative to using AccuDraw.
 Rendered camera view ofthe high rise building.
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 ➤ Set up a camera view using 3D data points
 1 Select the Camera Settings tool with the following settings:
 Camera Settings: Set Up
 Image Plane Orientation: Perpendicular
 2 Place a data point in Window 2 to define it as the camera view.
 3 In the Top view, while holding down the <Alt> key, place a data point at location 1 to define the x,y values of the data point.
 Borelines appear in each view, showing the location of the data point in the horizontal plane of the Top view. That is, they show the x,y position of the data point that you placed in the Top view. In the Front and Right views, you are looking along the x,y plane and can specify a z value for the data point (anywhere along the boreline).
 4 Move the pointer into the Front view and, while holding down the <Alt> key, place a second data point about half-way up the building (do not snap to any element) to set the z value of the data point.
 A graphic appears in each view, displaying the view cone for the camera view. The pointer controls the apex of the view cone, which is the camera location.
 5 Move the pointer into the Top view and, while holding down the <Alt> key, place a data point at location 2 to set the x,y values.
 Again, borelines appear in the other views. The apex of the camera view cone is attached to the boreline.
 6 Move the pointer into the Front view and, while holding down the <Alt> key, place a data point just above ground level (the green line) to set the z value.
 View 2 updates to display the newly defined camera view.
 Borelines in the Front and Right views, show the location of the data point in the horizontal plane of the top view.
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 7 Use the Render tool to smooth shade the camera view.
 When working with 3D data points, you do not have to start in the Top view. You could, for example, start in the Front view, setting the x-,z-values and then move to the Top view to set the remaining y-value.
 ➤ Set up a camera view with 3D data points, starting in the Front view
 1 Select the Camera Settings tool with the following settings:
 Camera Settings: Set Up
 Image Plane Orientation: Perpendicular
 2 Place a data point in Window 2 to define it as the camera view.
 3 In the Front view, while holding down the <Alt> key, place a data point at the center bottom of the building, at the level of the green line to set the x,z values (no need to snap to the line, just do it “by eye”).
 4 Move the pointer into the Top view and, while holding down the <Alt> key, place a data point at location 1 to set the y value.
 5 Move the pointer into the Front view and, while holding down the <Alt> key, place a data point (by eye) at the top center of the building, again to set the x,z values.
 6 Move the pointer into the Top view and, while holding down the <Alt> key, place a data point at location 2 to set its y value.
 View 2 updates to display the newly defined camera view.
 Rendered image of the newcamera view.
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 7 Use the Render tool to smooth shade the camera view.
 Using the Camera Settings tool in this way, you can quickly check how a newly designed building appears from any direction. Also, you can investigate how it appears relative to other existing buildings by placing simple solids in the design to represent the existing conditions. We can see how this works, using the current sample design file.
 ➤ Practice using the Camera Settings tool
 1 Turn on levels 11-13 in all views.
 2 Use the Fit View view control to fit the Top, Front, and Right views.
 All views now display existing roads and buildings around the new structure.
 3 Turn on level 62 in View 1.
 This level contains location markers 3,4 and 5 (colored red to help distinguish them in the view).
 First, we will set up a camera view, looking along one of the roads, using location markers 3 and 4.
 ➤ Set up a camera view
 1 Select the Camera Settings tool with the following settings:
 Camera Settings: Set Up
 Image Plane Orientation: Perpendicular
 2 Place a data point in View 2 to set it as the camera view.
 3 In the Top View, place a data point at location 3, to set the camera target point.
 4 Still in the Top View, place a data point at location 4, to set the camera location.
 Rendered image of thenew camera view.
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 5 Use the Render tool to smooth shade the camera view.
 Once we have created a camera view, we can change the position of the target point (without moving the camera) or we can move the camera position (without changing the target point).
 ➤ Move the camera position
 1 Select the Camera Settings tool with the following settings:
 Camera Settings: Move
 Image Plane Orientation: Perpendicular
 2 Place a data point in View 2 to set it as the camera view.
 The camera view cone appears in each view. As you move the screen pointer, notice that it is controlling the position of the camera, while the target remains stationary.
 3 In the Top View, while holding down the <Alt> key, place a data point at location 5.
 4 Move the pointer into the Front view and, while holding down the <Alt> key, place a data point at the top of the view.
 View 2 updates to display the new camera view.
 5 Use the Render tool to smooth shade the camera view.
 Camera view created withlocation markers 3 and 4.
 Camera view after movingthe camera position.
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 In a similar fashion, you can move the target position, while retaining the location of the camera. To do this, you simply set Camera Settings to Target. When you select the view, the pointer controls the position of the camera target position.
 Navigate Camera view control tool
 We have seen how to set up a camera view. Wouldn’t it be nice if we could “move” through our design, using our keyboard and/or mouse. Well, that’s exactly what we can do with the Navigate Camera view control. When we select Navigate Camera view control for the first time, it is in Basic Mode. This mode lets us move through a design immediately, using default settings. Additionally, we can select Advanced Mode and configure the default navigation options to suit our own specific needs.
 Basic Mode tool settings are as follows:
 Active View — sets the view in which to navigate the camera. If you try to navigate in a view which does not have a camera turned on, a warning message displays. Once you dismiss the message, the camera is turned on in parallel projection for that view.
 Mode — lets you choose between Basic (default key maps) and Advanced (allows custom key maps).
 Mouse Control — if on, lets you use the mouse to navigate (as well as keyboard keys).
 When you click the Show Settings button (lower left of the dialog box) further settings are displayed:
 Display View Cone — lets you display the camera view cone in all other views. This is useful for orientation in the design file.
 Distance — lets you set the default distance moved for each keypress, or for relative movement of the mouse when Mouse Control is on.
 Degrees — lets you set the default angle that the camera turns for each keypress, or for relative movement of the mouse when Mouse Control is on.
 Here, we will look briefly at Basic Mode navigation. The following table shows you the default navigation keys and what they do. Notice that you can use the arrow keys, or you can use alpha keys on either the left or right side of the keyboard.
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 Other keys let you change the default settings as follows:
 + — increases Distance settings by 10%
 - — decreases Distance settings by 10%
 [ — increases Degrees settings by 10%
 ] — decreases Degrees settings by 10%
 Pressing the Home key, <Q> or <U> resets the camera’s roll, elevation, and orientation. For example, pressing the Home key on your keyboard:
 • once - sets the camera’s tilt angle back to zero degrees (roll).
 • twice - sets the roll, then sets the camera’s elevation angle back to zero degrees (camera is horizontal to the ground).
 • three times - sets the roll, then sets the elevation, then sets the camera’s orientation angle back to zero degrees (camera points in the direction of the positive x-axis).
 When using the mouse to navigate, the following table shows the effects of moving the mouse left/right or forward/back.
 In the following exercises, you will get some practice in how this tool works. We will be “walking” around the model that we used in the Camera Settings tool section.
 Key Key alone <Shift>+Key <Ctrl>+Key <Ctrl-Shift>+Key
 Left Arrow,<A> or <J>
 Turn Left Roll Left Move Left Move Left
 Right Arrow,<D> or <L>
 Turn Right Roll Right Move Right Move Right
 Up Arrow,<W> or <I>
 Move Forward Tilt up Move Forward Move Up
 Down Arrow,<S> or <K>
 Move Back Tilt down Move Back Move Down
 Mouse Movement
 Mouse alone <Shift>+Mouse <Ctrl>+Mouse <Ctrl-Shift>+Mouse
 Left Turn Left Roll Left Move Left Move Left
 Right Turn Right Roll Right Move Right Move Right
 Forward Tilt up Tilt up Move Forward Move Up
 Back Tilt down Tilt down Move Back Move Down
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 ➤ Prepare for the exercise
 1 Open the design file vwcamera_02.dgn.
 2 In Window 2, select the Navigate Camera tool.
 The Navigate Camera dialog box opens.
 3 If necessary, click the Show Settings button (down arrow) in the lower left corner, to show the remaining settings
 4 Check that both Mouse Control and Display View Cone are on.
 This design file has been saved with a camera view set up in Window 2. Note that the camera view cone is present in the other open views. This helps you work out where the camera is located and where it is aimed. We will use the Navigate Camera tool to walk along the street.
 ➤ Use the arrow keys to navigate the camera in view 2 (the camera view)
 1 Press the Up arrow on your keyboard several times. Note that the camera moves forward in the camera view. This can be verified in the Top and Right views where you can see the camera view cone move forward.
 Each keypress moves the camera forward by the amount specified in the Distance field for Arrow Keys, in the tool settings.
 2 Now press the Down arrow several times. Note that the camera now moves backward, again by the specified distance for each keypress.
 3 Press the Right arrow several times to pan the camera to the right. Check in the other views to see that the camera view cone has panned right.
 Each keypress pans the camera by the amount specified in the Degrees field for Arrow Keys.
 4 Press the Left arrow several times to pan the camera back to the left.
 Similarly, you can use your mouse to perform these same tasks. To navigate with the mouse, you place a data point in the camera view and then move the mouse to manipulate the camera. When you have finished, you place a second data point to accept the new camera position, or Reset to return the camera to its original position. Various key and mouse movement combinations are required to perform different tasks.
 Navigate Camera dialog boxbefore (left) and after (right)
 clicking the Show Settings arrow.
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 Looking at the table above, to:
 Move Forward — hold down the <Ctrl> key as you move the mouse forward.
 Move Back — hold down the <Ctrl> key as you move the mouse back.
 Move Left — hold down the <Ctrl> key as you move the mouse left.
 Move Right — hold down the <Ctrl> key as you move the mouse right.
 Pan Right — move the mouse to the right (without holding down a key).
 Pan Left — move the mouse to the left (without holding down a key).
 You may accidentally move the mouse slightly up or down as you are panning left or right. This tilts the mouse up or down, respectively. Don’t worry if this happens. After you have positioned the camera, you can press the <Home> key twice to zero the roll and elevation. Let’s try it.
 ➤ Navigate the camera using the mouse
 1 Place a data point in Window 2.
 2 While holding down the <Ctrl> key, move the mouse forward. Note that the view camera moves forward. You can use the other views to check the position of the camera.
 The sensitivity of the mouse movement is controlled by the Distance field for Mouse value.
 3 While holding down the <Ctrl> key, move the mouse backward to move the camera back, or left/right to move the camera left/right.
 4 Release the <Ctrl> key and move the mouse left/right/forward/back to pan the camera left/right/up/down respectively.
 5 Place a data point to accept the new orientation of the camera.
 6 No doubt, you have a view that now is slightly skewed, from panning the camera. Press the <Home> key on your keyboard twice to zero the roll and elevation.
 Practice using both the key controls and the mouse to navigate around the model. Remember that you can place the camera anywhere in the design cube, pointing in any direction.
 Before we continue: Where is the Set Perspective tool located?
 Where is the Navigate Camera tool located?
 How do you turn off perspective in a view?
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 Working with QuickVisionGL
 Previously, we have set up a view and then rendered it. That is, all the view manipulation was performed in Wireframe display mode, prior to rendering it. Another option we have is to work with QuickVisionGL, a graphics accelerator that is delivered with MicroStation. It is an OpenGL based caching system designed to let you work with design file elements in a shaded (rendered) display mode. Additionally, QuickVisionGL lets you dynamically display hidden lines as well as supporting texture mapping and transparency (which we will cover later in this course).
 QuickVisionGL lets us set up cached views in Wiremesh, Hidden Line, Filled Hidden Line, Constant, or Smooth display modes. Neither Wireframe nor Phong are supported as cached views.
 Setting up QuickVisionGL
 QuickVisionGL is activated via the Rendering View Attributes dialog box. To use QuickVisionGL graphics acceleration, you must be running True (16.7M) or High (65K) color mode.
 ➤ Change the rendering view attributes
 1 Open the design file qvision_01.dgn.
 2 Select Settings > Rendering View Attributes, and set the following:
 View Number: 2
 Display: Smooth Shading
 3 Click Apply.
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 View 2 updates, displaying the model in Smooth Shading mode.
 Let’s see how this view behaves as we rotate it.
 ➤ Rotate view 2
 1 In View 2, select the Rotate View view control with the following settings:
 Method: Dynamic
 Dynamic Display: Off
 2 Rotate View 2 several times.
 Note that the view is rendered each time you rotate it.
 As you can see, the rendering of the view each time it is rotated really is not efficient. Let’s see now how QuickVisionGL can improve the performance of a rendered view.
 ➤ Activate and use QuickVisionGL
 1 In the Rendering View Attributes dialog box, turn on Graphics Acceleration.
 2 Click Apply.
 In the title bar of Window 2, observe that the word “cached” appears after the view title.
 3 Close the Rendering View Attributes dialog box.
 4 Select the Rotate View view control with the same settings as in the previous exercise.
 5 Rotate View 2 several times.
 Note that the re-display of the view now is significantly faster.
 Using Dynamic Display
 We have the option of turning on Dynamic Display when using various tools, such as Rotate View, Pan View, Zoom In/Out and Change View Perspective. In wireframe display
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 mode, screen updates are fast. In a non-accelerated rendered view, however, screen updates can be time-consuming.
 QuickVisionGL lets us work productively in a rendered view. With it activated, we can utilize dynamic display with rotation, panning and changes in perspective in the rendered view.
 ➤ Using dynamic display in the rendered view
 1 Select the Pan View view control with the following setting:
 Dynamic Display: On.
 2 In the Isometric (rendered) view, place a data point in the center of the opening in the top of the model.
 3 Move the pointer to place the opening in the center of the view.
 4 Select the Fit View view control with Center Active Depth turned on.
 5 Place a data point in View 2.
 6 Select the Rotate View view control with the following settings:
 Method: Dynamic
 Dynamic Display: On
 7 Place a data point in the center of View 2.
 8 Move the pointer about the screen and notice how the view rotates dynamically, while remaining in Smooth rendered display mode.
 9 Place a data point to accept the rotation.
 10 In the tool settings, change Method to Isometric.
 11 Place a data point in the cached view.
 The view is returned to an Isometric orientation.
 Another tool that features dynamic display is the Pan View view control.
 ➤ Pan the view with dynamic display activated
 1 Select the Pan View view control with the following setting:
 Dynamic Display: On.
 2 Place a data point in the cached view.
 3 Move the pointer around the view and notice how the model moves with the pointer but remains in the shaded mode.
 4 Place a second data point to accept the panned view.
 Similarly, you can change the perspective of the view.
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 ➤ Add perspective to the cached view
 1 In the cached view, select the Fit View view control to fit the view.
 2 Select the Change View Perspective view control with the following setting:
 Dynamic Display: On.
 3 Place a data point at the center of the cached view.
 4 Move the pointer away from the center of the view to change the perspective of the view. Notice that the view remains in the Smooth rendered display mode as the perspective is varied.
 5 Place a data point to accept the new perspective setting.
 6 Select the Rotate View view control with the following settings:
 Method: Dynamic
 Dynamic Display: On
 7 Place a data point at the center of View 2.
 8 Move the pointer about the screen and notice how the view rotates dynamically, while remaining in Smooth rendered display mode and retaining the perspective setting.
 9 Enter a Reset to leave the view at its original rotation.
 10 Select the Change View Perspective view control.
 11 Enter two data points at the center of the cached view to turn off perspective, in preparation for the next operation.
 Another viewing tool, Zoom In/Out, also lets you work with dynamic display in a cached view.
 ➤ Zoom in on the opening in the top of the model
 1 Select the Zoom In/Out tool (from the 3D View Control tool box).
 2 Place a data point at the center of the opening in the top of the model.
 3 Move the pointer away from the first data point, so that the cube graphic encompasses the complete opening in the top of the model, and enter a data point.
 The view is magnified to display the section of the model selected with the cube graphic. As you move the pointer away from, or toward the center of the view, the model view is zoomed in or out respectively.
 4 Place a data point to accept the degree of magnification.
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 Set View Display Mode tool
 You can use the Set View Display Mode view control tool to quickly switch between various display modes. You can choose from the unaccelerated Wireframe and Phong modes, or the accelerated Wiremesh, Hidden Line, Filled Hidden Line, Constant, or Smooth display modes.
 ➤ Using the Set View Display Mode view control
 1 Open the design file qvision_02.dgn.
 2 Select the Set View Display Mode view control with the following settings:
 View: 2
 Display Mode: Hidden Line
 Display Hidden Edges: Off
 View 2 updates to display the model in Hidden Line display mode.
 3 In the tool settings, turn on Display Hidden Edges.
 View 2 updates to display hidden edges as dashed lines.
 With the view cached in this display mode, still you can rotate, zoom in/out, pan, or set perspective. Each time, the view updates to display the model with hidden lines shown as dashed lines.
 4 In the Set View Display Mode tool settings, set Display Mode to Smooth.
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 View 2 updates to display the model in Smooth shaded display mode. By default, Display Edges is turned off.
 5 Turn on Display Edges.
 The model displays in Smooth shaded mode with Edges displayed as bold lines and Hidden Lines displayed as finer dashed lines. You can turn off Hidden Lines, so that only the visible edges are displayed.
 Before we continue: Which of the following rendering display modes are not supported by QuickVisionGL as cached views:Wireframe, Wiremesh, Hidden Line, Filled Hidden Line, Smooth, Phong, Ray Trace?
 Display mode set toSmooth, with Edges andHidden Lines displayed.
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4 Introduction to drawing in 3D
 To this point, we have concentrated on the 3D design environment, views and view manipulations, and a brief introduction to the rendering tools. This knowledge of the 3D environment is fundamental to constructing 3D models. In this lesson we will start with some simple drawing tools and element manipulation. The following topics will be covered:
 • “Basic element placement in 3D” on page 57
 • “Basic element manipulation and modification in 3D” on page 60
 • “Auxiliary Coordinate Systems (ACS)” on page 64
 Basic element placement in 3D
 Placing elements in a 2D file is as simple as drawing on a sheet of paper. All elements are in the one plane, the x,y plane. Consider planar elements, such as blocks, shapes, and circles. In 2D designs, their planes are always in the x,y plane of the design file. When you place these same elements in a 3D file, they are placed parallel to the view being used. For example, if you place a block in a Top view, it will be in the x,y plane. If you place the same block in a Front view, it will be aligned to the x,z plane, or in a Right view it aligns to the y,z plane. If you place a block in a rotated view (other than one of the standard views) still it will be placed parallel to the view (that is, parallel to your screen). In other words, you can orientate elements at any angle in a 3D file. The same applies to 3D specific elements.
 In the following example, we will begin construction of a simple rectangular box, using 2D blocks to form the surfaces. We will use the Place Block tool to draw the first three faces, making use of the standard views to place them with the correct orientation.
 ➤ Open the “blank” exercise design file
 1 Open the design file basic_draw_3D.dgn.
 This design file was created from the 3D seed file “seed3d.dgn.” Like many other 3D seed files, it contains a model of a cube with annotations on each face,
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 describing the face’s location. This is similar to the model we used in an earlier chapter. Note in the Isometric view, that we are looking directly along the diagonal from the Front-Top-Left corner to the Back-Bottom-Right corner of the cube.
 ➤ Prepare for the exercise
 1 In the Primary tool bar, set the following:
 Active Level: 2
 Active Color: Green (2)
 2 Turn off level 1 in each view.
 (The 3D cube is on level 1.)
 3 Start AccuDraw.
 First, using the Top view, we will draw the top face of the box.
 ➤ In the Top view, draw the top face of the box
 1 Select the Place Block tool.
 2 Place a data point in the lower left corner of the Top view.
 3 Move the pointer to the right and, with it indexed to AccuDraw’s x-axis, key in 1.5 (do not place a data point)
 4 Move the pointer upward and enter 1.25.
 5 Place a data point to complete the block.
 6 Use the Fit View view control to fit each view.
 The four viewsafter placing the
 first block,forming the top of
 the model.
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 Note that the block appears as a line in both the Front and Right views. This is because in both those views, it is edge on to the view, like looking at a sheet of paper edge on. Next, we will use the Front and Right views to draw the front and right faces, respectively. First, the front face.
 ➤ In the Front view, draw the front face of the box
 1 Select the Place Block tool.
 2 In the Front view, snap to the left end of the existing block, which appears as a line in the Front view, and accept with a data point.
 3 Move the pointer to the right and, with it indexed to AccuDraw’s x-axis, key in 1.5.
 4 Move the pointer downward and enter 0.5.
 5 Place a data point to complete the block.
 6 Use the Fit View view control to fit each view.
 ✍ Because AccuDraw was active, we did not have to set the active depth in the Front view. AccuDraw set the active depth temporarily to the depth of the first snap point.
 Now, to draw the right face.
 ➤ In the Right view, draw the right face of the box
 1 Select the Place Block tool.
 2 In the Right view, snap to the right end of the top surface (the horizontal line), and accept with a data point.
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 3 Still in the Right view, snap to the bottom of the front surface (the vertical line), and accept with a data point. As you do this, check in the Isometric view to ensure that the block is being placed correctly.
 As you can see, placing elements such as the block is no more difficult than in 2D. MicroStation’s views help you correctly orientate the elements. Later, you will see that AccuDraw makes this even more simple. We will complete this model in the next section.
 Basic element manipulation and modification in 3D
 All your 2D element manipulation tools can be used in 3D. Existing elements can be moved and copied without changing their orientation. That is, vertical elements remain vertical, horizontal elements remain horizontal, and so on. Some care is required when rotating elements, because in 3D you have three axes about which the element may be rotated.
 For our model, we will simply copy the existing elements to form the missing surfaces. For simplicity, we will use the Isometric view.
 ➤ Copy the front face to form the back face
 1 Select the Copy Element tool.
 2 In the Isometric view, snap to the top left corner of the front face of the model and accept with a data point.
 The model withthe top, front and
 right facescompleted.
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 3 Snap to the back left corner of the top surface and accept with a data point to complete the copy.
 4 Reset to finish.
 ➤ Copy the right face to form the left face
 1 Select the Copy Element tool.
 2 In the Isometric view, snap to the top back corner of the right face of the model and accept with a data point.
 3 Snap to the back left corner of the top surface and accept with a data point to complete the copy.
 4 Reset to finish.
 ➤ Copy the top face to form the bottom face
 1 Select the Copy Element tool.
 2 In the Isometric view, snap to the front right corner of the top face of the model and accept with a data point.
 3 Snap to the bottom right corner of the front surface and accept with a data point to complete the copy.
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 4 Reset to finish.
 Having created our simple box, we will now see how the modification tool works in 3D and how AccuDraw responds to the various elements we select.
 ➤ Modify the top surface
 1 Make sure that AccuDraw is active.
 2 Select the Modify Element tool.
 3 In the Isometric view, snap to the top surface of the box, at its front left vertex, and accept with a data point.
 Note that AccuDraw’s compass is aligned with the top surface element.
 4 Move the pointer to the right and, with it indexed to AccuDraw’s x-axis, key in 0.5 and enter a data point.
 This shortens the top surface by 0.5 meters.
 5 Reset to finish.
 6 In the Isometric view, snap to the front surface of the box, at its top left vertex, and accept with a data point.
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 Note that AccuDraw’s compass is now aligned with the front surface element.
 7 Move the pointer to the right, indexed to the x-axis, until the previous distance indicator appears, then enter a data point.
 8 Reset to finish.
 9 As an experiment, still in the Isometric view, snap to the left surface, at its top front vertex, and accept with a data point.
 Note that AccuDraw’s compass now aligns itself with the side surface element.
 10 Reset to exit, without adjusting the dimension of the side surface.
 In the preceding exercises, you have seen how you can use the views to correctly align elements in 3D. In the final exercise, where you modified the model box, you saw how AccuDraw aligned itself each time with the orientation of the chosen element. In the next chapter, we have a closer look at the power of AccuDraw in 3D. First, though, a quick discussion on Auxiliary Coordinate Systems.
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 Auxiliary Coordinate Systems (ACS)
 MicroStation’s default coordinate system is the Rectangular or Cartesian system. As well, MicroStation has two other coordinate systems available to you — Spherical and Cylindrical. In this course, we will use only the Rectangular coordinate system.
 You can use the Spherical coordinate system to draw objects that have a spherical nature, such as geodesic domes or cylinder heads. With the Spherical coordinate system, locations are specified by two angles and a distance from the origin of the coordinate system.
 In a similar way, the Cylindrical coordinate system simplifies the location of points on cylindrical objects, such as a spiral staircase or a screw. In this system, locations are specified by the distance from the origin, an angle and the height on the z-axis.
 As you will see in the next chapter, you can use AccuDraw shortcuts to create a rectangular Auxiliary Coordinate System, but not a Cylindrical nor a Spherical system.
 Before we continue: When you copy an element in 3D, how does its orientation change, if at all?
 How does AccuDraw react in a 3D file, when you identify a surface element to modify?
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 Working in 3D is made much simpler when you use AccuDraw effectively. As experienced MicroStation users, you should be familiar with the power of AccuDraw when working in 2D. In the previous section of this course, you saw how AccuDraw’s compass automatically aligned itself with the selected element when modifying elements in 3D. When drawing in 3D, AccuDraw is an intelligent drawing aid that interprets the position of the pointer relative to previous data points, view orientation, or coordinate system. Using AccuDraw you can quickly place additional data points that build on those placed previously. You can use AccuDraw by itself, or with a rectangular Auxiliary Coordinate System (ACS). We will concentrate on the following 3D AccuDraw functions:
 • “Using the AccuDraw drawing plane in 3D” on page 59
 • “Using AccuDraw to draw in 3D” on page 63
 • “Drawing plane rotation with AccuDraw” on page 65
 • “Using AccuDraw with an Auxiliary Coordinate System (ACS)” on page 74
 • “Tentative snaps with AccuDraw in 3D” on page 77
 Using the AccuDraw drawing plane in 3D
 Originally, AccuDraw was designed to work with the 3D drawing environment. Traditionally, more effort was required to place data points in 3D, compared to drawing in 2D. For example, to place data points (graphically) in the Top plane, you had to be in the Top view. If the next data point was in the Front view then you had to move to the Front view to place that point. You could use key-ins, but this also was cumbersome. With AccuDraw, the task is made simple.
 When using AccuDraw, you can work in a “picture” view. That is, views other than Top, Front, Right, and so on. Rotated views such as Isometric or Right Isometric display the design much more clearly. Using these views, when you want to draw an object in the Top plane, you simply rotate the AccuDraw compass to that plane using an AccuDraw shortcut. Using AccuDraw shortcuts, no matter what view you are working in, you can align the AccuDraw drawing plane to the current view or
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 to Top, Front or Side plane orientation. For example, while working in the Isometric view, you can place elements in the Top, Front or Side planes.
 ✍ Remember that the focus must be on the AccuDraw window for its shortcuts to work.
 Lets see how this works in practice.
 ➤ Prepare for the exercise
 1 Open the design file adraw_ex_01.dgn.
 2 If necessary, make the Active Color red.
 3 Start AccuDraw.
 This design file has been saved with four views open, displaying two hexagons, one above the other. For the first part of the exercise, we will place a block joining the front edges of the two hexagons. We will work in the Isometric view, using AccuDraw to correctly orientate the element.
 ➤ Using AccuDraw’s drawing plane
 1 Select the Place Block tool with Method set to Orthogonal.
 2 In the Isometric view, snap to the lower hexagon vertex at location 1 and accept with a data point.
 Note that the AccuDraw drawing plane is aligned with the view. The block is being drawn parallel to the view, or screen.
 3 Use the AccuDraw shortcut <F> to rotate the drawing plane to Front.
 Note that the block now is aligned exactly with the front edge of the hexagon.
 4 In the Isometric view, snap to the upper hexagon vertex at location 2 and accept with a data point.
 Isometric view showingAccuDraw’s drawing plane
 rotated to Top, Front, Side andView orientations.
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 5 Update all views.
 Looking at the other three views, you should be able to see that the block is located in the front plane of the design. In both the Top and Right views, the block appears as a red line because we are viewing it edge on.
 Other tools that rely on the view orientation also can be used with AccuDraw. Let’s look at some of these.
 ➤ Using AccuDraw with the Mirror Element tool
 1 Select the Mirror Element tool with Mirror About set to Horizontal. Leave all other settings turned off.
 2 In the Isometric view, identify the red block at location 4.
 Note that the drawing plane still is in the Front orientation and the element is being mirrored vertically.
 3 Use the AccuDraw shortcut <T> to change the drawing plane to Top.
 4 Snap to the center of the hexagon at location 3 and accept with a data point.
 5 Reset to finish.
 Placing the block in the Isometricview, using AccuDraw’s Front
 drawing plane.
 Mirroring the block using theIsometric view and AccuDraw’s Top
 drawing plane.
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 ➤ Using AccuDraw with the Rotate tool
 1 Select the Rotate tool with the following settings:
 Method: Active Angle
 Active Angle: key in 120
 Make Copy: off
 2 In the Isometric view, identify the red block.
 AccuDraw’s drawing plane still is in the Top orientation, as we want it.
 3 Snap to the center of the hexagon at location 3, and accept with a data point.
 4 Reset to finish.
 Similarly, you can use AccuDraw’s drawing plane orientation to create an array of the red block.
 ➤ Create a polar array of the red block
 1 Select the Construct Array tool with the following settings:
 Array Type: Polar
 Items: 6
 Delta Angle: 60
 Rotate Items: On
 2 In the Isometric view, identify the red block.
 3 Snap to the center of the hexagon at location 3 to define the center of the array.
 4 Accept with a data point to complete the array.
 Using AccuDraw in this way lets you work in any view.
 Rotating the block using theIsometric view and AccuDraw’s Top
 drawing plane.
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 Using AccuDraw to draw in 3D
 By now, you should have some idea of how AccuDraw works in the 3D environment. Before continuing, let’s go back one step and look at the simple box that we drew in the previous chapter. There, we used the views to correctly orientate the top and first two sides of the box. We will now draw the same model, in the Isometric view, with the aid of the AccuDraw drawing plane.
 ➤ Open the design file and draw the top
 1 Open the design file adraw_ex_02.dgn, which has been saved with only Window 2, an Isometric view, open.
 2 Make sure that AccuDraw is started.
 3 Select the Place Block tool with Method set to Orthogonal.
 4 Enter a data point at location 1.
 5 Use the AccuDraw shortcut <T> to set the drawing plane to Top.
 6 Move the pointer to location 2 and with it indexed to the x-axis, key in 1.5 (do not place a data point).
 7 Move the pointer to location 3 and key in 1.25.
 8 Place a data point to complete the block.
 Continuing, draw the front and right side faces.
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 ➤ Draw the front and right side faces
 1 With the Place Block tool still active, snap to the vertex of the top at location 1 and accept with a data point.
 2 Use the AccuDraw shortcut <F> to set the drawing plane to Front.
 3 Move the pointer to the right and snap to the top face’s vertex near location 2 (do not place a data point).
 4 Use the AccuDraw shortcut <O> to reset AccuDraw’s origin to the snap point.
 5 Move the pointer downward and with it indexed to AccuDraw’s y-axis, key in 0.5 and place a data point to complete the front face.
 6 Use the AccuDraw shortcut <S> to set the drawing plane to Side.
 7 With the pointer at the center of the AccuDraw compass, so that the X,Y, and Z values in the AccuDraw window are zero, place a data point to begin the next face.
 8 Snap to the top vertex, near location 3 and accept with a data point.
 9 Reset to finish.
 In fact, you did not have to change the orientation to Side for the last face. Because you are working in 3D each drawing plane has an X, Y, and Z component. Therefore, a block can be drawn at an angle to the drawing plane, but you need an element to snap to, or a coordinate value to key in. Without an existing element or
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 key-in value, AccuDraw lets you move graphically in its current X,Y drawing plane only. To see for yourself — without changing the AccuDraw drawing plane, draw the back face of the box.
 ➤ Draw the back face
 1 With the Place Block tool still active, snap to the bottom back vertex of the right side face at location 4 and accept with a data point.
 2 Snap to the back left vertex of the top face at location 5 and accept with a data point.
 If you want to complete the box, simply copy the top face to the bottom and the right face to the left, as you did in the earlier exercise.
 Drawing plane rotation with AccuDraw
 So far, we have drawn elements that are aligned with the axes of the design file. AccuDraw’s drawing plane feature lets you work in any view, while still maintaining the correct plane for the elements being drawn. Still you can snap to elements that are not on the current drawing plane and AccuDraw responds accordingly.
 When you work in 2D, AccuDraw’s drawing plane axes change depending on the tool and the previous two data points. Similarly, as you draw in 3D with AccuDraw active, you may observe the drawing plane rotating as you work. Again, this is feature that depends on the tool being used and/or the location of the three previous data points. For example, when you draw a SmartLine, it interprets a default rotation of the drawing plane from the three most recently placed data points — three points being the minimum requirement to describe a planar surface. In these cases, as you place the third data point, AccuDraw orientates the drawing plane to align with the “plane” formed by it and the two previous points. This becomes clear in the next exercise.
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 ➤ AccuDraw’s automatic drawing plane rotation
 1 Open the design file adraw_ex_03.dgn.
 This file has been saved with Top, Isometric, Front and Right views open. The Isometric view has level 2 turned on, containing location markers.
 2 Select the Place SmartLine tool with following settings:
 Segment Type: Lines
 Vertex Type: Sharp
 Join Elements: On
 3 Snap to the center of the circle at location 1 and accept with a data point.
 Note that AccuDraw’s drawing plane currently aligns with the view.
 4 Snap to the center of the circle at location 2 and accept with a data point.
 AccuDraw uses the two data points, plus the view to set the drawing plane orientation. This results in a drawing plane that is not in alignment with any of the standard Top, Front or Side drawing planes.
 5 Snap to the center of the circle at location 3 and accept with a data point.
 AccuDraw’s drawing plane now aligns itself with the plane of the three data points (1, 2 and 3). In this case the points are aligned with the Top drawing plane.
 6 Continue snapping to the centers of the circles at locations 4, 5 and 6, noticing how the drawing plane aligns each time with the three previously placed data points, as follows:
 Point 4 — Side (from points 2, 3 and 4)
 Points 5 and 6 — Front (points 3, 4, 5 and 6 are in the same plane).
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 7 Reset to finish.
 In the previous exercise, we snapped to existing elements to draw the SmartLine. It is not always possible to snap to an existing element to place a data point. In these instances, we can use the T, F and S AccuDraw shortcuts to set the drawing plane to the Top, Front or Side orientation, respectively. There will be cases, however, when the item being drawn is not aligned with any of these standard planes. For these cases, we can use AccuDraw shortcuts that let us rotate the drawing plane 90° about the x or y axes. Two of these shortcuts, RX and RY, let us specify the axis about which to rotate the drawing plane. Another shortcut, E cycles through rotations, first about the x-axis, then about the y-axis, then returns the drawing plane to the start orientation. In practice, the E shortcut may be the simplest to use because you can have your finger on the E key and press it once for rotation about the x-axis, or twice for rotation about the y-axis, with the third press returning the drawing plane to where it started.
 Let’s now see how we can use these shortcuts to place a SmartLine, but without snapping to existing elements.
 ➤ Prepare for the exercise
 1 Make Level 3 the Active Level.
 2 Turn off all other levels in all views.
 3 Turn on level 4 in view 2 (the Isometric view).
 Level 4 contains yellow location markers. In the following exercise, we will use these location markers as a guide, but we will not snap to them. We are drawing a similar SmartLine to the previous exercise. That is, all the segments are at right angles to each other, but they do not align with the x or y axes of the design cube.
 As the SmartLine is drawn,AccuDraw’s drawing plane
 changes orientation.
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 ➤ Place the SmartLine, using AccuDraw
 1 Select the Place SmartLine tool with following settings:
 Segment Type: Lines
 Vertex Type: Sharp
 Join Elements: On
 2 In the Isometric view, place a data point at location 1 without snapping to the element.
 3 Use the AccuDraw shortcut <T> to switch to the Top plane.
 4 Move the pointer to location 2 (note that it does not align with the x-axis) and place a data point (remember not to snap to the location markers).
 AccuDraw now rotates Top plane to align the x-axis with the line joining the two data points just placed.
 5 Move the pointer to location 3 and with it indexed to the y-axis, place a data point.
 The drawing plane remains “horizontal” but rotates to align the x axis with the last two data points.
 As the next point (4) is above point 3, we have to rotate the drawing plane.
 Left: Data point 2 is not indexed to the drawing plane x-axis. Right: After placing data point 2, the drawing plane aligns itself with the 2 data points.
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 6 Use the AccuDraw shortcut <RY> to rotate the drawing plane about the y-axis.
 7 Move the pointer upward to location 4 and with it indexed to the x-axis, place a data point.
 The drawing plane now aligns itself with the plane of the previous three data points.
 In order to move to location 5, we again have to rotate the drawing plane.
 8 Use the AccuDraw shortcut <RX> to rotate the drawing plane about the x-axis.
 9 Move the pointer to location 5 and with it indexed to the y-axis, place a data point.
 Left: After placing point 3 the drawing plane is aligned with the first 3 data points. Right: After rotating the drawing plane 90° about its y-axis.
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 10 Move the pointer to location 6 and with it indexed to the y-axis, place a data point.
 11 Reset to finish.
 ➤ Repeat the exercise using the <E> shortcut
 1 Delete or undo the SmartLine just placed.
 2 Select the Place SmartLine tool (use same settings as before).
 3 In the Isometric view, place a data point at location 1 without snapping to the element.
 4 Use the AccuDraw shortcut <T> to switch to the Top plane.
 5 Move the pointer to location 2 (note that it does not align with the x-axis) and place a data point (remember not to snap to the location markers).
 AccuDraw now rotates Top plane to align the x-axis with the line joining the two data points just placed.
 6 Move the pointer to location 3 and with it indexed to the y-axis, place a data point.
 The drawing plane remains “horizontal” but rotates to align the x axis with the last two data points.
 As the next point (4) is above point 3, we have to rotate the drawing plane.
 7 Use the AccuDraw shortcut <E> (once) to rotate the drawing plane about the x-axis.
 8 Move the pointer upward to location 4 and with it indexed to the y-axis, place a data point.
 In order to move to location 5, we again have to rotate the drawing plane.
 9 Use the AccuDraw shortcut <E> (once) to rotate the drawing plane about the x-axis.
 10 Move the pointer to location 5 and with it indexed to the y-axis, place a data point.
 11 Move the pointer to location 6 and with it indexed to the y-axis, place a data point.
 12 Press <E> three times and note how the drawing plane is rotated first about the x-axis, then the y-axis and finally is returned to the original orientation.
 13 Reset to finish.
 By now, you should be getting some idea of the power of AccuDraw in 3D. In the previous exercise, we worked with a SmartLine and were able to change the drawing plane rotation for each data point as we worked. Planar elements, such as the blocks and circles, rely on the orientation of the drawing plane to determine
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 their orientation. In other words, you have to set up the drawing plane prior to placing these elements. For this purpose, you can use another shortcut, RQ (think of Rotate Quick) to rotate the drawing plane. The following exercise shows you how it is done.
 ➤ Prepare for the exercise
 1 Open the design file adraw_ex_04.dgn.
 2 Make red the Active Color.
 This design file shows Top, Isometric, Front and Right views of a yellow triangle. Looking at the Top view, you can see that none of the yellow triangle’s sides are parallel with the x- or y- axes of the design cube. The Front and Right views show that the triangle is horizontal (that is, it is located in the xy-plane of the design). To demonstrate the RQ shortcut, we will place horizontal and vertical blocks that are aligned with the left side of the triangle.
 ➤ Place a horizontal block along the left edge of the triangle
 1 Select the Place Block tool with Method set to Orthogonal.
 2 Snap to the vertex at location 1 and accept with a data point.
 3 Use the AccuDraw shortcut <T> change the drawing plane to Top.
 As you move the pointer, note that the edge of the block is aligned with the drawing plane compass but not with the left edge of the triangle.
 4 Use the AccuDraw shortcut <RQ>.
 You are prompted to “Define X axis.” As you move the pointer, the AccuDraw compass rotates with it.
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 5 Snap to the vertex at location 2, and accept with a data point.
 The drawing plane compass now aligns with the edge of the triangle.
 6 Move the pointer to location 3 and place a data point.
 After placing the data point to complete the block, the AccuDraw compass now returns to the unrotated Top orientation.
 7 Reset to finish.
 Both the Top and Isometric views show that the block is aligned exactly with the edge of the triangle. The Front and Right views show that it is in the same plane as the triangle. Now to draw a vertical block along the same edge.
 ➤ Place a vertical block along the left edge of the triangle
 1 With the Place Block tool still active, snap to the vertex at location 2 and accept with a data point.
 2 Use the AccuDraw shortcut <RQ>.
 3 Snap to the vertex at location 1 and accept with a data point.
 This has rotated the drawing plane to align the x-axis with the edge of the triangle. We now have to rotate the drawing plane about the x-axis.
 After placing the block,AccuDraw’s drawing plane
 compass returns to theunrotated Top orientation.
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 4 Use the AccuDraw shortcut <RX>.
 The drawing plane now is vertical, which lets us place the block vertically.
 5 Move the pointer to location 4 and place a data point.
 After placing the data point to complete the block, the AccuDraw compass again returns to the unrotated Top orientation.
 6 Reset to finish.
 Again, looking at the Top and Isometric views, we can see that the block is aligned along the edge of the triangle.
 As you can see, it is not difficult to work in a rotated view, such as the Isometric view, using AccuDraw to set the drawing plane. You have seen, also, how easy it is to rotate the drawing plane to suit the situation. Where the drawing plane is rotated to a non-standard orientation, however, it returns to a standard orientation on completion of the current task. In the exercises, you saw it return to a Top orientation after placing the blocks. This form of rotation is fine, if you are drawing a single element, but what if you want to draw a number of elements. This is where the Auxiliary Coordinate System (ACS) feature of AccuDraw comes to our aid.
 After placing the block,AccuDraw’s drawing plane
 compass returns to theunrotated Top orientation.
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 Using AccuDraw with an Auxiliary Coordinate System (ACS)
 You have seen how simple it is to rotate AccuDraw’s drawing plane to draw an element. On completion of the task, the drawing plane returns to its unrotated state (View, Top, Front or Side). To draw a single element, this method is fine. Where you want to use this drawing plane orientation for future work, you should set up an Auxiliary Coordinate System or ACS. Also, it is not always that your designs will align with one or more axes of the design cube. It is important that you can draw elements no matter what their orientation in the design cube. Using an ACS, AccuDraw lets you quickly rotate its drawing plane to match the rotation of the design.
 You can use AccuDraw with a Rectangular ACS only — Spherical and Cylindrical ACSs are not supported. AccuDraw has shortcuts that let you create, save and recall rectangular ACSs.
 ➤ Prepare for the exercise
 1 Open the design file adraw_ex_05.dgn.
 2 Make sure that AccuDraw is started.
 This design file contains the base and two sides of a 3D model that are not aligned with any orthogonal plane in the design file. You can see in the Top view that the model is not aligned with the x- or y-axes. In the Front and Right views, you can see that it is not horizontal. Our task is to draw the remaining sides on this model. To do this, we could rotate our views so that they are aligned with the model. A simpler method is to create an ACS that is aligned with the model. We can then work in any view using AccuDraw and the ACS. Before doing this, let’s see if a quick rotation, like we used in the last exercises, will work.
 ➤ Try placing a block using quick rotation
 1 Select the Place Block tool with Method set to Orthogonal.
 2 In the Isometric view, snap to the vertex at location 1 and accept with a data point.
 3 Use the AccuDraw shortcut <T> to switch to the Top plane.
 4 Use the AccuDraw shortcut <RQ>.
 5 Snap to the vertex at location 2 and accept with a data point to set the rotation.
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 6 Move the pointer toward location 3, looking at the other views as you do this. Note that everything looks correct in the Top view, but the other views show that the block is not aligned with the model.
 7 Reset to exit.
 Because the RQ shortcut lets us rotate the drawing plane about one axis only, we cannot use this method to align with a model that is skew to all axes. This time, we will set up an ACS.
 ➤ Place a block using an ACS
 1 Select the Place Block tool.
 2 In the Isometric view, snap to the vertex at location 1 and accept with a data point.
 AccuDraw’s drawing plane has returned to the Top orientation.
 3 Use the AccuDraw shortcut <RA>.
 You are prompted to “Define X axis origin.”
 4 In the tool settings window, turn on Use Current Origin, which accepts the current data point as the origin.
 Graphics display the drawing plane, with its origin at the data point. The pointer controls the direction of the x-axis. You are prompted to “Define X axis.”
 5 Snap to the vertex at location 2 and accept with a data point.
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 The x-axis is fixed. As you move the pointer, the drawing plane spins about the x-axis as the pointer now controls the direction of the y-axis. You are prompted to “Define Y axis.”
 6 Snap to the vertex at location 3 and accept with a data point.
 The drawing plane is rotated to match the model. As you move the pointer, note that the block now is aligned with the edges of the model.
 7 Snap to the vertex at location 3 and accept with a data point.
 The block is completed. Note that AccuDraw’s drawing plane remains in the new rotated alignment this time. It does not return to the Top orientation.
 Currently, the ACS is in memory only. That is, if you used another of the AccuDraw shortcuts that rotate the drawing plane, then the ACS settings would be lost. We can, however, save the ACS for later recall, as follows:
 ➤ Save the ACS
 1 With the ACS active, use the AccuDraw shortcut <WA> (to Write ACS).
 The Write to ACS dialog box opens.
 2 In the Name field, key in MYACS.
 3 Click OK.
 The dialog box closes and the ACS is saved to disk.
 With the ACS saved, you can recall it at any time.
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 ➤ Change to a Top plane, and then recall the ACS
 1 Select the Place Block tool.
 2 In the Isometric view, snap to the vertex at location 3 and accept with a data point.
 3 Use the AccuDraw shortcut <T> to switch to the Top plane.
 4 Snap to the vertex at location 4 but do not enter a data point.
 The block is not correctly located on the model. To remedy this, we have to recall the ACS and redraw the block.
 5 Use the AccuDraw shortcut <GA>.
 The Get ACS dialog box opens.
 6 Check that Rotation is turned on, because we want to rotate the drawing plane to the ACS.
 7 If necessary, in the Name field, key in MYACS.
 8 Click OK.
 The dialog box closes and the drawing plane is rotated to the ACS. The block is now correctly orientated with the model.
 9 Accept with a data point to complete the block.
 10 With the ACS active, you can use the Place Block tool to complete the remaining three faces of the model.
 Tentative snaps with AccuDraw in 3D
 There will be many occasions in your 3D work when you will locate elements relative to others already present in the design. In 2D, all elements were on the same plane. In 3D the elements often are on different planes. In the following example, we will place a SmartLine to represent a paved area for a building complex. In this exercise file, the building complex is represented in a simplified form.
 ➤ Draw the paved area for the building complex
 1 Open the design file adraw_ex_06.dgn.
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 2 Select the Place SmartLine tool with following settings:
 Segment Type: Lines
 Vertex Type: Rounded
 Rounding Radius: 1.5
 Join Elements: On
 3 In the Isometric view, snap to the vertex at location 1 and accept with a data point.
 4 Use the AccuDraw shortcut <T> to switch to the Top plane.
 5 Move the pointer down to the left and with it near or indexed to the x-axis, press <Return> key to constrain the point to this axis (do not enter a data point).
 6 Snap to the vertex at location 2 and accept with a data point.
 As you snap to the vertex, AccuDraw displays a dashed line (perpendicular to the x-axis) back to the point being placed. This is just as you would expect in 2D.
 7 With the pointer still at location 2, press <Return> to constrain the next point to the y-axis.
 8 Snap to the vertex at location 3. As you snap to the vertex, AccuDraw displays a dashed line from the snap point vertically down to the plane of the element being drawn and then across to the point being placed.
 9 Accept with a data point.
 10 Again position the pointer and press <Return> to constrain the next point to the y-axis.
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 11 Snap to the vertex at location 4 and accept with a data point.
 12 Constrain the next point to the x-axis.
 13 Snap to the vertex at location 2 and accept with a data point.
 14 Reset to finish.
 Before we continue: What are the standard rotations in 3D for AccuDraw?
 What does the AccuDraw shortcut <E> do?
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6 Introduction to 3D drawing tools
 Previously, in this course, you have used the Place Block tool to draw 2D blocks in a 3D file. You have worked also with the Place SmartLine tool to place 3D SmartLines. Time now to look at some of the 3D specific tools. These can be divided into two basic groups. The first group includes tools for placing elements such as such as non-planar line strings and B-Spline curves. The second group comprises the tools for creating 3D primitives such as a slab, sphere, cone, cylinder, torus or wedge. In this chapter, we will cover the following topics:
 • “3D Curves” on page 81
 • “3D Primitives tool box” on page 90
 3D Curves
 You may have worked with SmartLines and B-spline curves in 2D, where they are constrained to being planar. In 3D design files, these elements no longer have this constraint. Additional to these tools, Place Helix, lets you draw a helix in 3D.
 ➤ Prepare for the exercise
 1 Open the design file curves_01.dgn.
 2 Open the B-splines dialog box (Element > B-splines).
 This dialog box displays the default settings for B-spline curves and surfaces.
 3 Check the following settings:
 Polygon Display: Invisible
 Curve Display: Visible
 4 Open the B-splines tool frame (Tools > B-spline Curves > B-spline Curves).
 The B-splines tool frame.
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 This design file is similar to that used earlier in the AccuDraw exercises. There, we drew a SmartLine connecting the marker locations. Here, we will use the same location markers to draw a 3D B-spline curve.
 Place B-spline Curve tool
 MicroStation’s B-spline curves can represent industrial standard NURBS curves (NURBS stands for Non-Uniform Rational B-Spline). The B-spline is defined by placing control points or poles. You can have as few as 3 poles or as many as 101. As a rule of thumb the number of control points must be greater than or equal to the Order of the equation. The Order of an equation is equal to the degree of an equation plus one. The degree refers to the highest exponential term in the equation.
 ✍ If you want to generate a curve according to an equation then you can use the Curve Calculator found in the Create Curves tool box.
 Appearance of a curve is controlled by the Order setting. The higher the order of an equation, the smoother the resulting curve. The Order is defined in the tool settings window for some types of B-splines. The minimum order possible is 2 and the maximum order allowed is 15.
 You may also choose between Open and Closed B-splines. When a B-spline is closed, with the first point and the last point being the same, the enclosed area is a surface.
 There are five methods used for creating B-spline curves in MicroStation:
 • Define Control Points
 • Through Points
 • L-Square By Tol
 • L-Square By Num
 • Catmull-Rom
 You can define a B-spline curve by placing points or by applying the curve to an existing element in the design file. This is determined by the Input By setting, which lets you choose between:
 • Enter Data Points — you place each control point or pole.
 • Pick Line String — uses the vertices of a previously created construction element to define the poles. Line strings or complex chains produce open B-splines. Shapes and complex shapes produce closed B-splines.
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 ➤ Draw a 3D B-spline curve
 1 From the B-splines tool frame, float the Create Curves tool box.
 2 Select the Place B-spline Curve tool with the following settings:
 Method: Define Control Points
 Input By: Enter Data Points
 Closure: Open
 Order: 3
 3 In the Isometric view, snap to the center of the circle at location 1 and accept with a data point.
 4 Snap to the center of the circle at location 2 and accept with a data point.
 As you move the pointer, the proposed curve displays. We are drawing a third order curve, so a minimum of 3 points are required to define the curve. Displayed also is its control polygon, which appears as a dashed line.
 5 In turn snap to the center of the circle and accept with a data point at the remaining location markers 3, 4, 5 and 6.
 6 Reset to finish.
 Once a B-spline curve has been placed, you can adjust various settings for it. For example, we have drawn a third order B-spline. We can change the order of the curve. When we do this, it cannot be changed to an order that is higher than the
 The Create Curves tool box.
 The open B-splinecurve created from
 points 1 to 6.
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 number of points used to place the curve. In practice, you would not have the points displayed, like we have the location markers displayed here. We can, however, check for this information using the Analyze Element tool, or else turn on the polygon display, to show us where the points are located.
 ➤ Display the Polygon for the curve
 1 Select the Change To Active Curve Settings tool.
 2 Turn on Polygon and set it to Visible.
 3 Identify the B-spline curve.
 4 Accept to change its settings.
 This shows us where the control points, or poles, are located. We can check this also, along with other information such as the Order of the curve, using the Analyze Element tool.
 ➤ Analyze the curve
 1 Select the Analyze Element tool.
 2 Identify the B-spline curve.
 3 Accept.
 The Element Information dialog box opens.
 The B-spline curve with itspolygon displayed.
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 Line 2 tells us that the curve is Order: 3, # of Poles: 6.
 As the order of the B-spline curve increases, the more points that are considered for calculating each part of the curve, resulting in a smoother curve. With the smoothing, there is more variation between the polygon and the curve. A second Order B-spline curve fits the shape of the polygon exactly, while higher order curves vary from the polygon. We can use the Change To Active Curve Settings to change the order of our curve and see this for ourselves.
 ➤ Change the order of the curve
 1 Select the Change To Active Curve Settings tool.
 2 Turn on Order and in its field, key in 2. Do not turn on Preserve shape.
 3 Identify the B-spline curve.
 4 Accept to apply the changes to its settings.
 Notice that the curve now follows the lines of the polygon exactly.
 ✍ If we had turned on Preserve shape, the curve still would have been changed to a second order curve, but it would have retained its original shape.
 Element Informationdialog box displaying
 information aboutour curve.
 Curve changed tosecond Order matches
 the polygon.
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 Experiment by changing the order of the curve between 2 and 6. For this curve, which was constructed with 6 control points, sixth order is the highest allowed.
 What you have drawn in the above exercise is an open B-spline. Another option is to construct a closed B-spline curve, which creates a surface. Before doing this, we will look at the settings dialog box for B-splines.
 ➤ Prepare for the exercise
 1 Make level 2 the active level.
 2 Turn off level 1 in all views.
 3 Make red the active color.
 4 Open the B-splines dialog box (Element > B-splines).
 The B-splines dialog box opens displaying the default settings for B-splines. Notice that Polygon Display is set to Visible. In the previous exercise, we used the Change to Active Curve Settings tool to turn on Polygon Display, which changes the default settings.
 5 Check the following settings:
 Polygon Display: Invisible
 Curve Display: Visible
 ➤ Create a closed B-spline curve
 1 Select the Place B-spline Curve tool with the following settings:
 Method: Define Control Points
 Input By: Enter Data Points
 Closure: Closed
 Order: 3
 2 In the Isometric view, snap to the center of the circle at location 1 and accept with a data point.
 3 Snap to the center of the circle at location 2 and accept with a data point.
 Note now, as you move the pointer, the proposed closed curve displays. We are drawing a third order curve, so a minimum of three points are required
 The B-spline curve as a fourthorder (left), fifth order (center)
 and sixth order (right).
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 to define the curve. Displayed also is its control polygon, which appears as a dashed line.
 4 In turn, snap to the center of the circle and accept with a data point at the remaining location markers 3, 4, 5 and 6.
 5 Reset to finish.
 Where you have an existing element in the design file, you can convert that to a B-spline curve.
 ➤ Prepare for the exercise
 1 Open the design file curves_02.dgn.
 1 Select the Place B-spline Curve tool with the following settings:
 Method: Define Control Points
 Input By: Pick Line String
 Closure: Closed
 Order: 3
 The closed B-splinecurve created from
 points 1 to 6.
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 2 In either view, place a data point on the shape on the left.
 The shape highlights and the proposed curve displays.
 3 Accept with a data point.
 4 In the tool settings, change Method to Through Points.
 5 Place a data point on the second shape (from the left).
 6 Accept with a data point.
 7 Repeat steps 4 to 6 for the remaining shapes, each time changing Method to the next option.
 If you turn on Polygon display, you will see the control points that determine the shape of the B-spline curves.
 Place Helix tool
 You can think of a helix as a spring. It is a 3D spiral. It is used for creating the basic shape of a screw, a spiral staircase, or coiled piping. Using the Place Helix tool is simple and subtle variations allow you to create a wide variety of helices. You will find the Place Helix tool in the Create Curves tool box, which is the left hand side tool box in the B-splines main tool box.
 B-spline curves applied to identical shapes. Left to right: Define Control Points, Through Points, L-Square By Tol, L-Square By Num and Catmull-Rom.
 The Place Helixtool settings
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 Tool settings for the Place Helix tool are as follows:
 Let’s continue by creating a helix to see how it works in practice.
 ➤ Creating a Helix
 1 Open the design file helix_01.dgn.
 2 If necessary, start AccuDraw.
 3 Select the Place Helix tool with the following settings:
 Thread: Left
 Axis: Points (AccuDraw)
 Orthogonal: On
 You are prompted to “Enter center point.”
 4 Snap to the center line at location 1 and accept with a data point.
 You are prompted to “Define radius.”
 5 Use the AccuDraw shortcut <space bar> to change to polar format (distance and angle).
 6 Use the AccuDraw shortcut <T> to change to the Top plane.
 7 Move in the positive x- direction and, with the pointer indexed to the x-axis, key in 2 and accept with a data point.
 You have defined the center point and Base Radius of the helix and are now prompted to “Define pitch height and axis.”
 8 Use the AccuDraw shortcut <F> to change to the Front plane.
 Helix Setting What it Does
 Thread Specifies if the helix spirals to the right or left
 Axis Determines the axis of the helix (you can use AccuDraw, or you can set it to either a design file axis or a view axis).
 Orthogonal If on the axis of the helix is perpendicular to the base and top
 Top Radius Radius at top of helix
 Base Radius Radius at bottom of helix
 Height Total height of helix
 Pitch Height of one revolution of the helix
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 9 Move in the positive y- direction and with the pointer indexed to the y-axis, key in 3.4 and accept with a data point.
 You have now defined the pitch of the helix and are prompted to “Define height.”
 10 Snap to the top of the center line at location 2 and place a data point to accept.
 This sets the height of the helix and you are now prompted to “Define radius.”
 11 Move in the positive x- direction and, with the pointer indexed to the x-axis, key in 2 and accept with a data point.
 You have now defined the top radius of the helix.
 12 Reset to finish.
 Using the Place Helix tool is simple when you use AccuDraw. As with other tools, reading your prompts is the best way to proceed.
 To this point, we have worked with 2D elements such as shapes and blocks and then on to 3D SmartLines, B-spline curves and helices. Now we will look at the tools that are used to create 3D solids and surfaces. We will start with the tools in the 3D Primitives tool box.
 3D Primitives tool box
 Tools in the 3D Primitives tool box let you create simple 3D solids and surfaces. These simple solids and surfaces form the basic building blocks for many models. Often, complex models can be simplified into a combination of these basic objects.
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 You will find the 3D Primitives tool box in the 3D Main tool frame.
 For each of these tools, the Axis option menu allows you to specify that the alignment of the element is relative to one of the following:
 Points — when AccuDraw is not active
 Points (AccuDraw) — when AccuDraw is active
 Screen X, Y or Z
 Drawing X, Y or Z
 For all but the Place Sphere tool, you can select a Type from Solid or Surface. This determines whether or not the element has a top and bottom surface.
 Place Slab tool
 Probably the most useful of all primitives, the Place Slab tool can be used to draw any rectangular or cubic object. Using this tool you can construct a box shaped solid or surface. The tool settings are as follows:
 Type: Solid or Surface.
 Axis: Points; Points (AccuDraw); Screen X, Y, or Z; Drawing X, Y, or Z.
 Orthogonal: When on, the sides are perpendicular to the base.
 Length: When on, specifies the length.
 Width: When on, specifies the width.
 Height: When on, specifies the height.
 Let’s try it. For the exercise, we will work in the Isometric View.
 Opening the 3D Primitives tool boxfrom the 3D Main tool frame.
 Slabs placed as Solid (left) andSurface (right).
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 ➤ Draw a slab
 1 Open the design file primitives_01.dgn.
 2 Select the Place Slab tool with the following tool settings:
 Type: Solid
 Axis: Drawing Z
 Orthogonal: On
 Length: On and set to 100
 Width: On and set to 80
 Height: On and set to 60
 3 In the Isometric view, place the first data point near the circle at location 1.
 4 Move the pointer to the right of location 1 and place a data point to define the direction for the length.
 5 Move the pointer above location 1 and place a second data point to define the direction for the width.
 6 Place a third data point to define the height direction to complete the slab.
 As you have just seen, when all the controls are turned on, you merely define the direction of each dimension. This is useful where a number of blocks are to be placed with exactly the same values in one or two dimensions (if they are all identical then the Copy tool can be used). Where the block is a “one-off” it is just as easy to use AccuDraw, as the next exercise shows.
 ➤ Draw a slab using AccuDraw
 1 If necessary, start AccuDraw.
 2 With the Place Slab tool still active, change the following tool settings:
 Axis: Points (AccuDraw)
 Length: Off
 Width: Off
 Height: Off
 3 In the Isometric view, place the first data point near the circle at location 2.
 4 Use the AccuDraw shortcut <T> to switch to the Top plane.
 Tool settings for thePlace Slab tool.
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 5 Move the pointer to the right and with it aligned to the x-axis, enter 100.
 6 Place a data point to accept.
 Notice that AccuDraw automatically switches to the correct plane in order to enter the next value, that of height.
 7 Move the pointer upward and enter 80.
 8 Place a data point to accept.
 9 Still in the Isometric view, move the pointer upward and enter 60.
 10 Place a data point to accept and complete the slab.
 When Orthogonal is disabled, you can create skewed slabs, where the sides and height are not restricted to being perpendicular to each other.
 Place Sphere tool
 With this tool, you can construct a sphere with two data points — one for the center of the sphere and a second to set the radius. The tool settings are as follows:
 Axis: Points; Points (AccuDraw); Screen X, Y, or Z; Drawing X, Y, or Z.
 Radius: When on, specifies the Radius.
 Since a sphere is always an enclosed volume, there is no option for surface/solid.
 ➤ Draw a sphere
 1 Make level 11 the Active Level and turn off all other levels in each view.
 Orthogonal slab (left) andNon-orthogonal slab (right).
 Rendered image of a spheredrawn with the Place Sphere tool.
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 2 Select the Place Sphere tool with the following tool settings:
 Axis: Points (AccuDraw)
 Radius: On and set to 50
 3 Place a data point in the center of the isometric view.
 4 Move the pointer around and notice that the axis of the sphere follows.
 5 From the Axis option menu, choose Drawing Z.
 6 Move the pointer around and notice that now the axis of the sphere is locked.
 7 Place a second data point to complete the sphere.
 8 Reset to finish.
 Place Cylinder tool
 A cylinder is defined by three data points — the center of its radius, then the radius, and finally the height. The tool settings are as follows:
 Type: Solid or Surface.
 Axis: Points; Points (Accudraw); Screen X, Y or Z; Drawing X, Y or Z.
 Orthogonal: When on, the center line of the cylinder is perpendicular to the base.
 Radius: When on, specifies the radius.
 Height: When on, specifies the height.
 ➤ Draw a cylinder
 1 Make level 12 the Active Level and turn off level 11 in each view.
 2 Turn on level 2 in the Isometric View (Window 2).
 Level 2 contains location markers for the exercise.
 Cylinders drawn as Solid (left)and Surface (right).
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 3 Select the Place Cylinder tool with the following tool settings:
 Type: Solid
 Axis: Drawing Z
 Orthogonal: On
 Radius: Off
 Height: Off
 4 In the Isometric View, place data points at locations 1, 2 and 3, to define the center of the base, the radius, and the height, respectively.
 Looking at the other views, you can see that the cylinder has been constructed relative to the Drawing Z axis. In the Top View, it appears as a circle, while in the Front and Right views it is seen as a rectangle.
 Place Cone tool
 Similar to the Place Cylinder tool, the Place Cone tool requires a fourth data point to define the Top radius of the cone. The tool settings are as follows:
 Type: Solid or Surface.
 Axis: Points; Points (Accudraw); Screen X, Y or Z; Drawing X, Y or Z.
 Orthogonal: When on, the center line of the cone is perpendicular to the base.
 Top Radius: When on, specifies the top radius.
 Base Radius: When on, specifies the base radius.
 Height: When on, specifies the height.
 ➤ Draw a cone
 1 Make level 13 the Active Level and turn off level 12 in all views (leave level 2 on, in the Isometric view).
 Cones drawn as Solid (left) andSurface (right).
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 2 Select the Place Cone tool with the following tool settings:
 Type: Solid
 Axis: Drawing Z
 Orthogonal: On
 Top Radius: Off
 Base Radius: Off
 Height: Off
 3 In the Isometric View, place data points at locations 1, 2 and 3 to define the center of the base, the radius of the base and the height of the cone respectively.
 4 Move the pointer around in the view and notice that this controls the radius of the cone’s top.
 5 Place a fourth data point to complete the cone.
 Looking at the other views, you can see that the cone is aligned with the design file’s z-axis. In the Top View, it appears as two circles joined by lines. In the Front and Right views, the cone appears as a trapezoid.
 ✍ You can use the Modify Element tool to reposition the base or top of both cylinders and cones.
 When Orthogonal is disabled, you can draw skewed cylinders and cones.
 Place Torus tool
 A torus is a doughnut shaped object that is defined by four data points — the start point, the center point, the sweep angle and the secondary radius. The primary radius is the one the torus is swept around and is the distance between the start point and the center point. The secondary radius defines the inner radius, or the radius of the torus’ circular section.
 With Orthogonal turned off,skewed cylinders and cones
 may be drawn.
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 The tool settings are as follows:
 Type: Solid or Surface.
 Axis: Points; Points (AccuDraw); Screen X, Y or Z; Drawing X, Y or Z.
 Primary Radius: When on, specifies the primary radius.
 Secondary Radius: When on, specifies the secondary radius.
 Angle: when on, specifies the sweep angle.
 ➤ Draw a torus
 1 Make level 14 the Active Level and turn off levels 2 and 13 in each view.
 2 Turn on level 3 in the Isometric view (to display location markers for the exercise).
 3 Select the Place Torus tool with the following tool settings:
 Type: Solid
 Axis: Drawing Z
 Primary Radius: On and set to 80
 Secondary Radius: On and set to 25
 Angle: Off
 4 In the Isometric View, place data points at location 1 and 2 to define the start point and (direction of) center point, respectively.
 Point 2 defines the direction of the center point, because the Primary Radius dimension is defined in the tool settings.
 5 Move the pointer and notice that it controls the sweep of the torus.
 6 Place a data point to complete the torus.
 Place Wedge tool
 A wedge is constructed by revolving a rectangular section about a point. It is defined by four data points. The first data point defines a corner of the wedge, the second data point defines the center point of the wedge and the point to rotate about, the third data point defines the sweep angle and the fourth data point defines the height of the wedge.
 Torus drawn as a Solid (left) andas a Surface (right).
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 The tool settings are as follows:
 Type: Solid or Surface
 Axis: Points; Points (Accudraw); Screen X, Y or Z; Drawing X, Y or Z
 Radius: When on, specifies the radius.
 Angle: When on, specifies the angle.
 Height: When on, specifies the height.
 ➤ Draw a wedge
 1 Make level 15 the Active Level and turn off level 14 in each view.
 2 Select the Place Wedge tool with the following tool settings:
 Type: Solid
 Axis: Drawing Z
 Radius: On and set to 100
 Angle: Off
 Height: On and set to 50
 3 In the Isometric View, place data points at location 1 and 2 to define the start point and (direction of) center point, respectively.
 Point 2 defines the direction of the center point, because the Radius dimension (100) is defined in the tool settings.
 4 Move the pointer and notice that it controls the sweep of the wedge.
 5 Place a data point to define the sweep angle.
 6 Place a further data point to define the direction of the height dimension for the wedge.
 Wedge drawn as a Solid (left)and Surface (right).
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 Drawing a door and hardware
 1 Open the design file 3dintro_ex_01.dgn, which has working units set at “ft” (MU) and “in” (SU) and work only in the Isometric view.
 2 Use the Place Slab tool to create the solid door, 7' tall, 2" thick and 30" wide (Front orientation).
 3 Place 1" diameter cylinders for the hinges (3" long starting 6" from the top and bottom) with the center of the hinge on the edge of the door.
 4 Use the Place Sphere and Place Cylinder tools to create the door knob (2" diameter spheres on both sides with a 1" diameter cylinder, 6" long, connecting them). Place the doorknob assembly 2" from the edge of the midpoint of the door.
 The lip around the shade is a torus with a primary radius of 12" and a secondary radius of 1”. It is placed from an edge of the shade.
 The shade is a surface cone with a Base radius of 2" and height of 9" and Top radius of 12".
 The pole is a surface cylinder 78" high and 2" in diameter.
 The base is a solid cylinder 2" high and 18" in diameter.
 1 Continue in the design file 3dintro_ex_01.dgn and, again working only in the Isometric view, draw a floor lamp. Use the dimensions and element types shown above.
 Drawing a Floor Lamp
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 Before we continue: When referring to a slab, what is the difference between a solid and a surface?
 Which 3D Primitive is always a solid?
 Which method(s) of Axis definition allows you to interactively choose the orientation?
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 MicroStation’s SmartSolids tools let you construct and modify solid objects and surfaces simply and quickly. Solid models can include such physical properties as weight, volume and surface area. This is in contrast to surface modeling where only the surfaces of an object are stored. If you cut holes in the faces of a surface modeling object, you see inside the object. When you work with SmartSolids and you cut into an object, you see the “faces” of the cut.
 Solid modeling
 Earlier in this course, you created a 3D box by assembling six rectangular blocks, which formed the faces of the box. In effect you were using 2D elements to create a 3D object. In the previous chapter you constructed a similar box with a single 3D tool, Place Slab. Similarly, you saw how to construct other simple 3D solids. The solid modeling tools are contained in the 3D Main tool frame, which in turn, contains the 3D Primitives, 3D Construct, 3D Modify and 3D Utility tool boxes. All of these will be covered in the following chapters.
 Typically, solid objects are built from base 3D objects using the boolean operations — union, difference and intersection. Base 3D objects include solids such as slab, sphere, cone, cylinder, torus and wedge, as well as solids created by extruding and revolving profile elements.
 Surface modelingexample (left) and
 solid modelingexample of same
 object (right).
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 As well as the construction tools, MicroStation’s solids modeling tools include those for modifying, filleting, chamfering and shelling (creating an empty space within a solid). Additionally, you can modify individual faces of a solid, while maintaining its integrity. You can perform any number of modifications on a solid object to create the finished article.
 Another modeling feature is the ability to remove faces from a solid using the Remove Faces tool. For example, you can remove fillets, chamfers and cuts and “heal” the model back to its original shape. This “undo” feature is very limited and is most useful in correcting a mistake, such as an incorrect fillet or chamfer size. In those instances, you can remove the offending fillet or chamfer and then replace it with one of the correct dimension. MicroStation Modeler, on the other hand, employs a feature tree where every operation used in the creation of a solid is stored and normally can be undone.
 Base 3D solids.
 Bracket on right has hadchamfers around holes
 removed with the RemoveFaces tool.
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 SmartSolid Settings
 How SmartSolids (and SmartSurfaces) display in a design file is controlled by settings in the SmartSolids Settings dialog box. In particular, this applies to curved faces on solids, where you can define the number of Surface Rule Lines. These are used to represent curved surfaces, and the Surface Rule Lines setting lets you define the number of rule lines that represent a full 360° of curvature. The other choice that you have is set the Display mode for SmartSolids to be either Wireframe (the default) or Surfaces. Surfaces mode should be used only where the design is to be rendered in earlier versions of MicroStation.
 ➤ To change the default settings for SmartSolids display, you:
 1 Choose Element > SmartSolids.
 The SmartSolid Settings dialog box opens.
 2 Change the settings as required.
 3 Choose File > Save Settings.
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8 SmartSolids construction tools
 Having been introduced to the 3D Primitives tool box and to the capabilities of MicroStation’s SmartSolids and SmartSurfaces tools, let’s look now at the SmartSolid construction tools. These tools are contained in the 3D Construct tool box. As each tool is discussed, a short exercise will introduce you to how the tool works. In this chapter, you will learn about the following tools:
 • “Extrude tool” on page 105
 • “Construct Revolution tool” on page 110
 • “Extrude Along Path tool” on page 112
 • “Shell Solid tool” on page 116
 • “Thicken To Solid tool” on page 120
 3D Construct tool box
 Tools in the 3D Construct tool box let you create solids or surfaces from existing elements.
 With these tools you can:
 • Extrude or revolve profile elements, either open or closed.
 • Extrude a profile element or a circular section along a defined path.
 • Shell out an existing solid (create an empty space in the solid).
 • Add thickness to an existing planar shape.
 Extrude tool
 This tool is used to construct 3D solids or surfaces from 2D profiles. With the Extrude tool, a planar 2D element is extruded along an axis to create the 3D object. Thus, lines become planes, circles become cylinders and blocks become slabs.
 The 3D Construct tool box.
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 When complex shapes or SmartLines are used as the profiles, quite complex solids or surfaces are possible with this tool. Tool settings are as follows:
 Type: Solid or Surface.
 Orthogonal: When on, the sides are perpendicular to the plane of the base element.
 Distance: When on, defines the distance of the projection.
 Spin Angle: When on, defines the angle through which the 2D element rotates (counter-clockwise) about the axis of projection (maximum 360°). To correctly specify the rotation, you must select the shape at the point about which the rotation is to occur.
 X Scale and Y Scale: When on, specifies the scaling factor for the shape as it is being projected. Scaling is uniform about the point at which the shape is identified.
 Keep Profile: When on, the original profile element is kept. When off, the profile is deleted.
 Let’s look at an example.
 ➤ Prepare for the exercises
 1 Open the design file smartsolids_01.dgn.
 2 Float the 3D Construct tool box from the 3D Main tool frame.
 The 3D Construct tool box is located at the top right position of the 3D Main tool frame.
 3 If necessary, open the 3D View Control tool box (Tools > View Control > 3D).
 This design has been saved with the Isometric view displaying the two complex shapes that we will extrude.
 ➤ Extrude the shapes
 1 In the Construct 3D tool box, select the Extrude tool, with the following settings:
 Type: Solid
 Orthogonal: On
 Tool settings for theExtrude tool.
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 Distance: On and in its field, key in 10
 Leave all other settings off.
 2 In the Isometric view, identify the left shape at location 1.
 3 Move the pointer upwards to define the direction of the extrusion.
 4 Place a data point to complete the extrusion.
 5 In the tool settings, change Type to Surface.
 6 Identify the right shape at location 2.
 7 Move the pointer upwards and place a data point to complete the extrusion.
 Looking at the two extrusions in wireframe display, there is no difference between them. Let’s render them to check that they have been extruded as a solid (left) and a surface (right).
 ➤ Render the Isometric view
 1 In the 3D View Control tool box, select the Render tool with the following settings:
 Target: View
 Render Mode: Smooth
 Render Type: Normal
 2 Place a data point in the Isometric view.
 After extruding thetwo complex shapes.
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 The view is rendered showing the left extrusion to be a solid, while that on the right is a surface (no top or bottom face).
 Because we had Orthogonal turned on, the extruded “walls” were perpendicular to the plane of the shape. Other settings for the Extrude tool let you, as you extrude the profile, scale it in either or both the x and y directions, or to spin it. All scaling and spinning is performed about the identification point of the profile.
 ➤ Extrude with 30° spin angle
 1 Make level 11 the active level.
 2 Turn off level 10 in all other views.
 3 Update all views.
 4 Turn on level 1 in the Top view.
 5 Select the Extrude tool with the following settings:
 Type: Solid
 Orthogonal: On
 Distance: On and in its field, key in 10
 Spin: On and in its field, key in 30
 6 In the Isometric view, snap to the profile at location 1 and accept with a (single) data point.
 Note, in the Top view, that the rotation is about the snap point.
 7 Reset to exit the operation.
 8 Use the AccuDraw shortcut <C> to select Center snap.
 Rendering the view showsclearly that the left extrusion
 is a solid, while that on theright is a surface.
 The Top view shows that therotation is about the snap point.
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3D Construct tool box
 9 In the Isometric view, snap to the profile at location 1 and accept with a (single) data point.
 This time, in the Top view, the rotation is about the center of the profile because we snapped to its center.
 10 Accept with a data point.
 ➤ Extrude with a scale factor
 1 Select the Extrude tool with the same settings as before except:
 Spin: Off
 X Scale and Y Scale: On and in their fields, key in 0.8
 2 In the Isometric view, snap to the profile at location 2 and accept with a (single) data point.
 Note, in the Top view, that the scaling is relative to the snap point.
 3 Reset to exit the operation.
 4 Use the AccuDraw shortcut <C> to select Center snap.
 5 In the Isometric view, snap to the profile at location 2 and accept with a (single) data point.
 Note, in the Top view, that the scaling this time is about the center of the profile.
 6 Accept with a data point.
 Let’s see what we have constructed.
 ➤ Render the Isometric view
 1 Select the Render tool with the following settings:
 Target: View
 Render Mode: Smooth
 Render Type: Normal
 The Top view shows that scaling isrelative to the snap point.
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 2 Place a data point in the Isometric view.
 In the foregoing exercises, Orthogonal has been on. This setting forces the extrusions to be perpendicular to the plane of the base element. If Orthogonal is off, then the second data point also defines the direction of the extrusion.
 ➤ Extrude with Orthogonal off
 1 Make level 12 the active level.
 2 Turn off all other levels in all views.
 3 Update all views.
 4 Select the Extrude tool and set Type to Solid. Turn off all other settings.
 5 Identify the shape at location 1.
 6 Move the pointer to location 2. If you have AccuDraw active, you will see that the extrusion is restricted to orthogonal still. AccuDraw anticipates that this is what you want. If necessary, press <Q> to exit AccuDraw. Note now that the extrusion follows the pointer.
 7 Place a data point to accept the extrusion.
 As you can see, with the Extrude tool, you can create complex 3D solids from a 2D shape or complex shape. Equally, you can extrude an open element, such as a line string or an arc to create a surface.
 Construct Revolution tool
 Where you require a curved extrusion, you can use the Construct Revolution tool. As with the Extrude tool, this tool also is used to construct 3D solids or surfaces
 Rendered image ofthe two extrusions.
 Extruding a shapewith Orthogonal
 turned off.
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 from 2D profiles. In effect, a profile is revolved about an axis to create a solid or surface. When complex shapes or SmartLines are used as the profiles, quite complex solids or surfaces are possible. Settings for this tool are as follows:
 Type: Solid or Surface.
 Axis: Defines the direction of the axis about which the revolution is performed. Options are: Points or Points (AccuDraw); Screen X, Y, or Z; Drawing X, Y, or Z.
 Angle: Defines the sweep angle of the revolution (about the axis).
 Keep Profile: When on, the original profile element is kept. When off, the profile is deleted.
 Let’s look at some examples.
 ➤ Create a solid by revolving a profile
 1 Open the design file smartsolids_02.dgn.
 2 In the Construct 3D tool box, select the Construct Revolution tool with the following settings:
 Type: Solid
 Axis: Drawing Z
 Angle: 360
 3 In the Isometric view, identify the shape at location 1.
 The proposed solid is displays. Note that your pointer now controls the axis of the revolution. As you move it the radius changes and the solid changes in size, accordingly.
 4 Snap to the center line at location 2 and accept with a data point.
 The solid is completed.
 5 Use the Render tool to view the solid more realistically.
 Construct Revolutiontool settings.
 The pointer controls thelocation of the axis.
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 You can turn off level 1 to get rid of the location markers and center line.
 Using the Construct Revolution tool, you can create complex curved 3D solids from a 2D shape or complex shape. Equally, you can revolve an open element, such as a line string or an arc to create a curved surface.
 Extrude Along Path tool
 We have seen how to create solids by extruding profiles in a straight line, or revolving them about an axis. With the Extrude Along Path tool, you can specify a path element that the profile is to follow as it is extruded. When using a profile, you can specify that the extrusion is attached to the path element, or that it merely follows the alignment of the path element. That is, you may create the extrusion away from the path element, with the path element merely defining the direction of the extrusion, but not its physical location.
 Typically, this tool can be used to place pipework or ductwork. You have the choice of creating the extrusion with a profile, or by specifying the outside and the inside radii where a circular solid or a hollow pipe is being constructed. Settings for this tool are as follows:
 Type: Solid or Surface.
 Defined By: Profile or Circular. Profile lets you select an existing element as the template for the extrusion. Circular lets you select the Inside and Outside radii for the extrusion.
 Rendered image of solidcreated as a revolution.
 Extrude Along Path toolsettings for profiles (left) and
 for circular (right).
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 When Solid is selected for Circular extrusions, the ends are capped. If Surface is selected, the extrusions are open.
 ➤ Extrude a circular pipe
 1 Open the design file smartsolids_03.dgn.
 2 In the Construct 3D tool box, select the Extrude Along Path tool with the following settings:
 Type: Solid
 Defined By: Circular
 Inside Radius: On and in its field, key in 20
 Outside Radius: On and in its field, key in 25
 3 In the Isometric view, identify the dashed path element with a data point anywhere along its length.
 4 Accept with a data point.
 The proposed pipe is calculated and displayed.
 5 Accept the construction with a second data point.
 Circular extrusion alongpath with Type set to Surface
 (left) and Solid (right).
 The circular pipe extrudedalong the path element.
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 When using a profile as the template for the extrusion, you have two choices. You can:
 • Create the extrusion directly from the position of the profile element, using the path element to define the direction, or
 • Create the extrusion by attaching the profile to the path element.
 ➤ Create an extrusion away from the path element
 1 Make level 11 the active level.
 2 Turn off level 10 in all views.
 3 Update all views.
 4 Select the Extrude Along Path tool, with the following settings:
 Type: Solid
 Defined By: Profile
 5 Identify the dashed path element with a data point anywhere along its length.
 6 Identify the green profile with a data point.
 7 Accept with a data point, to view the extrusion.
 The proposed extrusion is calculated and displayed.
 8 Accept the construction with a data point.
 The Isometric viewready for the exercise.
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 9 Fit all views.
 As we mentioned earlier, you can specify that the extrusion is attached to the path element. By snapping to the profile, you can define the point on it that you want attached to the path element. We will do that now.
 ➤ Create an extrusion attached to the path element
 1 Make level 12 the active level.
 2 Turn off level 11 in all views.
 3 Turn on level 2 in the Isometric view.
 4 Fit all views.
 5 Select the Extrude Along Path tool with the following settings:
 Type: Solid
 Defined By: Profile
 6 Identify the path element with a data point anywhere along its length.
 7 Snap to the green profile element at the center of its top edge, at location 1.
 8 Accept with a data point.
 9 Place a data point to view the proposed extrusion.
 10 Accept the construction with a further data point.
 The completed extrusionfrom the square profile.
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 11 Fit all views.
 Checking in the other views, you can verify that the extrusion follows exactly the path element.
 Shell Solid tool
 You can use the Shell Solid tool to hollow out a solid, leaving it with walls of a defined thickness. Where necessary, you can specify that one or more faces are removed to create an opening. Tool settings for this tool are as follows:
 Shell Thickness: Sets the wall thickness for the remaining faces of the shelled solid.
 Shell Outward: If on, material is added to the outside of the solid. That is, the existing solid defines the inside of the walls of the shelled solid.
 Selecting/deselecting faces for removal
 After selecting the solid for shelling, as you move the screen pointer over it, the face nearest the pointer highlights. Placing a data point selects the highlighted face, which then remains highlighted. You then can select further faces for removal in a similar fashion.
 Entering a reset deselects the last face selected. Subsequent resets deselect further faces in the reverse order. That is, the last face selected is the first face deselected.
 In the following exercises, you will create shelled solids both with and without openings.
 The extrusion attachedto the path element.
 Shell Solid tool settings.
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3D Construct tool box
 ➤ Create a shelled solid (with no openings)
 1 Open the design file smartsolids_04.dgn.
 2 In the Construct 3D tool box, select the Shell Solid tool with the following settings:
 Shell Thickness: 5
 Shell Outward: Off
 3 In any view, identify the green hexagonal solid with a data point.
 The solid highlights. As you move the pointer over the solid, the various faces highlight in a heavier weight dashed line.
 4 Move the pointer away from the solid so that no faces are highlighted and place a data point.
 The solid is hollowed out. As there are no openings, rendering the view would display only the outside surface.
 ➤ Create a shelled solid with the top face removed
 1 Make level 11 the active level.
 2 Turn off level 10 in all views.
 3 Update all views.
 4 Select the Shell Solid tool with the following settings:
 Shell Thickness: 5
 Shell Outward: Off
 5 In the Isometric view, identify the red hexagonal solid with a data point.
 The solid highlights. As you move the pointer over the solid, the various faces highlight in a heavier weight dashed line.
 6 Move the pointer over the solid until the top face highlights as a heavier weight dashed line, then place a data point.
 The top face now is highlighted as a heavier weight solid line.
 7 Move the pointer away from the solid and place a data point.
 The solid before (left) andafter (right) shelling with
 the Shell Solid tool.
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 The solid is shelled and the top face removed.
 8 Use the Render tool to render the Isometric view.
 When shelling a solid, you can select multiple faces for removal.
 ➤ Shell a solid with several faces removed
 1 Make level 12 the active level.
 2 Turn off level 11 in all views.
 3 Update all views.
 4 Select the Shell Solid tool with the following settings:
 Shell Thickness: 5
 Shell Outward: Off
 5 In the Isometric view, identify the yellow hexagonal solid with a data point.
 6 Move the pointer into the Top view and when the top face highlights as a heavier weight dashed line, place a data point.
 7 Move the pointer into the Front view and when the front face highlights (the face at the center of the solid in the Front view), place a data point.
 8 Move the pointer back to the Isometric view and when the back face of the solid highlights (the face diagonally opposite the highlighted front face), place a data point.
 9 Move the pointer away from the solid and place another data point.
 The solid with the topface highlighted (left)
 and after completing theshelling (right).
 Rendered view of theshelled solid.
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 The solid is shelled and the three selected faces are removed.
 Where a solid has rounding and/or one or more holes through it, the Shell Solid tool recognizes these and shells around them accordingly.
 ➤ Shell a solid containing rounding and holes
 1 Make level 13 the active level.
 2 Turn off level 12 in all views.
 3 Update all views.
 4 Select the Shell Solid tool with the following settings:
 Shell Thickness: 5
 Shell Outward: Off
 5 Identify the green solid with a data point.
 6 Move the pointer over the solid until the top surface highlights, then place a data point.
 The solid with thesurfaces to be removed
 highlighted (left) andafter the shelling
 operation (right).
 The top surface of thesolid highlighted.
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 7 Move the pointer away from the solid and place a data point to complete the shelling.
 8 Use the Render tool to render the Isometric view.
 Using the Shell Solid tool can save you considerable modeling time, in particular when the design has uniform thickness walls, as in the previous example.
 Thicken To Solid tool
 You can use the Thicken To Solid tool to add thickness to an existing surface, to create a solid. On identifying the surface, an arrow displays showing the distance and direction of the thickening to be added. If Add To Both Sides is on, arrows display in both directions. If Thickness is not turned on, then thickening is added graphically, with the amount of thickening defined by the screen pointer. If Add To Both Sides is off in these cases then the screen pointer also defines the direction of the thickening. Tool settings for this tool are as follows:
 Add To Both Sides — If on, the thickness value is added to both sides of the surface.
 Thickness — If on, the value in the field determines the amount of thickening added.
 The solid after shelling andremoving the top surface.
 Rendered image of theshelled solid.
 Thicken To Solid tool settings.
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 In the following example, you will draw a shape and then thicken it to create a strengthening rib in a simple bracket.
 ➤ Draw the shape to thicken
 1 Open the design file smartsolids_05.dgn.
 2 Select the Place Shape tool.
 3 In the Isometric view, snap to the center the top left edge of the bracket at location 1 and accept with a data point.
 4 Snap to the center of the line at location 2 and accept with a data point.
 5 Snap to the center of the line at location 3 and accept with a data point.
 6 In the tool settings box, click the Close Element button.
 With the shape drawn, we can thicken it to form the rib. We have placed the shape in the center of the bracket, so we can thicken both sides of the shape. The overall thickness that we want is 10mm, so we will add 5mm to both sides.
 ➤ Thicken both sides of the triangular shape
 1 In the 3D Construct tool box, select the Thicken To Solid tool with the following settings:
 Add To Both Sides: On
 Thickness: On and in its field, key in 5
 2 With a data point, identify the triangular shape that you just placed.
 The shape highlights and arrows appear, showing the direction and size of the thickening. These are most clearly seen in the Top and Right Views.
 The bracket with theshape drawn.
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 3 Accept with a data point to complete the thickening of the shape for the rib.
 Thickening can be applied to extruded surfaces as well as simple shapes.
 ➤ Thicken one side of an extruded surface
 1 Make level 11 the active level.
 2 Turn off all other levels in all views.
 3 Turn on level 2 in the Isometric view.
 4 Select the Thicken To Solid tool with the following settings:
 Add To Both Sides: Off
 Thickness: On and in its field, key in 5
 5 Identify the yellow surface at location 1.
 6 Move the pointer to location 2. In the Top view, note that there is one direction arrow only, as we are thickening one side only, of the surface.
 7 With the pointer at location 2, place a data point.
 Isometric view showingthe completed rib.
 Isometric view ofsurface after adding
 thickening to one side.
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 Similarly, you can thicken the other side of the same surface
 ➤ Thicken the other side of the extruded surface
 1 Make level 12 the active level.
 Level 12 contains a red copy of the original surface.
 2 Select the Thicken To Solid tool with the same settings as for the previous exercise.
 3 Identify the red surface at location 1.
 4 Move the pointer to location 3. In the Top view, the direction arrow this time points in the opposite direction to that for the previous exercise.
 5 With the pointer at location 3, place a data point.
 The red surface is thickened to a solid on the opposite side to that of the yellow solid.
 Before we continue: What setting in the Construct Revolution tool controls the orientation of the construction?
 With the Extrude tool, what is the difference between a Solid and a Surface type?
 With the Thicken to Solid tool, when Add to Both Sides is turned off, what decides the direction of the thickening?
 What are the two options for creating a surface/solid with the Extrude Along Path tool.
 Isometric view showing thetwo “thickened” solids.
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9 SmartSolids modification tools
 In previous chapters you have learned about the 3D Primitives solids and the 3D Construction tools. These tools let you create the basic “building blocks” for more complex 3D solids. In this chapter we will move on to the SmartSolids modification tools, which are contained in the 3D Modify tool box. In this chapter, you will learn about the following tools:
 • “Construct Union tool” on page 126
 • “Construct Intersection tool” on page 128
 • “Construct Difference tool” on page 129
 • “Cut Solid tool” on page 131
 • “Fillet Edges tool” on page 136
 • “Chamfer Edges tool” on page 142
 • “Modify Solid tool” on page 146
 • “Remove Faces and Heal tool” on page 150
 3D Modify tool box
 Tools in the 3D Modify tool box let you modify existing solids.
 With these tools you can:
 • Relocate the face of a solid.
 • Remove one or more faces from a solid.
 • Construct a solid from the union, intersection or difference of two or more solids.
 • Place a cut in a solid.
 • Fillet or chamfer the edge(s) of a solid.
 The 3D Modify tool box.
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3D Modify tool box
 Using the tools in this tool box, you can add the finishing touches to a 3D model. For example, you can create the underlying solid for a model from 3D primitives and then “carve” away the unwanted sections to create the finished article.
 First, we will look at the boolean tools. That is the tools that you can use to create a solid by uniting two or more solids, intersecting two or more solids or subtracting one solid from another.
 Construct Union tool
 With the Construct Union tool you can unite two or more overlapping or abutting solids into a single solid. This is very useful for amalgamating several separate solids into the basic solid from which the finished model can be produced. In the tool settings, you can turn on Keep Originals if you want to retain the original solids.
 When constructing a union of solids, you have two options.
 Method 1: Select the solids first, then the tool
 • Use the PowerSelector or Element Selection tool to select the solids.
 • Select the Construct Union tool.
 • Place a data point to accept the selection set and unite the solids into a single entity.
 — or —
 Method 2: Select the tool first, then the solids
 • Select the Construct Union tool.
 • Identify the first solid with a data point.
 • Identify the second and subsequent solids with further data points.
 • Place a data point to accept the construction of the union.
 When you use the first method, the color of the resulting solid is that of the (selected) solid that was placed in the file first. When you use the second method, the color of the resulting solid is that of the first solid selected.
 ➤ Prepare for the exercises
 1 Open the design file smartsolids_06.dgn.
 2 Float the 3D Modify tool box from the 3D Main tool frame.
 The 3D Modify tool box is located at the lower left position of the 3D Main tool frame.
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
 9-126

Page 137
                        

3D Modify tool box
 As with the other exercise, we will work in the Isometric view, which displays seven solids. These comprise two yellow cylinders, two cyan slabs, two red extruded solids and one green slab. We will now consolidate these individual solids into a single entity. First, we will select the solids using the PowerSelector tool.
 ➤ Construct the union of solids, using PowerSelector
 1 Select the PowerSelector tool with the following settings:
 Method: Block
 Mode: Add
 2 In any view, with two data points, place the PowerSelector block around all five solids.
 The selected solids highlight.
 3 In the 3D Modify tool box, select the Construct Union tool with the following settings:
 Keep Originals: Off
 4 Place a data point to accept the union.
 The separate solids are united into a single solid. The resulting solid is green because the green slab was placed first in the design file.
 When you select the solids individually, the color of the first solid selected is the color that is used for the combined solid.
 ➤ Construct the union of solids, selecting each solid separately
 1 Make level 10 the active level.
 2 Turn off level 9 in all views.
 3 Update all views.
 4 Select the Construct Union tool (still with Keep Originals turned off).
 5 With a data point, identify one of the yellow cylinders.
 Wireframe Isometricview of solids before
 (left) and after (right)being united into a
 single entity.
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 The yellow cylinder highlights.
 6 With data points, identify the remaining six solids, so that all are highlighted.
 7 Place a further data point to accept the construction.
 The solids are united into a single yellow solid.
 Construct Intersection tool
 Using the Construct Intersection tool, you can create a solid that is the intersection of two or more overlapping solids. If you turn on Keep Originals, the original solids are retained.
 When constructing a union of solids, you have two options.
 Method 1: Select the solids first, then the tool
 • Use the PowerSelector or Element Selection tool to select the solids.
 • Select the Construct Intersection tool.
 • Place a data point to accept the selection set and construction of the intersection between the solids.
 — or —
 Method 2: Select the tool first, then the solids
 • Select the Construct Intersection tool.
 • Identify the first solid with a data point.
 • Identify the second and subsequent solids with further data points.
 • Place a data point to accept the construction of the intersection between the solids.
 When you use the first method, the color of the resulting solid is that of the (selected) solid that was placed in the file first. When you use the second method, the color of the resulting solid is that of the first solid selected.
 ➤ Create a solid from the intersection of two existing solids
 1 Make level 11 the active level.
 2 Turn off level 10 in all views.
 3 Update all views.
 Displayed are two extrusions. In the Front view, you can see the sectional shape of the green extrusion. In the Right view, you can see the sectional shape of the yellow extrusion.
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 4 Select the Construct Intersection tool with Keep Originals turned off.
 5 With a data point, identify the yellow solid.
 6 With a data point, identify the green solid.
 7 Accept with a data point to complete the construction.
 The resulting solid is yellow because the yellow solid was the first chosen.
 As you can see, the resulting solid is identical to that created in the previous exercises. The two original solids for this exercise were created by extruding the front and side elevations of the model. Where you have 2D elevations of a design, often you will be able to use them to create a 3D solid of the object.
 Construct Difference tool
 With the Construct Difference tool you can subtract the volume of one or more overlapping solids from another solid. If you turn on Keep Originals, the original solids are retained.
 To construct a solid that is the difference between one solid and one or more overlapping solids, you:
 • Select the Construct Difference tool.
 • Identify the first solid from which the other solid(s) will be subtracted.
 • Identify the solid to subtract with a data point.
 • If necessary, identify other solids to subtract, with further data points.
 • Place a data point to accept the construction. That is, the subtraction of the latter solids from the first solid identified.
 In the following exercise, we will subtract six cylindrical solids from the base solid.
 Before (left) andafter (right)
 constructing theintersection of the
 two solids.
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 ➤ Construct the difference between solids
 1 Make level 12 the active level.
 2 Turn off level 11 in all views.
 3 Update all views.
 Displayed is a green solid with six red cylinders located around its outer edge. These partially overlap the green base solid.
 4 Select the Construct Difference tool.
 5 With a data point, identify the green solid.
 The solid highlights.
 6 With a data point, identify one of the red cylinders.
 The red cylinder highlights.
 7 With further data points, identify the remaining red cylinders.
 All cylinders, plus the base solid, now are highlighted.
 8 Place a data point to complete the construction.
 The parts of the cylinders that overlap the base solid are subtracted from the base solid.
 Before (left) and after(right) subtracting the
 cylinders from thebase solid.
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
 9-130

Page 141
                        

3D Modify tool box
 9 Use the Render tool to render the Isometric view.
 Using the 3D primitive solids, extrusions and the three boolean tools, you can create the basics for quite complex models. Other tools in the 3D Modify tool box let you add cuts, fillets and chamfers. We will look at these now.
 Cut Solid tool
 With the Cut Solid tool you can place a cut in a solid using a template or cutting profile. Cutting profiles may be open or closed elements, but open elements must extend to the edge of the solid. When you use an open element as a cutting profile, the identification point for the solid determines the portion of the solid that is retained. If Split Solid is on, however, no material is removed. In these cases, the solid is merely split at the cutting profile.
 Method 1: Select the cutting profile(s) first, then the tool
 • Use the PowerSelector or Element Selection tool to select the cutting profile(s).
 • Select the Cut Solid tool.
 • Identify the solid to be cut.
 Tool Setting Effect
 Cut Direction Sets the direction of the cut, relative to the cutting profile’s Surface Normal.• Both: Cuts both directions from the profile’s plane.• Forward: Cuts forward from the profile’s plane.• Back: Cuts back from the profile’s plane.
 Cut Mode Sets the limits of the cut.• Through: Cuts through all faces of the solid.• Define Depth: Cuts into the solid a defined distance.
 Cut Depth (Cut Mode set to Define Depth only) Sets the depth of the cut.
 Split Solid If on, no material is removed from the solid; it is split into two or more segments.
 Keep Profile If on, the original cutting profile remains in the design file.
 Rendered view of thefinished solid.
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 • Place a data point to accept the selection set and cut the solid.
 — or —
 Method 2: Select the tool first, then the solid and cutting profile(s)
 • Select the Cut Solid tool.
 • Identify the solid to be cut, with a data point.
 • Identify the cutting profile.
 • Place a data point to accept the construction of the cut.
 In the following example, we will place a number of cuts into a slab, using blocks and circles. We will then split the solid in order to create a cut-away view of the solid.
 ➤ Place the first cut in the slab
 1 Open the design file smartsolids_07.dgn.
 2 In the 3D Modify tool box, select the Cut Solid tool with the following settings:
 Cut Direction: Both
 Cut Mode: Through
 Split Solid and Keep Profile: Off
 3 In the Isometric view, identify the cyan slab with a data point.
 The slab highlights.
 4 Identify the left green block with a data point.
 The block highlights and arrows display to show the direction of the cut. In this case the arrows point both ways from the plane of the highlighted block.
 5 Accept with a data point to complete the cut.
 The slab is cut, using the green rectangular block as a cutting profile.
 Before (left) and after(right) cutting the slab
 using thegreen rectangle.
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3D Modify tool box
 In order to complete all the cuts through this model, using this method, we would have to repeat the above procedure for each cut. Because all the cuts use the same settings, however, we can complete the remaining cuts in a single operation.
 ➤ Place the remaining cuts in the solid
 1 Use the PowerSelector tool to select the remaining cutting profiles. That is, the green rectangle, the two red rectangles and the three yellow circles.
 2 Select the Cut Solid tool with the following settings:
 Cut Direction: Both
 Cut Mode: Through
 Split Solid and Keep Profile: Off
 3 Identify the solid with a data point.
 4 Accept with a data point to complete the construction of the cuts.
 An option that you have when applying cuts to a solid is to turn on Split Solid. This can be useful, for example, to present an isometric “cut away” view of a model. Let’s try this technique on our current model.
 ➤ Split the solid
 1 Turn on level 2 in the Top and Isometric views.
 Level 2 contains a dashed line string that we will use as our cutting element. Because it is an open element, it must extend at least to the edges of the solid.
 The completed solid afterapplying all the cuts.
 Top and Isometricview showing the solid
 and the dashedcutting element.
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 2 Select the Cut Solid tool with the following settings:
 Cut Direction: Both
 Cut Mode: Through
 Split Solid: On
 Leave Keep Profile turned off.
 3 Identify the solid with a data point.
 The solid highlights.
 4 Identify the green cutting profile with a data point.
 The profile highlights. Arrows display to show the direction of the cut.
 5 Accept with a data point to complete the cut.
 The cut is made in the solid but no material is removed. The model, however, is now split into two portions.
 With the model split, we can move the cut portion to another level. This then will let us display the model with or without the cut-away section, using level control.
 ➤ Move the cut-away section to another level and view the remaining portion
 1 Select the Change Element Attributes tool with the following settings:
 Level: On and in its field, key in 10
 Leave all other settings off.
 2 Identify the smaller portion of the solid (the front left portion) with a data point.
 3 Accept to move it to level 10.
 4 Make the active level 9.
 5 Turn off level 10 in the Isometric view.
 6 In the Isometric view, use the Change View Display Mode view control to set the Display Mode to Smooth.
 The solid, with the cut shownin a heavier line weight.
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 7 In the Isometric view, use the Rotate View view control with Method set to Dynamic to rotate the view and inspect the solid with the cut-away portion not displayed.
 So far, all our cuts have been through the solid. We can specify also, that cuts are limited to a particular depth. This can be used, for example, to create counter-bored holes in a solid.
 ➤ Prepare for the exercise
 1 In the Isometric view, use the Change View Display Mode view control to set the Display Mode to Wireframe.
 2 In the Isometric view, use the Rotate View view control with Method set to Isometric to rotate the view back to Isometric.
 3 Make level 11 the active level.
 4 Turn off all other levels in all views.
 5 Use the Fit View view control to fit each view.
 This model of a bracket already has the circles placed for the counter-bored holes. We will first “drill” the through holes and then add the counter-bore portion.
 ➤ Cut the through holes in the bracket
 1 Use the PowerSelector tool to select the six red circles.
 2 Select the Cut Solid tool with the following settings:
 Cut Direction: Both
 Cut Mode: Through
 Split Solid and Keep Profile: Off
 3 Identify the (cyan) solid with a data point.
 Views of the solid, with the cut-away portion not displayed.
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 4 Accept with a data point to cut the holes.
 Now we will cut the counter-bores for each hole.
 ➤ Cut the counter-bores
 1 Use the PowerSelector tool to select the six yellow circles.
 2 Select the Cut Solid tool with the following settings:
 Cut Direction: Forward
 Cut Mode: Define Depth
 Cut Depth: 2
 Split Solid and Keep Profile: Off
 3 Identify the (cyan) solid with a data point.
 4 Accept with a data point to cut the counter-bores.
 5 Use the Render tool to view the finished bracket.
 Fillet Edges tool
 You can use the Fillet Edges tool to fillet, or round, one or more edges of a solid, extruded surface, or a surface of revolution. From a basic solid, you can add fillets
 The bracket with thethrough holes cut.
 Rendered view of thefinished bracket.
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 to produce the finished design. Tool settings let you define the radius of the fillet and whether to select tangential edges.
 Selecting edges for filleting
 After identifying the solid, as you move the screen pointer over the solid, the edge nearest the pointer highlights. Entering a data point selects the highlighted edge, which then remains highlighted. This lets you select more than one edge on a solid for filleting.
 Deselecting edges for filleting
 Where you select an incorrect edge, a Reset deselects the edge. Where you have selected a number of edges, consecutive Resets deselect the edges in the reverse order. That is, the last edge selected is the first edge deselected.
 To fillet one or more edges of a solid, extruded surface, or surface of revolution:
 • Select the Fillet Edges tool.
 • Identify an edge to fillet with a data point. The solid highlights with the selected edge highlighted in a heavier weight line.
 • Place a data point away from any of the edges to accept the construction of the fillet.
 — or —
 • Continue identifying, with data points, edges to be filleted.
 • Place a data point away from any of the edges to accept the construction of fillets at all the selected edges.
 Tool Setting Effect
 Radius Defines the radius of the fillet.
 Select Tangent Edges If on, edges that are tangentially continuous are selected and filleted in one operation.
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 Let’s now look at how this tool works in practice. For the exercise, we will add rounding to a basic “square” solid to produce the finished article as shown below.
 ➤ Fillet an edge of a solid
 1 Open the design file smartsolids_08.dgn.
 2 In the 3D Modify tool box, select the Fillet Edges tool with the following settings:
 Radius: 10
 Select Tangent Edges: Off
 3 With a data point, identify the edge of the solid at location 1.
 The solid highlights with the selected edge further highlighted as a solid line. Observe as you move the pointer over the model, the various edges highlight in a dashed line.
 4 Move the pointer away from any edges and accept with a data point.
 The fillet is constructed for the selected edge.
 5 Repeat steps 3 and 4 for the edge at location 2.
 Multiple edges can be filleted (with the same radius) in the one operation.
 Basic solid (left) andcompleted model (right).
 Left: the selected edgehighlighted. Right: the
 completed fillet.
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 ➤ Fillet the two outer lower edges
 1 Turn off level 2.
 2 Turn on level 3.
 3 Select the Fillet Edges tool and set the Radius to 15.
 4 With a data point, identify the solid at the edge at location 3.
 The edge highlights.
 5 Move the pointer to location 4 so that edge highlights and enter a data point.
 This edges now highlights along with the first edge selected.
 6 Move the pointer away from any edges and enter a data point to complete the construction.
 Both edges are filleted.
 When applying fillets to a solid, you should consider the order in which the fillets are applied. The number of steps required can be reduced considerably, as the following will show.
 ➤ Prepare for the exercise
 1 Turn off level 3.
 2 Turn on level 4.
 Left: the selected edgeshighlighted. Right: thecompleted filleting of
 the selected edges.
 The solid ready to addthe final fillets.
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 To complete this model, we will add the fillets to the remaining edges. We will start by filleting the top front and back edges (indicated by the location marker 5 arrows). This will let us add the inside and outside edge fillets by identifying a single edge for each (locations 6 and 7), using the Select Tangent Edges option.
 ➤ Fillet the top front and back edges
 1 Select the Fillet Edges tool with the following setting:
 Radius: 10
 2 With a data point, identify the solid at one of the edges indicated by the arrows from location 5.
 The edge highlights.
 3 In turn, move the pointer to the remaining edges indicated by the arrows from location 5 and when they highlight, enter data points to accept them.
 4 Move the pointer away from any edges and enter a data point to complete the construction of the fillets.
 To complete this model, we will make use of the Select Tangent Edges option. First, we will see what happens with this setting turned off.
 ➤ Fillet the remaining edges
 1 Select the Fillet Edges tool with the following settings:
 Radius: 1
 Select Tangent Edges: Off
 2 With a data point, identify the solid at location 6. Only the curved section of the edge, where the data point was placed, is selected.
 Left: After selectingthe edges. Right: The
 completed fillets.
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 3 Move the pointer to location 7 and when the edge highlights, enter a data point to accept. Only the straight section of the edge, where the data point was entered, is selected.
 4 Reset twice to deselect the edges.
 5 In the tool settings, turn on Select Tangent Edges.
 6 Move the pointer to location 6 and when the edge highlights, enter a data point to accept. The entire edge highlights. This is because it is tangentially continuous.
 7 Move the pointer to location 7 and when the edge highlights, accept it with a data point. Note again that the entire edge highlights.
 8 Move the pointer away from any other edges and enter a data point.
 The fillets are added to the inside and outside edges of the solid.
 9 Turn off level 4.
 10 Use the Render tool to view the finished model.
 Generally speaking, edge rounding or filleting with the Fillet Edges tool should be added at the very end. You should complete the underlying solid first.
 Another tool that works in a similar fashion to the Fillet Edges tool is the Chamfer Edges tool.
 With Select TangentEdges turned off, only
 that part of the edge,where the data point is
 placed, is selected.
 With Select TangentEdges turned on, the
 entire edges are selectedbecause they are
 tangentially continuous.
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 Chamfer Edges tool
 Working in a similar fashion to the Fillet Edges tool, you can use the Chamfer Edges tool to apply a chamfer to one or more edges of a solid, extruded surface, or a surface of revolution.
 Selecting edges for chamfering
 After identifying the solid, as you move the screen pointer over the solid, the edge nearest the pointer highlights. Entering a data point selects the highlighted edge, which then remains highlighted. This lets you select more than one edge on a solid for chamfering.
 Deselecting edges for chamfering
 Where you select an incorrect edge, a Reset deselects the edge. Where you have selected a number of edges, consecutive Resets deselect the edges in the reverse order. That is, the last edge selected is the first edge deselected.
 To chamfer one or more edges of a solid:
 • Select the Chamfer Edges tool.
 • Identify an edge to chamfer with a data point. The solid highlights with the selected edge highlighted in a heavier weight line.
 • Place a data point away from any of the edges to accept the construction of the chamfer.
 — or —
 • Continue identifying, with data points, other edges to be chamfered.
 Tool Setting Effect
 Distance 1Distance 2
 Sets the distances to trim back the faces. If the Lock Control is on, then both distances are constrained to the same value.
 Lock Control • If on (closed) Distance 1 and Distance 2 are constrained to the same value.• If off (open) Distance 1 and Distance 2 may be different values.
 Select Tangent Edges If on, edges that are tangentially continuous are selected and chamfered in one operation.
 Flip Direction When Distance 1 and Distance 2 are different, reverses the direction of the chamfer and the values that the faces are trimmed.
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 • Place a data point away from any of the edges to accept the construction of chamfers at all the selected edges.
 Where you construct a chamfer with different values for Distance 1 and Distance 2, it may be that it is in the wrong direction. That is, Distance 1 and Distance 2 are applied to the wrong faces.
 To correct a chamfer that is constructed in the wrong direction:
 • Undo the chamfer(s).
 • Turn on Flip Direction.
 • Reconstruct the chamfer(s).
 Let’s try out the tool. By adding chamfers, we will convert the basic model on the left (below) to the finished model on the right.
 First we will thicken the base of the vertical section by adding a chamfer.
 ➤ Add a chamfer to the vertical section
 1 Make level 11 the active level.
 2 Turn off levels 10.
 3 Turn on level 5.
 4 Select the Chamfer Edges tool with the following settings:
 Turn off (open) the lock control (clicking on the lock icon toggles it open/closed).
 Distance 1: 50
 Distance 2: 2
 Flip Direction: Off
 5 With a data point, identify the edge of the solid at location 1.
 Left: Basic modelbefore adding
 chamfers. Right:Same model afteradding chamfers.
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 The solid highlights, with the selected line further highlighted.
 6 Move the pointer to location 2 and when the edge under it highlights, place a data point to accept.
 The edge highlights.
 7 Move the pointer away from any edges and place a data point to complete the operation.
 Next, we will counter-sink the bore holes with a chamfer. We want the chamfer to be 1mm deep and 3mm wide.
 ➤ Chamfer the bore holes
 1 Select the Chamfer Edges tool with the following settings:
 Leave the lock control off (open).
 Distance 1: 3
 Distance 2: 1
 Flip Direction: Off
 2 With a data point, identify the edge of the bore hole at location 3.
 The solid highlights, with the selected edge further highlighted.
 3 Move the pointer to location 4 and when the edge under it highlights, place a data point to accept.
 The edge of the bore hole highlights.
 4 Move the pointer away from any edges and place a data point to construct the two chamfers.
 Left: Solid with edgeshighlighted. Right:
 Chamfers completed.
 Left: Solid with edgeshighlighted. Right: After
 applying chamfers to theedges of the holes.
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 Looking at the two chamfers, it is obvious that the distances are reversed. That is, the chamfers are 3mm deep and 1mm wide. To correct this we will undo the last step and then reverse the direction of the two chamfers before reapplying them.
 ➤ Correct the two chamfers
 1 Undo the previous chamfers.
 2 Select the Chamfer Edges tool with the same settings as for the previous exercise, with one exception:
 Flip Direction: On
 3 With a data point, identify the edge of the bore hole at location 3.
 The solid highlights, with the selected edge further highlighted.
 4 Move the pointer to location 4 and when the edge under it highlights, place a data point to accept.
 The edge of the bore hole highlights.
 5 Move the pointer away from any edges and place a data point to construct the two chamfers. This time the chamfers are constructed correctly, with the chamfers 1mm deep and 3mm wide.
 To complete the model, we will place a 1mm x 1mm chamfer on the outer edges. We will turn on Select Tangent Edges so that the chamfers are applied around the rounded corners.
 ➤ Chamfer the outer edges
 1 Turn off level 5.
 2 Turn on level 6.
 3 Select the Chamfer Edges tool with the following settings:
 Turn on the lock control (so that it is closed).
 Distance 1: 1
 (Due to the lock control being on, Distance 2 automatically will be constrained to the same value when you enter the value for Distance 1.)
 Select Tangent Edges: On
 4 With a data point identify the edge on the solid at location 1.
 The two boreholes withcorrected chamfers.
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 5 Move the pointer to location 2 and when the edge under it highlights, place a data point.
 6 Repeat step 5 for the remaining edges at locations 3, 4, 5 and 6.
 7 Move the pointer away from any edges and place a data point to complete the construction of chamfers on the selected edges.
 To see the finished model, turn off level 6 and render the view.
 Often, during the design process, changes are made to the model. In an earlier exercise, where a chamfer was applied incorrectly, we used Undo to “delete” the offending chamfer. Undo can be used only in the current design session and is most useful for the most recent operations. We do, however, have two tools in the 3D Modify tool box that let us delete faces of a solid or relocate faces. Let’s now see how these two tools work.
 Modify Solid tool
 You can use this tool to relocate faces on a solid. That is, you can move a face perpendicularly to its plane. The Distance tool setting displays the distance that the face is being moved. If you turn on Distance, you can specify (that is, lock) the distance that the face is moved. The pointer defines the direction of the relocation.
 Selecting the face to modify
 After selecting the solid, which highlights, the nearest face to the pointer also highlights. As you move the pointer over the solid, different faces highlight, depending on the location of the pointer. Only one face at a time may be modified.
 Let’s see the tool in action.
 ➤ Make changes to a solid, using the Modify Solid tool
 1 Open the design file smartsolids_09.dgn.
 2 In the 3D Modify tool box, select the Modify Solid tool.
 3 Check in the tool settings that Distance is off.
 4 With a data point, identify the solid on any of its edges.
 The solid highlights. As you move the pointer over the solid, the nearest face to the pointer highlights.
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 5 Move the pointer to the region of location 1 to highlight the face containing the marker.
 6 When the required face highlights, place a data point to accept.
 The face remains highlighted. An arrow now displays, originating from the data point. This displays the direction and distance of the modification to the face.
 7 Snap to the vertex at location 2 and place a data point to accept.
 The highlighted face is relocated to the new position. Adjustments are made to the adjacent faces to maintain the integrity of the solid.
 Curved faces also may be modified. In this model, for example, we can increase the diameter of one or more of the holes.
 ➤ Modify the diameter of a hole
 1 Select the Modify Solid tool.
 2 In the tool settings, turn on Distance and in its field, key in 2.
 3 With a data point, identify the solid.
 4 Move the pointer to location 3 and when the hole highlights, place a data point to accept.
 5 Move the pointer to location 1 and place a data point.
 The face highlighted.
 Left: Snapping tolocation 2 to define thedistance for relocating
 the face. Right: Aftermodifying the solid.
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 The hole is enlarged by 2 mm.
 Where a face is moved to a position within a cut or a hole, appropriate openings are made in the surface.
 ➤ Modify a face to the center of a hole
 1 Turn off level 2.
 2 Turn on level 3.
 3 Select the Modify Solid tool.
 4 In the tool settings, turn off Distance.
 5 With a data point, identify the solid (at any edge).
 6 Move the pointer to location 1 and when the face in which it is located highlights, place a data point.
 7 Move the pointer to location 2 and snap to the center of the hole.
 8 Accept with a data point.
 The face is relocated. Note the breaks where the holes are located.
 Often, faces of a solid are joined by fillets. In these cases, all the “joined” faces are modified in a single operation, as the following exercise shows.
 After enlarging the hole.
 Left: Identifying theface to relocate. Right:
 After relocating theselected face.
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 ➤ Modify faces connected with a fillet
 1 Make level 11 the active level.
 2 Turn off all other levels.
 3 Select the Modify Solid tool with the following setting:
 Distance: On and in its field, key in 4
 4 Identify the solid.
 5 Move the pointer so that the upper horizontal face highlights (as shown below) and place a data point to accept.
 6 Move the pointer upwards and place a data point to complete the modification.
 The upper horizontal face is relocated 4 mm vertically. As well, the vertical face and the rounding that joins them are relocated “outwards” by 4 mm.
 Similarly, modifying any of the side faces results in the entire side surface being modified, as it is one tangentially continuous face (flat faces joined by rounding at the corners).
 The solid with theselected surface
 highlighted in a heavierweight line.
 The solid before (left)and after (right)
 modification.
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 ➤ Modify the side face
 1 Select the Modify Solid tool with the same setting as for the previous exercise.
 2 Identify the solid.
 3 Move the pointer so that any of the side faces is highlighted and accept with a data point.
 4 Move the pointer away from the center of the solid and place a data point.
 The solid is increased in width and height by 4mm.
 If we wanted to increase the thickness of the vertical leg of the solid while leaving the horizontal leg as is, we would have to first delete the rounding that joins them. Similarly, if we wanted to increase the length of the horizontal and vertical legs by different amounts, we would have to delete the rounding on the corners first. To do this we make use of another tool, the Remove Faces and Heal tool.
 Remove Faces and Heal tool
 Using this tool, we can remove an existing face(s) on a solid, with the resulting “wound(s)” being healed automatically. You can choose to remove the selected face only or to include other faces that were created at the same time.
 In the following example, we will make use of both settings.
 Tool Setting Effect
 Method Sets the method used to select and remove faces:Faces — removes the selected face(s).Logical Groups — removes the selected face(s) plus other faces that were created at the same time. For example, you may create a number of fillets in the one operation. This setting lets you remove them all in the one operation, by selecting any one of them.
 Before (left) andafter (right)
 modifying theside faces.
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 ➤ Prepare for the exercise
 1 Make level 12 the active level.
 2 Turn off level 11.
 To start with, let’s remove the hole in the horizontal tab of the bracket.
 ➤ Remove a face (hole) from the solid
 1 In the 3D Modify tool box, select the Remove Faces and Heal tool with the following setting:
 Method: Faces
 2 Identify the solid with a data point.
 3 Move the pointer to the hole in the horizontal tab of the bracket and when it highlights, place a data point to accept.
 4 Move the pointer away from the solid and place another data point to complete the operation.
 The hole is deleted from the solid.
 Where a number of fillets were created in a single operation, you can remove them individually by setting Method to Faces. Alternatively, you can remove them all by setting Method to Logical Groups.
 ➤ Remove several faces using Logical Groups
 1 Select the Remove Faces and Heal tool with the following setting:
 Method: Logical Groups
 2 Identify the solid with a data point.
 3 Move the pointer to any of the fillets on the top of the vertical arms of the solid and when the fillet highlights, place a data point to accept it.
 All four fillets at the top of the arms highlight. All four were created in a single operation.
 Left: The solid with theselected hole
 highlighted. Right:After removing
 the hole.
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 4 Place a data point to accept their removal.
 Left: Solid withselected fillets
 highlighted. Right:After removing
 the fillets.
 Construct a packer
 1 Open the design file solids_ex_01.dgn, which has been set up with mm as the master units (all dimensions are shown in mm).
 2 Start with a 40 x 40 x 10 slab.
 3 Draw a block and create the 12 x 6 (through) cutout at the rear of the packer.
 4 Draw two 19 x 18 blocks and create the 6 deep cutouts in the top face.
 5 Add the 6 x 6 chamfer and the 6 radius fillet.
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10 SmartSolids utility tools
 To complete this section on SmartSolids, we will now look at the tools in the 3D Utility tool box. In this chapter, you will learn about the following tools.
 • “Align Faces tool” on page 153
 • “Change SmartSolid Display tool” on page 160
 • “Extract Face or Edge Geometry tool” on page 163
 • “Intersect Solid/Surface with Curve tool” on page 165
 3D Utility tool box
 Tools in the 3D Utility tool box are used to:
 • Relocate elements so that their faces are aligned.
 • Change the display of SmartSolids.
 • Extract a face, edge or untrimmed surface from a solid.
 • Intersect a solid or surface with a linear element.
 These tools are used with existing solids in the design file.
 Align Faces tool
 Where a 3D model consists of several individual components, often it is convenient to create each component separately and then assemble them later. Where the assembly requires manipulating elements such that various faces align with each other, the Align Faces tool is invaluable. This tool is used to align the selected face of the first element to the selected face of a second element. It is very useful for aligning various parts of a model, where one or more of the faces do not coincide
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 with the design file coordinate system. In aligning the faces, various tool settings let you choose how the alignment is performed.
 Tool settings are:
 To align faces using AccuDraw’s drawing plane:
 • Select the Align Faces tool with Method set to Use AccuDraw.
 • Identify the element to align.
 • Move the pointer over the element to highlight the required face and place a data point to accept.
 • Identify the second element.
 • Move the pointer over the element to highlight the required face and place a data point to accept.
 To align faces by defining 3 points:
 • Select the Align Faces tool with Method set to By 3 Points and Use ACS for set to Neither.
 • Identify the element to align.
 The element highlights.
 • Place a data point to accept the element.
 • Define the ‘from’ coordinate origin.
 Defines the origin point for the element that is being aligned.
 Tool Setting Effect
 Method Sets the way that the planes of the faces are selected.• Use AccuDraw — AccuDraw’s drawing plane defines the orientation of the faces.• By 3 Points — The orientation of the planes are defined by 3 points.
 Use ACS for (Method set to By 3 Points only) Sets the way that the orientation of the selected face’s plane is calculated.• Neither — orientation for both faces is defined by 3 points.• Element — orientation for the first element is taken from the ACS. If no ACS is
 active, the design file coordinate system is used.• Placement — orientation for the placement of the first element is taken from the
 ACS. If no ACS is active, the design file coordinate system is used.
 Make Copy If on, a copy of the first element is used and the original element is not manipulated.
 Flip Direction Lets you reverse the direction of the aligned element.
 Tool settings with Methodset to Use AccuDraw (left)
 and By 3 Points (right).
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 • Define the ‘from’ coordinate first axis point.
 A red arrow displays, showing the direction of the first (x) axis.
 • Define the ‘from’ coordinate second axis point.
 Green and blue arrows display, showing the direction of the second (y) and the third (z) axis’ directions, respectively.
 • Define the ‘to’ coordinate origin.
 This defines the origin point for the relocation. The first element’s origin point will be located at this point.
 • Define the ‘to’ coordinate first axis point.
 A red arrow displays, showing the direction of the first (x) axis.
 • Define the ‘to’ coordinate second axis point.
 Green and blue arrows appear, showing the direction of the second (y) and the third (z) axis’ directions, respectively. At the same time, the first element is relocated with its defined axes aligning with the defined axes of the second element.
 • Accept the relocation with a data point. Alternatively, click the Flip Direction button to reverse the direction of the relocated element before accepting with a data point.
 In the following exercises we will show you how you can use this tool.
 ➤ Prepare for the exercises
 1 Open the design file smartsolids_10.dgn.
 2 Float the 3D Utility tool box from the 3D Main tool frame.
 The 3D Modify tool box is located at the lower right position of the 3D Main tool frame.
 To begin, we will align a face of the red slab (marker 1) with the sloping face (marker 2) of the green solid, using AccuDraw’s drawing plane to orientate the slab.
 ➤ Align the faces of two solids, using AccuDraw
 1 In the 3D Utility tool box, select the Align Faces tool with the following setting:
 Method: Use AccuDraw
 2 With a data point, identify the red slab.
 The slab highlights.
 3 Move the pointer over the solid to highlight the left face, containing the location marker 1. When the face highlights, accept with a data point.
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 The face remains highlighted.
 4 With a data point, identify the green solid.
 The solid highlights.
 5 Move the pointer over the solid to highlight the sloping face, containing the location marker 2. When the face highlights, accept with a data point.
 The red slab is relocated with its identified face abutting that of the green solid. The slab is located symmetrically in the face of the green solid. Check the other views, particularly the right view, to verify that the red slab is correctly aligned with the face of the green solid.
 When you use the By 3 Points method to align the faces, you can control the location and orientation of the relocated element.
 ➤ Align faces of two solids using the By 3 Points method
 1 In the Isometric view, turn off level 2.
 2 In the same view, turn on level 3.
 3 Select the Align Faces tool with the following settings:
 Method: By 3 Points
 Use ACS for: Neither
 4 With a data point, identify the yellow slab.
 The slab highlights.
 5 Accept the slab with another data point.
 6 Snap to the vertex of the slab at location 1 and accept with a data point.
 This defines the ‘from’ coordinate origin.
 7 Snap to the vertex at location 2 and accept with a data point.
 Left: The two solids with the selected faces highlighted. Right: After aligning the red slab.
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 This defines the ‘from’ coordinate first (x) axis point. On acceptance, a red arrow displays.
 8 Snap to the vertex at location 3 and accept with a data point.
 This defines the ‘from’ coordinate second (y) axis point. On acceptance, green and blue arrows display, showing the direction of the y and z axes.
 9 On the green solid, snap to the vertex at location 4 and accept with a data point.
 This defines the ‘to’ coordinate origin.
 10 Snap to the vertex at location 5 and accept with a data point.
 This defines the ‘to’ coordinate first (x) axis point. On accepting the point, a red arrow displays.
 11 Snap to the vertex at location 6 and accept with a data point.
 This defines the ‘to’ coordinate second (y) axis point. On acceptance, green and blue arrows display, showing the direction of the y and z axes.
 At the same time, the slab is relocated so that its defined coordinates match those of the ‘to’ coordinates.
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 12 Place a data point to accept the relocation.
 Let’s now look at a more complicated example that requires aligning faces of two solids.
 ➤ Prepare for the exercise
 1 Make level 11 the active level.
 2 Turn off all other levels in all views.
 3 Use the Fit View view control to fit all views.
 In this model, there is an anchor point (the green solid) and a shackle (the red solid). In this model, we want to align the shackle with the anchor point. As you can see, in the Front view, the anchor point is not vertical, which means we have to rotate the shackle to match the angle of the anchor. The Align Faces tool lets us do this simply.
 As you have seen, in the previous exercise, you can align the faces exactly, first time, using the By 3 Points method. In some cases, however, it may be simpler to quickly align the faces with the Use AccuDraw method and then move the objects into their exact location. We will use that method here.
 ➤ Align the faces of the two solids
 1 Select the Align Faces tool with Method set to Use AccuDraw.
 2 Identify the shackle (red solid).
 After relocating thesecond slab.
 Front and Isometricviews of the model for
 the exercise.
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3D Utility tool box
 3 Move the pointer over the solid until the inside face of the left leg of the shackle highlights and accept with a data point.
 4 Identify the anchor point (the green solid).
 5 Move the pointer over the solid to highlight the left face of the anchor and place a data point.
 The face highlights. At the same time the shackle is relocated with its selected face aligning with the selected face of the anchor.
 6 Accept the relocation with a data point.
 All that remains, is to move the shackle so that its hole aligns with that of the anchor. This will not alter the alignment of the elements.
 Selecting the inside face of theleft leg of the shackle.
 Identifying the left face ofthe anchoring point.
 The relocated shacklenow is aligned with
 the anchor.
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 ➤ Move the shackle so that the holes align
 1 In the Isometric view, use the Window Area tool to zoom in on the two solids such that the two holes are clearly visible.
 2 Select the Move Element tool.
 3 Snap to the center of the hole on the inside of the left leg of the shackle.
 4 Accept with a data point.
 5 Snap to the center of the left side of the hole in the anchor.
 6 Accept with a data point to complete the move.
 7 Use the Render tool to view the model.
 Change SmartSolid Display tool
 By default, SmartSolids display with two Surface Rule Lines. This is controlled by the Surface Rule Lines setting in the SmartSolid Settings dialog box.
 Where you want to change the value for an existing element, however, you can use the Change SmartSolid Display tool. Surface Rule Lines are used to represent curved surfaces. The Surface Rule Lines setting applies to curved surfaces and lets you define the number of rule lines that represent a full 360° of curvature. The other
 Close-up showing the requiredmovement of the shackle to
 align the holes.
 Rendered image of model afterrelocating the shackle.
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 choice that you have is set the Display mode for SmartSolids to be either Wireframe (the default) or Surfaces. Surfaces mode should be used only where the design is to be rendered in earlier versions of MicroStation.
 Tool settings are:
 When working in wireframe screen display mode, curved surfaces sometimes are not clearly displayed in one or more views. You can remedy this by changing the number of surface rule lines that define these curved surfaces.
 ➤ Prepare for the exercise
 1 Open the design file smartsolids_11.dgn.
 This design file contains two solids. While the Isometric view displays both solids relatively clearly, this is not always the case in other views. This applies, in particular, to the Front and Right views. In these views, the edges of the yellow solid do not display completely in either view. In the Front view, the top of the
 Tool Setting Effect
 Display Sets the display mode for SmartSolids and SmartSurfaces:• Surfaces — required only if the design is to be rendered with an earlier
 version of MicroStation.• Wireframe — the default display mode, which should be used unless the
 design is to be rendered with an earlier version of MicroStation.
 Surface Rule Lines Sets the number of rule lines that represent a full 360° of curvature of curved surfaces.
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 curved surface for the green solid does not display. Increasing the number of surface rule lines rectifies this.
 ➤ Change the number of surface rule lines used to display a curved surface
 1 In the 3D Utility tool box, select the Change SmartSolid Display tool with the following settings:
 Display: Wireframe
 Surface Rule Lines: 4
 2 In any view identify the yellow solid.
 The solid highlights.
 3 Accept with a data point.
 The display of the yellow solid updates. In the Front and Right views the edges now are defined.
 4 Repeat steps 2 and 3 for the green solid.
 The display of the green solid updates.
 You can have different settings for various solids in your design. For example, the green solid may look clearer with more surface rule lines, particularly in the Isometric view. Let’s try it.
 ➤ Increase the number of surface rule lines for the green solid
 1 Select the Change SmartSolid Display tool with the following settings:
 Display: Wireframe
 Surface Rule Lines: 10
 Edges of the curvedsurfaces now appear
 in each view.
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 2 In any view identify the green solid.
 The solid highlights.
 3 Accept with a data point.
 Display of the green solid updates. Its curved surfaces now display much more clearly in the Isometric view.
 Extract Face or Edge Geometry tool
 You can use this tool to extract a face or an edge from a solid. Many solids are created by adding cuts, fillets and chamfers to an underlying primitive solid, such as a slab. Using the Extract Face or Edge Geometry tool, you can create a separate element that matches a face or an edge of the solid. This may be to create a template or profile, which you can use to create a further solid.
 Selecting faces/edges for extraction
 After identifying the solid, as you move the screen pointer over the solid, the face/edge nearest the pointer highlights. Entering a data point selects the highlighted face/edge, which then remains highlighted. This lets you select more than one face/edge on a solid for extraction.
 Deselecting edges for extraction
 Where you select an incorrect face/edge, a Reset deselects it. Where you have selected a number of faces/edges, consecutive Resets deselect them in the reverse order. That is, the last face/edge selected is the first deselected
 The curved surface of the greensolid (left) now displays moreclearly in the Isometric view.
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 Tool settings for this tool let you define the symbology (level, color, weight and style) of the extracted face or edge.
 Let’s do an exercise to see how the tool works in practice.
 ➤ Prepare for the exercise
 1 In the design file smartsolids_11.dgn, make level 12 the active level.
 2 Turn off level 10 in all views.
 3 Turn on level 11 in all views.
 You should now be looking at a short length of pipe with a flange. In the following exercise, we will create a spacer for the pipe flange. We will use the extracted face from the flange as the template to extrude the spacer.
 ➤ Extract the face of the flange
 1 In the 3D Utility tool box, select the Extract Face or Edge Geometry tool with the following settings:
 Extract: Faces
 Level: On and set to 12
 Color: On and set to red (color 3)
 2 Identify the pipe and flange.
 The solid highlights. As you move the pointer over the solid, the face nearest the pointer highlights.
 Tool Setting Effect
 Extract Sets the type of element to be extracted:• Faces — extracts selected faces from solid.• Edges — extracts selected edges from solid.• Untrimmed Surfaces — extracts an untrimmed surface from solid. That is, a simple
 surface, less any cuts, chamfers, fillets.
 Level Defines the level on which the extracted element is placed.
 Color Defines the color of the extracted element.
 Weight Defines the line weight of the extracted element.
 Style Defines the line style of the extracted element.
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 3 Move the pointer over the solid until the bottom face of the flange highlights, then place a data point to accept.
 4 Move the pointer away from any faces and place a data point to complete the extraction of the face.
 5 Update all views to display the newly extracted (red) element.
 To complete the spacer, you can extrude this extracted element.
 ➤ Extrude the extracted element
 1 In the 3D Construct tool box, select the Extrude tool with the following settings:
 Type: Solid
 Orthogonal: On
 Distance: On and set it to 15
 2 In the Isometric view, identify the red spacer element just extracted.
 3 Move the pointer downward to define the direction of the extrusion and place a data point to complete.
 Intersect Solid/Surface with Curve tool
 With this tool you can find the intersection point between a solid/surface and a linear element (curve). Optionally, you can have points, normals, or both points and normals placed at the intersection points. The following exercise will show you how this tool works.
 ➤ Intersect a solid with a linear element
 1 Still in the design file smartsolids_11.dgn, make level 13 the active level.
 2 Turn off all other levels in all views.
 3 In the 3D Utility tool box, select the Intersect Solid/Surface with Curve tool.
 4 In the tool settings, turn on Intersection Points and Normals at Intersections.
 5 Identify the yellow solid with a data point.
 Solid with flange face highlighted.
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 The solid highlights.
 6 Identify the red dashed line.
 The line highlights.
 7 Accept with a data point.
 Points and normals appear at each intersection point of the line with the solid.
 Views showing thepoints and surface
 normals at theintersection points.
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 As well as working with solids, we need to be able to create surfaces. That is, surfaces other than the simple blocks, ellipses and shapes. MicroStation’s surfaces tools let you work with and create both simple and complex surfaces. Surface modeling tools are contained in the Surface Modeling tool frame, which contains the Create Surfaces, Modify Surfaces, Fillet Surfaces and 3D Query tool boxes.
 Surfaces, in the form of B-spline surfaces, can be constructed by entering points, or by using existing elements in the design file. These existing elements may form the edges of the surface, or you may sweep one element (curve) along two other elements (traces). Other surfaces can be created from a network of elements, or by a number of sections. Additionally, you can create a helical surface by sweeping a profile along a helix, or create a surface that is offset from an existing surface.
 MicroStation’s SmartSurface tools let you modify existing surfaces in the design.
 Introduction to B-spline surfaces
 Free-form surfaces, or NURBS surfaces, are the most flexible of all surfaces. NURBS stands for Non-Uniform Rational B-Spline. These surfaces can be used to model the most complex of surfaces, such as the human body, the hood of a car, the surface of an aircraft wing, and many others.
 Examples of a helicalsurface (left) and free-
 form surfaces (centerand right).
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 NURBS surfaces are special because they can be controlled locally. That is, you can modify one part of a NURBS surface without affecting other parts of the same surface. For example, if you were modeling a human face, you could change the size of the nose without affecting the shape of the cheeks. As with B-spline curves, B-spline surfaces have a control polygon (sometimes called a control net) that determines their shape. You can modify a B-spline surface by changing the control points, or poles, which make up the control polygon of the surface. These poles are located in the U and V direction, which are two directions that define the number of points in each row (U) and column (V) of the control polygon. The order of the B-spline surface in each direction sets the minimum number of points required to define each row or column of the control polygon.
 Much of your work with surfaces will involve B-spline surfaces. When you create a B-spline surface, settings let you choose whether or not the control polygon is visible. Whether or not the control net is visible, you still can modify a B-spline surface because when you identify it, the control polygon appears. Additionally, you can turn on display of the control net, whenever required. Before going any further, let’s have a “hands-on” look at the basics of B-spline surfaces.
 ➤ Prepare for the exercise
 1 Open the design file b_spline_intro.dgn.
 2 Use the <Q> shortcut to turn off AccuDraw.
 This design file has been saved with a green block displayed in all views, along with location markers. First, we will look at how a standard block can be modified.
 ➤ Modify the block
 1 Select the Modify Element tool.
 2 In the Isometric view, snap to the block at location 1 and accept with a data point.
 3 Snap to the center of the circle at location 2 and accept with a data point.
 Note that the block has retained its straight sides and remains planar.
 4 Reset to finish.
 5 In the Isometric view, snap to the block at its vertex at location 3 and accept with a data point.
 6 Snap to the center of the circle at location 4 and accept with a data point. The block still remains planar (Front and Right views show this) and it has retained straight sides.
 7 Reset to finish.
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 As you can see, a block can be modified but remains planar with straight sides. Let’s see how a similarly shaped B-spline surface reacts to similar modifications.
 ➤ Modify a B-spline surface
 1 Make level 3 the active level.
 2 Turn off level 2 in all views.
 3 Update all views.
 While this element has the same shape as a block, it is a B-spline surface. To make it easier to visualize the surface, extra rule lines display.
 4 In the Isometric view, snap to the surface at location 1 and accept with a data point. The dashed lines appear. These represent the control net for the B-spline surface. Note that the screen pointer controls the shape of this control net.
 5 Snap to the center of the circle at location 2 and place a data point. The edge of the surface has been “stretched” and is no longer linear. Still the pointer controls the selected point of the control net.
 6 Reset to complete the modification.
 7 In the Isometric view, snap to the surface at location 3.
 8 Move the pointer to location 4, snap to the center of the circle and accept with a data point. Refer to the other views to see how this has changed the shape of the surface, both horizontally and vertically.
 9 Reset to complete the modification.
 When modifyinga block, it
 remains planar.
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 As you can see, B-spline surfaces are much more flexible and let you stretch them in any directions.
 B-spline surfaces can take on virtually any shape and still you can modify them.
 As with B-spline curves, there are five methods available for creating B-spline surfaces in MicroStation:
 • Define Poles
 • Through Points
 • L-Square By Tol
 • L-Square By Num
 • Catmull-Rom
 You can define a B-spline surface by placing points or by applying the surface to an existing element in the design file. This is determined by the Define By setting, which lets you choose between:
 • Placement — you place each control point or pole.
 • Construction — uses the vertices of a previously created construction element to define the poles. The construction element must have at least the same number of vertices as the Order, in each direction.
 Additionally, you have the option of creating an Open or Closed surface. A closed surface closes upon itself automatically, or place an additional data point(s) to make the last data point entered the same as the first data point.
 In the following chapter we will discuss the tools used to create B-spline surfaces.
 B-spline surfaces can bemodified in any
 direction. They do nothave to be planar.
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Introduction to B-spline surfaces
 Before we continue: What controls the shape of a B-spline surface?
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12 SmartSurfaces creation tools
 In this chapter, we will look at the other 3D construction tools, those for creating surfaces. You can create B-spline surfaces that follow virtually any shape, no matter how complex. In the following section you will learn about the following tools:
 • “Construct Surface by Section or Network tool” on page 174
 • “Construct Surface by Edges tool” on page 179
 • “Place Free-form Surface tool” on page 183
 • “Construct Skin Solid/Surface tool” on page 187
 • “Sweep Along Two Traces tool” on page 190
 • “Construct Helical Surface tool” on page 194
 • “Offset Surface tool” on page 196
 Create Surfaces tool box
 Tools in the Create Surfaces tool box are used to place surfaces using various methods.
 With the tools in this tool box you can create a surface:
 • from existing section elements or elements of a network.
 • from existing elements that form the edges of the surface.
 • by placing data points or from existing shapes or line strings.
 • by translating one profile to another along a trace (path element).
 • by sweeping one or two profiles along two trace curves.
 • by sweeping a profile along a helix curve.
 • that is offset from an existing surface.
 The Create Surfaces tool box.
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 Construct Surface by Section or Network tool
 This tool lest you construct a B-spline surface from existing elements. The surface is transformed between the existing section elements or the elements of a network.
 Using section elements
 When using section elements, they must all be in the same direction to avoid twisting of the surface. As the elements are selected, a visual aid displays the element’s direction. If a section element is in the opposite direction to others, you can reverse its direction with the Change Element Direction tool in the Modify Curves tool box. The following exercise clarifies this. First, we will prepare for the exercise by setting the B-spline surface display characteristics.
 ➤ Prepare for the exercise
 1 Open the design file surfaces_01.dgn.
 2 From the Element menu, choose B-splines.
 The B-splines dialog box opens.
 3 In the Surface group box, set the following:
 Polygon Display: Invisible
 Surface Display: Visible
 Number U Rules: 10
 Number V Rules: 10
 The U and V rules values sets the number of lines that represent the B-spline surface in wireframe display mode.
 4 Close the B-splines dialog box.
 5 Select Tools > Surface Modeling > Surface Modeling to open the Surface Modeling tool frame.
 6 From the Surface Modeling tool frame, float the Create Surfaces tool box (located at the top left position of the Surface Modeling tool frame).
 Tool Setting Effect
 Define By Sets how the surface is constructed• Section — transformed between sections (lines, line strings, arcs, ellipses, complex
 chains, complex shapes or B-spline curves).• Network — a Gordon surface is constructed, interpolating a network of elements.
 Each element in the network’s u-direction must intersect each element in its v-direction and vice-versa.
 Apply Smoothing If off, the continuities of the constructed surface are those of the input cross-sections.If on, each input cross-section is approximated by a smooth B-spline curve. The surface is created from the approximated curves.
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 In this design file, we will use the red section elements to construct a surface. When you select section elements, the order in which they are selected is important. The surface will be constructed by transforming the sections in the order in which they are selected.
 ➤ Construct a surface by section
 1 In the Create Surfaces tool box, select the Construct Surface by Section or Network tool with the following settings:
 Define By: Section
 Apply Smoothing: Off
 2 In the Isometric view, identify section element number 1 with a data point anywhere on the element.
 Note the element direction arrow that appears at the left hand end of the selected element.
 3 Continue selecting the remaining elements in order 2 to 5. Note that the direction arrow on element 4 is the reverse of the rest. This will cause a twist in the surface but we will ignore this for now.
 4 Move the pointer away from the sections and place a data point to view the proposed surface.
 As we expected, the surface has a twist in it.
 5 Enter a Reset to abort the construction.
 6 Update all views.
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 Because element number 4 is in the opposite direction to the other elements, the proposed surface was twisted. To correct this, we will use the Change Element Direction tool in the Modify Curves tool box.
 ➤ Change the direction of section element 4
 1 In the Modify Curves tool box, select the Change Element Direction tool.
 2 With a data point, identify section element number 4.
 The direction arrow appears at the right hand end of the element. We are prompted to “Define start of element or Reset.”
 3 Move the pointer to the opposite end of the section element and place a data point.
 4 Check that the direction has changed by again identifying the element with a data point.
 5 Check that the direction arrow now is at the opposite end of the element and enter a Reset to exit without again changing the direction.
 With the direction of the section element corrected, all the elements run in the same direction. Now we can use the Element Selection tool to select the sections in one step.
 ➤ Construct the surface from the section elements
 1 Select the Construct Surface by Section or Network tool.
 2 In the Isometric view, identify section element number 1 with a data point anywhere on the element.
 3 Continue selecting the remaining elements in order 2 to 5.
 4 Move the pointer away from the sections and place a data point to view the proposed surface.
 This time the surface is smooth, without a twist.
 5 Place a further data point to accept the surface.
 Section element 4 now isin the correct direction.
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 6 In the Isometric view, turn off levels 2 and 3, then use the Render tool to render the view.
 7 When you have finished, turn on levels 2 and 3 in the Isometric view, ready for the next exercise.
 In the previous example, the surface followed the line of the section elements exactly. If we turn on Apply Smoothing, then the section elements are approximated with B-spline curves, prior to construction of the surface. Let’s try that option now.
 ➤ Construct a surface with smoothing of the section elements
 1 Make level 11 the active level.
 2 Turn off level 10.
 3 Update all views.
 4 Select the Construct Surface by Section or Network tool with the following settings:
 Define By: Section
 Apply Smoothing: On
 Smoothing Tolerance: 0.01
 5 In turn, identify the section elements from element number 1 through to number 5.
 6 Accept with a data point to view the surface.
 The surface this time is smoothed, without the sharp edges of the previous version.
 The completedsurface in wireframe
 and rendered.
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 7 Place a further data point to complete the construction.
 Network elements
 Working with a network is similar to working with sections. The difference is that when you create a surface from elements arranged in a network, you must be sure that each element in the network’s u-direction intersects each element in the network’s v-direction. With this tool, you first identify the sections in one direction (u or v) and then the sections in the other direction. Like with the previous tool, the order in which you select the network elements in each direction affects the final surface. Let’s try it.
 ➤ Construct a surface from a network of elements
 1 Still in the design file surfaces_01.dgn, make level 4 the active level.
 2 Turn off all other levels in all views.
 3 Update all views.
 The views display the network elements from which we will create the surface.
 4 Select the Construct Surface by Section or Network tool with the following setting:
 Define By: Network
 We are prompted to “Identify first U section curve.”
 5 In the Isometric view, identify the green element to the left in the view.
 Isometric view showingnetwork elements.
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 The element highlights and we are prompted to “Identify next section curve, or miss.”
 6 In the Isometric view, identify with data points the remaining two green elements. Identify them in order from left to right.
 7 With the three green elements highlighted, place a data point away from the network elements.
 This data point completes the selection of the elements in the U direction. We are now prompted to “Identify first V section curve.”
 8 Now, in a similar fashion, identify in turn each of the orange elements. Again, identify them in order — either from left to right or right to left.
 9 When you have selected all three orange elements, place a data point away from the network elements.
 The proposed surface displays.
 10 Place a data point to accept the construction.
 Construct Surface by Edges tool
 With this tool you can construct a B-spline surface that uses existing elements to define its edges. You can use lines, line strings, shapes, arcs, curves, B-spline curves, complex chains and complex shapes as edges. Where the number of edges is three to six inclusive, they must meet at their endpoints. The form of the resulting surface depends on the number of edges that are selected, as follows:
 • Two edges — a ruled surface connecting either the closest or farthest ends is constructed between the edges. You can reverse closest/farthest with a Reset after selecting the edges and viewing the proposed surface.
 • Three edges — you can choose between a Coons patch or an n-sided patch, via the tool settings.
 • Four edges — bi-cubically blended Coons patch.
 • Five or six edges — five or six surfaces respectively, are joined to form one patch.
 The surface created froma network of elements.
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 Via the tool settings, you have a choice between two patches when three edges are selected.
 Using this tool, you can create a complex surface from simple edge elements.
 With this tool, you can use either of two methods:
 Method 1: Select the edges first, then the tool
 • Use the PowerSelector or Element Selection tool to select the edge elements.
 • Select the Construct Surface By Edges tool.
 • Place a data point to accept the selection set and construct the surface.
 — or —
 Tool Setting Effect
 Method For 3 Edges Sets the method that is used to create the surface from the three edges• Degenerate Coons Patch• N-sided Patch
 Examples of surfaces and the edges used to create them (from 2 through 6). For 3 edges, both the Coon patch (left) and the n-sided patch (right) are shown.
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 Method 2: Select the tool first, then the solids
 • Select the Construct Surface By Edges tool.
 • Identify the first edge with a data point.
 • Identify the second and any subsequent edges with further data points.
 • Place a data point to accept the construction of the surface.
 Let’s get some hands-on experience with this useful tool. Where there are two edges only, it is quicker to use the second method. That is, select the tool and then the edges.
 ➤ Construct a surface from two edge elements
 1 Open the design file surfaces_02.dgn.
 2 In the Create Surfaces tool box, select the Construct Surface By Edges tool.
 3 In turn, identify the two red edge elements with data points.
 4 With both elements highlighted, enter a further data point to view the surface.
 5 Accept the surface with another data point.
 6 Use the Render tool to view the result.
 In some cases, surfaces created from two edge elements can be twisted. Surfaces created from two edge elements are constructed by joining either the nearest or farthest points on each element. When a twist appears in the proposed element, a Reset will reverse the way that the surface is constructed, and untwist it. The following exercise demonstrates this feature.
 ➤ Use a reset to correct a surface
 1 Make level 3 the active level.
 2 Turn off level 2 in all views.
 3 Update all views.
 4 Select the Construct Surface By Edges tool.
 Rendered view of thesurface created from the
 two edge elements.
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
 12-181

Page 192
                        

Create Surfaces tool box
 5 In turn, identify the block and the circle, so that they both are highlighted.
 6 Place a further data point to view the proposed surface.
 The surface is twisted.
 7 Enter a Reset.
 The surface “untwists.”
 8 Accept the surface with a data point.
 As you can see, this tool lets you quickly create complex surfaces from simple linear elements. Let’s finish off with a surface created from four edge elements. Two line strings define the beginning and ending shapes of a chute, while two arcs define the curve of the chute. Here, we can select the edges first, with the PowerSelector tool, then select the tool.
 ➤ Create a surface from four edges
 1 Make level 4 the active level.
 2 Turn off level 3 in all views.
 3 Update all views.
 4 Make red the active color.
 5 Select the PowerSelector tool with the following settings:
 Method: Block
 Mode: Add
 6 In any view, with two data points, place the PowerSelector block around all four edge elements.
 All four elements highlight.
 7 Select the Construct Surface By Edges tool.
 The proposed surface displays.
 At first the surfaceis twisted (left), but
 a Reset correctsit (right).
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 8 Place a data point to accept the surface.
 9 Use the Render tool to Phong render each view.
 Before we continue: When creating a surface from a network, what is required of elements forming the network?
 What is the maximum number of edges allowed when creating a Surface By Edges?
 Place Free-form Surface tool
 Almost any 3D surface can be created with this tool. You define a free-form surface with a series of data points arranged in a row-column fashion. Using AccuDraw, you can define each point easily.
 ✍ It is important that you read the prompts in the status bar while using this tool.
 Summarizing the methods available for placing free-form surfaces:
 • Define Poles — Poles (vertices) of the control polygon, or net, are defined by data points or vertices of elements. The number of poles in the u- and v- direction must be greater than or equal to the Order in that direction.
 • Through Points — The resulting surface passes through the points defined by data points or the vertices of elements. One pole is defined for each data point, the number of which must be greater than or equal to the Order.
 Views of the surfaceconstructed from the
 four edge elements.
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 • L-Square By Tol — The surface is approximated, based on the defined points. The maximum deviation of the input points from the surface is adjustable using the Tolerance setting.
 • L-Square By Num — The sum of the squares of the distances from the input points to corresponding points on the surface is minimized. With this method, you can specify the Order and the Number of Poles independently.
 • Catmull Rom — The Catmull-Rom method constructs surfaces that are defined as fourth order curves and requires a minimum of four points to define a row. Surfaces defined by the Catmull-Rom method have additional poles for each data point, enabling you to have more control when editing those surfaces
 ✍ When creating a surface by entering data points, or by using the vertices of selected line strings, the number of poles (input points) must be greater than or equal to the Order.
 In the following exercises, we will create a turbine blade using the Place Free-form Surface tool.
 ➤ Prepare for the exercise
 1 Open the design file surfaces_03.dgn.
 2 Look at all four views to see how the dashed elements define the skeleton shape of the turbine blade.
 3 In this design file, the Snap Divisor has been set to 3 to create four snap points along each element. Use the <K> AccuDraw shortcut to verify this.
 4 To simplify the placing of the points, maximize the Isometric view.
 5 Fit the Isometric view.
 ➤ Construct the free-form surface
 1 Select the Place Free-form Surface tool with the following settings:
 Method: Define Poles
 Define By: Placement
 Closure: Open for both U and V
 Order: 4 for both U and V
 2 Snap to the top curve at location 1 and place a data point to accept.
 You have started your first point in the first row.
 3 Snap to the curve at location 2 and place a data point to accept.
 This is the second column of the first row.
 4 Continue by snapping to and accepting the curve at locations 3 and 4.
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 5 After you place the data point at location 4, press the Reset button to complete the first row.
 This is the only time you will need to hit the Reset button in this tool until you are finished with the surface.
 6 Look at the message in your status bar.
 It should read “Row(U):2, Column(V):1 of 4”. This display helps you keep track of where you are in placing the B-spline. After each data point, you get an update as to your row and column location.
 At this point MicroStation dynamically displays a rubber band from the first data point entered. You are now ready to place a point for the first column of the second row.
 7 Snap to the next curve at location 5 and place a data point to accept.
 8 Continue snapping to and placing data points at locations 6, 7 and 8.
 Observe how after placing the data point at location 8, MicroStation automatically sends you back to the first row of the next column (row 3, column 1).
 9 Move on and snap to and place data points at locations 9 through 12 to complete the third row.
 10 Complete the fourth row placing points at locations 13 through 16.
 11 Reset to complete the surface.
 The surface does not follow exactly the points that are on the curved lines of the “skeleton.” This is particularly noticeable with the top and bottom curved lines. Remember, we placed the surface using the “Define Poles” method. If we want the surface to follow the curve of the defined points, we can use the Through Points method.
 After placing free-formsurface By Poles.
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 ➤ Construct the surface using the “Through Points” method
 1 Make level 5 the active level.
 2 Turn off level 4.
 3 Update the view.
 4 Select the Place Free-form Surface tool with the following settings:
 Method: Through Points
 Define By: Placement
 Closure: Open for both U and V
 Order: 4 for both U and V
 5 Repeat the steps 2 through 11 from the previous exercise, to place the surface.
 This time, the surface follows exactly the defined points.
 Using the same technique we could construct free-form surfaces with any of the other Method settings. Another option that we have is to define the points by Construction. That is, the surface is constructed from the vertices of selected line strings or shapes.
 ➤ Construct a free-form surface from line strings
 1 Make level 6 the active level.
 2 Turn off all other levels.
 3 Update the view.
 Free-form surface placed with theThrough Points method.
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 4 Select the Place Free-form Surface tool with the following settings:
 Method: Through Points
 Define By: Construction
 Closure: Open for both U and V
 Order: 4 for both U and V
 5 With data points, identify the four line strings, from top to bottom.
 The order of selection of the line strings determines the shape of the surface.
 6 Place a data point to complete the surface.
 Before we continue: Name three methods of creating a Free-Form surface?
 As a rule of thumb what should be greater: Poles or Order?
 A Free-Form surface of fifth order needs a minimum of how many data points to define it?
 Construct Skin Solid/Surface tool
 With the Construct Skin Solid/Surface tool, you can construct a B-spline surface by transforming two elements (sections) along another element (the trace). The sections and trace can be lines, line strings, arcs, ellipses, complex chains/shapes or B-spline curves.
 Solids/surfaces are generated between the section elements, commencing at their starting point and progressing in the element direction. To avoid twists, the section element’s direction should be the same, with their starting points aligned. Where
 Linestrings (left) used toconstruct surface (right).
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
 12-187

Page 198
                        

Create Surfaces tool box
 necessary, we can use the Change Element Direction tool to change the direction and starting points of the section elements. Settings for this tool are as follows:
 Type: Can be Solid (capped) or Surface (not capped).
 Orthogonal: If on, each section is rotated to be perpendicular to the trace.
 To create a skin solid/surface, you:
 • Select the Construct Skin Solid/Surface tool.
 • Identify the trace element.
 • Identify the first section element.
 • Identify the second section element.
 • Accept to view the solid/surface.
 • Accept to complete the construction.
 In an earlier exercise, we created a chute from four edges. With this tool, we can define the beginning shape, the ending shape, and the path that we want the chute to take. The following exercises demonstrate this.
 ➤ Create a surface from sections and trace path
 1 Open the design file surfaces_04.dgn.
 2 In the Create Surfaces tool box, select the Construct Skin Solid/Surface tool.
 3 Identify the green dashed trace element with a data point.
 4 Identify either of the white section elements with a data point.
 5 Identify the remaining white section element with a data point.
 6 Place a data point to view the proposed surface.
 7 Accept the construction with a further data point.
 Where the section elements are shapes or ellipses, you can choose between solid and surface for the finished construction.
 Left: The two sectionelements and thetrace. Right: The
 completed surface.
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 ➤ Construct a skin surface from a block and an ellipse
 1 Make level 3 the active level.
 2 Turn off level 1 in all views.
 3 Turn on level 2 in all views.
 4 Select the Construct Skin Solid/Surface tool with the following settings:
 Type: Solid
 Orthogonal: On
 5 Identify the green dashed trace element with a data point.
 6 Identify either of the white section elements with a data point.
 7 Identify the remaining white section element with a data point.
 8 Place a data point to view the proposed surface.
 9 Accept the construction with a further data point.
 10 Turn off level 2 in the Isometric view.
 11 Use the Render tool to Phong render the Isometric view.
 Left: The two sectionelements and thetrace. Right: The
 completed surface.
 Rendered view of the skin surface.
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 Sweep Along Two Traces tool
 This tool extends the variety of complex 3D surfaces that you can create. With this tool, you can sweep one or two section profiles along two trace curves. Various settings let you control how the surface is constructed.
 To sweep one section profile along two trace curves:
 • Select the Sweep Along Two Traces tool.
 • Identify the first trace curve.
 • Identify the second trace curve.
 • Identify the section curve.
 • Accept to view the surface.
 • Accept to complete the construction.
 To sweep two section profiles along two trace curves:
 • Select the Sweep Along Two Traces tool.
 • Identify the first trace curve.
 • Identify the second trace curve.
 • Identify the first section curve.
 • Identify the second section curve.
 • Accept to view the surface.
 • Accept to complete the construction.
 Work through the following examples to get a feel for how this tool works in practice.
 In these examples we will construct different surfaces from the same construction elements.
 Tool Setting Effect
 Method Sets the number of section profile curves.• Sweep One Along Two — one section profile curve.• Sweep Two Along Two — two section profile curves.
 Scale To Second Trace This option is enabled only if Method is set to Sweep One Along Two.• On — the section profile curve is scaled as it sweeps along the two trace
 curves.• Off — the second trace curve simply serves to control orientation.
 Scale Section Height This option is enabled only if Method is set to Sweep One Along Two and Scale To Second Trace is on.If on, the section profile curve is also scaled in the height direction.
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 ➤ Create a surface by sweeping one shape along two traces
 1 Open the design file surfaces_05.dgn.
 2 In the Create Surfaces tool box, select the Sweep Along Two Traces tool with the following settings:
 Method: Sweep One Along Two
 Scale To Second Trace: Off
 3 With a data point, identify one of the white (dashed) trace elements so that it highlights.
 4 Similarly, identify the second white (dashed) trace element so that it highlights.
 5 Identify the yellow section curve so that it highlights.
 6 Place a data point to view the proposed surface. The proposed surface looks like a straight extruded surface.
 7 Enter a Reset to cancel the construction of the surface.
 When Scale To Second Trace is turned off, the second trace determines the orientation of the swept surface only. When it is turned on, the section curve is scaled to sweep along the second trace as well as the first.
 ➤ Turn on Scale To Second Trace and create the surface
 1 Select the Sweep Along Two Traces tool with the following settings:
 Method: Sweep One Along Two
 Scale To Second Trace: On
 Scale Section Height: Off
 2 Identify one of the white (dashed) trace elements with a data point.
 3 Identify the second white (dashed) trace element with a data point.
 4 Identify the yellow section curve with a data point.
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 5 Place a data point to view the proposed surface. This time, the surface matches both trace lines.
 6 Place a data point to complete the construction.
 In the previous example, the section was scaled to the second trace curve. That is, it was scaled in one direction only, the width. Our third option is to scale the section height. That is, the section curve is scaled in both the width and height directions.
 ➤ Prepare for the exercise
 1 Make level 4 the active level.
 2 Update all views.
 ➤ Turn on Scale Section Height and create the surface
 1 Select the Sweep Along Two Traces tool with the following settings:
 Method: Sweep One Along Two
 Scale To Second Trace: On
 Scale Section Height: On
 2 Identify one of the white (dashed) trace elements with a data point.
 3 Identify the second white (dashed) trace element with a data point.
 4 Identify the yellow section curve with a data point.
 5 Place a data point to view the proposed surface. The section curve now is scaled in both directions.
 The resulting surface isscaled to the second trace.
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 6 Place a data point to complete the construction.
 Where we want the finishing section curve to be different to that of the starting section curve, we can use the “Sweep Two Along Two” setting. We will look at that option now, as we construct a sump pan.
 ➤ Prepare for the exercise
 1 Make level 5 the active level.
 2 Turn off all other levels in all views.
 3 Update all views.
 As for the previous exercises, the trace curves are white dashed lines. The section curves are solid yellow elements. Looking at the Top and Front views, you can see clearly the shape of the trace and section elements.
 ➤ Construct the surface by tracing two sections along two traces
 1 Select the Sweep Along Two Traces tool with the following setting:
 Method: Sweep Two Along Two
 2 With a data point, identify one of the white trace curves.
 3 Identify the second of the white trace curves.
 4 Identify one of the yellow section curves.
 5 Identify the second yellow section curve.
 The surface created with ScaleSection Height turned on.
 Top and Front views showclearly the shape of the
 trace and section curves.
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 6 Place a data point to view the proposed surface.
 7 Accept the construction with a further data point.
 8 Use the Render tool to Smooth render the views to see the surface.
 Construct Helical Surface tool
 Using this tool, you can construct a helical shaped B-spline surface by sweeping a section profile curve along a pre-defined helix curve. In preparation for using this tool, you place the trace curve, with the profile curve located at one end of the trace. Additionally, you must place a line that represents the axis direction of the helix curve. Only the direction of the line matters.
 ✍ While this tool is called the Construct Helical Surface tool, in fact the trace does not have to be a helix curve. You can use any B-spline curve as the trace element, but there must be a line to represent the axis direction of the trace.
 To create a helical surface:
 • Select the Construct Helical Surface tool.
 • Identify the helix curve.
 • Identify the section profile curve.
 • Identify the line that defines the axis direction of the helix curve.
 Tool Setting Effect
 Scale Section in X Sets the factor by which the section profile is scaled as it sweeps along the helix curve. Scale direction is from the starting point of the helix curve to its center point — that is, the radius direction.
 Scale Section in Y Sets the factor by which the section profile is scaled as it sweeps along the trace curve. Scale direction is in the direction of the helix axis — that is, the height direction.
 Spin Angle Sets the angle at which the profile is spun as it sweeps along the helix curve.
 Rendered view of thecompleted surface.
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 • Place a data point to view the surface.
 • Accept the construction with another data point.
 With this tool, you can use open or closed elements as the section profile curve. In the following exercises, we will use both. In these exercises, you will find that the Front view is the easiest to use for identifying the various elements in constructing the helical surfaces.
 In the first example, we will create a spring, having a rectangular section.
 ➤ Create a spring
 1 Open the design file surfaces_06.dgn.
 2 In the Create Surfaces tool box, select the Construct Helical Surface tool with the following settings:
 Scale Section in X and Scale Section in Y: both set to 1
 Spin Angle: 0
 3 With a data point, identify the white (dashed) helix curve so that it highlights.
 4 Identify the yellow section profile.
 5 Identify the white (dashed) line.
 6 Place a data point to view the surface.
 7 Accept the construction with another data point.
 8 Use the Render tool to view the resulting surface.
 As well as closed shapes, open elements can be used as the section profile. In the following exercise, we will create a screw thread.
 Front and Rightrendered views of the
 helical surface.
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 ➤ Prepare for the exercise
 1 Make level 5 the active level.
 2 Turn off all other levels in all views.
 3 Turn on level 4 in the front view.
 ➤ Construct the screw thread
 1 Select the Construct Helical Surface tool with the same settings as used in the previous exercise.
 2 In the Front view, identify the helical curve.
 3 Identify the yellow thread profile.
 4 Identify the red center line of the helical curve.
 5 Place a data point to view the surface.
 6 Accept the construction with a further data point.
 7 Turn on level 6 in all views.
 8 Use the Fit View view control to fit each view.
 9 Use the Render tool to view the screw thread on a bolt.
 Offset Surface tool
 Where a “parallel” surface is required, you can use the Offset Surface tool either to offset an existing surface, or to make an offset copy of the surface. Extruded surfaces, surfaces of revolution, and B-spline surfaces may be offset.
 Tool Setting Effect
 Distance If on, sets the offset distance in the surface normal direction.
 Make Copy If on, the surface is copied and the original surface is not altered.
 Rendered view of thecompleted bolt with
 screwthread.
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 To construct an offset surface:
 • Select the Offset Surface tool.
 • Identify the surface.
 A surface normal displays, indicating the direction and distance of the offset surface. If distance is on, their length is fixed. If distance is off, then the pointer determines both the direction and the distance.
 • Enter a data point.
 A simple example will demonstrate this tool to you. Here, we will create an offset surface that is 30mm above an existing B-spline surface.
 ➤ Create an offset surface
 1 Open the design file surfaces_07.dgn.
 2 In the Create Surfaces tool box, select the Offset Surface tool with the following settings:
 Distance: On and set it to 30
 Make Copy: On
 3 In the Front view identify the surface.
 A normal arrow displays, showing the distance and direction of the proposed offset surface. The distance is fixed at 30mm.
 4 Move the pointer upwards to define the direction of the offset surface.
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 5 Place a data point to construct the surface.
 Before we continue: When constructing a helical surface, how do you define the axis direction of the helix curve?
 The completed offsetsurface above the original
 B-spline surface.
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 Following on from the previous chapter, where you were introduced to the construction tools for 3D surfaces. Here, we will look at tools for modifying surfaces. These tools are located in the Modify Surfaces tool box. In the course of this chapter, you will learn about the following tools:
 • “Construct Trim tool” on page 200
 • “Change Normal Direction tool” on page 204
 • “Project Trim tool” on page 206
 • “Modify Trim Boundary tool” on page 210
 • “Stitch Surface tool” on page 212
 • “Split Surface tool” on page 213
 • “Convert 3D tool” on page 216
 • “Change To Active Surface Settings tool” on page 218
 • “Extend Surface tool” on page 221
 Modify Surfaces tool box
 Within the Modify Surfaces tool box are tools that let you modify existing surfaces in a design.
 Included in this tool box are tools that let you trim, extend, stitch or split surfaces. As well you can modify B-spline specific attributes, or change the direction of surface normals.
 The Modify Surfaces tool box.
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 Construct Trim tool
 This tool lets you trim one or two surfaces back to their intersection point, or you can opt to display the intersection curve only. With this tool you can:
 • Trim two elements to their common intersection.
 • Trim one element to its intersection with a second.
 • Construct a curve along the common intersection of the two elements.
 When using this tool, before accepting the trim, you can adjust the various tool settings to suit.
 To trim two elements back to their common intersection, you:
 • Select the Construct Trim tool.
 • Identify the first element.
 • Identify the second element.
 • Place a data point to view the trim.
 • If necessary, make adjustments to the tool settings.
 • Accept with a data point.
 Tool Setting Effect
 Intersection Curve If on, a curve is constructed along the common intersection of the surfaces
 Trim 1st Surface If on, the first surface identified is trimmed to its intersection with the second element.
 Trim 2nd Surface If on, the second surface identified is trimmed to its intersection with the first element.
 Flip 1st Sets which portion of the 1st selected element is retained after trimming:Off — selected portion is retained.On — selected portion is deleted.
 Flip 2nd Sets which portion of the 2nd selected element is retained after trimming:Off — selected portion is retained.On — selected portion is deleted.
 Copy 1st If on, a copy is made of the first selected element, and the original element is retained in the design.
 Copy 2nd If on, a copy is made of the second selected element, and the original element is retained in the design.
 Construct Trim tool settings.
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 Work through the following exercises to see “hands-on” how this tool works.
 ➤ Prepare for the exercises
 1 Open the design file surfaces_08.dgn.
 2 From the Surface Modeling tool frame, float the Modify Surfaces tool box.
 The Modify Surfaces tool box is located at the top right position in the Surface Modeling tool frame.
 This design file has been saved with two intersecting cylinders displayed in the four views.
 ➤ Trim the two surfaces
 1 In the Modify Surfaces tool box, select the Construct Trim tool with the following settings:
 Intersection Curve: On
 Turn off all other settings.
 2 Identify the green cylinder with a data point at location 1.
 The cylinder highlights. The location of the selection point determines the portion to be retained.
 3 Identify the red cylinder with a data point at location 2.
 Both cylinders now are highlighted.
 4 Place a data point to view the Intersection Curve.
 The cylinders remain highlighted. A yellow curve appears in all views (the curve is drawn with the active color). This curve shows the common intersection of the two surfaces.
 5 Turn on Trim 1st Surface and turn off Intersection Curve.
 The first selected cylinder now is trimmed back to the common intersection. Note that its display changes. When it is trimmed, it changes from being a
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 3D primitive cylinder to a SmartSurface. Default display of SmartSurfaces is controlled by the SmartSolids Settings.
 6 Turn on Trim 2nd Surface.
 Both elements now are trimmed back to the common intersection. The second cylinder now takes on a similar appearance to that of the first.
 7 Turn on Flip 1st and Flip 2nd.
 The trimmed sections are reversed with the previously deleted portion being retained.
 8 Turn off Flip 1st and Flip 2nd.
 9 Place a data point to complete the trim.
 As you can see, you don’t have to work out what settings are required prior to using this tool. You can adjust the settings to get the required effect after selecting the elements, but prior to accepting the construction. Let’s look at a further example with a slab and a rectangular block. While the slab is a solid, still you can manipulate it with the Construct Trim tool.
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 ➤ Prepare for the exercise
 1 Make level 3 the active level.
 2 Turn off level 2 in all views.
 In this example, we will trim the slab back to leave an angled face on it. We will identify the slab at location 1 and the block at location 2. So that the trimmed block fills the space where the trim occurs, we will turn on Flip 2nd.
 ➤ Trim the slab
 1 Select the Construct Trim tool with the following settings.
 Trim 1st Surface: On
 Trim 2nd Surface: On
 Flip 2nd: On
 Turn off all other settings.
 2 Identify the slab at location 1.
 3 Identify the block at location 2.
 4 Place a data point to view the trim.
 5 Accept the construction with a further data point.
 Complex surfaces also can be trimmed, as the following example shows. This time, we will use the location of the identification point to define which part of the surface we wish to retain.
 ➤ Trim using a B-spline surface
 1 Make level 4 the active level.
 2 Turn off level 3 in all other views.
 3 Select the Construct Trim tool.
 4 Identify the green slab at location 1.
 5 In the Front view, identify the red B-spline surface at location 2.
 Isometric view of the slaband block before (left) andafter (right) trimming back
 to their commonintersection.
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 Using the Front view, we make sure that we are selecting the surface at a point within the region of the slab, as this is the part of the surface that we want retained.
 6 Place a data point to view the trim.
 7 Accept the construction with a further data point.
 Change Normal Direction tool
 Surface Normals are indicators that are generated every time you create a surface. They are invisible during the creation process and after the surface is created. The only time that you see them is when you use certain surface modification tools and the Change Normal Direction tool.
 A normal to a surface is an imaginary line that is perpendicular to the surface at a given point. You have the possibility of two such lines on any given point on the surface. These lines are 180° apart. That is, on either side of the surface. The Change Normal Direction tool “flips” the normal through 180°.
 To check and/or change the direction of surface normals on a surface:
 • Select the Change Normal Direction tool.
 • Identify the surface to be checked/changed.
 The surface normals display.
 • Accept with a data point to reverse the direction of the surface normals.
 OR
 • Reset to leave the surface normals as they are.
 Surface Normals indicate the direction of the surface for rendering and some surface modification tools, which we will be looking at later. One of these tools, Project Trim, uses an element as a cutting profile. The direction of the surface normals of this element determines in which direction the cutting profile is projected.
 Isometric view of the slaband B-spline surface before
 (left) and after (right)trimming back to theircommon intersection.
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 Let’s look at this tool now. The design file that we will use contains a green pressure vessel and a red circle.
 ➤ Checking/changing direction of Surface Normals
 1 Open the design file surfaces_09.dgn.
 2 In the Modify Surfaces tool box, select the Change Normal Direction tool.
 3 With a data point, identify the green element (pressure vessel).
 Surface normal arrows display. They are pointing outwards from the center of the pressure vessel.
 4 Enter a Reset to leave them as they are.
 5 With a data point, identify the red circle.
 Surface normal arrows display. They are pointing downward from the red circle.
 6 Place a data point to change the direction of the Surface Normals.
 ➤ Again check the Surface Normals direction for both elements
 1 Select the Change Normal Direction tool.
 2 With a data point, identify the green element (pressure vessel).
 Surface normal arrows display. They are pointing outwards from the center of the pressure vessel, as before. Because we entered a Reset before, their direction was not changed.
 3 Enter a Reset to leave them as they are.
 4 With a data point, identify the red circle.
 Surface normals for thecircle pointing downward.
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 Surface normal arrows display. They are pointing upward from the red circle, whereas earlier they pointed downward. They have changed direction because earlier we entered a data point to accept the change.
 5 Reset to leave them pointing in the displayed direction.
 Project Trim tool
 With the Project Trim tool, you can:
 • Punch a hole in a surface by projecting a cutting profile.
 • Project a B-spline curve onto a surface.
 Tool settings let you choose how the cutting profile is projected, whether or not the surface is punched, and how it is punched. The inner edge of the newly punched out surface is called the boundary.
 When using this tool, with Direction set to Orthogonal, the direction of the cutting profile’s projection is in the direction of its surface normals. Using the Change Normal Direction tool, you can check/set the direction for the cutting profile.
 Tool Setting Effect
 Direction Sets the direction of the projection of the cutting profile, as follows:• Orthogonal — normal to the cutting profile.• View — normal to the active view.• Vector — direction is determined by two data points.• Normal to Surface — normal to the plane of the surface being trimmed.
 Output Mode Sets the method used to trim the surface, as follows:• Trim Surface — the region either inside or outside the projected curve is trimmed
 away. The identified portion of the surface is retained.• Split Surface — the projected cutting profile divides the surface into two regions;
 one inside and the other outside the projected profile.• Project Curve — projects a B-spline curve on the surface. The surface is not altered.• Impose Onto — the cutting profile is imposed onto the surface as a boundary.
 Keep Profile If on, the cutting profile curve is retained.
 The red circle’s surfacenormals now point upward.
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 To punch a hole in a surface, you
 1 Select the Project Trim tool.
 2 Identify the surface to punch, on a portion of the surface that is to be retained.
 3 Identify the cutting profile.
 4 Accept to create the hole.
 OR
 If Direction is set to Vector, enter the first point to define the vector direction.
 5 Enter the second point to define vector direction and create hole.
 Typically, you could use this tool to cut holes in pressure vessels or in building walls. It is not a difficult tool to use, as the following example demonstrates. In this example, we will first cut a round hole in the upper surface of a pressure vessel. This is the same design as we used in the section for the Change Normal Direction tool. To prepare for the Project Trim exercise, we will first check the direction of the surface normals for the cutting profile.
 ➤ Prepare for the exercise
 1 If necessary, re-open the design file surfaces_09.dgn.
 2 Select the Change Normal Direction tool.
 3 Identify the red circle with a data point.
 Surface normal arrows display, pointing upward. This is the correct direction for the first part of our exercise.
 4 Enter a Reset to leave the surface normals for the circle pointing upwards.
 Now that we know that the surface normals are correctly orientated, we can use the circle as a cutting profile to cut a hole in the top of the pressure vessel.
 ➤ Punch a hole in the top of the pressure vessel
 1 Turn on level 2 in the Isometric view.
 2 In the Modify Surfaces tool box, select the Project Trim tool with the following settings:
 Direction: Orthogonal
 Output Mode: Trim Surface
 Keep Profile: On
 3 With a data point, identify the green pressure vessel at location 1.
 4 With a data point, identify the red cutting profile at location 2.
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 5 Accept with a data point to complete the hole.
 The hole is punched in the top of the pressure vessel. The display of the pressure vessel changes. It now has become a SmartSurface and its display is controlled by the SmartSolids settings.
 If we now wanted to cut a similar hole in the bottom of the pressure vessel, we first have to reverse the direction of the cutting profile’s surface normals.
 ➤ Punch a hole in the bottom of the pressure vessel
 1 Select the Change Normal Direction tool.
 2 Identify the red circle with a data point.
 Surface normals display, pointing upward.
 3 Place a data point to change the direction of the surface normals.
 4 Select the Project Trim tool with the same settings as before, except turn off Keep Profile.
 5 With a data point, identify the green pressure vessel at location 1.
 6 With a data point, identify the red cutting profile at location 2.
 7 Accept with a data point to complete the hole.
 Before (left) andafter (right)
 punching the hole inthe top of the
 pressure vessel.
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 The new hole is punched in the bottom of the pressure vessel. The cutting profile this time was not retained, because we turned off Keep Profile.
 When you select the surface to be trimmed, the identification point is important. In particular this applies when you have Output Mode set to Trim Surface. In these instances, the identification point determines which part of the surface is retained and which part is deleted as the following exercise illustrates.
 ➤ Prepare for the exercise
 1 Make level 3 the active level.
 2 Turn off all other levels in all views.
 3 Update all views.
 ➤ Punch a hole in the surface and retain the punched region only
 1 In the Modify Surfaces tool box, select the Project Trim tool with the following settings:
 Direction: Orthogonal
 Output Mode: Trim Surface
 Keep Profile: On
 2 In the Top view, identify the green pressure vessel at location 1.
 Note that we are identifying the pressure vessel within the boundary of the red circle, the cutting profile.
 3 Identify the red cutting profile at location 2.
 4 Accept with a data point.
 Pressure vessel with holepunched in bottom surface.
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 Because we identified the pressure vessel within the region of the cutting profile, only that region remains.
 Modify Trim Boundary tool
 Currently for use with B-spline surfaces (only) containing trim boundaries (or holes).
 Three settings for the Modify Trim Boundary tool let you Reverse, Remove All (holes) or Remove One (hole). Reverse simply makes the punched hole a surface and the surface a hole.
 To remove one trim boundary from a B-spline surface:
 • Select the Modify Trim Boundary tool.
 • Set Trim Boundary to Remove One.
 • Identify the trim boundary (hole) to remove with a data point.
 • Accept with a data point to complete the removal.
 To remove all trim boundaries or to reverse the trim boundaries for a B-spline surface:
 • Select the Modify Trim Boundary tool.
 • Set Trim Boundary to Remove All or Reverse as desired.
 • Identify the B-spline surface with a data point.
 • Accept with a data point to complete.
 In the following exercises, we will see how each of the settings works in practice.
 Isometric view showing thepressure vessel before (left)
 and after (right) cuttingaway the region outside the
 cutting profile.
 Modify Trim Boundary tool settings box.
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 ➤ Modifying a Trim Boundary of a B-spline Surface
 1 Open the design file surfaces_10.dgn.
 2 Select the Modify Trim Boundary tool with the following setting:
 Trim Boundary: Reverse
 3 Select the green B-spline surface with a data point.
 4 Place a second data point to accept.
 This reverses the existing surface and the holes. We now have two surfaces where the holes used to be.
 5 Undo the previous operation.
 6 In the tool settings, set Trim Boundary to Remove One.
 7 With a data point, select the green rounded trim boundary on the B-spline surface at location 2.
 8 Accept with a second data point.
 The selected hole is removed.
 9 Undo the last operation.
 10 In the tool settings, set Trim Boundary to Remove All.
 11 With a data point, select the B-spline surface at location 1.
 12 Accept with a second data point.
 Isometric viewshowing the B-spline surface
 before (left) andafter (right)
 reversing thetrim boundaries.
 Before (left) andafter (right)
 removing therounded
 trim boundary.
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 All the trim boundaries are removed.
 Stitch Surface tool
 With the Stitch Surface tool, you can join two surfaces along their abutting edges creating one new surface. The surfaces must abut along an edge or at least part of an edge.
 This tool works with shapes, B-spline surfaces, extruded surfaces, and surfaces of revolution. The Stitch Surface tool does not have any tool settings. You can stitch surfaces together using either of the following methods:
 Method 1: Select the surfaces first, then the tool
 • Use the PowerSelector or Element Selection tool to select the surfaces.
 • Select the Stitch Surface tool.
 • Place a data point to accept the selection set and stitch the surfaces together.
 — or —
 Method 2: Select the tool first, then the solids
 • Select the Stitch Surface tool.
 • Identify the first surface with a data point.
 • Identify the second and subsequent surfaces with further data points.
 • Place a data point to accept the construction of the stitched surface.
 When you use the first method, the color of the resulting surface is that of the (selected) surface that was placed in the file first. When you use the second method, the color of the resulting surface is that of the first surface selected.
 In the following example, we will stitch together four surfaces to create a single surface.
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 ➤ Stitching surfaces together
 1 Open the design file surfaces_11.dgn.
 1 Select the PowerSelector tool with the following settings:
 Method: Block
 Mode: Add
 2 In any view, with two data points, place the PowerSelector block around all four surfaces.
 The selected surfaces highlight.
 3 Select the Stitch Surface tool.
 The selected surfaces are stitched together forming a single surface. Observe that the display of the surface is different. It has become a single SmartSurface. The color of the resulting surface is red, as this was the first element placed in the design.
 Using the Stitch Surface tool is a great way to create surfaces from existing elements. From simple surfaces you can create complex SmartSurfaces and then modify these using other SmartSolids/SmartSurfaces tools.
 Split Surface tool
 Just as the Stitch Surface tool lets you join surfaces into a single entity, the Split Surface tool lets you take one surface and split it into two surfaces. You can use it also to break up a primitive, like a slab or a cylinder. When you split a surface, it automatically becomes a B-spline surface regardless of what it was before. In effect, this tool is similar to the Delete Part of Element tool. Whereas the Delete Part of Element tool works with linear elements, the Split Surface tool works with surfaces.
 When using the Split Surface tool, you select a location where you want to split the surface and then another point to determine the direction of the split. As with the Delete Part of Element tool it is important where you select the element and where you select the direction for partial delete.
 Before (left) and after(right) stitching the
 four surfaces together.
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 To split a surface:
 • Select the Split Surface tool.
 • Identify the surface at the point at which you want the partial delete to start.
 • Place a second data point to define the direction for the partial delete.
 • Place a third data point to define the end point for the partial delete.
 ✍ After placing the second data point you also have the option to use the Reset button to select a different direction for the partial delete.
 In the following exercise, you will use the Split Surfaces tool to modify surfaces in the design file.
 ➤ Splitting a surface
 1 Open the design file surfaces_12.dgn.
 2 Select the Split Surface tool.
 3 In the Isometric view, snap to the red surface at location 1 and accept with a data point.
 4 Snap to the surface at location 2 and accept with a data point.
 As you move the pointer, you are viewing dynamically the deletion, horizontally, of part of the surface.
 5 Enter a Reset to change the direction of the deletion.
 Now, as you move the pointer, you are viewing the deletion, vertically, of part of the surface.
 6 Snap to the surface again at location 2 and accept with a data point, to complete the deletion.
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 Because the original surface that you just modified was a B-spline surface, there was no significant change in the way that the modified surface displayed on screen. Where you split a primitive, for example, the modified surface becomes a B-spline surface and its display changes in line with the B-spline display settings. Shortly, we will look at how to change these. Let’s first split the green cylinder in our current design file.
 ➤ Splitting the cylinder
 1 Select the Split Surface tool.
 2 In the Isometric view, snap to the green cylinder at location 3 and accept with a data point.
 3 Again snap to the cylinder at location 3 to set the direction for the split.
 As you move the pointer, you are viewing dynamically the deletion, vertically, of part of the cylinder.
 4 Enter a Reset to change the direction of the deletion.
 Now, as you move the pointer, you are viewing the deletion, horizontally, of part of the cylinder.
 5 Snap to the cylinder at location 4 and accept with a data point to complete the deletion.
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 The cylinder has been split into two sections.
 You can use this same tool to split complex B-spline surfaces.
 ➤ Split a complex B-spline surface
 1 Make level 3 the active level.
 2 Turn off all other levels in all views.
 3 Select the Split Surface tool.
 4 Snap to the yellow surface at location 1 and accept with a data point.
 5 Snap to the surface at location 2 and accept with a data point.
 6 Note, in the Top view, how the surface is partially deleted in the x direction as you move the pointer around.
 7 Reset to change the direction of the partial deletion to the y direction.
 8 Place a data point at location 3 to complete the partial deletion.
 Convert 3D tool
 This tool can be handy, for example, where you have created a slab as a surface or extruded a complex shape as a surface, when you actually wanted them to be solids. With it, you can convert the surface elements to solids. Alternatively, you can convert a solid back to a surface (without top and bottom faces).
 Two options in the tool settings let you Convert To:
 • Surface — converts the element to surfaces.
 • Solid — converts the element to a solid, adding faces where necessary (such as top and bottom faces to an extruded surface element).
 Isometric view of the splitB-spline surface.
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 To convert a 3D element:
 • Select the Convert 3D tool.
 • Identify the solid/surface element.
 • Accept with a data point to complete the change to solid/surface.
 Let’s look at a simple example of an extruded shape.
 ➤ Prepare for the exercise
 1 Open the design file surfaces_13.dgn.
 2 Use the Render tool with Render Mode set to Smooth, to render the view.
 As you can see, the model has no front or back surfaces.
 ➤ Convert the surface to a solid
 1 Select the Convert 3D tool with the following setting:
 Convert To: Solid
 2 Identify the model.
 The model highlights.
 3 Accept with a data point.
 4 Use the Render tool to again Smooth render the view.
 Looking at the model, you can see that it now has a front face at least. If you check the element with the Analyze Element tool, you will find that now it is a solid. We can reverse the procedure and return the solid back to a surface.
 Smooth renderedview of model.
 Smooth rendered viewof model after
 conversion to a solid.
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 ➤ Convert the solid to a surface
 1 Select the Convert 3D tool with the following setting:
 Convert To: Surface
 2 Identify the model.
 The model highlights.
 3 Accept with a data point.
 4 Use the Render tool to again Smooth render the view.
 You will see that the front and back faces have been removed from the model.
 Change To Active Surface Settings tool
 When you create a B-spline surface, various settings that determine its construction and appearance are controlled by settings in the B-splines dialog box. This dialog box is opened by selecting Element > B-splines and contains settings for both B-spline curves and B-spline surfaces. Here, we will be looking at the Surface settings only.
 Settings in the B-splines dialog box apply to surfaces as you place them in your designs. Once a B-spline surface has been placed, however, you can change its settings using the Change To Active Settings tool.
 When working with B-spline surfaces, their display is represented with rule lines. We have to trade off screen updates with how “visible” the surface is. That is, the more rule lines that are used to display the surface, the easier it is to visualize in wireframe mode, but screen updates will be affected. Let’s look at a B-spline surface and experiment with some of the settings.
 B-splines dialog box.
 Change To Active SurfaceSettings dialog box.
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 ➤ Prepare for the exercise
 1 Open the design file surfaces_14.dgn.
 2 Use the Render tool to Phong render the Isometric view.
 The model that in wireframe display looked like four simple edge elements is in fact a B-spline surface.
 This B-spline surface was created with the Number U Rules and Number V Rules both set to a value of 2. Thus, only two lines display in each direction to represent the surface in wireframe display mode. To help us see the B-spline surface in wireframe display, we can add some rule lines.
 ➤ Add rule lines to the B-spline surface
 1 Select the Change To Active Surface Settings tool.
 2 In the tool settings, turn on Rules and set the values for both U and V to 5.
 3 Identify the surface with a data point.
 4 Place a data point to make the change.
 The surface now is more easily seen in wireframe display. There are five rule lines in each direction, as we specified.
 This is a big improvement but we can do better by increasing the number of V rules.
 5 In the tool settings, change the value for V rules to 15.
 6 Identify the surface with a data point.
 The wireframe display(left) doesn’t display
 adequately the B-splinesurface (right).
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 7 Place a data point to make the change.
 With the new values for U and V rules, the surface is easier to see in wireframe mode.
 As well as the display parameters, we can change other settings for B-spline surfaces. We can turn on the display of the control polygon and we can change the Order of the surface.
 ➤ Prepare for the exercise
 1 Make level 2 the active level.
 2 Turn off level 1 in all views.
 3 Use the Fit View view control to fit all views.
 First, we will turn on display of the control polygon.
 ➤ Change control polygon and surface settings for the B-spline surface
 1 In the Change to Active Surface Settings tool settings:
 Turn on Polygon and set it to Visible.
 All other settings should be turned off.
 2 Identify the surface with a data point.
 3 Accept with a data point to make the change.
 With the control polygon visible, you now can make the surface invisible.
 After increasingV rules to 15.
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 4 In the tool settings, turn on Surface and set it to Invisible.
 5 Identify the surface with a data point and accept with a further data point.
 The surface disappears, leaving the control polygon only.
 6 Change the Surface tool setting back to visible and repeat the previous step to turn the surface display on again.
 Also, you can change the order of the B-spline surface with or without preserving its current shape.
 ➤ Change the order of the B-spline surface
 1 In the Change to Active Surface Settings tool settings:
 Turn on Order for both the U and V directions and set their values to 5.
 When you turn on Order, you have the option of whether or not to preserve the shape of the original B-spline surface. First we will try the tool without preserving the shape.
 2 Identify the surface with a data point.
 3 Accept with a further data point. Note the change in the shape of the surface. Note also, that it still is contained within the control polygon, which remains unchanged.
 4 Undo the previous operation.
 5 In the tool settings, turn on Preserve Shape.
 6 Identify the surface with a data point.
 7 Accept with a further data point. This time, the surface retains its original shape but the control polygon has changed and now has many more points.
 Extend Surface tool
 With the Extend Surface tool, you can extend an edge of a surface, in a similar fashion to extending a line with the Extend Line tool. Soon, you will see that this is where the similarity ends between the two tools.
 The shape of the originalsurface is retained but the
 control polygon has changed.
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 You can use this tool to extend different types of surfaces, such as a cone, extruded surface, surface of revolution, or B-spline surface, along one of its edges.
 Settings for this tool determine how the surface is extended.
 To extend a surface:
 • Select the Extend Surface tool.
 • Identify the surface near the edge to be extended.
 • Adjust the settings as necessary.
 • Accept the extension with a data point.
 To help get a clearer understanding of how this tool works we will work through several exercises using a B-spline surface.
 ➤ Extend edges of a B-spline surface tangentially
 1 Open the design file surfaces_15.dgn.
 2 Select the Extend Surface tool with the following settings:
 Extend Mode: Tangential
 Distance: On and in its field, key in 100
 3 In the Top view, identify the surface with a data point at the edge near location 1.
 The proposed extension displays.
 Tool Setting Effect
 Extend Mode Sets how the surface is extended:• Tangential — extension is tangent continuous at the joint of extension.• By Angle — extension is at an angle as specified in the Angle field.
 Distance If on, sets the distance of the extension.
 Angle (Extend Mode set to By Angle only) Sets the angle at which the extension is made. An angle of 0° creates a tangential extension.
 Make Copy If on, a copy is made and the original surface is retained in the design file
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 4 Place a data point to accept the extension.
 5 In the Top view, identify the surface with a data point at the edge near location 2.
 6 Place a data point to accept the extension.
 Similarly, you can extend the two remaining edges tangentially.
 ➤ Extend the remaining edges
 1 With the Extend Surface tool still active, use the Front view to identify the surface at the edge near location 3.
 The proposed extension displays.
 2 Place a data point to accept the extension.
 3 Repeat steps 1 and 2 for the remaining edge near location 4.
 When you choose to extend a surface By Angle, the extension is “flared” at the chosen angle. By making the angle a negative value, you can toggle the flaring inward/outward.
 ➤ Extend the edges of a B-spline surface By Angle
 1 Make level 4 the active level.
 2 Turn off level 3 in all views.
 3 Update all views.
 Level 4 contains a (magenta) copy of the surface used in the previous exercises.
 Top view showing thesurface before (left)
 and after (right)extending the edge
 near location 1.
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 4 Select the Extend Surface tool with the following settings:
 Extend Mode: By Angle
 Distance: On with a value of 100
 Angle: 20
 5 In the Top view, identify the surface with a data point at the edge near location 1.
 The proposed extension displays. It is flared inward from the existing edge.
 6 In the tool settings, add a minus sign before the angle value of 20. After keying in the minus sign, remember to press <Enter> to accept the new value.
 The display of the proposed extension now flares outward from the existing edge.
 7 Place a data point to accept the extension.
 8 In the Top view, identify the surface with a data point at the edge near location 2.
 The proposed extension displays. It is flared inward from the existing edge.
 9 In the Angle field, remove the minus sign and press <Enter>.
 The extension now flares outward from the existing edge.
 10 Place a data point to accept the extension.
 You can continue with this exercise, extending the remaining edges. Use the Front view and extend the edges near locations 3 and 4. Make all the extensions flare
 Changing the anglefrom +20° to -20°
 reverses the flaringfrom inward (left) to
 outward (right).
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 outward by modifying the value of the angle. That is, add or remove the minus sign as necessary.
 Before we continue: What dialog box controls the display of SmartSurfaces?
 What happens to a Solid if you trim it?
 What is a Surface Normal?
 How do you change the direction of a split using the Split Surface tool?
 To make a surface longer, what would be the best tool to use?
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14 SmartSurfaces filleting tools
 Earlier in this course you worked with the SmartSolids Fillet Edges and Chamfer Edges tools. These tools let you round or chamfer edges on solids along continuous surfaces. Here, we will look at SmartSurface tools that let you join separate surfaces with a fillet or blend. In this chapter, you will be introduced to the following tools:
 • “Fillet Surfaces tool” on page 227
 • “Blend Surfaces tool” on page 231
 • “Extract Surface Rule Line tool” on page 234
 • “Blend Surfaces Between Rail Curves tool” on page 237
 Fillet Surfaces tool box
 Tools for constructing fillets and blends to join two surfaces are found in the Fillet Surfaces tool box.
 Within this tool box are the necessary tools to construct a fillet or a blend between two surfaces, or to blend a surface between rail curves.
 Fillet Surfaces tool
 Similar in function to the Fillet Edges tool, this tool lets you join two surfaces with a fillet. Whereas the Fillet Edges tool is used to round edges on solids, we can use the Fillet Surfaces tool to join two surfaces with a fillet. The two surfaces that we are joining with the fillet do not have to be touching, but they must be within the range of the fillet radius.
 Fillet Surfaces tool box.
 Fillet Surfaces tool settings.
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 Tool settings let you choose which elements are trimmed during construction of the fillet.
 To construct a fillet between two surfaces:
 • Select the Fillet Surfaces tool.
 • Identify the first surface with a data point.
 • Identify the second surface with a data point.
 • Place a data point to view the proposed fillet.
 • Accept with a data point to construct the fillet.
 ➤ Prepare for the exercises
 1 Open the design file surfaces_16.dgn.
 2 From the Surface Modeling tool frame, float the Fillet Surfaces tool box.
 The Fillet Surfaces tool box is located at the bottom left location of the Surface Modeling tool frame.
 In this design file, is a model of a lamp. In the following exercise, we will construct fillets between various parts of the lamp.
 ➤ Create a fillet between surfaces (both truncated)
 1 In the Fillet Surfaces tool box, select the Fillet Surfaces tool with the following settings:
 Truncate: Both
 Radius: 1.5
 2 In window 3, with a data point, select the top of the base at location 1.
 3 Now, select the pole at location 2.
 4 Enter a data point to view the proposed fillet.
 The proposed fillet displays.
 Tool Setting Effect
 Truncate Defines which surface(s) are to be truncated (trimmed back):• Both — both surfaces are trimmed.• Single — the first surface selected is trimmed.• None — neither surface is trimmed.
 Radius Sets the radius of the fillet.
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 5 Place a data point to accept the construction of the fillet.
 With the fillet constructed, the pole, fillet and top surface of the base now are all part of a single SmartSurface. Let’s continue by placing a fillet on the outside edge of the base.
 6 With a data point, select the vertical edge of the base at location 1.
 7 Select the edge of the top surface of the base, again at location 1.
 The pole, fillet and top surface of the base all highlight.
 8 Place a data point to view the proposed fillet.
 9 Accept the construction of the fillet with another data point.
 10 In Window 3, turn off Construction elements (level 63).
 11 Use the Render tool to Smooth render Window 3, to view the results of the fillets.
 Where you want to truncate only one of the surfaces, it is the first surface selected that is trimmed. We will use that feature in the following exercises.
 After creating a fillet betweenthe base and the pole.
 After completing the edgefillet of the base.
 Rendered view of the lampbase with fillets.
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 ➤ Create a fillet and truncate only one of the surfaces
 1 Select the Fillet Surfaces tool with the following settings:
 Truncate: Single
 Radius: 3
 2 In Window 1, with a data point, select the circular section at location 4.
 3 Now, select the pole at location 5.
 4 Place a data point to view the proposed fillet.
 5 Accept with a further data point to complete the construction.
 You may have noticed that the pointer location did not control on which side of the circular section the fillet was placed. In fact, it was placed on the side of the circle from which the surface normals point. For the next fillet, we will change the direction of the surface normals to place the fillet on the lower side of the circular section.
 ➤ Change the direction of the surface normals for the circle section
 1 In the Modify Surfaces tool box, select the Change Normal Direction tool.
 2 With a data point, select the circular section at location 6.
 Surface normals display. They are pointing upward. This would produce a fillet on the upper face of the circle as it did for the circular section below.
 3 Place a data point to reverse the direction of the surface normals.
 4 To check, again select the circular section at location 6.
 The surface normals now point downward.
 5 Reset to leave the surface normals as they are.
 With the surface normals pointing in the correct direction, we can now continue with the construction of the fillet.
 ➤ Construct the fillet on the second circular section
 1 Select the Fillet Surfaces tool with the following settings:
 Truncate: Single
 Radius: 3
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 2 In Window 1, with a data point, select the circular section at location 6.
 3 Select the pole at location 7.
 4 Place a data point to view the proposed fillet.
 This time the fillet is placed on the lower face of the circular section.
 5 Accept with another data point to complete the fillet.
 6 In Window 1, turn off Construction elements (level 63).
 7 Use the Render tool to Smooth render Window 1 to view the results of the fillets.
 Blend Surfaces tool
 This tool can be used to construct a B-spline surface that blends two surfaces with a specified Continuity. Surfaces that can be blended include extruded surfaces, surfaces of revolution, cones, shapes, or B-spline surfaces.
 Setting the Continuity specifies how the blend between the surfaces is formed. The direction of the first and last tangents of the blend is the direction of the tangents of the original elements at their trimmed edges. You can adjust the relative magnitudes of these tangents to achieve the desired blend.
 Rendered view of thefillets applied to the two
 circular sections.
 Blend Surfacestool settings box.
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
 14-231

Page 242
                        

Fillet Surfaces tool box
 With this tool, you can change the settings to view interactively the proposed blend prior to accepting it with a data point.
 To create a blend between two surfaces:
 • Select the Blend Surfaces tool.
 • Select the first surface at the point from which you want the blend to start (the original element will be trimmed back to this point).
 • Accept by selecting the edge on the first surface that you want blended.
 • Select the second surface at the point that you want the blend to finish (the original element will be trimmed back to this point).
 • Accept by selecting the edge on the second surface that you want blended.
 • Make any adjustments to the tool settings.
 • Place a data point to complete the blend.
 ✍ When selecting surfaces, the finished blend assumes the color of the first selected surface.
 To see how the various settings determine the shape of the blend, try the following exercise.
 ➤ Create a blend between two extruded surfaces
 1 Open the design file surfaces_17.dgn.
 2 Select the Blend Surfaces tool with the following settings:
 Continuity: Position
 Factor 1: 0
 Factor 2: 0
 3 In the Isometric view, snap to the green surface at location 1 and accept with a data point.
 This point determines where the blend will start.
 Tool Setting Effect
 Continuity Sets the order of continuity of the blend surface:• Position — has zero control points and produces a straight surface between the
 blend points.• Tangent — has two control rows and columns in the u and v directions. This setting
 is appropriate for most cases.• Curvature — has the u and v values set to 4.
 Factor 1 Sets the magnitude of the initial tangent.
 Factor 2 Sets the magnitude of the final tangent.
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 4 Snap to the surface at location 2 and accept with a data point to define the edge to be blended.
 The selected edge is trimmed back to the first snap point (location 1).
 5 Snap to the red surface at location 3 and accept with a data point.
 This point defines where the blend will end on the second surface.
 6 Again snap to the red surface at location 3 and accept with a data point to define the edge that is to be blended.
 The proposed surface displays.
 7 In the tool settings, use the slide controls to change the values for Factor 1 and Factor 2. Note that it makes no difference to the proposed surface. Because Continuity is set to Position, the blend is restricted to the two selected positions on the surfaces.
 8 Return the Factor 1 and Factor 2 settings to 0.
 9 In the tool settings, change the Continuity setting to Tangent.
 Front and Isometricviews showing the
 proposed blend surface.
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 10 Again, use the slide controls in the tool settings to change the values for Factor 1 and Factor 2. Changing these values changes the shape of the blend.
 11 Change the Continuity setting to Curvature and repeat step 10.
 12 When you are happy with the shape of the blend, place a data point to complete it.
 Before continuing with the Blend Surfaces Between Rail Curves tool, we will look at another tool that can be used in conjunction with it. This tool, Extract Surface Rule Line, can be used to create rail curves on surfaces.
 Extract Surface Rule Line tool
 Using this tool, you can extract B-spline curves from B-spline surfaces and other surfaces. The curves are extracted in the U (row) or V (column) direction of the surface. Settings for this tool let you extract a single curve or multiple curves evenly spaced. When a single curve is specified, you can set the position graphically or use the Iso Value setting to position it on the surface.
 As Factor 1 and Factor2 settings are changed
 the blend changesaccordingly.
 Tool settings for ExtractSurface Rule Lines tool.
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 To extract a single curve from a surface:
 • Select the Extract Surface Rule Lines tool with Extract set to Single Curve.
 • Identify the surface.
 As you move the pointer, an iso-u curve displays dynamically.
 • Enter a data point to define the curve’s position and create the iso-u curve
 OR
 Reset to display an iso-v curve.
 As you move the pointer, an iso-v curve displays dynamically.
 • Enter a data point to define the curve’s position and create the iso-v curve.
 To extract multiple curves from a surface:
 • Select the Extract Surface Rule Lines tool with Extract set to Multiple Curves.
 • Set Numbers U/V to the number of curves required.
 • Identify the surface.
 • Accept the surface.
 The curves are generated.
 ✍ When using this tool, the generated surface rule lines take the active element attribute settings.
 Tool Setting Effect
 Extract Sets the objective of the tool:• Single Curve — Extract a curve that has a constant parametric u-value (iso-u
 curve) or constant parametric v-value (iso-v curve). The u-value or v-value is the specified Iso Value. The u-direction is the direction in which the data points that defined each row were entered. The v-direction is the direction in which the columns were defined.
 • Multiple Curves — Extract a set of curves that are spaced evenly on the surface in both directions.
 Iso Value (Enabled only if Extract is set to Single Curve) If on, sets the iso value of the extracted curve.
 Numbers U/V (Enabled only if Extract is set to Multiple Curves) Sets the number of curves extracted from both parametric u- and v-directions.
 Ignore Trim Region(s)
 (Enabled only if Extract is set to Multiple Curves) If off, the curves are trimmed by the B-spline trim curves, if any.
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 ➤ Extracting single surface rule lines in either the u or v direction
 1 Open the design file surfaces_18.dgn.
 2 In the Create Curves tool box, select the Extract Surface Rule Lines tool with the following settings:
 Extract: Single Curve
 Iso Value: Off
 3 In the Top view, select the surface with a data point.
 A vertical rule line appears on the surface. As you move the screen pointer, the surface rule line moves over the surface. As it moves, it changes shape to match the surface. This is most apparent in the Front view.
 4 Enter a Reset to change the direction of the surface rule line.
 The direction of the rule line changes to horizontal (in the Top view). Again, as you move the screen pointer, the surface rule line moves over the surface, changing shape to match the surface. This is most apparent in the Right view.
 5 Enter a data point to place the surface rule line approximately in the center of the surface.
 If you turn on the Iso Value setting, you can position the extracted surface rule line exactly on the surface. Values can be from 0 through 1, where, for example:
 0 — places the rule line on one edge
 1 — places it at the opposite edge
 0.25 and 0.5 — places it quarter way and midway between the edges, respectively.
 If you set Extract to Multiple Curves, you can place a network of surface rule lines on the surface.
 ➤ Extract Multiple Curves from a surface
 1 Make level 2 the active level.
 2 Turn off level 1 in all views.
 Isometric view of surface withextracted surface rule line.
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 3 Update all views.
 4 Select the Extract Surface Rule Lines tool with the following settings:
 Extract: Multiple Curves
 Numbers: 10 (for both U and V fields)
 5 In any view, identify the surface with a data point.
 6 Accept with another data point, to complete the construction.
 Blend Surfaces Between Rail Curves tool
 This tool is used to construct a blending B-spline surface between two surfaces along their rail curves. Surfaces that may be blended in this way include extruded surfaces, surfaces of revolution, cones, or B-spline surfaces. A rail curve is an element lying on the surface. Rail curves can be elements such as lines, arcs, line strings, ellipses, complex shapes, complex chains, or B-spline curves. Tool settings let you choose between a Chamfer or Round blend.
 To create a blend between rail curves:
 • Select the Blend Surface Between Rail Curves tool.
 • Identify the first surface.
 • Identify the first rail curve.
 • Identify the second surface.
 • Identify the second rail curve.
 • Accept with a data point to view the proposed blend.
 • Accept with a data point to complete the construction.
 Rail curves are elements that lie on the surface. Typically, you could use any of the following tools to create a rail curve on a surface:
 • Extract Face or Edge Geometry — in the 3D Utility tool box.
 • Project Trim — in the Modify Surfaces tool box.
 • Extract Surface Rule Lines — in the Create Curves tool box.
 Surface after extractingmultiple surface rule lines.
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 Where a surface is “flat” you could simply draw the rail curves on the surface. Let’s work through an example now. In this example, the Project Trim tool was used to produce the green dashed rail curve on the green surface, while the Extract Surface Rule Lines tool created the yellow dashed rail curve on the hexagonal solid. As with all tools, read the prompts as you proceed through the exercise.
 ➤ Create a chamfer blend between rail curves
 1 Open the design file surfaces_19.dgn.
 2 Check that level 5 is the active level.
 3 Select the Blend Surfaces Between Rail Curves tool with the following setting:
 Blend Type: Chamfer
 4 With a data point, select the green B-spline surface at location 1.
 5 Select the green dashed rail curve at location 2.
 6 Select the yellow hexagonal solid at location 3.
 7 Select the yellow dashed rail curve at location 4.
 8 Place a data point to view the blend.
 9 Accept the blend with another data point.
 The blend is constructed. In the Front view, you can see that it has a straight (chamfer) slope.
 ➤ Create a round blend between rail curves
 1 Make level 6 the active level.
 2 Turn off level 5 in views 2 and 4.
 3 Update views 2 and 4.
 4 Select the Blend Surfaces Between Rail Curves tool with the following setting:
 Blend Type: Round
 5 With a data point, select the magenta B-spline surface at location 5.
 Front view shows clearly that thesurface has a straight slope.
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 6 Select the magenta dashed rail curve at location 6.
 7 Select the red hexagonal solid at location 7.
 8 Select the red dashed rail curve at location 8.
 9 Place a data point to view the blend.
 10 Accept the blend with another data point.
 The blend is constructed. In the Front view (Window 4), you can see that it has a curved (round) slope.
 Before we continue: When you fillet between two surfaces, do they have to be abutting along an edge?
 Front view showsthe blend has a
 curved slope.
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15 3D Queries tool box
 Tools in the 3D Queries tool box are used to evaluate the attributes of surfaces or to visualize the curvature of surfaces. In this chapter, we will look at:
 • “Evaluate Surface tool” on page 241
 • “Analyze Curvature” on page 244
 Evaluate Surface tool
 With this tool you can graphically and numerically evaluate certain attributes of a B-spline surface, other than order, poles, and knots, at given locations on the surface. Tool settings give us a choice of four ways to define locations on a surface and two output options.
 Curve attributes that can be computed are points, tangents and normal directions. Computed attributes can be used as reference points or reference lines for other purposes.
 This tool also can be used to evaluate primitive surfaces and solids.
 Evaluate Surface dialog box.
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 Tool Setting Effect
 Attribute(s) Output By Sets the method used to output the computed attributes:• Display Only• Save In File — the attributes are saved in the active design file with the same
 graphic group number for easy manipulation.
 Location(s) Input By Sets the manner in which the locations on the surface are defined:• Enter Data Point — interactively define a single location on the surface.• Parameter — using the Parameter Value U and V settings. The values, which
 must be in the range 0–1, specify the location from the domain to map to the displayed object. Within MicroStation, the domain is from 0.0 to 1.0.
 • Dist[ance] Along Curve — using the Dist From Start(%) U and V settings. The values are each a percentage of the total length of the u or v curve on the surface. For example, to extract the tangent direction of a surface at its middle point, set Dist. From Start(%) U and V each to 50.
 • Point Array option — using the Number of Points U and V settings. The values are the number of evenly spaced locations on the u and v curves, respectively. For example, to evaluate at 200 evenly spaced locations on the surface, set Number of Points U to 10 and Number of Points V to 20.
 Tangent Plot Scale Sets the scale factor applied to the magnitude display. If set to 1.0, the computed tangents will be the true derivative vector; that is, the tangent direction with the magnitude.
 Normal Plot Scale Sets the scale factor applied to the perpendicular line segments in Normal output. If set to 1.0, the true normal vector display; that is, the direction plus its true magnitude.
 Parameter Value U/V Sets the parameter values applicable to the Parameter option for defining locations on the surface; see Location(s) Input By above.
 Dist[ance] From Start(%) U/V
 Sets the distance values applicable to the Dist. Along Curve option for defining locations on the surface; see Location(s) Input By above.
 Number of Points U/V Sets the numeric values applicable to the Point Array option for defining locations on the surface; see Location(s) Input By above.
 [Compute] Points
 If on, the points on the surface at which evaluation is performed are displayed in the output.
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 We can see how this tool works in practice with the following exercise.
 ➤ Evaluate a B-spline surface
 1 Open the design file eval_bspline.dgn.
 2 From the Surface Modeling tool frame, float the 3D Queries tool box.
 The 3D Queries tool box is located at the bottom right location of the Surface Modeling tool frame.
 3 In the 3D Queries tool box, select the Evaluate Surface tool with the following settings:
 Attribute(s) Output By: Display Only
 Location(s) Input By: Point Array
 Tangent Plot Scale: 0.25
 Normal Plot Scale: 20.0
 Number of Points: 5 (for both U and V)
 Points: On
 4 With a data point, identify the green B-spline surface.
 The element highlights and the U and V directions display.
 [Compute] Tangents
 If on, the surface’s tangents are computed. In the context of this tool’s operation, a tangent is computed as the partial derivatives of the surface in both parametric u and v directions.
 [Compute] Normal
 If on, the surface’s normal directions are computed.
 Tool Setting Effect
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 5 Accept with a data point.
 Five points display in each of the U and V directions of the element. Because the B-spline surface displays with five rule lines in each of the U and V directions, the points coincide with the intersections of these lines.
 6 Repeat steps 4 and 5 for the remaining elements.
 7 Update the view to remove the display of the points.
 8 In the tool settings, turn on Tangents.
 9 Repeat the exercise to display tangents at each of the points.
 10 Turn off Tangents and turn on Normal.
 11 Repeat the exercise to display Normals at each of the points.
 Analyze Curvature
 With this tool you can visualize the curvature of a curve or Gaussian curvature of a surface. When you select a curve for analysis, it displays in varying colors according to its curvature. These range from red for flat regions through to purple for sharply curved regions. Regions of intermediate curvature display in a range of colors in between these extremes of red and purple. Similarly, when you select a surface, the element is rendered with coloring according to its curvature, with purple for the acutely curved regions through to red for the flatter regions.
 You can try this with the same design file as for the previous tool.
 ➤ Analyze a curve and surfaces
 1 If necessary, open the design file eval_bspline.dgn.
 2 Make level 2 the active level to display a B-spline curve along with the other elements.
 3 In the 3D Queries tool box, select the Analyze Curvature tool.
 4 With a data point, identify the cyan colored B-spline curve and accept with a data point.
 The B-spline curve displays in various colors representing the differing degrees of curvature.
 5 With further data points, identify the remaining 3D surfaces and solids, accepting each with a data point.
 Each of the elements is rendered with colors representing the differing degrees of curvature in their surfaces.
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16 Creating and using 3D Cells
 As experienced MicroStation users, no doubt you are familiar with the concept of cells. These are items that you use regularly in your designs. Rather than redraw them each time, you can save them in a Cell Library for you or other users to recall for future designs. Similarly, when working in 3D, you can create models of regularly used items and save them in a Cell Library. The difference is that the 3D cells must be stored in a 3D cell library. In this chapter you will be introduced to the following topics:
 • “Creating a 3D cell library” on page 247
 • “Creating a 3D cell” on page 247
 • “Placing cells in 3D” on page 251
 Overview
 In order to create a 3D cell, you must first have a 3D cell library attached to your design file. 3D cell libraries can be attached to 3D design files only. A 2D cell library, however, can be attached to either 2D or 3D design files. Creating a 3D cell library is no different to creating the 2D equivalent, except that you must select the 3D cell library seed file, seed3d.cel.
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Overview
 When you have created a 3D cell library, the Cell Library dialog box looks similar to that for 2D except that you see four views of the selected cell, compared to the single view in 2D.
 When we create 2D cells, we place a fence around that part of our design file that contains the elements forming the cell. Only those elements displayed within the fence are included in the cell. An additional consideration in 3D is the display depth. When creating a 3D cell, only those elements that are displayed within the fence and located within the display depth of the view are included. That is, the volume described by the area of the fence and the depth between the front and back clipping planes.
 3D Cell Library dialog boxdisplays four views of
 selected cell.
 Back Clipping Plane
 Front Clipping Plane
 Fence
 Shaded portion shows the volume that is
 included in the cell definition.
 Defining a 3D cell.
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 Creating a 3D cell library
 Creating a 3D cell library is no more difficult than creating a 2D version. The only difference is that you have to choose the 3D cell library seed file, seed3d.cel. By default, MicroStation saves newly created cell libraries in the “Workspace\standards\cell\” directory.
 ➤ Creating a 3D cell library
 1 Open the design file cells_01.dgn.
 2 In the main menu, select Element > Cells.
 The Cell Library dialog box opens.
 3 In the Cell Library dialog box, select File > New.
 The Create Cell Library dialog box opens.
 4 Click the Select button to specify a seed file.
 The Select Seed File dialog box opens.
 5 From the list of files, select seed3d.cel.
 6 Click OK.
 The Select Seed File dialog box closes.
 7 In the Files field, key in my3dcells.cel and select the directory used for the example design files used in this class.
 The new 3D cell library is created and attached to the current design file.
 8 Close the Cell Library dialog box.
 Creating a 3D cell
 As with creating the cell library, the 3D cell creation process also can be as easy as creating a 2D cell. One consideration that you have in 3D is which view to use for creating the cell. That is, whether to create the cell in a Top view, Front view or some other orientation. Thought should be given to how the cell normally would be placed in a design. In most cases, a Top view is the most convenient, but there may be occasions where a cell normally would be placed in a front or side view, so it may be better to create it in a similar view. No matter which view you use, AccuDraw can help you place the cell correctly. As well, the cell can be manipulated in the design after it is placed.
 Before you can create a cell, you must construct the model. Let’s get started on two simple models, a bolt and a nut, that we will construct and then save as cells in our library.
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 ➤ Create the bolt to be saved as a cell
 1 Continue in the design file cells_01.dgn.
 2 Select the Place Cylinder tool with the following settings:
 Type: Solid
 Axis: Drawing Z
 Orthogonal: On
 Radius: On and set to 6
 Height: On and set to 40
 3 In the Isometric view, snap to the center of the left hexagon at location 1 and accept with a data point.
 4 Move the pointer downward to define the direction and place a second data point to complete the cylinder.
 5 Select the Extrude tool with the following settings:
 Type: Solid
 Orthogonal: On
 Distance: On and set to 6
 6 In the Isometric view, identify the left hexagon with a data point at location 2.
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 7 Move the pointer upward and enter a data point to complete the extrusion.
 ➤ Create the nut to be saved as a cell
 1 With the Extrude tool still active and with the same settings, identify the right hexagon with a data point at location 3.
 2 Move the pointer upward and enter a data point to complete the extrusion.
 3 Select the Cut Solid tool with the following settings:
 Cut Direction: Both
 Cut Mode: Through
 4 With a data point, identify the extruded “nut” at location 3.
 5 With a data point, identify the green circle at location 4.
 The completed bolt.
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 6 Accept with a data point to create the cut.
 With the two parts completed, we are now ready to make cells of them and store them in our cell library. We will use the Top view to create the cell.
 ➤ Create a cell of the bolt
 1 Use the Fit View view control with Expand Clipping Planes turned on to fit the Top view.
 This ensures that the display depth of the Top view includes all the elements of the cell. If an element is not included or if it is only partially included in the display depth of the view, it will not be included in the cell that we are creating.
 2 In the main menu bar, select Element > Cells to open the Cell Library dialog box.
 3 In the Top view, use the Place Fence tool to place a fence around the bolt at the left of the view.
 4 Select the Define Cell Origin tool.
 5 In the Isometric view, snap to the center of the top of the cylinder at location 1 and accept with a data point.
 Any view can be used to define the cell origin. Placing the origin at the top of the bolt’s shaft makes it easier to place the cell later, with the head of the bolt flush against other surfaces.
 6 In the Cell Library dialog box, click the Create button to open the Create Cell dialog box.
 The nut and boltparts ready to bemade into cells.
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 7 In the Name and Description fields, key in BOLT1 and 12 MM BOLT respectively.
 8 Click the Create button.
 The cell is created and added to the Cell Library.
 Similarly, we can create a cell of the nut.
 ➤ Create a cell of the nut
 1 In the Top view, use the Place Fence tool to place a fence around the nut at the right of the view.
 2 Select the Define Cell Origin tool.
 3 In the Isometric view, snap to the center of the top of the hole in the nut and accept with a data point.
 4 In the Cell Library dialog box, click the Create button to open the Create Cell dialog box.
 5 In the Name and Description fields, key in NUT1 and 12 MM NUT respectively.
 6 Click the Create button.
 The cell is created and added to the Cell Library.
 Placing cells in 3D
 Correct placement of cells in a 3D design requires two parameters, location and orientation. We can use AccuDraw to help us correctly place and orientate our cells, as the following exercise will show.
 ➤ Prepare for the exercise
 1 Open the design file cells_02.dgn.
 2 In the main menu, select Element > Cells.
 The Cell Library dialog box opens.
 3 In the Cell Library dialog box, select File > Attach.
 4 Select the cell library that you created in the previous section and click OK.
 This design file contains a flange. We will place a bolt and nut, our two cells, through the hole indicated by the yellow center lines. We will work in the Isometric view, using AccuDraw to correctly align the cells.
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 ➤ Placing a cell in 3D
 1 If necessary, start AccuDraw.
 2 In the Cell Library dialog box, select cell BOLT1 and click Placement.
 Note that the preview window shows four views of the 3D cell.
 3 Select the Place Active Cell tool with the following settings:
 Active Cell: BOLT1
 Active Angle: 0°
 X, Y, and Z Scale: All set to 1
 4 In the Isometric view, snap to the center of the hole on the front face of the flange, at the intersection of the two yellow center lines, but do not place a data point.
 5 Use the AccuDraw shortcut <F> to rotate the drawing plane to Front.
 6 Place a data point to place the bolt.
 7 Reset to finish.
 ➤ Place the nut cell
 1 In the cell library dialog box, select cell NUT1 and click Placement.
 2 Select the Place Active Cell tool.
 Isometric viewshowing the bolt in
 the flange.
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 3 In the Isometric view, snap to the center of the hole at the opposite end to that used to place the bolt and accept with a data point.
 Before we continue: Apart from the fence, what is another important consideration to ensure that all elements are included when creating a 3D cell?
 When creating a cell in a Top view, should any particular view be used to define the cell origin?
 Which seed file should you use for creating a 3D cell library (Hint: seed??.cel)?
 The bolt and nut cellsplaced in the flange.
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17 Creating drawings from 3D models
 While working in 3D is an efficient way of designing, we still need to produce 2D drawings of our designs. In the manual drafting days of old, we would have the 3D design pictured in our mind as we developed plans, elevations and sections. Here, working with a 3D model, we can let MicroStation produce these views and sections. As all views and sections are produced from the one 3D model, we know that they are correct. This chapter covers two methods that we can use to produce the various elements of our drawings:
 • “Drawing Composition” on page 255
 • “Generate Section utility” on page 268
 Drawing Composition
 As its name suggests, the Drawing Composition tools let you compose a drawing from your 3D model. This is done using reference files displaying different views of the model within a title border. That is, instead of redrawing the geometry of the model for each view, you attach views of the model as reference files. While you could do this with the reference file attachment and manipulation tools, the Drawing Composition dialog box simplifies the procedure in a number of ways:
 • When attaching a view, you can choose from any of the standard views (such as Top, Front, Right, and so on) or any saved view.
 • You can attach views at any scale.
 • Related attached views can be grouped, letting you manipulate them together.
 • You can attach a view by folding an existing attached view about an orthogonal axis, or a line defined by two data points. Folded views automatically are aligned and grouped with the originating view.
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
 17-255

Page 266
                        

Drawing Composition
 • Nested reference files can be included when attaching a view.
 Drawing Composition settings
 You can create a drawing in a sheet view in the same design as the model or you can create a separate “drawing” file. Where a model consists of a number of files referenced together, reference file nesting lets you include these files. An advantage with using a Sheet View created in the same file as the model is that you can use associative dimensioning. If you later change part of the model, the associative dimensioning updates accordingly.
 Before we proceed with some exercises, let’s look at the various options that are available in the Drawing Composition dialog box (File > Drawing Composition). This is divided into three sections — Sheet Parameters, View Parameters and Attachment Parameters. File, Tools and Settings menus provide the remaining options and tools for creating a drawing.
 Sheet Parameters
 These options let you define the location of the drawing sheet, and the levels used for dimensioning the drawing and adding text.
 Sheet Parameter What it does
 Sheet Location Lets you define where the drawing sheet is located:• Sheet File — in a separate design file.• Sheet View — in a view of the current design file.
 Sheet Dimension Level Sets the level to be used for dimensioning (default 63).
 Sheet Annotation Level Sets the level to be used for placing text, in the sheet view only (default 62).
 Drawing Compositiondialog box.
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 View Parameters
 Settings in the View Parameters group let you define how the view of the model is placed in the drawing.
 Attachment Parameters
 As you attach views to the drawing, you can give each a Logical Name and Description. This is recommended, particularly if you have multiple attachments of the same view. For example, you may have multiple attachments looking at the model from the Top view orientation, but with different levels displayed.
 Giving them different logical names with descriptions simplifies matters when you look through the reference file list. For example, you may have the following:
 First attachment — Logical Name: Top 1; Description: 1st floor (levels 1-10)
 Second attachment — Logical Name: Top 2; Description: 2nd floor (levels 11-20)
 Using views with Hidden Line Removal on/off
 Normally, our drawings are composed of various views of our model, displayed with hidden lines removed. We can attach the views with hidden line removal turned on. If we want to dimension a view with associative dimensions, however, we should not turn on Hidden Line Removal until after dimensioning is completed. To understand why, we need to know what processes are involved with the Hidden Line Removal feature.
 When MicroStation attaches a view with Hidden Line Removal turned on, it creates a separate file of the view (with hidden lines removed) and attaches this. All this is
 View Parameters What they do
 Scale (Sheet:Model) Sets the ratio of scales between the sheet and the view of the model.
 Margin (%) Sets the distance of the clipping boundary around the elements of the view (as a percentage of the area of the view). The margin is required to allow room to place dimensioning, when using a Sheet View.
 Attach Nested Reference Files If on, nested reference files automatically are attached with the view. Often models are created in a number of files referenced together. When this setting is turned on, any reference files are included with the view — you need only attach a single view.
 Hidden Line Removal If on, the view is attached with hidden lines removed. When Hidden Line Removal is turned on, further settings let you define the method and whether or not hidden lines are included in the view.Additionally, you can set other parameters for Hidden Line Removal (in the Drawing Composition dialog box, select Settings > Hidden Line Settings).
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Drawing Composition
 done automatically. These hidden line removal files have the same name as the design file, but with an incremental suffix “.h01, .h02” and so on.
 Because associative dimensioning applies only to elements contained within the design file, we must dimension the wireframe view first and then turn on Hidden Line Removal. Drawing Composition lets you change a view from wireframe to Hidden Line Removal, so you can toggle between the two modes as required. In the following exercise, you will see how this works.
 Creating a drawing from a 3D model
 In the following exercise, we will work with a sheet view to create a drawing of a simple bracket. We will produce a half-scale drawing in an A4 size drawing sheet. We will use associative dimensioning on our drawing so that when a change is made to the model, the dimensioning updates automatically. Let’s get started.
 ➤ Prepare for the exercise
 1 Open the design file drawcomp_01.dgn.
 2 From the File menu, choose Drawing Composition.
 The Drawing Composition dialog box opens.
 3 In the Drawing Composition dialog box, set the following:
 Sheet Location: Sheet View
 Sheet Dimension Level: 63
 Sheet Annotation Level: 62
 Scale (Sheet: Model): 1.000: 1.000
 Margin (%): 25.000
 Attach Nested Reference Files: Off
 Hidden Line Removal: Off
 4 In the Drawing Composition dialog box, select Tools > Open Sheet View > 8.
 Window 8 opens. Its title is “Sheet View.”
 At the same time, an Alert box opens, asking us if we want to:
 Turn the sheet annotation and dimension levels (62 and 63) off in non-sheet views?
 5 In the Alert box, click Yes.
 6 Maximize Window 8.
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 With our sheet view set up, we are ready to attach a border file followed by the views of the model that will form the elements of the finished drawing.
 ➤ Attach a drawing border
 1 In the Drawing Composition dialog box, select Tools > Attach Border > Fitted.
 The Attach Border File dialog box opens.
 2 Navigate to the directory containing the design files for this course and select the file A4title.dgn.
 3 Click OK.
 4 Place a data point in the center of the Sheet View.
 5 Use the Fit View view control to fit the view.
 We are ready now to compose our drawing. We do this by attaching views of the model. We can attach the views with or without Hidden Line Removal applied. For the orthogonal views, which we will be dimensioning, we will leave Hidden Line Removal turned off until dimensioning is completed.
 ➤ Attach a Top view of the model
 1 In the Drawing Composition dialog box, set the following:
 Scale (Sheet: Model): 1.000: 2.000
 2 From the dialog box’s Tools menu, select Attach Standard > Top.
 Two rectangles appear attached the pointer. The inner rectangle with diagonals represents the limits of the top view of the model, while the outer
 Sheet View afterattaching the
 border file.
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
 17-259

Page 270
                        

Drawing Composition
 rectangle shows the limits of the 25% margin. This margin allows for the placement of dimensioning.
 3 Move the pointer so that the top left corner of the outer rectangle matches the top left corner of the drawing border (the solid line) and place a data point.
 The top view of the model displays.
 We can use a similar method to place Front and Side views of our model, locating them interactively. Another method, however, is quicker and assures that the views are aligned. With this method, we attach views “folded” orthogonally from the original top view.
 ➤ Attach folded views
 1 From Drawing Composition’s Tools menu, select Attach Folded > Orthogonal.
 2 Place a data point on an element of the top view of the model.
 The view highlights with the margin also displayed.
 3 Click the bottom (horizontal) margin line.
 A rectangle displays attached to the pointer. It can move up or down only, not sideways. Because we placed a data point below the model (that is, to
 Attaching thetop view ofthe model.
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 the front of the model), MicroStation has determined that we wanted a view folded orthogonally about the front edge of the model.
 4 Move the rectangle downward, clear of the top view and place a data point. Don’t be too concerned about the location as Drawing Composition has tools that let you move the view later, if necessary.
 A front view of the model appears. Focus is returned to the top view of the model, with the dashed margin reappearing. This lets us choose another orthogonally “folded” view.
 5 Click the right hand side (vertical) margin line.
 A rectangle displays attached to the pointer. This time it can move left or right only. Because of the location of our data point, MicroStation has determined that we wanted a view folded orthogonally about the right edge of the model.
 6 Move the rectangle to the right to about the center of the view and place a data point.
 A right side view of the model appears.
 Attaching thefront view, foldedfrom the top view.
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 7 Reset to complete.
 To complete the placement of views, we will add an Isometric view. Because we will not be dimensioning it, we can turn on Hidden Line Removal for this view.
 ➤ Attach a view with Hidden Line Removal on
 1 In the Drawing Composition dialog box, turn on Hidden Line Removal.
 2 From the Hidden Line Removal option menu, choose SmartSolids.
 This setting is the most efficient for models that consist of SmartSolids such as this model.
 3 From the Tools menu, choose Attach Standard > Isometric.
 As before, two rectangles appear attached to the pointer. These denote the model and the margin.
 4 Position the rectangles in the top right corner of the border and place a data point.
 MicroStation creates the view of the model with the hidden lines removed.
 Sheet View afterplacing the threeorthogonal views
 of the model.
 Isometric viewwith hidden
 lines removed.
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 Drawing Composition has tools that let you rearrange the attached views either in groups or individually. To let you see how these work, we will rearrange our drawing now.
 ➤ Move a single view
 1 In the Drawing Composition dialog box’s Tools menu, select Move > Single.
 2 With a data point, select the Isometric view of the model.
 A dashed rectangle appears around the view, denoting the margin around the view.
 3 Move the pointer downward until the bottom edge of the dashed rectangle aligns with the top line of the title block area and place a data point.
 ➤ Move a group of views
 1 In the Drawing Composition dialog box’s Tools menu, select Move > Group.
 2 With a data point, select any of the Top, Front or Right views of the model.
 Dashed rectangles appear around all three views. These views are grouped because the Front and Right views were developed from the Top view.
 3 Move the pointer a little to the right and place a data point.
 All three views are moved to the right.
 Although the three original views in our drawing are grouped together, you can move them individually by selecting Move > Single. Other options let you group views together or remove a view from a group (Tools > Group > Add and Tools > Group > Remove respectively).
 Let’s now add some dimensions to our drawing.
 Drawing sheet afterrearranging the views
 of the model.
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 ➤ Dimension the drawing
 1 Select the Dimension Element tool with the following settings:
 Alignment: View
 Association Lock: On
 2 Add dimensioning to the three orthogonal views of the model, as shown below.
 Now that we have added the dimensioning, we can change the display of the orthogonal views to that with Hidden Line Removal turned on. First, we will adjust the Hidden Line Settings to suit.
 ➤ Set the parameters for Hidden Line Removal
 1 From the Drawing Composition dialog box’s Settings menu, choose Hidden Line Settings.
 The Hidden Line Settings dialog box opens. Here, you can define how both the visible lines and the hidden lines appear in the view.
 2 In the Hidden Edge Overrides group box, turn on and set the following:
 Style: 2
 Weight: 0
 3 Leave all other settings turned off.
 4 Close the Hidden Line Settings dialog box.
 Sheet view withdimensioning
 added to theorthogonal views.
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 ➤ Turn on Hidden Line Removal for the orthogonal views
 1 From the Drawing Composition dialog box’s Tools menu, choose Modify Hidden Line > Group.
 2 With a data point, identify an element in any of the three orthogonal views.
 Dashed line rectangles appear around each of the orthogonal views.
 3 Accept with a second data point.
 The Attachment Hidden Line Settings dialog box opens.
 4 Set the following:
 Hidden Line Removal: On
 Hidden Line Method: SmartSolids
 Include Hidden Lines: On
 5 Click OK.
 Each orthogonal view updates to display the model with hidden lines displayed as dashed lines.
 If more dimensioning is required, we would reverse the process and convert the views back to wireframe display before adding new dimensions. This ensures that the dimensioning is relative to the design model rather than the hidden line file of the view.
 Orthogonal viewsdisplayed with
 hidden linesshown dashed.
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 Modifying a model/drawing
 Because we used associative dimensioning for our drawing sheet view, the dimensions adjust as we make any changes to our model. There is, however, one point to remember. We have set up our drawing with hidden line removal turned on, which relies on separate hidden line files. After making any changes to our model, we have to regenerate these hidden line files. This is done automatically with the Synchronize option, as you will see in the following exercise.
 ➤ Prepare for the exercise
 1 Open the design file drawcomp_02.dgn.
 This is a finished copy of the file used in the previous exercises.
 2 Open the 3D Modify tool box (Tools > 3D Main > 3D Modify).
 This design file has been saved with two Windows (views) open. Window 2 is an Isometric View of the actual model. Window 8 is a Sheet View showing the drawing sheet created with the Drawing Composition tool. All views of the model in the Sheet View have Hidden Line Removal turned on.
 In the right view of the drawing sheet, the vertical leg of the bracket is 10mm thick while the horizontal leg is 15mm thick (dimension at top left of view). In the following exercise we will change the horizontal leg from 15mm to 10mm to match the other. We will use Window 2, the Isometric View to modify the design.
 ➤ Modify the model
 1 In the 3D Modify tool box, select the Modify Solid tool.
 2 In the tool settings turn on Distance and in its field, key in 5.
 3 In Window 2, select the bracket model with a data point.
 4 Move the pointer over the bracket until the front face of the vertical leg highlights, then place a data point.
 5 Move the pointer to the left to define the direction of the modification toward the back of the bracket and place a data point.
 The front faceof the vertical
 leg highlighted.
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 The model is modified.
 If you inspect the Sheet View, you will see that the dimension of the horizontal leg of the bracket in the Right View has changed from 15 to 10. The drawing, however, has remained as it was. There has been no change to the thickness of the leg in any view in which it is visible (the Plan, Right View and Isometric View elevations).
 While we have changed the actual model, the hidden line views in the Sheet View have not been synchronized. We will do that now.
 Defining thedirection of the
 modification.
 The dimension haschanged from 15 to10 but the diagramremains as it was.
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 ➤ Synchronize the Hidden Line views
 1 From the Drawing Composition dialog box’s Tools menu, select Modify Hidden Line > Synchronize.
 All hidden line views are synchronized with the model.
 Generate Section utility
 Often, drawings require sections of the design to illustrate a particular feature or to clarify part of the design. MicroStation’s Generate Section tool lets us create 2D sections from the 3D model, which we then can hatch, dimension and/or annotate. While it is important that we can create and dimension sections, this utility has other uses as well. Using sections, for example, we can check for interferences. Tool settings let us control how the section is generated, as well as how and where it is placed. The Section Generation dialog box has two menus — File and Tools. Also, it is divided into two groups — Options and Symbology.
 Using the Symbology settings, you can override the current element symbology settings to define how the section geometry appears. Settings in the Options group let you determine how the section geometry is generated and placed, as follows:
 Option What it does
 Output File Indicates where the 2D section will be placed.
 Tolerance Overrides System Tolerance.
 Flatten Section If on, section geometry is flattened to 2D along an axis perpendicular to the section.
 The finisheddrawing after
 synchronizingthe hiddenline views.
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 Options in the File menu let you decide where the section geometry is placed:
 Menu selections in the Tools menu let you decide how the section is generated:
 Using the Section Generation tool, we can create sections through our 3D models, just as we used to draw sectional views in the days of manual drafting.
 ✍ If a change is made to the 3D model, you will have to delete the existing sections and regenerate your sectional views to reflect these changes.
 Section by View
 When you choose to create a section by view, you have three options.
 • Horizontal — creates a section for all elements that intersect a horizontal plane, perpendicular to the screen.
 • Vertical — creates a section for all elements that intersect a vertical plane, perpendicular to the screen.
 • Depth — creates a section for all elements that intersect a plane, parallel to the screen, at the Active Depth of the view.
 Interactive Positioning If on, the orientation of the section geometry is set by the view being used and its size and position is set by the active scale, active angle and a data point.If off, the section geometry is generated in-situ.
 Assemble Segments If on, section geometry segments for all adjacent surfaces are assembled into complex chains or a shape.
 Option What it does
 New Output File Lets you create a new design file for placing section geometry.
 Open Output File Lets you define an existing design file into which the section geometry is placed.
 Tools menu item Used to create a section at the intersection of the 3D model with:
 Section by Element An existing element.
 Section by Fence A fence placed in the design.
 Section by Plane A plane defined by three data points.
 Section by Projection The projection of an existing element or a line string defined by data points.
 Section by View A horizontal or vertical plane perpendicular to a view or at a depth parallel to a view.
 Option What it does
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
 17-269

Page 280
                        

Generate Section utility
 In the following exercises, we will create sections through a 3D model of a hose fitting.
 ➤ Prepare for the exercise
 1 Open the design file x_sects_01.dgn.
 2 From the Utilities menu, choose Generate Section.
 The Section Generation dialog box opens.
 3 In the Options group, turn on Interactive Positioning and Assemble Segments.
 4 In the Symbology group, turn on Level and set it to 10.
 5 Leave all other settings turned off.
 First, we will use the Section by View tool to create sections through the center of the model.
 ➤ Create a Section by View - Vertical
 1 In the Section Generation dialog box, select Tools > Section by View > Vertical.
 2 In the Top View, snap to the center of the model and accept with a data point.
 MicroStation generates the section geometry along a vertical plane, perpendicular to the view, that passes through the data point. When it is completed, the section is attached to the screen pointer.
 3 Move the pointer to the right and place a data point to position the section next to model.
 Similarly, we can generate a section perpendicular to this first section, using the Section by View > Horizontal option.
 Top View of model,along with section
 generated using theSection by View
 Vertical tool.
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 ➤ Create a Section by View - Horizontal
 1 In the Section Generation dialog box, select Tools > Section by View > Horizontal.
 2 In the Top View, snap to the center of the model and accept with a data point.
 MicroStation generates the section geometry. When it is completed, the section is attached to the screen pointer.
 3 Move the pointer upwards and place a data point to position the section above the model.
 When you create a section in this manner, you can control its size and rotation with the Active Scale and Active Angle settings. For example, we could create a half-size vertical section with the same orientation as our horizontal section; that is, rotated 90°. We can set the Active Angle and Active Scale prior to generating the section or we can do it interactively, as follows.
 ➤ Create a half-size vertical section rotated 90°
 1 In the Section Generation dialog box, select Tools > Section by View > Vertical.
 2 In the Top View, snap to the center of the model and accept with a data point.
 Top View showingmodel and both
 sections generated bythe Section
 Generation tool.
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 MicroStation generates the section geometry along a vertical plane, perpendicular to the view, that passes through the data point. When it is completed, the section is attached to the screen pointer.
 3 Move the pointer to the right of the horizontal section above the model but do not place a data point. The section is the same size and orientation as the existing vertical section.
 4 In the main menu bar, select Settings > Design File.
 The Design File Settings dialog box opens.
 5 In the Category list, select Active Angle.
 6 In the Active Angle field of the Modify Active Angle Parameters section, key in 90 (do not press <Enter>).
 7 In the Category list, select Active Scale.
 8 In the Modify Active Scale Parameters section, click the Halve button.
 9 Click OK.
 The dialog box closes. The section now is half the scale and rotated 90°.
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 10 With the section in position, place a data point to complete.
 Section by Fence
 When you create a section using a fence to define the required area, all elements within the display depth of the view are included. Using the Section by Fence option, for example, you can create a sectioned elevation where the elements behind the section plane also are included. Let’s do it!
 ➤ Prepare for the exercise
 1 Open the design file x_sects_02.dgn.
 2 If necessary, open the Section Generation dialog box (Utilities > Generate Section).
 3 In the Section Generation dialog box, set the following:
 Interactive Positioning and Assemble Segments: On
 Level: On and set to 10
 Leave all other settings turned off.
 This is a copy of the design file used in the previous exercise. It has a block set up to help you place the fence.
 After placing the 1/2scale rotated
 vertical section.
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 ➤ Create a section using a fence
 1 Select the Place Fence tool.
 2 In the Top view, place a fence over the yellow block.
 3 Turn off level 63 in the Top view (to hide the yellow block).
 4 In the Section Generation dialog box, select Tools > Section by Fence.
 You are prompted to “Enter point to accept section from fence.”
 5 Place a data point in the left half of the Top view to accept the contents of the fence.
 Wait till the section is calculated and the prompt changes to “Enter point to accept and position section.”
 6 In the Top view, position the section to the right of the model.
 7 Fit the Front view to display both the model and the section.
 8 Use the Render tool with Render Mode set to Hidden Line to render the Front view.
 9 Make level 10 the active level and turn off level 2 in all views.
 Only the section view remains displayed because we specified Level 10 as the location for the generated section.
 Section by Element
 We can use this method to create a section based on the limits of an existing element in the design file. We will try this on a model of a house. In the example file, a block already has been placed for the exercise.
 Hidden Line renderingshows the original
 model (left) and thesection view (right).
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 ➤ Create a section by element
 1 Open the design file xsects_03.dgn.
 2 Open the Section Generation dialog box (Utilities > Generate Section).
 3 In the Section Generation dialog box, set the following:
 Flatten Section and Interactive Positioning: Off
 Assemble Segments: On
 Level: On and in its field, key in 50
 This design file is set up for this exercise with Window 4 displaying level 50 only so that we will be able to see the section when it is created.
 4 In the dialog box, select Tools > Section by Element.
 5 In the Front view, identify the cyan block with a data point.
 6 Accept the highlighted block with a second data point and wait while the section is calculated.
 7 When you are prompted to “Enter point to accept/RESET to reject,” place a data point (in any view).
 The section is generated and placed on level 50. Window 4 displays the section.
 Because we turned on Assemble Segments we can manipulate the generated section as a single element with Graphic Group lock active (the section was created as a graphic group).
 ➤ Delete the section
 1 Check that Graphic Group lock is active.
 2 Select the Delete Element tool.
 3 In Window 4, identify any part of the section with a data point.
 4 Accept with a second data point to delete the section.
 You should be getting the idea of the section tool by now. So far, we have created the sections in the active design file. Another option we have is to place them in a separate design file. In the following exercises, where we discuss creating sections by Projection, we will use this method. For these exercises, we will continue using the same model of a house.
 ➤ Create a separate design file for sections
 1 Open the design file xsects_04.dgn.
 2 If necessary, re-open the Section Generation dialog box.
 3 From the dialog box’s File menu, choose New Output File.
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 The Create Section Output File dialog box opens.
 4 Make sure that “seed3d.dgn” is selected as the Seed File.
 5 Name the output file “genxs.dgn” and place it in the default directory used for this class.
 6 Click OK.
 The Create Section Output File dialog box closes and the name “genxs.dgn” appears as the Output File in the Options section of the Section Generation dialog box.
 7 Close the Section Generation dialog box.
 We are ready now to create further sections of the house model and place them in a separate design file.
 Section by Projection
 With Section by Projection we have two choices
 • Element — lets us choose an existing element in the design file. The section is generated from all design elements within the display depth of the view that intersect the projection of the selected element. The projection is taken along the z-axis of the view.
 • Line String —lets us interactively place a temporary line string with data points. The generated section is produced from the intersection of design elements within the display depth of the view with the projection of the temporary line string. The projection is taken along the z-axis of the view.
 Here, we will use existing elements to define the position of the sections.
 ➤ Prepare to create the sections
 1 Open the Section Generation dialog box.
 2 The Output File now is the name of our active design file. Whenever we close the Section Generation dialog box, the name of the Output File is “forgotten.” Before continuing, we will have to re-open it.
 3 In the dialog box, select File > Open Output File.
 The Open Section Output File dialog box opens.
 4 Use the controls to select the section output file (genxs.dgn) that you created in the preparation for these exercises and click OK.
 The Open Section Output File dialog box closes and the selected file name again appears as the Output File in the Section Generation dialog box.
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 5 In the Section Generation dialog box, set the following:
 Assemble Segments: On
 Level: On and set to 1
 Leave all other settings turned off.
 ➤ Create sections by projection of existing elements
 1 In the Section Generation dialog box, select Tools > Section by Projection > Element.
 2 In the Top view, select the top horizontal cyan colored line with a data point.
 3 Accept with a data point to start generation of the section.
 4 When processing is complete and you are prompted to “Enter point to accept/RESET to reject,” place a data point to accept.
 The section is generated in the separate design file (genxs.dgn).
 5 Repeat steps 2 to 4 for the remaining two horizontal cyan colored lines.
 6 Close the Section Generation dialog box.
 Having completed the sections, let’s have a look at how they turned out.
 ➤ Inspect the generated sections
 1 Open the design file genxs.dgn.
 2 Use the Delete Element tool to delete the default cube. This cube is a graphic group so you can delete it in one step with graphic group lock active.
 3 Fit each view.
 Note, in the Top and Right views particularly, that the sections have been generated in their correct location relative to one another. In the Front view, we are looking at all three, one behind the other.
 ➤ To view each section separately in the Front view
 1 Select the Set Display Depth tool (in the 3D View Control tool box).
 2 Place a data point in the Front view to set this as the view being adjusted.
 3 In the Right view, place a data point just to the left of the required section to set the front clipping plane in the Front view.
 4 In the Right view, place a data point just to the right of the required section to set the back clipping plane in the Front view.
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 In practice, as you view each section, you could create Saved Views of them so that you could quickly recall them later. This may be to place in a drawing with Drawing Composition, for example.
 Before we continue: Name four different methods for creating sections?
 What will the Flatten Section option do?
 What is the “New Output File” option used for?
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 There are times when we need to exchange design file data between 2D and 3D files. You can reference 2D design files to 3D but not vice-versa. Alternatively, you can export the 2D design file to 3D, thus creating a 3D design file containing the 2D elements. To put 3D elements into a 2D design file, however, you must first “flatten” them into 2D elements. This can be done by exporting the 3D elements to a 2D design file. To create a “drawing” of a 3D model, with or without hidden lines displayed, you can export to a Visible Edges design file.
 In this chapter, we will discuss:
 • “Exporting 3D to 2D” on page 280
 • “Exporting Visible Edges” on page 281
 • “Exporting 2D to 3D” on page 284
 Depending on which type of file you are in (2D or 3D) the opposite type of format is available for export from the File > Export menu.
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 Exporting 3D to 2D
 To export a 3D design file to a 2D design file you reduce all the z- values for elements to one z- value, effectively flattening the design.
 Conversion options
 When you select File > Export > 2D, the Save 3D as 2D dialog box opens. First, let’s look at the options available to us under this dialog box. These control the conversion options.
 Source — sets the type of file to convert:
 • Design File — the active design file.
 • Attached Cell Library — the active cell library. Remember, a 3D cell library may be attached only to a 3D file. You can, however, attach a 2D cell library to a 3D file.
 View — sets the view that determines the orientation of the design plane upon which 3D elements are projected. In other words, do you want to project all of the information in one of the x-, y-, or z- axes on to one xy-, xz- or yz- plane. This allows you flexibility as you can, for example, reduce all your z-depth data in the Top view for plan drawings or the y-depth data in the Front view for front elevation drawings.
 Reference Files — controls the conversion of reference files:
 • No Conversion — the attached reference files are not converted and attachment information is not passed on to the new design file.
 The Save 3D as 2Ddialog box.
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 • Merge Attached Files — elements in the attached reference files are exported and merged into the 2D design file.
 • Convert Attachment Info — converts the reference file attachment information (type 5 level 9 and type 66 level 5 elements) but does not convert the reference file itself. When you use this option, any attached 3D reference files must be converted manually to 2D to ensure that the resultant 2D master file displays correctly (the reference file information).
 • Convert Attached Files — converts all attached reference files.
 Preserve Z Range — if on, the 3D Z range data is stored in the generated 2D elements. This data then can be used if the elements are converted back to a 3D design file.
 While this form of conversion from 3D to 2D has its uses, a more practical option for producing drawing style 2D files is Export Visible Edges. With this option, you can have the hidden lines removed, or displayed in a different linestyle and/or placed on a different level.
 Exporting Visible Edges
 When we worked with Drawing Composition, we were able to display views of our design with hidden lines shown dashed. In displaying those views, the system created separate visible edges files, which were then referenced back to the drawing file. With the Export Visible Edges option, we can create our own visible edges design files.
 When we select File > Export > Visible Edges, the Export Visible Edges dialog box opens.
 The Export Visible Edgesdialog box.
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 In this dialog box are numerous options grouped under five tabs — General, Output, Hidden, Visible, and Advanced.
 Tab Option Description
 General View Sets the view used for the orientation of the visible edges.
 Boundary Sets the boundary of the exported visible edges design file.• Design File — entire design file is exported.• View — view contents are exported.• Fence — existing fence contents are exported (not available if
 there is no fence).
 Method Selects the method for computation of visible edges:• Trace Edges — displays all unique edges of a design in the export
 file. If more than one edge is duplicated or stacked such that they appear as a single edge in the view, only the closest edge is exported.
 • Exact — computes the visible edges using an exact method, which substantially increases processing time. This option automatically removes stacked edges. If one or more edges are on top of each other, only the one closest to the eye is exported.
 • Fast — computes the visible edges quickly but makes some approximations.
 • SmartSolids — produces an output similar to the Exact method and is recommended when working with smart solid models.
 Rule Lines If on, internal rule lines are drawn on surfaces.
 Calculate Intersections If on, intersections between elements are calculated automatically in the visible edges design file, which significantly increases the processing time. Off is the default.This option is disabled (dimmed) if Method is set to SmartSolids.
 Process Text and Dimensions
 If off, text and dimensions display without any test for visibility. The default is on.This option is disabled (dimmed) if Method is set to SmartSolids.
 Include Hidden Edges If on, hidden edges are drawn. The Hidden tab has controls to set the Level, Color, Line Style or Line Weight of the hidden edges.
 Remove Smooth Edges within each SmartSolid.
 If on, blended (smooth) edges of two tangent surfaces are not displayed. This option is disabled (dimmed) if Method is set to Fast.
 Output Store in Active Design If on, the visible edges are saved in the active design file. If off, a visible edges design file is generated. The visible edges can be saved in a 2D or 3D design file, which is chosen from the File Dimension option menu.
 Automatically open output file
 If on, the “.hln” file is opened automatically on completion of the hidden line process. This option is dimmed when the Store in Active Design check box is selected.
 File Dimension Sets whether the exported visible edges design file is 2D or 3D (the default).
 Hidden Include Hidden Edges If on, hidden edges are drawn. (This control also appears on the General tab.)
 Level, Color, Style, Weight
 If on, controls that particular attribute for the drawing of hidden lines. If off, the original element attribute is used.
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 A simple exercise will let you experiment with these settings.
 ➤ Prepare for the exercise
 1 Open the design file 3d_convert_2d.dgn.
 2 In the main menu bar, select File > Export > Visible Edges.
 The Export Visible Edges dialog box opens.
 3 Click the Hidden tab and set the following:
 Include Hidden Edges: On
 Color: On and set to White
 Style: On and set to medium dash (2)
 Weight: On and set to 0
 4 Click the Output tab and set the following.
 Automatically open output file: On
 File Dimension: 2D
 Visible Level, Color, Style, Weight
 If on, controls that particular attribute for the drawing of visible lines. If off, the original element attribute is used.
 Advanced Exact Settings Accuracy — Controls the precision to which hidden line removal processing performs internal calculations. In general, most calculations are exact (accurate). Sometimes, however, it is faster to produce approximate results. If the options Low, Medium or High are selected, the accuracy is computed accordingly, based on the size of the view to be processed. Selecting High Accuracy produces higher quality output at the expense of increased processing time.
 Tolerance — Controls the maximum error (the precision) for the hidden line removal calculations explicitly (independent on the view size). Lower tolerance values produce higher quality output at the expense of increased processing time.
 Fast Settings Resolution — Sets the number of vertical and horizontal lines of the visibility test grid. The given resolution is applied to the longer side of the view.
 Working Memory (Kbytes) — Sets the amount of memory to set aside for visibility tests. A rule of thumb is to set this to no higher than ¼ of the main (RAM) memory of the computer. Using a larger block of memory may lead to excessive swapping or thrashing as data is moved back and forth between RAM and disk memory.
 Tab Option Description
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 5 Click the General tab and set the following:
 View: 1
 Boundary: View
 Method: SmartSolids
 ➤ Create a visible edges file
 1 In the Export Visible Edges dialog box, click the Preview button.
 View 1 updates to show a preview of the visible edges file. The hidden lines display as white dashed lines of weight zero, as we defined. This is a preview display and updating the view removes it.
 2 Click the Export button.
 The Save Visible Edges Design File As dialog box opens. By default it has given the proposed file the same name as the active design but with a “.hln” extension (for hidden line).
 3 Click OK.
 The file is processed. On completion, the active file is closed and the visible edges file is opened (because we enabled Automatically open output file).
 4 Use the Fit View view control to fit the view.
 When you create a visible edges design file, it creates a new design file. You cannot add visible edges views to an existing file via the Export Visible Edges process.
 Exporting 2D to 3D
 In 2D MicroStation you work on a design plane that can be likened to a sheet of paper. This plane is defined by x- and y- coordinates. In 3D design files we add another coordinate, the z- coordinate. When converting from 2D to 3D, nothing really changes with the geometry in the file. Still it will be flat (unless elements
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 contain Z range data from previous conversions from a 3D design file). However, once converted to a 3D design file, you can use those elements to produce 3D solids using the 3D construction tools, such as Extrude and Construct Revolution.
 Let’s review the settings associated with exporting a 2D design file to a 3D design file.
 Selection Options — control the source and the orientation:
 • Source — lets you choose between converting the active design file or cell library.
 • View Orientation — sets the view in the 3D design file into which the 2D design file elements are placed. This can be any one of the standard views, such as Top, Front or Left. In other words, is my 2D design file to be used as a Top/Bottom, Front/Back or a Right/Left view.
 Z Depth Options — Each converted element is placed at a depth in the Top view that can be the same or vary from element to element.
 To specify a fixed depth, choose Fixed from the Type option menu and enter the depth, in working units, in the Value field. The default depth is 0:0 – or zero working units in z-.
 The following Type options are useful only when elements were converted to 2D with Preserve Z Range on.
 • Contour Z Low or Contour Z High — fixes the depth for all elements at the design file’s lower or upper Z contour limit. This means all elements are brought to the elevation of either the upper or lower z- contour.
 The Save 2D as 3Ddialog box.
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 • Element Z Low or Element Z High — places each converted element at the depth that equals its lower or upper Z range limit. These limits equal the bottom and top of the design cube so essentially you are putting all the elements at the top or bottom of the design cube.
 • 2D Z Range/Z Low or 2D Z Range/Z High — places each converted element at the depth that equals its maintained 2D Z range lower or upper limit.
 Reference File Options are the same as when we exported 3D to 2D design files.
 Before we continue: What are the Reference File Options for both exporting and importing 2D and 3D?
 If you have no Z range information preserved, what is your best option for exporting 3D?
 Which 3D view would you use (for example: Top, Right, Front, Back, Isometric) to create a plan view in 2D?
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 Earlier in this course we were introduced to the rendering tools available with MicroStation. These tools let us create virtual photographs of our 3D model(s). While wireframe display mode usually is employed during the design process, shaded rendering display modes let us see our models much more as they would be seen in real life. To add realism, we can apply material definitions to elements so that when they are rendered they look like the finished product. For example, we can apply materials that add rough texture to a cast metal object, transparency to glass objects, reflections to shiny objects or a wood grain pattern to wooden objects.
 Rendering, along with animation, is a complex topic that is covered in another course. In this course, we aim to get you started on the way to producing rendered images and animations. In this chapter we will look at the following topics and tools.
 • “Rendering Tools tool box” on page 287
 • “Render tool” on page 288
 • “Facet Smoothing tool” on page 299
 • “Define Camera tool” on page 300
 • “Saving rendered images” on page 308
 Rendering Tools tool box
 Apart from the Render tool, which we used earlier, the Rendering Tools tool box also contains other tools associated with rendering.
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 ➤ Open the Rendering Tools tool box
 1 In MicroStation’s main menu bar, select Tools > Visualization Tools > Rendering Tools.
 In this course, we will look at the following tools from this tool box:
 • Define Light — to define and place Source Lighting in a design.
 • Define Camera — to set up a camera view for rendering.
 • Apply Material — to define and apply material definitions to elements in the design.
 • Render — to render a view.
 • Facet Smoothing — used to create smooth renderings from digital terrain models.
 Render tool
 We used the Render tool in an earlier chapter. There, we selected it from the 3D View Control tool box. Here, we will look at the shading modes in a little more detail. We know from our earlier work with this tool that we have a choice of rendering display modes. During the rendering process, MicroStation reduces the model to a polygon mesh (in memory only, the design file is left untouched). This polygon mesh is most noticeable with curved surfaces, in particular when Wiremesh or Constant rendering is used. It is the way that this polygon mesh is treated that differentiates the various rendering methods.
 The Rendering Tools tool box.
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 The Render tool is located in the both the 3D View Control and Rendering Tools tool boxes and its settings are as follows:
 Earlier, we saw the different rendering modes and how they treated a simple model. Let’s recap by looking at the shaded rendering modes as applied to a model that has material definitions applied to the elements in the design. This example file contains a desklamp, glass vase and cast brass paperweight, which has a smooth handle. They are sitting on a round table top.
 Tool Setting Option Description
 Target View Renders the entire view.
 Fence Renders the contents of a fence.
 Element Renders a selected element.
 Render Mode Wiremesh Displays the polygon mesh. Most noticeable with curved surfaces.
 Hidden Line Hidden lines are removed, such that edges that would not normally be visible are not displayed.
 Filled Hidden Line Same as Hidden Line, except that the polygons are filled with the element color.
 Constant Produces a shaded image in which each polygon is filled with a constant color. Produces a tiled effect with curved surfaces
 Smooth Colors are computed at the polygon vertices and a smooth transition displays across the polygon. On curved surfaces, the tiled effect, as seen with Constant shading, is not evident.
 Phong Colors are computed for each pixel, producing much more realistic shading. Optionally, approximated shadows also may be produced.
 Ray Trace MicroStation’s most realistic shading mode in which the path of light ray, from the viewers eyepoint is calculated. Reflections and refraction are displayed, as are accurate shadows.
 Radiosity While not a rendering method, produces a lighting environment that then may be Smooth rendered or Ray Traced to produce images that include the reflection of light from objects in the scene.
 Shading Type Normal Standard shading.
 Antialias Image is rendered several times and averaged to reduce jagged lines along the edges of objects.
 Stereo Image is rendered twice to produce a composite image that, when viewed through Red and Blue glasses, takes on a 3D effect.
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 ➤ Render views using the four shading modes
 1 Open the design file render_3.dgn.
 2 Select the Render tool with the following settings:
 Target: View
 Render Mode: Constant
 Shading Type: Normal
 3 Place a data point in Window 1.
 The view is rendered in Constant shading mode.
 4 Change Render Mode to Smooth.
 5 Place a data point in Window 2.
 The view is rendered in Smooth shading mode.
 6 Change Render Mode to Phong.
 7 Place a data point in Window 3.
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 The view is rendered in Phong shading mode.
 8 Change Render Mode to RayTrace.
 9 Place a data point in Window 4.
 The view is rendered in RayTrace shading mode.
 Inspecting the four rendering options, observe the following:
 • Constant rendering (Window 1) — displays the curved surfaces as a number of facets, or tiles. The tabletop displays as a woodgrain pattern, the vase as a transparent material and the paperweight has the color of brass, but does not display the rough texture as seen in the Phong and Ray Traced versions. There is little indication of the light source from the desklamp.
 • Smooth rendering (Window 2) — displays curved surfaces smoothly with some indication of the light from the desklamp. The tabletop displays as a woodgrain pattern. Again, the rough texture of the paperweight is not apparent.
 • Phong rendering (Window 3) — displays the rough texture of the paperweight base. As well, we see much more clearly the limits of the lighting from the desklamp. Shadows also are displayed.
 • Ray Trace rendering (Window 4) — displays the objects in a photo-realistic manner. Note the reflection of the objects in the polished surface of the table
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 and of the green lamp in the rough surface of the brass paper weight. Note also, the effect of refraction when viewing part of the lamp through the glass vase.
 Well, that should give you an idea of what is possible. Let’s start by looking at how to set up lighting, which we will follow with how to apply materials to elements.
 Antialiased rendering
 When you are producing “final” images, the antialias setting for Shading Type reduces the jagged lines that appear where an edge is not exactly horizontal or vertical on the screen. Antialias is available for all render modes except Wiremesh.
 When you select Antialias as the Shading Type, the view is rendered a number of times, shifting slightly each time. The results then are combined into one image reducing the effect of the jagged lines. Antialiasing quality is determined by the Antialiasing Grid Size in the Rendering Settings dialog box. The default setting of 2 is adequate for most cases, requiring the view to be rendered 4 times.
 ➤ Render a view “Antialiased”
 1 Select the Render tool with the following settings:
 Target: View
 Render Mode: Constant
 Shading Type: Antialias
 2 Place a data point in Window 2.
 The view is rendered 4 times and the results combined into one image.
 Compare this image to that in Window 1, which you rendered previously as a Constant shaded view, with no antialiasing. Note, in particular, the difference along the lower arms of the desklamp and in the light reflections in the vase.
 Constant rendered image without Antialiasing (left) and with (right).
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 Settings that affect rendering
 Before we continue, let’s check out the settings that affect our rendered images. In particular, we will look at settings contained in the Ray Tracing, Rendering View Attributes and Rendering Settings dialog boxes.
 For the exercises, we will work with a simple design file containing several solids that will render quickly and let us see how the various settings change the appearance of the image. The model is illuminated by a single Spot Light (we will learn about these shortly) and the Flashbulb.
 ➤ Prepare for the exercises
 1 Open the design file render_settings.dgn.
 This design file has been saved with three views open to let us compare results as we experiment with the settings.
 2 In the main menu bar, select Settings > Rendering > General.
 The Rendering Settings dialog box opens.
 3 In the main menu bar, select Settings > Rendering > View Attributes.
 The Rendering View Attributes dialog box opens.
 4 In the main menu bar, select Settings > Rendering > Ray Tracing.
 These three dialog boxes control settings that affect how a view is shaded with the various Render Modes. In the following exercises, we will see how several of these settings affect the quality and the appearance of our images.
 Rendering Settings, Rendering View Attributes and Ray Tracing dialog boxes.
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 Stroke Tolerance
 This setting has a direct affect on the time taken to render a view, as well as the accuracy of curved surfaces. When a view is rendered, the system first decomposes the model into a mesh of polygons. Where a curved surface is involved, the deviation of the polygon mesh from the original surface is controlled by the Stroke Tolerance, which affects the quality of rendered images as follows:
 • Larger Stroke Tolerance values reduce processing time but the rendered curved surfaces are further from the original surfaces. This is most noticeable around the edges of surfaces.
 • Smaller Stroke Tolerance values increase processing time but the rendered surfaces are closer to the original.
 ➤ Change Stroke Tolerance values
 1 In the Rendering Settings dialog box, check that Stroke Tolerance is set to the default value of 0.500.
 2 Select the Render tool with the following settings:
 Target: View
 Render Mode: Smooth
 Shading Type: Normal
 3 Place a data point in Window 1.
 The view renders very quickly.
 4 Change the Stroke Tolerance value to 5.000.
 5 Place a data point in Window 2.
 The view renders almost instantaneously but the curved surfaces do not appear smooth around the edges.
 6 Change the Stroke Tolerance value to 0.010.
 7 Place a data point in Window 3.
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 The view takes longer to render but the image is much better with the curved surfaces looking very smooth around the edges.
 Generally, the default setting of 0.5 for Stroke Tolerance is adequate for all but the final rendered images.
 Shadows
 For standard rendering without using Radiosity solving, only Phong and Ray Traced images can display shadows. Shadows may be generated by a number of the available light sources, as follows:
 • Phong — Spot Lights, Distant Lights, Area Lights, and Solar lighting. Note that Phong rendering does not generate shadows from Point Light sources.
 • Ray Tracing — Point Lights, Spot Lights, Distant Lights, Area Lights, and Solar lighting.
 Where accurate shadows are required, the RayTrace option should be used. Phong rendering uses shadowmaps, which approximate shadows. The accuracy of these shadows are controlled by the Shadow Filter Size and the Shadow Tolerance settings in the Rendering Settings dialog box. In either case, you can render with or without shadows.
 To display shadows in a rendered view for:
 • Phong rendering — in the Rendering View Attributes dialog box, turn on Shadows for the view being used to create the rendered image. Shadows for Phong rendering can be enabled/disabled for each view individually.
 • Ray Tracing — in the Ray Tracing dialog box, turn on Shadows. Ray Tracing settings apply to all views.
 Effects of Stroke Tolerance settings of 0.500 (left), 5.000 (center), and 0.010 (right).
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 ➤ Phong render with and without shadows
 1 In the Rendering Settings dialog box, set the following:
 Stroke Tolerance: 0.500
 Save Shadow Maps: On
 2 In the Rendering View Attributes dialog box, set the following:
 View Number: 1
 Shadows: Off
 3 Click Apply (do not click All as we want the other views to remain with Shadows turned on).
 4 Select the Render tool with Render Mode set to Phong.
 5 Place data points in Window 1 and Window 2.
 Window 1 is Phong rendered without shadows. Window 2 displays shadows because Shadows still was turned on in that view.
 Phong rendering and shadows
 When shadows are generated with Phong rendering, a shadowmap is generated for each supported light source, to approximate the shadows. To reduce rendering time in future, these shadowmaps may be saved to disk. We did this in the previous exercise when we turned on Save Shadowmaps before we rendered the views. Shadowmaps are saved as files with the suffix “.l01”, “.l02” and so on, one for each light source. There is a trap to be aware of, however, if you do this. If you save the shadowmaps, the rendering process will use these each time it is asked to Phong render the design file. For example, if you modify the model or turn off a level displaying one of the elements, the shadows remain unchanged. The Define Light tool has an option that lets you clear the shadowmaps, as we will see later, or you can simply turn off Save Shadowmaps. Let’s see this in practice.
 Window 1 Phongrendered without
 shadows, Window 2with shadows.
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 ➤ “Turn off” an element and re-render the view
 1 Turn off level 2 in Window 2.
 Level 2 contains the violet rectangular box.
 2 Select the Render tool with Render Mode set to Phong.
 3 Place a data point in Window 2.
 The view is Phong rendered. The shadow from the violet box still remains even though the display of this element has been turned off.
 4 In the Rendering Settings dialog box, turn off Save Shadow Maps.
 5 Again place a data point in Window 2 to Phong render it.
 The view is Phong rendered. This time, the shadow from the box has disappeared. When Save Shadow Maps is turned off, the shadow maps are regenerated each time that you render a view.
 Ray Tracing and shadows
 Shadow settings for Ray Tracing are separate from those for Phong rendering and are located in the Ray Tracing dialog box. These settings apply for all views.
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 ➤ Ray Tracing with and without shadows
 1 Turn on level 2 in Window 2.
 2 In the Ray Tracing dialog box, turn off Shadows.
 3 Select the Render tool with Render Mode set to RayTrace.
 4 Place data points in Window 1 and Window 2.
 Both windows are ray traced without shadows.
 5 In the Ray Tracing dialog box, turn on Shadows.
 6 Place data points in Window 1 and Window 2.
 Both windows are ray traced with shadows. The shadows are much more clearly defined than they were with Phong rendering.
 With ray tracing, the shadows are calculated each time you render a view. If you change the model in any way or turn off the display of elements, the changes are taken into account and correct shadows produced.
 ➤ “Turn off” an element and again ray trace the view
 1 Turn off level 2 in Window 2.
 2 Select the Render tool with Render Mode set to RayTrace.
 3 Place a data point in Window 2.
 Both ray traced viewsdisplay shadows asdefined in the Ray
 Tracing dialog box.
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 The view is ray traced. The shadows are correctly displayed.
 Facet Smoothing tool
 This tool is useful for creating smooth shaded images of surfaces that are created as a mesh of polygons, such as those that may be generated by digital terrain modeling software. Using the Facet Smoothing tool, you can produce a rendered image in which the surface appears smooth. Tool settings for this tool are as follows:
 In the following example, we have a digital terrain surface consisting of a mesh of polygons. When rendered, no matter which shading mode is selected, the surface appears tiled because it consists of separate polygons. Using the Facet Smoothing tool, we can create rendered images with the surface looking smooth.
 ➤ Using Facet Smoothing to smooth out a digital terrain surface
 1 Open the design file facet_smoothing.dgn.
 2 Use the Render tool to Smooth render Window 1.
 3 From the main menu, select Edit > Select All to select all the polygons forming the surface.
 Tool setting Description
 Mode Defines whether facets are to be added to, or removed from, the smoothing operation:• Attach — adds the selected polygons to the facet smoothing operation.• Detach — removes the selected polygons from the facet smoothing operation.
 Angle Tolerance Sets the maximum angle that is allowed between adjacent polygons that will be smoothed. Adjacent polygons having an angle between them that exceeds this value are not smoothed.
 Ray tracing recalculatesthe shadows each time.
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 4 Select the Facet Smoothing tool with the following settings:
 Mode: Attach
 Angle Tolerance: 30.00
 5 Place a data point in any view to accept the selected polygons.
 6 Use the Render tool to Smooth render Window 1.
 This time, much of the surface rendered as a smooth entity. Where the angle between adjacent polygons exceed 30°, the tiled look still remains.
 Define Camera tool
 Earlier, we looked at the Camera Settings tool in the 3D View Control tool box, and the Navigate Camera view control in the window border. Here we will look at another camera tool, Define Camera, which is designed specifically for setting up views for rendering.
 When using this tool, a camera view is chosen and you have the option of displaying its viewing cone in all other views that display the same volume of the design file. You can manipulate this view cone in the other views or you can use tools from the Define Camera dialog box to manipulate the view camera.
 Try this tool out now. We will use the same model as we used earlier for the Navigate Camera view control.
 Smooth rendered views before (left) and after (right) smoothing facets.
 Define Camera dialog box.
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 ➤ Prepare for the exercise
 1 Open the design file defcamera_01.dgn.
 2 In the Rendering Tools tool box, select the Define Camera tool with the following settings:
 Continuous View Updates: On
 Display View Cone: On
 You are prompted to “Select active view.”
 3 Place a data point in Window 2.
 4 Check that Projection (in the tool settings) is set to Three Point.
 This becomes the Active View, as shown in the Define Camera dialog box. The View Cone for the selected view appears in the remaining views.
 You may recall that earlier when we worked with the Camera Settings tool, we used 3D data points to place the camera target and eyepoint locations. With the Define Camera tool, we can manipulate the view cone via the handles that appear at the eyepoint, target, center and a fourth handle that lets us alter the viewing
 View Cones in the remaining views show what part of the design is being displayed in the camera view (Window 2).
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 angle. The target handle is located at the center of a rectangle that represents the image plane.
 Using these handles, you can manipulate the view cone as follows:
 • Camera handle — positions the camera or eyepoint relative to the target.
 • Center handle — position the entire view cone without changing the relative positions of the camera and target.
 • Target handle — positions the target relative to the camera or eyepoint.
 • Viewing Angle handle — changes the viewing angle of the camera. Reducing the view angle is equivalent to using a telephoto zoom lens. Without moving the camera or target locations, you can zoom in or out by changing the view angle.
 ➤ To change the position of a view cone handle
 1 Place a data point on the handle that you want to move.
 2 Move the handle to the new location.
 3 Place a second data point to complete the change.
 ✍ You can use the click and hold method also. That is, place a data point on the handle and hold down the data button as you move the handle. Releasing the data button completes the move.
 Just as we used two views to place 3D data points earlier in this course, we need two views open to quickly manipulate the view cone. For example, you can use the Top view to manipulate the view cone horizontally and the Front or Right views to manipulate it in the vertical direction.
 ➤ Try manipulating the view cone yourself
 1 Place a data point on one of the view cone handles.
 2 Move the pointer and observe that the camera view (Window 2) updates continuously as you manipulate the view cone.
 View Conewith handles.
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 If you turn off Continuous View Updates, the view updates after you have moved the handle.
 3 Try all the view cone handles to see how they relate to each other.
 Using the view cone and a camera view in this fashion gives you visual feedback on just what the camera view is displaying. Currently, the Projection is set to Three Point, which displays the camera view much as you would see it through a normal camera. We do have other options also, which we will look at now.
 ➤ View other projection modes for the camera view
 1 Attach the Saved View “START” to Window 2.
 This returns the view to the orientation at the beginning of the exercise.
 2 In the Define Camera tool settings, change Projection to Parallel.
 The camera view updates to display in Parallel projection. The view cones update to display the new viewing parameters. Parallel projection is the default viewing mode for MicroStation.
 3 In the Define Camera tool settings, change Projection to One Point.
 The camera view updates to display in One Point projection. Currently, this looks similar to Three Point projection, except that there is a fifth handle on a “lever” attached to the target handle. Using this new handle, you can
 Front and Camera views showing parallel projection.
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 manipulate the image plane orientation (you will get a chance to try this out in a moment).
 4 In the Define Camera tool settings, change Projection to Two Point.
 The camera view updates to display in Two Point projection. With this display mode, the image plane always is vertical resulting in all vertical lines of the image being vertical.
 5 Experiment with these various settings yourself. At any time, you can return to the original camera view by attaching the Saved View “START” to the camera view.
 As you have seen, manipulating the view camera is quite simple with the Define Camera tool. We will now look at other options available with this tool.
 Two Point projection displays all vertical lines as vertical.
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 Camera action options
 Across the top of the Define Camera dialog box are nine buttons that let us control the camera view cone directly. These buttons match options in the Camera Action option menu. The following exercise will help you understand how they operate.
 ➤ Using a camera action tool
 1 Attach the Saved View “START” to Window 2.
 This returns the view to the original orientation.
 2 In the Define Camera tool dialog box, check the following settings:
 Active View: 2
 Projection: Three Point
 Reference Point: Target
 Continuous View Updates: On
 Display View Cone: On
 3 Click the Pan button.
 4 Place a data point at the center of the camera view (Window 2).
 5 Move the pointer:
 Left/right to rotate the camera (eyepoint) left/right about the target point.
 Up/down to rotate the camera up/down about the target point.
 This is similar to moving around a stationary object (the target).
 6 Reset to return the view to its original orientation.
 7 In the tool settings, set Reference Point to Eye.
 8 Move the pointer:
 Left/right to rotate the target point left/right about the camera.
 Up/down to rotate the target point up/down about the camera.
 This is similar to standing in the one spot and turning your head left/right/up/down to view the surroundings.
 9 Reset to return the view to its original orientation.
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 Try the other camera action options in the Define Camera tool dialog box. Following is a table describing each of the camera action tools and how they operate:
 Controlled Movement
 So far, we have moved the camera using the mouse. We have another option that lets us move or rotate the camera view cone by a defined distance/angle. To do this, we have to turn off Continuous View Updates and use data points to specify movement. The amount of movement or rotation per data point is specified in the Controlled Movements settings.
 Camera Option Effect
 Pan Move the camera or target radially relative to each other, either horizontally or vertically.
 Pan Horizontal Move the camera or target radially (horizontally) relative to each other.
 Pan Vertical Move the camera or target radially (vertically) relative to each other.
 Roll Roll or tilt the camera.
 Dolly/Elevate Move the camera sideways or vertically.
 Dolly Move the camera in, out, or sideways.
 Lens Focal Length
 Change the lens focal length.
 Lens View Angle
 Change the lens viewing angle.
 Pan/Dolly Walk through the view.
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 ➤ Set the Controlled Movement values
 1 In the Define Camera dialog box, click the More button.
 The dialog box expands to display further settings options. Next to each option is a button with a down arrowhead to open the settings.
 2 Open the settings for Controlled Movement.
 3 In the Distance field, key in 20.
 4 In the Angle field, key in 5.
 Now, when we move the camera/target with Continuous View Updates disabled, each data point moves the camera view cone 20 meters. Similarly, if we rotate the view cone, each data point causes a 5° rotation. For view cone manipulation with data points, the position of the data point in the view determines the direction of the movement or rotation. If we think of the view as being divided into nine
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 sections, then the movement performed by a data point in one of these sections is as shown in the diagram below.
 ➤ Manipulate the camera view cone, using controlled movements
 1 Attach the Saved View “START” to Window 2.
 2 In the Define Camera tool dialog box, turn off Continuous View Updates.
 3 Select the Dolly camera action button.
 4 In Window 2, click in the various regions of the view and note how the view cone moves. For example:
 Clicking in the corners of the view moves the view cone in both the horizontal and vertical directions.
 Clicking in the center sections of the left or right view edges moves the view cone horizontally left or right.
 Clicking in the center sections of the upper or lower view edges moves the view cone vertically left or right.
 5 Experiment with the other camera action buttons, using the Top, Front and Right views to check the movement of the view cone.
 Saving rendered images
 Now that you can set up and create rendered images of your models, you might want to save one or more of them and impress your friends by sending them a file containing the image. You can quickly save your MicroStation images using the Save option in the Utilities > Image menu.
 You have many choices when saving your images, such as file format, resolution and type of shading. As well as being able to save your images, MicroStation provides a viewing facility and a way to perform limited modifications.
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 There are many variables that you can adjust when saving images, however, you will find that most remain consistent once you begin to integrate images into your workflow. Here, we will cover the basics for:
 • Saving a Rendered Image
 • Displaying and Modifying existing images
 These tools are found on the Utilities > Image menu. In addition to these basics you can also convert images, capture the screen as an image and save an image using multiple computers to speed up the processing time.
 Saving a rendered image
 To save an image we select Utilities > Image > Save, which opens the Save Image dialog box. Let’s look at the options available to us in this dialog box.
 • View — controls which view will be rendered.
 • Format — controls the type of file format in which the image file will be saved. MicroStation supports a wide variety of file formats including JPG, TIF, TGA, Postscript, PCX and others.
 • Compression — selects the type of file compression for those formats that allow it. For example, if you choose JPEG then you have the option of choosing High Loss (high compression) through to Minimum Loss (high quality).
 • Mode — lets you choose the bit depth of the image or grey scale.
 • Shading — lets you choose which type of shading to use. For high quality images that cast shadows, select RayTrace shading mode.
 • Shading Types — lets you choose between Normal, Antialias and Stereo.
 • Resolution — controls how large an image you produce, in terms of pixels. Thought should be given to displaying the saved image. In order to display the saved image, you must have enough RAM on your video card to hold the
 The Save Image dialog box.
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 image. This depends also on what bit depth (24 bit or 8 bit) you choose in Mode. The following table can be used as a guide:
 When one of the Resolution values (X or Y) is adjusted the other updates to maintain the view aspect ratio. Using higher resolution allows you to have more pixels to work with, hence a finer quality image.
 • Gamma Correction — controls the white content of an image. The values range from 0.10 to 3.00. A value of 0.10 is very dark while 3.00 is very bright.
 After specifying the settings for your image, you can save the image with a unique file name and place it on your hard drive. The default location in which MicroStation stores image files is “…Workspace\projects\examples\generic\out.”
 Let’s go ahead and save an image of our example file.
 ➤ Save a rendered image
 1 Open the design file render_4.dgn.
 2 Select Utilities > Image > Save.
 The Save Image dialog box opens.
 Amount of RAM on the video card
 Maximum Resolution at 24 bits
 Maximum Resolution at 8 bits
 1 MB 640x546 1024x1024
 2MB 1024x682 1600x1310
 4MB 1280x1092 1600x2621
 8MB 1600x1747 1600x5242
 The Save Image Asdialog box.
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 3 In the Save Image dialog box, set the following:
 View: 1
 Format: JPEG (JFIF)
 Compression: Minimum Loss
 Mode: 24 Bit Color
 Shading: RayTrace
 Shading Type: Normal
 Resolution: X: 640
 Gamma Correction: 1.00
 4 Click the Save button and accept the default file name and settings.
 By default, MicroStation gives the image file the same name as the design file, but with the extension that applies to the selected image format. In this case, the image file will be given the name “render_4.jpg.”
 ✍ How long it takes to process an image depends largely on the resolution specified, plus the number of light sources in the design and the materials assigned to elements in the model. You can check the progress of a ray tracing by looking at the prompt area of the status bar (left hand side). There you will see a message such as “Tracing line 205 of 400” as the line by line processing progresses.
 Displaying and modifying images
 You can display and modify existing images from within MicroStation. You can open an image for display by selecting Utilities > Image > Display. From the dialog box that opens with the image displayed, you then can perform several editing tasks.
 The Display Imagedialog box.
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 When we display an image, the Display Image window informs us which file is open, the image’s resolution and the image type. There are three menu selections in the Image window menu bar — File, Edit and Image. Using these tools, you can perform minor editing of your images without exiting MicroStation.
 File — has the following options
 • Open — to open an existing image.
 • Save As — to save an existing image as a new image.
 • Save — to save your modifications to an existing image (overwriting the existing image).
 Edit — contains image editing tools. These tools can be used with or without a fence (some tools require a fence to be placed first). When using a fence, you designate a specific region of the image that you want to modify. The tools available when image editing are as follows:
 • Cut — cut the contents of a fence from the image.
 • Copy — copy the contents of a fence from the image.
 • Paste — paste the contents of a fence, previously cut or copied from the image.
 • Size — re-size the image.
 • Crop — crop the image by removing the area outside the fence.
 • Rotate — to rotate the image 90° clockwise, 90° counter-clockwise, or 180°.
 • Mirror — mirror the image about a horizontal or vertical axis
 Image — contains image processing tools that can be used to fine-tune your images as follows:
 • Equalize — lets you process a light or dark image to create a wider separation of light and dark areas.
 • Gamma Correction— controls the whiteness in an image. This lets you brighten or darken an image. This is especially useful with a dark image where it can be lightened to display subtle details. You can preview the change before applying it to the image.
 • Tint — modifies the RGB value of each pixel in the image. You can preview the change before applying it to the image.
 • Negate — converts an image into its negative or color complement.
 • Blur — minimizes jagged edges by creating a smooth transition between adjacent pixels.
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 • Color Mode — lets you to adjust the color depth of an image (see the table below).
 ✍ You cannot undo an image edit operation. If you are not satisfied with your editing, do not save the image. Simply close the image and start over. Remember, you should always work in a copy of an image file to prevent accidentally overwriting your original image.
 Time to have a look at these image editing tool. For this exercise, we will work with the image we just created.
 ➤ Open and modify a rendered image
 1 In the main menu bar, select Utilities > Image > Display.
 The Display Image dialog box opens.
 2 Select the image file that you created in the previous exercise, render_4.jpg.
 The display image dialog box opens displaying the selected rendered image.
 3 Place a fence around part of the image.
 Color Mode Used to
 RGB Change the color depth to 24 bits (256 red, 256 green, 256 blue) for 16.7 M possible colors.
 16 Colors Change the number of colors to 16 (4-bit color depth).
 256 Colors Change the number of colors to 256 (8-bit color depth).
 Grey Scale Process all colors to the closest gray-scale value (256 shades of gray).
 Monochrome Process all colors (or grays) to 1-bit or black and white (using extreme dithering).
 Display Imagedialog box
 displaying thesaved image.
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 4 From the Edit menu, choose Crop.
 If you are not satisfied with your results, start over by selecting File > Open and reopening the image file.
 5 From the Image menu, choose Gamma Correction.
 6 Adjust your Gamma value to 1.5 and click Preview to view your results.
 7 Reduce your Gamma value to 0.05 and click Preview to view your results.
 The first time you adjust the Gamma value (to 1.5) should produce a much lighter image than that with the second Gamma value (0.5).
 8 Set the Gamma value to a value that gives you an image that you are happy with and then click Apply.
 9 From the Edit menu, choose Size.
 10 Enter 600 for the X- field, leaving the Y- field locked.
 Note how the image enlarges.
 11 Select the Tint option from the Image menu.
 12 Decrease the Blue value to 180 and preview the results.
 Note how tinting changed the color of your entire image.
 13 Now try using some of the other Image editing tools to adjust your image.
 Cropped imagewith Gamma setto 1.5 (left) and
 0.5 (right).
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 Before we continue: What is Gamma Correction and how do you use it?
 What do you need to place before cropping an image?
 What are five shading methods you can use to save a rendered image?
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20 Lighting
 Lighting is a key ingredient to producing rendered images of your design. If you have no lighting, your rendering appears as a blank view. MicroStation gives you the choice of two classes of lighting — Global and Source lighting. You can use either or both to illuminate your model. Source lighting consists of special lighting cells, which you place in the design, while Global lighting is defined entirely from a dialog box. In this chapter, we will cover the following topics:
 • “Global lighting” on page 317
 • “Source Lighting” on page 321
 • “Define Light tool” on page 323
 Global lighting
 Three global lighting types can be used in your rendered images — Ambient, Flashbulb and Solar. All settings for these light sources are defined in the Global Lighting dialog box. From this same dialog box, you can turn on Add Sky Light to all Solar and Distant Lights and Approximate Ground Reflection for Sky Light to simulate lighting from the sky and reflected light from the ground, respectively. In this course, we will look at Ambient, Flashbulb and Solar lighting.
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 ➤ Open the Global Lighting dialog box
 1 In the main menu bar, select Settings > Rendering > Global Lighting.
 2 If necessary, click the down arrow next to the Solar check box to display further settings for Solar lighting.
 Ambient
 Ambient lighting affects every element in the design. It adds lighting equally to all elements. As you increase the value of Ambient lighting, the amount of contrast diminishes. Ambient lighting is useful for illuminating surfaces that would not otherwise receive light. No shadows are cast by Ambient light. Settings for this light source let you adjust its Intensity and Color.
 Flashbulb
 Like a flashbulb on a camera, this light source illuminates all elements that are facing the viewing position or camera. Useful for checking models during construction, it can be used to add light to a final image also. No shadows are cast by this light source. Via settings in the Global Lighting dialog box, you can adjust the Intensity and Color of the Flashbulb.
 Solar
 Used to simulate lighting from the Sun, Solar lighting has settings that let you set any of the following:
 • Latitude, longitude, time and date of the rendering.
 • Solar Direction Vectors of the sunlight.
 • Azimuth Angle and Altitude Angle of the Sun.
 Global Lighting dialog box without (left) and with (right) extra settings
 displayed for Solar lighting.
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
 20-318

Page 329
                        

Global lighting
 You can input this data manually in the relative fields or you can use dialog boxes to select a city from a list or pick a location from a map of the world. These dialog boxes are opened by clicking one of the following buttons in the Location group box of the Global Lighting dialog box:
 • Cities — to open the Location By City dialog box from which you can select a city from the list.
 • Map — to open the Location By Map dialog box, which displays a map of the world. Clicking on this map sets the latitude and longitude values for the point. With this method, you must still enter the GMT Offset manually.
 • Zones — to open the GMT Offset By Time Zone dialog box from which you can select a time zone.
 Optionally, you can turn on Solar Shadows to view the effect of shadows generated by the Solar lighting (sunlight) when rendering with the Phong or RayTrace options. As with other Global light sources, you can specify the Intensity and Color of the simulated sunlight.
 ➤ Setting the Flashbulb and Ambient lighting
 1 Open the design file global.dgn.
 2 Open the Global Lighting dialog box (Settings > Rendering > Global Lighting).
 3 In the Global Lighting dialog box, turn on Flashbulb and set its Intensity to 0.5.
 4 Select the Render tool with the following settings:
 Target: View
 Render Mode: RayTrace
 Shading Type: Normal
 5 Place a data point in Window 1.
 The view is ray traced but it is quite dark.
 6 Set Flashbulb Intensity to 1.0.
 7 Place a data point in Window 2.
 The image appears brighter than at first.
 8 In the Global Lighting dialog box, turn on Ambient and set its value to 0.2.
 9 Place a data point in Window 3.
 The view is ray traced. Its appearance is much brighter. Ambient lighting has added illumination equally to all elements in the view.
 10 Set Ambient Intensity to 0.5.
 11 Place a data point in Window 4.
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
 20-319

Page 330
                        

Global lighting
 The view appears even brighter, but has lost some of its contrast.
 ➤ Setting Solar lighting
 1 In the Global Lighting dialog box, turn on Solar and set its Intensity to 1.0.
 2 Turn on Solar Shadows and check that the Lock is turned off.
 3 Click the Cities button.
 4 Select Philadelphia from the list of cities and in the Time section, set the following:
 Time: 2:30 PM, Standard
 Date: June 27
 Year: 2000
 5 Turn on Ambient and set its Intensity to 0.2.
 6 Turn off Flashbulb.
 7 Use the Render tool to ray trace Window 1.
 8 Click the Cities button and select Melbourne (Australia) as the city.
 9 Ray trace Window 2.
 The four views displaying the variations in rendering due to Flashbulb and Ambient lighting.
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 Note how the light intensity has changed along with the shadow length and direction. Try changing the time of day to morning and rendering the view again.
 Source Lighting
 Unlike Global lighting, which is controlled solely from a dialog box, Source lighting consists of light sources in the form of special cells that you place in the design. This is done with the Define Light tool, which we will look at shortly. First, a brief description of source lighting.
 Source lighting cells are stored in the cell library “lighting.cel,” which is accessed automatically by the Define Light tool. That is, you do not have to attach the cell library before placing light sources. These special lighting cells contain enter data fields that specify each light source’s settings. Again, the Define Light tool lets you enter this data as you place the light source and modify them, if necessary, at a later date.
 Shadow generation from source lighting
 Not all rendering modes support the generation of shadows, even if the Shadow setting is turned on in the light source and for the view. For general rendering, only Phong and RayTrace modes support the generation of shadows. Where radiosity solving is used, Smooth rendering also can display shadows.
 Source Lighting types
 Source lighting provides a choice of four lighting types — Point, Spot, Distant and Area. These light sources provide lighting as follows:
 Effect on Philadelphia (left) and Melbourne (right) of solar lighting on a late June afternoon.
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 • Distant — directional light source that produces parallel light rays throughout the design, similar to sunlight. All surfaces that face a Distant light source are illuminated by it. Shadows can be generated by this light source for Phong and RayTrace rendering.
 • Point — similar to a light globe, point light sources radiate light in all directions, from a “point” light source. Shadows can be generated by this light source in RayTrace rendering only.
 • Spot — directional light source that behaves similar to a flashlight. Spot Lights have a conical beam. This can be defined to taper off to zero at the edge of the beam. That is, you can define the Cone Angle for the beam, and a Delta Angle through which the beam reduces from full intensity to zero. Shadows can be generated by this light source for Phong and RayTrace rendering.
 • Area — created from existing polygons in the design, these light sources are useful for simulating fluorescent lighting, for example. Shadows can be generated by this light source for both Phong and RayTrace rendering.
 Each source lighting cell that you place in your design can have different settings for such things as Intensity and Color. As well, you can specify whether or not they cast shadows.
 Size of source lighting cells
 When you place source lighting cells, a default size is used, which is affected by the Active Scale setting. You can vary the size of the cells by changing the active scale setting, but there is no real need to do this. The size of light source cells (apart from Area Lights, which are created from existing polygons) has no bearing on their effectiveness. Also, there is no need to be able to see them for modification purposes as the Define Light tool lets you select them by name, or it can scan the file for you.
 Spot light showing ConeAngle and Delta Angle
 (where light intensityfades to zero).
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 Define Light tool
 You use the Define Light tool to create and modify light sources in your design. Both Global and Source lighting can be created and modified via options in the Define Light dialog box.
 Tool settings for the Define Light tool are as follows:
 Tool Setting Effect
 Mode Sets general type of operation:• Modify — modify an existing light source.• Create — create a new light source or define global lighting.• Clear Shadow Map(s) — (available only if shadow maps are present on
 disk) delete existing shadow maps for the design file.
 Method When Mode is set to Modify, sets the specific operation to be performed. Options are Edit Light, Apply Values, Delete Light, Move Light, Target Light, Position Light, Dolly Light.
 Type When Mode is set to Create, sets the type of light source to create, from: Distant, Point, Spot or Area light.
 Name Lets you define a name for light sources (Mode set to Create) or to specify a light source by name (Mode set to Modify). By default, the system gives each light source a name, which you can change prior to placing the light source.
 On Defines whether the light source is turned on or off.
 Color Opens the Modify Color dialog box that lets you define the color of the light from the light source.
 Shadow Sets whether the light source can cast shadows, where the rendering mode supports it.
 Attenuate If on, the light source is attenuated; its intensity decreases over distance.
 Brightness Sets the light source brightness when used with radiosity solving.
 Intensity Sets the intensity of the light source for general rendering (without a radiosity solution).
 Resolution (Phong rendering only) Sets the resolution of the shadow map generated for the light source.
 Distance (Attenuate on only) sets the distance from the light source at which it is half the original intensity.
 Define Light dialog box.
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 In the following example, we will add light sources to a design and check the effects by rendering the view.
 ➤ Prepare for the exercise
 1 Open the design file srclite_01.dgn.
 This design file has been saved with the views set up for the exercise. Window 2 is a camera view that has been set up for rendering. Window 4 displays the entire model, which consists of two walls, floor and ceiling of a room. In the corner are a small coffee table, a table lamp and a separate floor lamp. Windows 1 and 3 have been set up for adding light sources.
 2 Use the Render tool to ray trace Window 2.
 Currently, only the Global lighting Flashbulb, in conjunction with Ambient, is illuminating the scene.
 Cone Angle (Type set to Spot Light only) Sets the cone angle of the beam cone.
 Delta Angle (Type set to Spot Light only) Sets the angle through which the spot light beam falls from full intensity to zero at the edge of the beam cone.
 Samples (Type set to Area Light only) Sets the number of samples to be taken when computing ray traced shadows.
 Global (button) (Mode set to Create only) Opens the Global Lighting dialog box.
 Scan (button) (Mode set to Modify only) Used to scan the design file for source lighting cells, when modifying.
 Show Light List (button)(right arrow button next to Mode option menu)
 Displays a list of light sources that have been placed in the design file. When modifying light sources, you can select a light source from this list.
 Show IES Data (button)(down arrow button below Scan or Global button)
 Used for advanced rendering, using IES lighting data (not covered in this course).
 Tool Setting Effect
 Ray traced view withFlashbulb and Ambient
 as the only lighting.
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 ➤ Place a Point light source as a ceiling light
 1 In the Rendering Tools tool box, select the Define Light tool with the following settings:
 Mode: Create
 Type: Point Light
 On: On
 Shadow: On
 Attenuate: Off
 Intensity: 1.0
 Resolution: 256
 As you move the pointer, there is an element attached to it. This is the light source cell that we are about to place. Light source cells, by default, are placed on level 1. They are created from Construction class elements so that their display can be disabled either by turning off level 1 or by turning off display of Construction elements.
 2 Click the Start AccuDraw icon in the main menu bar.
 3 Press the AccuDraw shortcut <C> to set the snap mode to Center.
 4 In Window 4, snap to the ceiling at location 1 but do not enter a data point.
 The pointer snaps to the center of the ceiling.
 5 Press the AccuDraw shortcut <O> to set the snap point as the new AccuDraw origin and <F> to set the AccuDraw compass to the Front orientation.
 6 Move the pointer down and with it aligned with the negative Y direction, key in 0.5 and place a data point to accept.
 7 Reset to finish placing Point light sources.
 8 Use the Render tool to Phong render Window 2.
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 Observe that there are no shadows. Phong rendering does not generate shadows from Point light sources.
 9 Use the Render tool to ray trace Window 2.
 This time, there are shadows. Ray tracing can generate shadows from Point light sources. For the remaining exercises we will use ray tracing to check our model as we add further light sources.
 Before we go on, let’s have a look at the light source cell that we just placed. You should be able to see it in Window 4.
 ➤ Inspect the Point light source cell
 1 Use the Rotate View view control to rotate Window 4 to a Front view.
 2 In Window 4, use the Window Area view control to magnify the light source cell that you just placed. It should be located a little below the center of the ceiling.
 Note the various fields displayed in the light source cell. These match the fields that we saw in the Define Light tool dialog box. In particular, note the Name given to the light source. This is a default name that was given, because we did not fill in
 The Point light source cell.
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 the Name field when placing the light source. We can, however, change this name with the Modify Mode of the Define Light tool with Method set to Edit Light.
 ➤ Change the name of the Point light source
 1 Select the Define Light tool with the following settings:
 Mode: Modify
 Method: Edit Light
 2 Click the Show Light List button at top right of the dialog box.
 The Light List list box displays. The name of the Point Light that we just placed is shown in the list.
 3 Select the light source in the Light List list box.
 The light source highlights (in Window 4). At the same time, the name of the light source appears in the Name field.
 4 In the Name field, change the existing name to Ceiling (press <Enter> to complete the change).
 5 Reset to finish.
 6 Update Window 4.
 The name of the Point Light cell has changed to Ceiling.
 Naming light cells in this fashion helps us later if we want to edit them. Using the Define Light tool, we don’t need to have light source cells displayed in a view, we can simply select them from the list. Another alternative is to Scan the file for existing light sources using the Scan button, but more on that later. First, we will place more light sources.
 Because Point light sources radiate light in all directions, we did not have to consider direction when we were placing our ceiling light source. With Spot Light lighting, which is a directional lighting source, we have to define the direction in which the Spot Lights are pointing.
 In our sample design file we have two conical light shades on the floor lamp. We can simulate lighting from these with Spot Light light sources. The yellow light shade is directed at the corner of the room, so let’s start with it. As we create this light source, we will give it a name that will help us identify it later.
 ➤ Place a Spot Light light source cell
 1 In Window 4, use the Rotate View view control to rotate Window 4 to Isometric.
 2 Use the Fit View view control to fit Window 4.
 We will use this view to define the target of the spotlight.
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 3 Select the Define Light tool with the following settings:
 Mode: Create
 Type: Spot Light
 Name: Floor Lamp Upper
 On: On
 Shadow: On
 Cone Angle: 30
 Delta Angle: 5
 4 In Window 1, snap to the center of the base of the yellow cone and accept with a data point.
 The Spot Light light source cell is placed at the data point. Graphics display the beam of the light source, the direction of which is controlled by the pointer.
 5 In Window 4, snap to the corner of the room above the table at location 2 and accept with a data point.
 6 Reset to finish.
 7 Use the Render tool to ray trace Window 2.
 The pointer controls thedirection of the
 spotlight’s beam.
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 Note the effect of the beam from the spot light in the corner of the room.
 At this point, we can turn off the view Flashbulb as it is making the image too bright. This can be done via the Global button of the Define Light tool.
 ➤ Turn off Flashbulb
 1 Select the Define Light tool with Mode set to Create.
 2 Click the Global button to open the Global Lighting dialog box.
 3 Turn off Flashbulb.
 4 Close the Global Lighting dialog box.
 5 Reset to finish.
 6 Use the Render tool to ray trace Window 2.
 Just as we modified the name of the Point light source, we can adjust other settings associated with a light source cell. For example, we can broaden the beam of our spot light.
 ➤ Modify the beam of the Spot Light
 1 Select the Define Light tool with the following settings:
 Mode: Modify
 Method: Edit Light
 2 In the Light List list box, select “Floor Lamp Upper.”
 The name of the light highlights. Graphics appear that show us the light source with its conical beam and the delta angle through which the intensity of the light falls to zero.
 3 In the Cone Angle field, change the value to 60 and press <Enter>.
 The graphics showing the light’s beam update to reflect the new value.
 4 In the Delta Angle field, change the value to 15 and press <Enter>.
 Ray traced viewafter turning off the
 view Flashbulb.
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 Again, the graphics of the light’s beam update to reflect the new value.
 5 In any view, place a data point to accept the changes.
 6 Use the Render tool to ray trace Window 2.
 The beam from the spotlight now is much broader and illuminates more of the corner of the room.
 Next, we will place the second spotlight to simulate light from the lower conical lampshade of the floor lamp. Here, we will use the direction of the cone and AccuDraw’s “Rotate Quick” feature to temporarily rotate AccuDraw’s axes to align with that of the cone.
 ➤ Place a Spot Light light source cell using AccuDraw to aim it
 1 In Window 1, turn off level 5 and turn on level 6.
 2 Use the Fit View view control to fit Window 1.
 This view now displays only the cyan colored cone of the floor lamp’s lower lampshade.
 3 Select the Define Light tool with the following settings:
 Mode: Create
 Type: Spot Light
 We can input other settings just before we place the light source.
 4 In Window 1, snap to the apex of the cone, but do not enter a data point.
 5 Use the AccuDraw shortcut <O> to set the origin at the snap point.
 6 Now press the AccuDraw shortcut <RQ> to rotate the AccuDraw Axes.
 7 Snap to the center of the base of the cone and accept with a data point.
 Ray traced viewafter changing the
 beam of thespot light.
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 This rotates the AccuDraw drawing plane to line up with the cone.
 8 Again snap to the center of the base of the cone and accept with a data point to place the light source.
 This defines the location of the spotlight. The pointer now controls the direction of the spotlight’s beam.
 9 In the Define Light tool’s dialog box, set the following:
 Name: Floor Lamp Lower
 All other settings are as we set for the previous spotlight and should not have changed.
 10 Move the pointer to the right and slightly downward and with it aligned to AccuDraw’s x-axis, place a data point.
 This defines the direction of the spotlight.
 11 Reset to finish.
 12 Use the Render tool to ray trace Window 2.
 To complete this model, we will add another Point Light light source to simulate the globe in the table lamp. For this light source, we will turn on Attenuate and set Distance to 1.0. This causes the intensity of the light source to diminish to half its intensity over a distance of one meter.
 Rotating AccuDraw’sdrawing plane.
 Ray traced view withboth spotlights.
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 ➤ Place a Point Light light source in the table lamp
 1 Select the Define Light tool with the following settings:
 Mode: Create
 Type: Point Light
 Name: Table Lamp
 On: On
 Shadow: On
 Attenuate: On
 Intensity: 1.0
 Resolution: 256
 Distance: 1.0
 2 In Window 3, snap to the center of the top of the green cylinder, but do not place a data point.
 3 Use the AccuDraw shortcut <O> to set the origin at the snap point.
 4 Use the AccuDraw shortcut <F> to set AccuDraw’s drawing plane to Front.
 5 Move the pointer upward and with it indexed to AccuDraw’s y-axis, key in 0.05 and place a data point.
 This places the light source 50mm above the top of the cylinder.
 6 Reset to finish placing Point light sources.
 7 Use the Render tool to ray trace Window 2.
 You should be getting some idea by now of the possibilities with MicroStation’s rendering and lighting options. One form of source lighting that we have not looked at is the Area Light. This light source is useful for simulating fluorescent lighting, or diffuse lighting, for example, where the light source does not emanate from a point but from an area. Shadows generated from this form of lighting are not
 Ray traced view with alllight sources placed.
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 as distinct as from point light sources. Using a copy of the same model that we have been working with previously, let’s see how area lighting works.
 ➤ Prepare for the exercise
 1 Open the design file srclite_02.dgn.
 2 Use the Render tool to ray trace Window 1.
 As you can see, this is the same model as you worked with in the previous exercises, except that all the light sources have already been placed in the design. To help discern the differences between the effects of the Point Light and an Area Light that we will create, all source lighting has been turned off except for the ceiling light. Additionally, Flashbulb has been turned on with an Intensity of 0.50.
 We can create Area light sources from any polygon present in the design. In this design file, we have placed a “fluorescent” light on level 10. We will use a block in this to create an area light source.
 ➤ Create an Area Light from an existing polygon
 1 Make level 10 the Active Level.
 The light fitting appears in each view. We will use the yellow rectangle as our Area Light.
 2 Select the Define Light tool with the following settings:
 Mode: Create
 Type: Area Light
 Name: Fluorescent
 On: On
 Shadow: On
 Attenuate: Off
 Intensity: 1.0
 Resolution: 256
 Samples: 4
 3 In Window 4, identify the yellow rectangle with a data point.
 The rectangle highlights. An arrow appears to show the direction of the light from the Area Light. This is controlled by the pointer.
 4 Move the pointer down so that the arrow points downward from the yellow rectangle and place a data point.
 The Area Light is created.
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 Before we render a view to see how the Area Light affects our rendered image, we should turn off the original ceiling light.
 ➤ Turn off the original ceiling light and ray trace the model
 1 In the Define Light tool dialog box, set the following:
 Mode: Modify
 Method: Edit Light
 2 If necessary, click the Show Light List arrow to open the list box of existing light sources.
 3 In the list box, select Ceiling.
 4 Turn off On (that is, uncheck its check box).
 This turns off the selected light source.
 5 Place a data point in any view to accept.
 6 Use the Render tool to ray trace Window 2.
 The area light is visible in the view and that the shadows created by it are much softer than those from the Point Light source. Light sources, other than Area Lights, do not appear in rendered images, only their reflection in surfaces.
 In this exercise, we used the default Samples value of 4. This setting affects the appearance of the shadows generated by the Area Light. Higher values produce
 Ray traced images with the Point Light (left) and the Area Light (right).
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 smoother shadows but take longer to render. With Samples set to 50, the image below is produced but at a cost of much longer processing time. Typically, the higher value would be used for producing the final images, while the default setting can be used for checking purposes.
 You have seen how easy it is to modify settings in light sources. You simply select the light source from the list box and make the required adjustments. You may have observed when Method is set to Edit Light that a Scan button is present in the lower left corner of the Define Light dialog box. When you click this button, the design file is scanned and when a source lighting cell is found, its details are entered in the dialog box. If the Light List list box is open, the light is highlighted. In this last exercise, we will use Scan to find the floor lamp and desk lamp light sources as we switch them on.
 ➤ Switch on the floor lamp and desk lamp lights
 1 Select the Define Light tool with the following settings:
 Mode: Modify
 Method: Edit Light
 2 Click the Scan button.
 The light “Floor Lamp Upper” is found.
 3 In the Define Light dialog box, turn on On (check its check box).
 4 Click the Scan button.
 This accepts the last modification and scan finds the next light source, “Floor Lamp Lower.”
 5 Again turn on On.
 6 Click Scan.
 The next light source “Desk Lamp” is found.
 7 Turn on On.
 8 Enter a data point in any view to accept the change.
 Ray traced image withSamples set to 50 for the
 Area Light.
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 This is the last source light that we are changing.
 9 Use the Render tool to ray trace window 2.
 The rendered image now has a mixture of sharp shadows from the point light in the desk lamp, the spotlights in the floor lamp and softer shadows from the area light above.
 To finish off this section on lighting, we will add a little color to the incandescent lights in the desk and floor lamps. Currently, they are set to the default color, which is white. We will give them a more natural yellow tinge.
 ➤ Add color to the incandescent lights
 1 Select the Define Light tool with the following settings:
 Mode: Modify
 Method: Edit Light
 2 In the Light List, select Desk Lamp.
 3 In the dialog box, click the Color button.
 The Modify Color dialog box opens.
 4 In the Named Colors list, select light yellow.
 5 Click OK.
 The Modify Color dialog box closes.
 6 Repeat steps 2 to 5 for light sources “Floor Lamp Lower” and “Floor Lamp Upper.”
 7 Use the Render tool to ray trace window 1.
 The lighting has a more natural look than that from the previous rendering in Window 2.
 All our rendering to this stage has dealt with elements in their design file colors. That is, we have accepted default material characteristics for the elements. In the
 Ray traced view withfloor and desk lamp
 switched on.
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 next chapter, we will look at material definitions and their application to elements in a design file.
 Before we continue: Which light source cell does not generate shadows with Phong rendering?
 What is the Spotlight delta angle?
 With which rendering mode, if any, does Flashbulb generate shadows?
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21 Material Definitions
 Few things add as much realism to rendered images as textures and materials. With material definitions applied to elements in your 3D model, instead of producing simple colored surfaces, realistic textured surfaces are displayed. In this chapter, we will cover the basics of materials and their associated properties, including:
 • “Apply Material tool” on page 340
 • “Defining Materials” on page 345
 Introduction
 By default, MicroStation rendering assumes that each design file surface is made of a material with a smooth shiny surface, such as plastic. Material definitions let you specify, for example, that an element in your design is water or wood or brickwork. When rendered, instead of seeing the “plastic” element, you see the specified material such as water, wood or brickwork. Each material definition can include a pattern map and/or a bump map, as well as other settings determining the finish and transparency of the element. Pattern maps and bump maps are image files that are applied to surfaces during the rendering process.
 Pattern maps
 A pattern map is an image file that is applied to an element. You can think of this in terms of wall-papering a wall. When you render an element that has a pattern map applied to it, instead of seeing the element (wall) you see the pattern map (wall-paper). MicroStation provides a large range of image files, in JPG and TIF format, that can be used for pattern maps. These are stored in the “…/Workspace/system/materials/pattern” directory. Additionally, you can use your own image files as pattern maps.
 Bump maps
 Like pattern maps, a bump map is an image file that is applied to an element. Where it differs from a pattern map is that a bump map applies “roughness” or
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 texture to a rendered surface. While it is not mandatory for bump map images to be grey-scale, quite often they are. MicroStation uses the contrast in the bump map image to calculate texture, or bumps, in the rendered image. As part of the material definition, you can vary the height of these bumps. This lets you use the same bump map image file, for example, to create cast metal from very rough-cast through to nearly smooth.
 Palette files
 Just as cell libraries store cells, palette files store material definitions. MicroStation is delivered with a wide range of palette files containing numerous material definitions. Material definitions include references to image files, where the definition incorporates a pattern map or bump map.
 When assigning materials to elements in your design, you can use the delivered materials or modify them and save them in your own palette files. Palette files have the suffix “.pal” and the delivered palette files are stored in the “…/Workspace/system/materials” directory.
 Material tables
 When you assign materials from a palette file to an element in your design, the assignment is stored in a material table. By default, material tables are given the same name as the design file but have a “.mat” suffix. Also, by default, material tables are saved in the same directory as the design file. Of course, you can save them under another name and/or in another directory, if you wish.
 Apply Material tool
 Using the Apply Material tool, we can:
 • Assign material definitions to elements in the design file either by Color/Level or as an Attribute.
 • Check the material that is attached to an element.
 • Remove material definitions from elements in the design file.
 • Preview how a material will look on an element.
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 When we select the Apply Material tool, the Apply Material dialog box opens. From this dialog box, we can load palette files, apply materials or open the Define Materials dialog box.
 An alternative to the Apply Material tool is the Assign Materials dialog box that is opened by selecting Settings > Rendering > Assign Materials. This dialog box essentially contains the same options as the Apply Material tool’s dialog box but in a different format. Here, we will use the Apply Material tool.
 Let’s find out how to apply materials with an exercise.
 ➤ Prepare for the exercise
 1 Open the design file materials_01.dgn.
 This design file has been saved with only Window 1 open, displaying an Isometric view of a single green (vertical) wall that has door and window openings in it.
 2 Use the Render tool with Render Mode set to Constant to render the view.
 The rectangle is rendered as a green surface.
 3 In the Rendering Tools tool box, select the Apply Material tool.
 The Apply Material dialog box opens. Note that the material table file name displayed on the Table button is the same as that of the design file.
 We will now use the Apply Material tool to select a material and apply it to the green rectangle.
 Apply Materialdialog box.
 Assign Materialsdialog box.
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 ➤ Select a material and apply it to the element
 1 In the Apply Material dialog box, click the Open button for Palette.
 The Open Palette File dialog box opens. By default, it opens in the system directory containing the delivered palette files (…/Workspace/system/materials).
 2 In the list of palette (.pal) files select “masonry.pal.”
 3 Click OK.
 The Open Palette File dialog box closes and the palette file name “Masonry” appears in the Palette field of the Apply Material dialog box. The first material in this palette appears in the Material field and a preview of the material appears in the preview window to the right.
 4 From the Display option menu, choose Rectangle.
 The preview window on the right updates to display the material in a rectangular display.
 5 In the tool settings, check that the following settings are current:
 Method: Assign Color/Level
 Mode: Apply Material
 6 From the Material option menu, choose Brick - rose.
 The preview window updates to display the material.
 7 Identify the green wall element with a data point.
 The rectangle highlights.
 8 Accept with a second data point to apply the material.
 An asterisk appears next to the material name in the Material field. This indicates that the selected material has been applied at least once in the design file.
 9 Use the Render tool with Render Mode set to Constant to render the view.
 Apply Material dialog boxwith selected material.
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 The rectangle is rendered as a brick wall.
 10 Repeat the above step with Render Mode set to Smooth.
 Again, the rectangle is rendered as a brick wall looking similar to that produced with Constant rendering mode.
 The material looks like a brick wall but doesn’t have the “roughness” of a brick wall. In fact, this material does have a bump map in its description, but Constant and Smooth rendering modes do not support bump maps. To display the material correctly, we must use Phong or Ray Trace rendering modes.
 ➤ Render the wall using Phong and Ray Trace
 1 Use the Render tool with Render Mode set to Phong to render the view.
 The wall now appears to have some texture.
 2 Repeat the above step with Render Mode set to RayTrace.
 When we have applied materials to elements in our design, it is a good idea to save the material assignment table.
 Constant rendered view ofthe rectangle with the
 brick material applied.
 Ray traced wall displays“roughness” inthe brickwork.
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 ➤ Save the material assignment table
 1 Select the Apply Material tool.
 2 In the Apply Material tool dialog box, click the Save button (next to the Table name button).
 The Save Table As dialog box opens. By default, it opens in the same directory as that in which the design file resides, and the default name for the table is that of the design file, but with a “.mat” extension.
 3 Click OK.
 The material assignment table is saved to disk. This table will be loaded automatically the next time that we open this design file.
 When we apply a material to an element in the design file with Method set to Assign Color/Level, the assignment is made to all elements of the selected color(s) on the selected level(s). We can check just which elements are included by clicking the Assign button.
 ➤ Display the material assignment
 1 In the Apply Material dialog box, click the Assign button.
 The Assign Materials dialog box for material “Brick - rose” opens. In the list box, level 10, color 2, are specified as the elements to have this material applied.
 When you know the levels and colors to which you want material definitions applied, you can use this dialog box to select the levels and colors. This can be useful if you have a number of colors and levels that you want to have included for a particular material. You simply select the relevant levels and colors in this dialog box.
 2 Click Cancel to close the dialog box.
 Assign Materialsdialog box showingthe assignment for
 Brick - rose.
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 What this means is that any green elements that you now place on level 10 will have the “Brick - rose” material applied to them. Try this for yourself.
 ➤ Draw some other elements
 1 Check that Active Level is set at level 10.
 2 Set Green as the Active Color.
 3 Draw a shape.
 4 Set Red as the Active Color.
 5 Again draw a shape.
 6 Make level 11 the Active Level.
 7 Draw a red and a green circle.
 8 Render the view.
 The green shape is rendered as brickwork, while the green circle that was drawn on level 11 renders as green. Both the red elements render as red. Only the green elements that were located on level 10 are rendered as brickwork.
 Where you need to remove a material definition, again you can use the Assign Materials dialog box and deselect the levels and colors. Alternatively, you can remove the definition in a similar fashion to that used to apply the material earlier.
 ➤ Remove the material definition
 1 Select the Apply Material tool with the following settings:
 Method: Assign Color/Level
 Mode: Remove Material
 2 Identify with a data point the green wall (or any of the other green shapes that you drew on level 10).
 3 Accept with a second data point.
 4 Render the view to see the result. The green elements on level 10 no longer render as brickwork.
 Well, we know now how to apply a material to elements in a design. Time now to look at how a material definition is created.
 Defining Materials
 Material definitions tell MicroStation’s rendering process how elements should be treated when they are rendered. Using the Define Materials dialog box you can
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 create your own material definitions. You may want to start with the delivered definitions and modify them for your own use, or you could create new materials from your own image files. Whenever you modify the delivered material definitions it is a good idea to store them in a separate material palette and keep the palette in a directory separate from the MicroStation directory system. This protects your customized materials from being over-written during a software upgrade.
 To start with, we will define a material like that used in the previous section and see how various settings affect it.
 ➤ Prepare for the exercise
 1 Open the design file materials_02.dgn.
 This design file is similar to the file used in the previous section with the addition of rectangular and circular elements.
 2 In the main menu bar, select Settings > Rendering > Define Materials.
 The Define Materials dialog box opens.
 Looking at the Define Materials dialog box, note that it is divided into three main sections or group boxes. The left side of the dialog box lets you select and preview materials, as well as add, delete or replace material definitions. The right side of the dialog box lets you edit individual materials to suit your needs. The upper right section of the dialog box contains settings that control the characteristics of the material. In the lower right section are the controls for applying pattern maps and bump maps as part of a material’s definition.
 To start, we will create a material definition containing the pattern map of the brickwork.
 The Define Materialsdialog box.
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 ➤ Create a brick material
 1 In the preview window section, change Display to Rectangle.
 2 In the Define Materials dialog box, check that Map (lower right section of dialog box) is set to Pattern. Leave all other settings at their default values.
 3 Click the Select button.
 The Select Pattern Map dialog box opens.
 4 In the Image File list, find and select “brick02.jpg.”
 5 Click the Preview button to check the image.
 6 Click OK.
 The dialog box closes and the image file name appears in the Name field of the Map section of the Define Materials dialog box. The material preview window also updates.
 7 In the Material Name field, key in Brickwork.
 8 Click the Add button.
 The material name Brickwork appears in the Materials list at the left of the dialog box.
 9 From the dialog box’s File menu, choose Save Palette As.
 The Save Palette As dialog box opens. By default, palette files are saved in the “…\Workspace\system\materials” directory.
 10 In the name field, key in mypalette.
 By default, the suffix “.pal” is added when we click OK.
 11 Click OK.
 The dialog box closes and we are returned to the Define Materials dialog box. The name of the palette file now appears in the dialog box’s title bar.
 12 Close the Define Materials dialog box.
 Select Pattern Mapdialog box with
 “brick02.jpg” imagefile previewed.
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 We now can try out our new material.
 ➤ Apply the new material
 1 Select the Apply Material tool.
 2 Click the Open button to open the Open Palette File dialog box.
 3 Select “mypalette.pal.”
 4 Click OK.
 The palette file is loaded and the material brickwork is already selected (as it is the only material in the palette).
 5 Identify any of the green elements with a data point.
 6 Accept with a second data point.
 7 Use the Render tool to Ray Trace the view.
 Well, it worked, except that the bricks are far too large for the main wall and they have a green tinge. Note also that they are different sizes for each element.
 These two problems with our material are:
 • First, we did not set a Base Color or Specular Color so the element’s own color, green, was used for reflection from the light source.
 • Second, the size of the bricks can be controlled in the Mapping Mode section. There, you see a button with the word Surface on it. This is telling the rendering system to apply the image file to the entire surface of the element. The scale of the image, relative to the surface, is controlled by the Size X and Y settings, which are set to 1.0, by default. That is, the entire image file will be scaled to the surface by a factor of one. In our image it has been stretched to cover the surface of each element to which it is applied. Shortly, we will see how we can set the size of the brickwork exactly.
 We can adjust settings in the Define Materials dialog box to fix these problems.
 Ray traced viewafter applying the
 new material.
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 The following table shows all the Map settings and how they affect the material.
 Looking at some of these settings in more detail:
 Weight — (Pattern Maps only) Adjusts the amount of color that comes through the material (pattern map) from the element, ranging from a value of 0 (no pattern is visible) to 1 (the pattern in completely visible). When you assign an image file as a pattern map, you can use the Weight settings to specify how much the background color of the element, or a specified Base Color, shines through the image file when rendered. This lets you, for example, use a single woodgrain image file to create different colored wood materials.
 Transparent Background — (Pattern Maps only) Lets you create materials of people or trees, for example, in which only the person or the tree is displayed, not the background. The rendering system does this by making the background color transparent. The background color is defined by the color of the top left pixel in the image file.
 Height — (Bump Maps only) Defines the “roughness” of the map. If Height is set to zero, then the bump map appears smooth, while the maximum setting of 20 makes the bump map appear rough. Values between 1 and 5 usually are acceptable.
 Mapping Mode — Sets the method used to map the image file to the surface. This is split over two option menus, one that defines the way that the image file is mapped to surfaces and a second that sets the size of the image file when mapped.
 Choices from the first menu defining how the images file is mapped are:
 • Default Parametric — the default mapping mode, where the image file is mapped to the element relative to the element’s origin. For example, if the
 Pattern/Bump Map setting Effect
 Weight (Pattern Maps only) Sets the degree to which a map overrides the base color.
 Transparent Background Sets the background color of an image file to transparent, for materials such as people and trees.
 Height (Bump Maps only) Sets the height of bump maps.
 Invert Reverses bumps and valleys on bump maps — bumps become valleys and vice-versa.
 Angle Rotates the pattern/bump map.
 Size X and Y Sets the size of the pattern/bump map.
 Mapping Mode Sets the way the image file is mapped to the surface.
 Offset X and Y Moves the origin of the pattern/bump map.
 Flip Mirrors the pattern/bump map.
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 pattern map appeared reversed, you could mirror image the element to correct the mapping. This is an alternative to using the Flip option, which mirror images the pattern image on the surface, but changes the material definition.
 • Elevation Drape — “drapes” an image file over all surfaces in a view. An example would be draping an aerial photograph over a topographic map.
 • Planar — the horizontal axis of the pattern map is aligned with the horizontal plane of the design cube, and the image is then tilted as necessary to align with the face of the surface. This mode is useful, in particular, for materials attached to SmartSolids.
 While those from the second menu defining the relative size of the pattern map are:
 • Surface — maps the image file to the surface with size determined relative to the size of the surface. This relative size is controlled by the Size X and Y values, such that values of 1 for both X and Y maps one copy of the image file to the surface. Size X and Y values of 2 would double the size of the image in both X and Y directions, so that we would see only 1/4 of the image mapped to each surface. Alternatively, values of 0.5 would halve the size of the image in both the X and Y directions, so that we would see 4 copies of the image “tiled” to each surface.
 • Master Units — maps the image file to the surface with size of the pattern map image defined in Master Units, which then are controlled by the Size X and Y settings (in Master Units).
 • Sub Units — maps the image file to the surface with size of the pattern map image defined in Sub Units, which then are controlled by the Size X and Y settings (in Sub Units).
 With that background knowledge, let’s now set about correcting our material definition. First, we will set the size of the material such that the brickwork will look correct relative to our design elements.
 Setting the correct size of a material
 Not all materials can be set to a specific size, but materials such as brickwork can be related quite accurately to physical size.
 ➤ Prepare to define the material size
 1 In the Apply Material dialog box, double-click the material preview window.
 The Define Materials dialog box opens with the palette file already loaded and the material selected.
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 2 In the Define Materials dialog box, set the following:
 Display: Rectangle
 Mapping Mode: Surface
 Size X: 1
 Size Y: 1
 With the display set to Rectangle, the mapping mode set to Surface and with the Size values set to 1, we are viewing the complete pattern map image file in the preview window. In this we can see that the image is 2 bricks wide, by 6 layers of bricks high. We will assume that the bricks are 225mm x 75mm and the mortar thickness is 10mm. In that case, in physical dimensions, the image should be 470mm wide (2 x225 plus 20) by 510mm high (6 x 75 plus 60). This design file has been set up with Meters as the Master Units and millimeters as the Sub Units, so we can set the correct size directly in millimeters.
 ➤ Set the size of the pattern map
 1 In the Define materials dialog box, set the Mapping Mode to Default Parametric and Sub Units.
 As soon as you change one of the existing settings, the Replace button becomes active (in the Materials section of the dialog box).
 2 In the Size X field, key in 470.
 3 In the Size Y field, key in 510.
 4 In the Materials section, click the Replace button.
 5 Close the Define Materials dialog box.
 An Alert box opens, asking us if we want to save the palette file. When we made the changes, they were performed in memory only. We could have saved the file before exiting, but when we forget, this Alert box saves the day.
 6 Click Yes.
 7 Use the Render tool to Ray Trace the view.
 The brickwork now is the same size in all three elements.
 We have corrected the size problem, now to fix the color. This we can do by setting Base and Specular colors for the material. Currently, the color is being taken from the color of the design file element (green).
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 ➤ Set the Base and Specular colors for the material
 1 In the Apply Material dialog box, again double-click the material preview window to open the Define Materials dialog box.
 2 Turn on Base Color and Specular Color. By default, these are set to White, as displayed on their respective buttons.
 3 Click the Base Color button.
 The Modify Material Color dialog box opens.
 4 From the list of Named Colors, choose “brown.”
 5 Click OK.
 The Modify Material Color dialog box closes. The Base Color button now displays the selected color.
 6 Click the Specular Color button.
 The Modify Material Color dialog box opens.
 7 From the list of Named Colors, choose “rosy brown.”
 8 Click OK.
 The Modify Material Color dialog box closes. The Specular Color button now displays the selected color.
 9 Click the Replace button.
 10 Use the Render tool to Ray Trace the view.
 The brickwork now has a more natural color.
 To complete the creation of our brick material, we will add a bump map to give it some texture.
 ➤ Add a bump map to the material
 1 In the Define Materials dialog box, set the Map option menu to Bump.
 2 Click the Select button.
 The Select Bump Map dialog box opens.
 3 From the list of image files, select “brick02b.jpg.”
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
 21-352

Page 363
                        

Defining Materials
 4 Click the Preview button to check the image file.
 5 Click OK.
 The Select Bump Map dialog box closes. The preview window in the Define Materials dialog box updates to display the material with bump map. By default, the bump map height is set at 1.
 6 Change the Height value to 5.
 The preview window updates to display the bump map with the new height setting.
 7 Click the Replace button.
 8 From the dialog box’s File menu, choose Save Palette.
 9 Close the Define Materials dialog box.
 10 Use the Render tool to Ray Trace the view.
 Material lighting settings
 You may be wondering just what all those settings are for at the top right of the Define Materials dialog box. They determine the characteristics of the material and affect how it reacts to light. You can control the Ambient, Diffuse, Specular, Finish and Transmit characteristics of a material from the settings visible in the dialog box. Clicking the More Settings button opens a further dialog box with settings for Reflect, Refract, Fresnel and Radiosity. These settings can change the characteristics of a material by affecting the way that light reacts with the underlying element’s color (or Base Color and Specular Color if they are enabled). These settings do not
 Selecting the bumpmap image file.
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 affect any image files that may be included in the definition as a pattern map or bump map.
 Ambient — controls the intensity of the material’s ambient reflectance, or luminance, not directly attributed to any light source. The overall Ambient light setting together with the material’s Ambient setting, defines the way the material will look when rendered. The color is the Base Color of the material. If Base Color is not enabled, then the color of the design file element is used.
 Diffuse — controls the intensity of the material’s diffuse color, which can range from 0% (black, no diffuse color) to 100% diffuse color. Diffuse color is based on the Base Color of the material. If Base Color is not enabled then the color of the design file element is used. Choosing lower values means that the Base color is not being used as much for highlights and shadowy areas.
 By modifying the diffuse color when using a pattern map you can minimize the number of pattern maps in your library. For example, both blue and pink marble materials could be created by mixing different base colors with a single marble pattern map.
 Specular — controls the intensity of the Specular highlight (used in conjunction with the setting for Finish). Zero is dull, while one is shiny (creates “hot spots”). Low values produce dull materials, such as felt. High values produce shiny materials, such as chrome.
 Finish — controls the smoothness of the material, where a value of 0 has low polish and a value of 1 has high polish. As with Specular, low values produce dull materials, such as felt, while high values produce shiny materials, such as chrome. Use Specular and Finish together to control a material’s highlights.
 Transmit — sets the material’s transparency (how much light it transmits). You must turn on transparency in the View Attributes dialog box (Settings > Rendering > View Attributes) for this feature to be enabled. For Ray Tracing, you also must turn on Transparency (the default) in the Ray Tracing settings dialog box (Settings > Rendering > Ray Tracing). A Transmit value of zero produces an opaque material, while a value of 1 produces a completely transparent
 The material lighting section of the Define Materials dialog box (left) and the More Material Settings dialog box (right).
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 material like clear glass. Intermediate values make an object partially transparent, like tinted windows.
 Base Color — defines the overall color of the material. When Base Color is turned on, the Base Color button is enabled. Clicking this opens the Modify Material Color dialog box from which you can select a color to be used with the material. You can change the base color by choosing RGB values or by picking on the color map.
 Specular Color — lets you define the color of the highlights. As with Base Color, if Specular Color is turned on, the Specular Color button is enabled. Once again by clicking on this button you get the option of selecting a color from the same style dialog box as for Base Color.
 With Ray Traced images, the Specular Color setting defines the color of the shadows produced by light passing through transparent materials, such as glass.
 Cast Shadows — when turned on, enables a material to cast shadows.
 More settings
 When you click the More Settings button, the More Material Settings dialog box opens, letting you define additional material characteristics that are used for Ray Tracing and Radiosity.
 Reflect — determines how reflective a material is when ray traced. Values range from 0.0 (no reflections) to 1.0 (perfect mirror). This setting is affected also by the material’s Specular and Specular Color settings.
 Refract — sets the refractive index of the material, which determines how much light bends as it passes through the material, when ray traced. A value of 1.0 does not bend the light at all. Values greater than 1.0 causes the light to bend toward the surface normal of the object to which the material is applied. Values of less than 1.0 causes the light to bend away from the surface normal of the object.
 Fresnel — produces fresnel effects in the material. That is, the transparency of a material and the amount that a material reflects light varies depending on the angle at which the material is viewed. For example, when you look at a window at a sharp angle, it appears more reflective than transparent.
 Radiosity — for use with Radiosity solving. Used in conjunction with the Radiosity dialog box’s Material Usage settings, lets you choose whether or not a material is considered for receiving and transmitting radiosity illumination.
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 Working with the material settings
 To see how the various material settings affect the appearance of a material, you need only look at the Preview window. If you want to check out how it appears on an element in your design, you can use the Preview button. The following exercises make use of both these features.
 ➤ Prepare for the exercise
 1 Open the design file materials_03.dgn.
 2 Open the Define Materials dialog box (Settings > Rendering > Define Materials).
 The Define Materials dialog box opens. Currently, there is no palette file loaded.
 The material settings are set at their default values. The preview window is displaying a sphere in Phong rendering mode (again, the default). We can change the various settings and view the results in this preview window.
 ➤ Change the settings and view the results
 1 Try changing the various settings for Ambient, Diffuse, Specular, Finish and Transmit and check the results in the Preview window.
 2 When you finish modifying the values, return them to their default values:
 Ambient: 1.00
 Diffuse: 0.60
 Specular: 0.40
 Finish: 0.90
 Transmit: 0.00
 Other settings relate specifically to Ray Trace rendering mode. As well, the Transmit setting is much more effective with Ray Tracing. Let’s now look at these settings with regard to Ray Tracing.
 ➤ Check out the Ray Tracing settings
 1 In the Define Materials dialog box Preview window, set Shading to Ray Trace.
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 2 Set the following settings:
 Diffuse: 0.25
 Specular: 0.45
 Finish: 0.90
 Transmit: 0.50
 Cast Shadows: On
 Base Color and Specular Color: Off
 The Preview window updates after each change. This takes a little longer with Shading set to Ray Trace.
 3 Click the More Settings button.
 The More Material Settings dialog box opens.
 4 Set the Refract value to 1.10.
 The Preview window updates. The Bentley logo behind the sphere now is distorted, due to refraction through the translucent material.
 5 In the More Material Settings dialog box, set the Reflect value to 0.30.
 The Preview window updates. The sphere now includes reflections in the sphere.
 What we have defined is a glass material that will take on the color of the design file element (because Base Color and Specular Color have not been enabled). Let’s add this material to our palette file. When we load a palette file, we do not lose the
 The Preview window showingthe sphere with Refraction
 (left) and both Refraction andReflection added (right).
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 current material settings. That means that we can load our palette file and save this definition with our previously defined material.
 ➤ Save the new material
 1 In the Define Materials dialog box, select File > Open Palette.
 The Open Palette File dialog box opens.
 2 Select the palette file that we created earlier “mypalette.pal.”
 3 Click OK.
 4 In the Define Materials dialog box’s Material Name field, key in Glass.
 5 Click the Add button.
 The material is added to the list.
 6 In the Define Materials dialog box, select File > Save Palette.
 We now can apply our new material to elements in the design.
 ➤ Apply the “glass” material to elements in the design
 1 Select the Apply Material tool.
 2 Click the palette Open button.
 3 Select the palette “mypalette.pal.”
 4 From the Material option menu, choose “Glass.”
 5 In turn, identify and accept with a data point, the green slab, yellow sphere and red cylinder.
 6 Use the Render tool to Ray Trace the view.
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 This design file has a spotlight light source that is aimed down on the elements in the design. The shadows from the glass material are tinged with the color of the elements.
 Because we did not specify a Base Color or Specular Color, the elements are rendered in their design file colors.
 ➤ Turn on Base and Specular color
 1 In the Define Materials dialog box, with Glass selected as the material, turn on Base Color and Specular Color.
 2 Set these at magenta and cyan, respectively.
 3 In the Materials section of the Define Materials dialog box, click Replace.
 4 Use the Render tool to Ray Trace the view.
 This time, all the solids are the same color, as are their shadows.
 Previewing Materials
 We have used the preview window to preview the look of a material as we define it. Another option that we have is to preview the material on an element in the design file. By selecting the Preview button on the lower left side of the dialog box, we can select an element in the design to be rendered with the material applied (temporarily).
 ➤ Preview a material
 1 In the Define Materials dialog box, select File > Open Palette.
 2 In the Open Palette File dialog box, select the palette “surface.pal.”
 Ray Traced view afterapplying glass
 material to solids.
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 3 Click OK to close the Open Palette File dialog box and load the selected palette file.
 4 In the Define Materials dialog box Materials list, select “stucco - fine.”
 5 Click the Preview button.
 6 Identify the green slab in the design and accept with a data point.
 Note how your Preview window shows you the element in its rendered form. This method lets you quickly test applying different materials on an element. You can see immediately if the material needs to be adjusted in any way.
 You can change a material’s definitions and preview them on the object of interest. When you have decided that the new material is adequate, you can give it a new name and then save the palette.
 Before we continue: What is the difference between a pattern map and a bump map?
 What are your options for changing an pattern map image’s size and how do they differ?
 Which rendering method(s) gives you realistic transparency with refraction and reflection?
 Material palettes delivered with MicroStation
 We mentioned earlier that there are a number of palette files delivered with MicroStation. The following table lists these palettes:
 Palette Name What’s in it
 Backyard Grass, shrubs and trees
 Backdrop Clouds and Sunsets
 Brake Materials used for a brake assembly
 Carpet Different types of carpet
 Door_Win Doors and Windows
 Fabric Different types of fabric
 Finish Different surface finishes, like plastic
 Flora Plants
 Glass Glass and colored glasses
 Granite Different types of granite
 Homeofic Appliances and Furniture for a Home/Office
 Kitchen Different kitchen appliances
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 We can use materials from these palettes directly, or we can create our own materials based on these. In the following exercise, we will use materials from several palette files.
 ➤ Assigning materials from different palette files
 1 Open the design file materials_04.dgn.
 2 Select the Apply Material tool with the following settings:
 Method: Assign Color/Level
 Mode: Apply Material
 3 Use the Palette file Open button to open the palette file “carpet.pal.”
 4 From the Material list, select the material Carpet - plush white.
 5 Click the Assign button.
 The “Assign Materials: Carpet - plush white” dialog box opens.
 6 Select level 44 and color Blue (1).
 7 Click OK.
 This sets all blue elements on level 44 to have the material “Carpet - plush white” applied to them, when rendered.
 8 Now, select a new palette file “rug.pal.”
 9 Select Rug - majestic as your material.
 10 With a data point, identify the white block at location 1 and accept with a second data point.
 All elements on the same level and with the same color as the white block will have the “Rug-majestic” material applied to them when rendered.
 11 Turn off level 1 to remove the location markers.
 Marble Different types of marble
 Masonry Different types of stone
 Metal Different metals
 People Pictures of people
 Proctext Procedural textures
 Raytrace Glass and mirrors
 Rug Oriental rugs
 Surface Different surface materials like wallpaper, stucco, laminate
 Tile Different styles of tile
 Tower Materials used in the tower.dgn file
 Vehicle Pictures of different types of transportation
 Water Different types of water
 Wood Wood finishes
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 12 Render Window 2 using the Smooth Shading Mode.
 The floor and the rug are rendered with their respective materials.
 Continue assigning materials to the office interior.
 ➤ Continue assigning materials
 1 Turn on level 2.
 2 Select the palette file, “wood.pal” and the material, Lightwood.
 3 Identify the yellow table at location 2 and accept with a data point.
 4 Turn off level 2.
 5 Again render the view using the Smooth Shading Mode.
 6 Try out your own ideas and assign a variety of materials to complete the office interior.
 Attaching materials as attributes
 We have seen how to apply material definitions to elements in our designs. Assignments have been by color and level. That is, all elements of selected color(s) and level(s) have the material applied to them when rendered. Maybe, when you are designing, you prefer to draw particular items in a particular color and on a particular level, for ease of recognition in wireframe display mode. It may be that the item consists of a number of parts that are made of different materials or surface finishes. Using the assign by color and level method of applying materials would not work in this case. We do have another option, however, attaching the material as an attribute. This lets us apply a material directly to the element in the design. If you change the color of the element or move it to another level, still it will retain its material definition. A material applied as an attribute takes precedence over a material applied by color and level. Say, for example, you have a material applied to green elements on level 11. On this same level, you have a green element that has a different material applied as an attribute. When you render these elements the green element with the material attached as an attribute will render as the attribute material. The remaining green elements will render as the material applied by color and level. The following exercise will demonstrate this feature.
 ➤ Apply a material by Color/Level
 1 Open the design file materials_05.dgn.
 2 Select the Apply Material tool with the following settings:
 Method: Assign Color/Level
 Mode: Apply Material
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 3 Open the palette file Finish.
 4 Select the material Flat - Olive.
 5 Identify one of the red blocks in Window 2 and accept with a data point.
 6 Use the Render tool to Ray Trace the view.
 The red blocks are rendered as flat olive colored blocks.
 Now, we will apply a different material definition to the horizontal red block (the largest block). Because it is the same color and on the same level as the other blocks and we want them to retain their current material, we will attach the new material as an attribute.
 ➤ Apply a material as an attribute
 1 Update the view to remove the rendered image.
 2 Select the Apply Material tool with the following settings:
 Method: Attach Attribute
 Mode: Apply Material
 3 Select the material Cast Metal.
 This material has a bump map that gives a rough cast finish.
 4 Identify the horizontal red block and accept with a data point.
 5 Use the Render tool to Ray Trace the view.
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 The horizontal red block now renders as cast metal, while the other blocks retain their original material definition.
 When a material is attached as an attribute to an element, you can move that element to other levels and/or change its color without affecting the material assignment. Currently, all the red blocks are located on level 10.
 ➤ Change the color/level attributes of the horizontal block
 1 Select the Change Element Attributes tool.
 2 Turn on Level and set it to 20.
 3 Turn on Color and set it to Green (color 2).
 4 Identify the horizontal red block and accept with a data point.
 5 Identify one of the vertical red blocks and accept with a data point.
 6 Use the Render tool to Ray Trace the view.
 The horizontal block still renders with the rough finish. It has retained its material definition because it was applied as an attribute. The vertical block now renders as green. It has lost its material definition because it was applied using the color/level method.
 Before we continue: Can you explain why the red cast metal material rendered as green when we changed the color of the block from red to green.
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 SmartSolids and materials
 SmartSolids let us quickly construct 3D models. When we come to rendering, because they are single elements, all surfaces of a SmartSolid will render with the same material definition. That is, if we use the Assign Color/Level method. For SmartSolids, we can use the Attach Attribute method to assign different materials to individual faces of a SmartSolid. Let’s look at a typical example.
 ➤ Prepare for the exercise
 1 Open the design file materials_06.dgn.
 2 Use the Render tool to Phong render both views.
 This SmartSolid model is of a small corner bracket. It has the material Cast Metal applied to it from the palette file “Finish.” The Assign Color/Level method was used so all faces display the same material characteristics.
 In practice, this small bracket should have smooth polished faces for the screw holes and for the flat faces. We can apply the material Polished to these faces.
 ➤ Attach a material to individual faces of a SmartSolid
 1 Update the views to remove the rendered image.
 2 Select the Apply Material tool with the following settings:
 Method: Attach Attribute
 Mode: Apply Material
 3 Select Polished from the Material list.
 4 Identify the model with a data point.
 As you move the pointer over the model, the faces highlight.
 5 Use data points to select the faces forming the two holes and the countersunk section, plus the two flat faces (as shown below).
 Phong rendered views of the corner bracket.
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 6 Move the pointer away from the solid and accept with a data point.
 7 Use the Render tool to Phong render both views.
 The holes and rear faces now are smooth, while the remaining faces retain their cast metal appearance.
 This same method can be used with SmartSurfaces to apply different materials to discrete parts of the surface only.
 Rendered views showing the new polished material applied to the holes and rear faces.
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22 Fly Through and Solar Study creation
 An exciting part of working with MicroStation 3D is the ability to create FlyThrough sequences of your models. These provide a feeling of motion by viewing a sequence of still images with the camera position moved slightly for each image.
 We know that our visual acuity or the ability to sense motion is approximately 12 frames per second. That means if you are viewing a sequence of images that is displayed at 12 or more frames per second your eyes think there is motion. If there are less than 12 frames per second your eyes sense these as separate images.
 We create FlyThrough sequences by first defining a path along which we want the view camera to travel. As well, we tell MicroStation how many frames it takes to travel along that path. Solar Studies let us animate shadows generated by Solar lighting over a set time period, so that you can study the effect that your model might have on its environment. In this case we define how many frames are generated over a set time to see the movement of the shadows. In this lesson you will use the FlyThrough and Solar Study tools to learn about:
 • “Creating FlyThrough Sequences” on page 368
 • “Displaying a FlyThrough Sequence” on page 375
 • “Conducting Solar Studies” on page 376
 The FlyThroughProducer and SolarStudy dialog boxes.
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 Both FlyThrough and Solar Study dialog boxes are opened from the Utilities > Render menu.
 Creating FlyThrough Sequences
 In the FlyThrough Producer dialog box, there are three main parts, Camera Settings, Output and Frame.
 Camera settings
 These settings set up the camera as follows:
 • Angle and Focal Length — both these settings are tied together so that adjusting one setting affects the other. Adjusting the Angle or Focal length widens or narrows the field of vision.
 • Standard Lens — options range from Fish Eye to Telescopic. A good choice for a walk-through is a Normal or Wide angle lens.
 • Front Clip Distance — sets the distance of a clipping plane in front of the camera, along the view axis. Anything located in front of this clipping plane is not visible to the camera.
 • Back Clip Distance — locates the back clipping plane for the camera view. Usually, this is set to a large distance so that we view all the elements in our model. Elements located outside the two clipping planes are not seen.
 • Target Position — can be set to fixed or floating:
 Fixed — the camera focuses on one (defined) point as it moves along the defined camera path.
 Floating — the camera “looks ahead” as it moves along the defined camera path. The camera target is set straight ahead along a linear path and tangent to curved paths. Use this setting for walk-throughs.
 Output
 This section is the same as when we created image files with one exception; you can specify the Speed (ticks/frame) to be generated by the FlyThrough Producer.
 • Speed — sets the number of ticks per frame, where one tick represents 1/60 of a second. Setting Speed to 1 yields an animation of 60 frames per second. A setting of 2 yields 30 frames per second, 3 produces 20 frames per second, and so on. Increasing this number when you travel a great distance between each frame yields a choppy animation. Typically you might use a larger number when you are previewing a FlyThrough sequence.
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 Frame
 This setting lets you set the total number of frames to be created in the FlyThrough sequence. In conjunction with the Speed setting, this value determines the total time of your animation. For example, if you specify a speed of 2 and a frame value of 120, you will get a FlyThrough sequence of 4 seconds. That is, 120 frames divided by 30 (60 ticks divided by 2). If your speed is 3 then you will have 20 frames per second and a frame value of 120 will yield 6 seconds for your FlyThrough sequence.
 Defining the Camera Path
 Camera paths can be defined by a line, linestring, arc, B-spline curve, and so on. Where you want to use more than one element they must be chained together as a complex chain. Keeping this path element as an open element lets you to turn off its display when rendered using the Ignore Open elements and Text setting in the General Rendering Attributes dialog box (Settings > Rendering > General). After creating the path element you must define its start point and end point, using the Define Path option in the Tools menu of the FlyThrough Producer dialog box. The camera flies along this path starting and finishing at the selected points. In between the start and end points, the remaining frames are placed, equally spaced. The view specified in the Output section is the view used for previewing the camera views.
 ✍ A common mistake when defining a camera path is using a closed element to define the path. A closed element can work just fine. If, however, you pick the same start and end points you will be creating all of your frames in one spot, not distributed along the element. To avoid this, you can delete part of the element between the required start and end points.
 ✍ You can create your path also as a construction element. You then can turn off the display of construction elements when you create your FlyThrough sequence.
 Camera Velocity
 Camera velocity varies with the length of the camera path and the number of frames used. You can check the velocity as follows:
 Use the Measure Distance tool with the Along Element method to determine the length of your path element. The velocity then is calculated with the formula:
 Velocity of Camera (units/second) = Distance along path element (in units)/Total time in seconds.
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 Compare the velocity of the camera to the values listed below:
 • For Walk-Throughs, a velocity of 1 to 2 units per second is appropriate.
 • For FlyThroughs, a velocity of 10 to 20 units per second, depending on how high you are from the ground surface, typically provides appropriate camera movement. The velocity of the camera should decrease the closer you get to the ground.
 Using the above equation, a path length of 100 units using the recommended velocity (2) for the walk-through method, the length of the sequence and number of frames can be calculated as follows:
 Time in seconds = 100 units/2 units per second = 50 seconds.
 50 seconds at 30 frames per second (assumes that your Speed [ticks/frame] was set to 2) is 1500 frames.
 Using the recommended velocity (20) for a FlyThrough the length of the sequence and number of frames can be calculated:
 Time in seconds = 100 units/20 units per second = 5 seconds.
 5 seconds at 30 frames per second is 150 frames.
 As you can see creating FlyThrough sequences require the processing of a large number of frames. You should preview the sequence prior to generating the images.
 Previewing
 You can preview your FlyThrough sequence using the Preview option in the Tools menu of the FlyThrough Producer dialog box. Preview has two options, Camera and View.
 • Camera — shows the position of the camera and its view volume at each point on the camera’s path.
 • View — lets you preview the animation as seen by the camera.
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 Recording
 Finally, you can save a FlyThrough sequence using the Record option of the Tools menu in the FlyThrough Producer dialog box.
 When creating a FlyThrough sequence, pay particular attention to the Format, Compression and Color Mode settings. Available formats are the same as for image creation plus options for FLC, FLI and AVI formats. These three formats can be played using the Windows Media Player.
 ✍ If you need to save your FlyThrough sequence to video tape then Targa format should be selected.
 ✍ JPG format generates small individual files and maintains 24 bit color. If you select the JPEG you have the option of selecting High or Low compression for the images.
 Color Mode — sets the number of colors per pixel for the FlyThrough sequence. FLC and FLI formats are limited to 256 colors. Use these formats for quick and easy distribution of your animation. The Windows AVI format is also a good choice for saving your animation. With AVI format you can use the animation in many different Windows applications, while retaining a color depth of 24 bits.
 When using formats other than FLC, FLI or AVI, MicroStation saves each frame as a separate image file. The files are numbered sequentially and upon playback they are loaded and played in sequence.
 ✍ Saving individual image files allows you to edit or replace individual files, reducing processing time when revising your flythrough sequences.
 Now, let’s create a FlyThrough sequence. For the exercise, we will create a fly-around of the Capitol Building in Washington DC, USA.
 The Record Sequencedialog box.
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 ➤ Prepare for the exercise
 1 Open the design file fly_through.dgn.
 2 In the main menu bar, select Utilities > Render > FlyThrough.
 The FlyThrough Producer dialog box opens.
 3 In the FlyThrough Producer dialog box, enter the following settings:
 Standard Lens: Wide
 Target Position: Fixed
 View: 1
 Shading: Smooth
 Speed: 2
 Resolution X: 320 Y: 200
 Frame: 30 (key in value in right hand field — the “of” field)
 We have already placed a path element in the design file for you. Continue by defining the path.
 The example file, with the Capitol building and the camera path.
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 ➤ Define camera path
 1 In the FlyThrough Producer dialog box, select Tools > Define Path.
 You are prompted to “Identify Element at path beginning.”
 2 In Window 3 (the Top view), snap to the start point on the path element at location 1 and accept with a data point.
 You now are prompted to “Accept Element at path end.”
 3 Snap to the other end of the element at location 2 and accept with a data point.
 After accepting the end point, you are prompted to “Define Target Point.”
 4 In Window 4, the Right View, snap to the top of the flagpole at location 3 and accept with a data point.
 View 1 updates to show the camera view for frame 1. All other views update to show the orientation of the camera view cones for each frame.
 You can preview the camera view at any of the view cone locations by keying in a Frame number, or by using the scroll controls to select the required frame. Another option lets you preview the Fly Through. Try that now.
 Window 1 displaying the camera view for frame 1, while other views display the camera view cones for each frame.
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 ➤ Preview the Fly Through
 1 In the FlyThrough Producer dialog box, select Tools > Preview > View.
 The camera view updates, in turn, for each position of the camera in the proposed fly through.
 You may have noticed that it was a little “jerky.” That is, there was too much difference in position of the camera between each frame. We can correct that by changing the number of frames. We can do that without re-establishing the camera path.
 ➤ Change the number of frames and preview the Fly Through
 1 In the “of” Frame field, key in 60.
 The views displaying the camera view cones update to display the extra view cones.
 2 In the FlyThrough Producer dialog box, select Tools > Preview > View.
 This time, the fly through appears much smoother.
 With our fly through set up as we want it, we can record it to disk.
 ➤ Record the fly through
 1 In the FlyThrough Producer dialog box, select Tools > Record.
 The Record Sequence dialog box opens.
 2 Use the following settings:
 Format: JPEG (JFIF)
 Compression: Minimum Loss
 Color Mode: 24 Bit Color
 Accept the default directory, which is …/Workspace/projects/examples/generic/out.
 Top View displaying 60view cones.
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 3 Click OK.
 The processing of the frames begins. The camera view updates for each frame. You can check on the progress by looking at the frame number in the FlyThrough Producer dialog box.
 Stopping processing of a movie
 You can stop the processing at any time by entering a reset. When you do this, an Information box appears with the message “Error - 144 Saving Movie.” Clicking OK returns you to MicroStation.
 Displaying a FlyThrough Sequence
 Just as you can display a rendered image that you have created, MicroStation has a facility for displaying a FlyThrough sequence, the Movies dialog box. This is opened by selecting Utilities >Image > Movies.
 Options provided to view a movie in MicroStation also let you control the movie and adjust various settings. You can load a movie, preview it, edit the movie by inserting or deleting frames, or adjust other playback settings. Play the movie that you created in the previous exercise.
 ➤ Displaying a Movie
 1 In the main menu bar, select Utilities > Image > Movies.
 The Movies dialog box opens.
 2 From the dialog box’s File menu, choose Load.
 The Load Movies dialog box opens. By default, it searches the …/Workspace/projects/examples/generic/out directory.
 3 Set the List Files of Type option menu to JPEG (JFIF) Files [*.jpg].
 4 Select the file “fly_through01.jpg.”
 5 Click OK.
 The 60 frames are loaded into memory.
 6 Click the Play button to view your movie.
 By default, the movies settings are set to loop. That is, the movie playback repeats until you stop it.
 The Movies dialog box.
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 7 Click the Stop button to stop the movie.
 8 Use the scroll controls to view specific frames of the movie.
 Conducting Solar Studies
 Solar Studies are useful for studying where shadows are cast by the Sun over a period of time. Solar Study sequence generation is based on a Solar light source. For a Solar Study to function correctly, you must make sure that you have specified the location from which the solar study is being conducted. This is specified in the Location settings for Solar lighting in the Global Lighting dialog box. The Solar Study dialog box consists of three sections — Settings, Start Time, Duration.
 Settings — these are similar to those in the FlyThrough Producer with the exception of the Solar Shadows button. Of course, it wouldn’t be much of a Solar Study without shadows, so make sure it is turned on! Also, the only Render Mode settings are Phong and RayTrace as these are the only modes that support shadows.
 Start Time — here you specify the start time of the study.
 Duration — this setting defines the Time taken for the study. The time will be equally divided by the number of frames, which are specified in the Settings section. Normally a solar study conducted over eight or more hours provides the best results.
 In the following exercise, we will again work with the same model as used in the previous section. We will study the Solar shadows generated during a 10 hour period in the month of October.
 ➤ Conducting a Solar Study
 1 Open the design file solar.dgn.
 2 Select Settings > Rendering > Global Lighting to open the Global Lighting dialog box.
 3 Verify that the Solar light is positioned for Washington, DC.
 4 Close the Global Lighting dialog box.
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 5 Select Utilities > Render > Solar Study to open the Solar Study dialog box and adjust the settings as follows:
 View: 1
 Resolution: X=320, Y=200
 No. of Frames: 10
 Speed: 2
 Gamma: 1.00
 Anti-Alias: Off
 Solar Shadows: On
 Render Mode: Ray Trace
 Time: 8:00 AM Standard
 Date: November 1
 Year: 2000
 Time: 10:00
 6 Click the Save button.
 The Record Sequence dialog box opens.
 7 Name the file solar01.jpg and save the Solar Study in the same default directory as for the FlyThrough “…/Workspace/projects/examples/generic/out” with the following settings:
 Format: JPEG (JFIF)
 Compression: Minimum Loss
 Color Mode: 24 Bit Color
 8 When processing is complete, select Utilities > Image > Movies to open the Movies dialog box.
 9 In the Movies dialog box, select File > Load and choose the file “solar01.jpg” to load the Solar Study sequence.
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 10 Play the movie to view your Solar Study generated for the Capitol Building.
 Because we recorded the Solar Study over a 9 hour period with 9 frames, each frame represents a 1 hour difference in time. You can use the scroll controls to view each frame individually.
 Frame 2 of the Solar Study.
 FlyThrough animation of a Piping facility
 Standard Lens: NormalTarget Position: FloatingView: 1Shading: PhongSpeed (ticks/frame): 2Resolution X: 320 Y: 200Frames: 50
 You will create a FlyThrough sequence around and through a piping model.
 1 Open the design file EX_fly_through.dgn.
 2 Select the FlyThrough tool. Adjust your settings as shown above. Note, in particular, that Target Position is set to Floating so that the camera view will be looking straight ahead along the camera path.
 A path element has already been created on level 63.
 3 Select the element at location 1 for the start point and then select the element at location 2 as the end point of the camera’s path.
 4 Record and Display your FlyThrough sequence.
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23 Animation
 To complete this course, we will now look at animation with MicroStation. Animation adds another dimension to your models. You can see how they “work,” for example, and maybe check for conflicts. MicroStation has options for you to animate your models in a variety of ways. These include keyframes, parametric and hierarchical motion, and paths. Using the various tools that are included with MicroStation, you can animate anything from geometry, lighting and cameras, through to material definitions. Much of this animation is performed by creating “actors” from elements in your design file and then scripting them to move over time, which is defined in terms of frame numbers. In this course we will introduce you to animation with an example of keyframe animation.
 Keyframe animation is defined and controlled via the Animation Producer dialog box. In this chapter, we will cover the following topics:
 • “The Animation Producer dialog box” on page 380
 • “Producing a keyframe animation” on page 383
 • “Recording and viewing an animation sequence” on page 392
 ✍ You can generate animation sequences from 2D files as well as 3D files.
 Overview of keyframe animation
 When we use keyframe animation, we move the design geometry to its location at critical points, or keyframes, in the sequence. Let’s consider a simple example, such as a steel ball bouncing (once) on the ground. This animation would require three keyframes:
 1 — starting point
 2 — hitting the ground
 3 — finishing point
 In creating such an animation, we position the steel ball in our design for each of the keyframes and save them. We then specify a frame number for each keyframe, a procedure called scripting. This determines how many frames are required for the
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 movement in between the keyframes. When we create a keyframe animation, the Animation Producer in MicroStation calculates the frames in between the keyframes for us. This process generally is referred to as “tweening,” short for “in-betweening.”
 Thus, to create a keyframe animation, we:
 1 Create the keyframes.
 Place the elements in the design at the required locations for particular frames in the animation.
 2 Script the keyframes.
 Define Frame Number, Interpolation and Velocity for each keyframe.
 3 (Optionally) preview the animation.
 4 Record the animation.
 The animation process interpolates the positions of the elements for each frame in between each keyframe.
 To create keyframe animations, we work through the Animation Producer dialog box.
 The Animation Producer dialog box
 A keyframe animation created with MicroStation can include several keyframes with many different elements moving or transforming. In such an animation sequence, each element can have its own independent motion.
 Transformations that reflect changes in geometry are stored in a script file. It is the setting up of the script that pulls the animation together. It is important that you understand the scripting process before you can create an animation in MicroStation.
 The Animation Producerdialog box.
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 There are two selections on the Animation Producer menu, File and Settings:
 • File — includes options to create, save and record scripts. Script files are saved using a “.msa” extension and are stored in the same directory as the design file.
 • Settings — includes options for creating keyframes, animating other settings such as lighting and materials, and settings for previewing the animation sequence.
 Creating keyframes
 To define a keyframe you must first position the geometry to be keyframed. You can do this with MicroStation’s element manipulation tools.
 ➤ Creating a keyframe
 1 From the Animation Producer > Settings menu select KeyFrames.
 The dialog box has four buttons along the bottom.
 2 To create a keyframe click the Create button. If a keyframe already exists, select it and then Delete, Freeze or Script it.
 Before you select the Create button make sure your elements are in their proper positions.
 If no elements are selected (using the Element Selection tool) then you are prompted to select an element for keyframing. After selecting an element, the Create KeyFrame dialog box appears.
 3 Type in the Name and Description of the keyframe.
 ✍ A keyframe may contain several elements, but for speed and efficiency only include geometry that moves during the keyframe interval.
 The AnimationKeyFrames dialog box.
 The Create KeyFramedialog box.
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 Each keyframe must have a unique, up to 8 character name (or more depending on your operating system) and may have an up to 18 character description.
 ✍ Descriptions are useful for describing exactly what each keyframe is controlling. This makes it easier to understand if you come back to the animation at a later date.
 Scripting an Animation
 After creating a keyframe you must script it. This is done by selecting it and then clicking Script in the Animation KeyFrames dialog box.
 Frame Number — lets you type in the number of the frame for the keyframe.
 Interpolation — determines how the in-between frames will transition. Linear interpolation produces unnatural looking, maybe even jerky motion. Spline interpolations are more natural and appear smoother.
 Velocity — controls how you get from one keyframe to the next. Your choices are: Constant Velocity, Accelerate, Decelerate, Accelerate-Decelerate, Infinite and Custom:
 • Constant moves you from one keyframe to the next in a uniform fashion. Essentially the in-between frames are evenly spaced.
 • Accelerate means that as you approach this keyframe your transformation accelerates, or there are less frames at the end of the keyframe interval than at the beginning.
 • Decelerate is the opposite of Accelerate, or there are less frames near the beginning of the keyframe interval than at the end.
 • Accelerate-Decelerate means an object transforms quickly at first and slowly at the end. Here the majority of frames are at either end of the keyframe interval.
 • Infinite causes the transformation to occur instantly.
 The Script KeyFramedialog box.
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Producing a keyframe animation
 ➤ Scripting a keyframe
 1 Select KeyFrames from the Settings menu.
 The Animation KeyFrames dialog box opens with the existing keyframes displayed.
 2 Select the keyframe that you want to script
 3 Click the Script button.
 The Script KeyFrames dialog box opens.
 4 In the Script KeyFrames dialog box, key in the required frame number.
 All animations and keyframes start at frame 0.00.
 5 Select your required Interpolation and Velocity.
 6 Click OK.
 The Script entry is added to the Animation Producer dialog box.
 For some models, creating an animation may be a little difficult at first, but it is a rewarding 3D experience once you get the hang of it. Using animation properly can allow you to create and analyze important effects associated with your 3D models.
 Producing a keyframe animation
 By far, the best way to learn animation is to do it yourself. In the following exercises, we will work with a simple animation of a bouncing ball. While it is a simple example, the techniques are no different to those used for complex keyframe animation. Be careful and follow the directions step-by-step.
 ➤ Prepare for the exercise
 1 Open the design file animation_01.dgn.
 2 If necessary, start AccuDraw.
 3 In the main menu bar, select Utilities > Render > Animation.
 The Animation Producer dialog box opens. Currently, there is no animation script loaded, so its title is “Untitled.”
 4 In the Animation Producer dialog box, select Settings > KeyFrames.
 The Animation KeyFrames dialog box opens.
 Let’s go ahead and create our first keyframe.
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Producing a keyframe animation
 ➤ Create the first keyframe
 1 In the Animation KeyFrames dialog box, click Create.
 You are prompted to Identify Element.
 2 With a data point, identify the green sphere and accept with a second data point.
 The Create KeyFrame dialog box opens.
 3 In the KeyFrame dialog box, enter the following:
 Name: UP
 Description: starting point
 4 Click OK.
 The dialog box closes and the keyframe appears in the Animation KeyFrames dialog box.
 For our second keyframe, we must first move the ball to its new position.
 ➤ Move the ball and create the second keyframe
 1 Select the Move tool.
 2 In the Front view, identify the green sphere with a data point.
 3 Move the pointer down and with it indexed to AccuDraw’s y-axis, key in 2 and place a data point.
 This moves the ball down to just touch the yellow block.
 4 Reset to finish.
 5 In the Animation KeyFrames dialog box, click the Create button.
 6 With a data point, identify the green sphere and accept with a second data point.
 The Create KeyFrame dialog box opens.
 7 In the Create KeyFrame dialog box, enter the following:
 Name: DOWN
 Description: touching ground
 Animation KeyFramesdialog box displaying the
 first keyframe.
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Producing a keyframe animation
 8 Click OK.
 The dialog box closes and the second keyframe appears in the Animation KeyFrames dialog box.
 For this animation, we will use the keyframe UP as both the starting point and finishing point. With the keyframes saved, we will now script them.
 ➤ Script the starting keyframe
 1 In the Animation KeyFrames dialog box, click the UP keyframe.
 2 Click Script.
 The Script KeyFrame dialog box opens with the Key Frame UP shown. By default, the starting frame number 0.00 is shown.
 3 In the Script KeyFrame dialog box, set the following:
 Frame Number: 0.00 (the default)
 Interpolation: Spline
 Velocity: Constant
 4 Click OK.
 The dialog box closes and the scripting entry is entered in the Animation Producer dialog box.
 In a similar fashion, we now script the DOWN keyframe and then the finishing UP keyframe. We will make the animation a total of 30 frames, with the ball touching the ground at the mid-point, frame 15.
 Script KeyFrame dialogbox, with settings for
 keyframe UP.
 Animation Producerdialog box with first
 script entry displayed.
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 ➤ Script the remaining keyframes
 1 In the Animation KeyFrames dialog box, select DOWN.
 2 Click Script.
 The Script KeyFrame dialog box opens. By default, the Frame Number value is incremented by 10. We will change that to our required number, 15.
 3 In the Script KeyFrame dialog box, set the following:
 Frame Number: 15
 Interpolation: Spline
 Velocity: Accelerate
 We set Velocity to Accelerate because the ball is falling with gravity accelerating it.
 4 Click OK.
 The new script entry is added to the Animation Producer dialog box.
 5 In the Animation KeyFrames dialog box, select UP.
 6 Click Script.
 7 In the Script KeyFrame dialog box, set the following:
 Frame Number: 30
 Interpolation: Spline
 Velocity: Decelerate
 We set Velocity to Decelerate because as the ball rebounds, gravity will be slowing it.
 8 Click OK.
 Our last script entry is added to the Animation Producer dialog box.
 Before we continue, let’s look at another feature of the Animation KeyFrames dialog box, the Freeze button. This button lets us move the selected geometry to its position for any of the saved keyframes. Try this for yourself.
 Animation Producerdialog box with the three
 script entries displayed.
 Everything 3D Copyright © 2000 Bentley Systems, Incorporated Do Not Duplicate
 23-386

Page 397
                        

Producing a keyframe animation
 ➤ Freeze the geometry at its keyframe locations
 1 In the Animation KeyFrames dialog box, select UP.
 2 Click Freeze.
 The ball moves to its location for UP.
 3 Now select DOWN and click Freeze.
 The ball moves to its location for DOWN.
 4 When you have finished, return the ball to its UP position and close the Animation KeyFrames dialog box.
 Using this feature, you can quickly check your keyframes prior to recording an animation. A similar option is available in the Animation Producer dialog box also. You can use the scroll controls or key in any frame number to view the geometry at that frame number. Alternatively, you can click the Freeze button in this dialog box to freeze the geometry at the selected frame number.
 ➤ Freeze the geometry at selected frame numbers
 1 In the Animation Producer dialog box, set View to 3.
 This sets the view in which the geometry is animated.
 2 In the Preview frame field, key in 12 and press <Enter>.
 In View 3, the sphere displayS at its location for that frame number.
 3 Update the view.
 The sphere moves back to its original position. Unless we freeze it in position, it is moved in memory only.
 4 In the Animation Producer dialog box, click Freeze.
 5 The sphere moves to its location for frame 12. This is shown in all views and updating them makes no difference. We have “frozen” the geometry at its location for the selected frame. That is, we have physically moved it to its location for that frame.
 6 In the Preview frame field, key in 0 and press <Enter>.
 7 Click the Freeze button.
 The geometry now is back at its starting position.
 Once we have finished setting up our animation, we can preview it in wireframe display.
 ➤ Preview the animation
 1 In the Animation Producer dialog box, click the Play (>>) button.
 The sphere “bounces” in view 3.
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 2 Change the View setting to 2.
 3 Again click the Play (>>) button.
 The sphere “bounces” in view 2.
 4 In the Animation Producer dialog box, select Settings > Preview.
 The Preview Settings dialog box opens.
 5 In the Preview Settings, turn on Loop.
 6 In the Animation Producer dialog box, click the Play (>>) button.
 This time the animation loops so that the ball continues bouncing.
 7 Reset to stop the animation.
 Commonly used settings in the Preview Settings dialog box let you:
 • Clear View Between Frames — to avoid screen clutter. When off, each frame remains displayed. Can be useful to check for conflicts.
 • Loop — when on, the animation repeats until a reset is entered.
 • Animated Elements — if on, animated elements display in the preview.
 • Static Elements — if on, static elements display in the preview.
 • Skip Frames — lets you specify a number of frames to “skip” between each displayed frame. Useful for quickly previewing long animations.
 Once you have previewed an animation sequence, it may be that you want to modify it. In our sequence, for example, we could add a second “bounce” where the ball bounces to half the original height. To do this, we simply create a new keyframe and script it. At the same time we can adjust existing entries as required.
 ➤ Create a new keyframe
 1 Select the Move tool.
 2 In the Front view, identify the green sphere with a data point.
 3 Move the pointer down and with it indexed to AccuDraw’s y-axis, key in 1 and place a data point.
 4 Reset to finish.
 5 In the Animation Producer dialog box, select Settings > KeyFrames to open the Animation KeyFrames dialog box.
 6 In the Animation KeyFrames dialog box, click the Create button.
 7 With a data point, identify the green sphere and accept with a second data point.
 The Create KeyFrame dialog box opens.
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Producing a keyframe animation
 8 In the Create KeyFrame dialog box, enter the following:
 Name: REBOUND
 Description: bounce half way
 9 Click OK.
 The dialog box closes and the keyframe appears in the Animation KeyFrames dialog box.
 Next, we will script the new keyframe, add another entry for when the ball drops back to the ground from the half-way rebound, and adjust the existing end frame number.
 ➤ Add the new script entries to the sequence
 1 In the Animation KeyFrames dialog box, select REBOUND.
 2 Click Script.
 3 In the Script KeyFrame dialog box set the following:
 Frame Number: 20
 Interpolation: Spline
 Velocity: Decelerate
 4 Click OK.
 5 In the Animation KeyFrames dialog box, select DOWN.
 6 Click Script.
 7 In the Script KeyFrame dialog box set the following:
 Frame Number: 25
 Interpolation: Spline
 Velocity: Accelerate
 8 Click OK.
 All that remains now is to adjust the entry for the final frame number. We can open the Edit KeyFrame dialog box by:
 • double-clicking the required entry in the Animation Producer dialog box,
 or
 • right-clicking the required entry and selecting Edit from the pop-up menu.
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Producing a keyframe animation
 ➤ Edit the frame number for the final UP keyframe and preview
 1 In the Animation Producer dialog box, double-click the second entry for UP, which currently is listed as frame 30.
 The Edit KeyFrame dialog box opens with the details for the script entry for UP at frame 30.
 2 Change the Frame Number value to 40.
 3 Click OK.
 The dialog box closes and the amendment is made to the script entry in the Animation Producer dialog box.
 4 Click the play button (>>) in the Animation Producer. The ball now “bounces” twice.
 5 Reset to end the preview.
 With the sequence completed, we should save our script to disk.
 ➤ Save the animation script
 1 In the Animation Producer dialog box, select File > Save Script.
 The Save Script As dialog box opens. By default, the script file is given the same name as the design file but with a “.msa” suffix.
 2 Click OK to accept the default file name.
 The dialog box closes and the name of the script file now appears in the title of the Animation Producer dialog box.
 Sometimes, you will find that your script works well but is too fast or too slow. You could go through and manually change each frame number but there is an easier
 The Edit KeyFrame dialogbox with the entry for
 UP displayed.
 The Animation Producerdialog box with the
 completed script entries.
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Producing a keyframe animation
 way. We can scale the script. For example, if we wanted to double the speed of our bouncing ball, we could scale the script by 0.5. If we wanted to halve its speed, we could scale the script by 2.0. Each time that you scale a script, the scaling is applied to the original values of the script. Try this for yourself.
 ➤ Reduce the number of frames by half
 1 In the Animation Producer dialog box, select File > Scale Script.
 The Scale Script dialog box opens.
 2 In the Scale Script dialog box, key in 0.5.
 3 Click OK.
 All the frame number values in the Animation Producer dialog box are halved.
 4 Preview the animation. Note that it is much faster.
 Now, let’s slow things down.
 ➤ Double the number of frames
 1 In the Animation Producer dialog box, select File > Scale Script.
 The Scale Script dialog box opens.
 2 In the Scale Script dialog box, key in 2.0.
 3 Click OK.
 All the frame number values in the Animation Producer dialog box are increased to double the original amount.
 4 Preview the animation. Note that it is much slower.
 ➤ Return the number of frames to the original values
 1 In the Animation Producer dialog box, select File > Scale Script.
 2 In the Scale Script dialog box, key in 1.0.
 3 Click OK.
 All the frame number values in the Animation Producer dialog box are returned to their original values.
 We are ready now to record and display our animation sequence.
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 Recording and viewing an animation sequence
 Recording and displaying animation sequences is similar to that of the Fly Through Producer and Solar Study operations. We can choose from a variety of Shading modes and save the sequence in any of a number of formats. Here, we will use Phong rendering and the JPEG (JFIF) format.
 ➤ Record the animation sequence
 1 In the Animation Producer dialog box, select File > Record Script.
 The Record Script dialog box opens.
 2 In the Record Script dialog box, set the following:
 View: 2
 Turn on the lock for Resolution X and Resolution Y
 Resolution X: 320
 Begin Frame: 0
 End Frame: 40
 Shading: Phong
 List Files of Type: JPEG (JFIF)
 Leave other settings at their default values. The default file name is the first five characters of the design file name, followed by a number consisting of
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 three digits and the suffix “.jpg.” As each frame of the animation is created, the filename number is incremented by 1.
 3 Click OK.
 Recording of the animation sequence commences. A window opens displaying each frame as it is created to let you monitor progress. When processing is complete, the window closes.
 With our animation sequence saved to disk, we can use the Movies dialog box to view the action.
 ➤ Display the animation
 1 In the main menu bar, select Utilities > Image > Movies.
 The Movies dialog box opens.
 2 In the Movies dialog box, select File > Load.
 The Load Movie dialog box opens.
 3 Set List Files of Type to JPEG (JFIF) Files [*.jpg].
 4 In the File list, select anima000.jpg.
 5 Click OK.
 The frames for the animation are loaded into memory.
 6 In the Movies dialog box, click the Play button (>) to view the animation.
 Before we continue: What is the term for adding frames in between keyframes?
 What is a keyframe?
 Tree View and Timeline
 Using Tree View and Timeline, you can analyze your animation setup graphically and make modifications. As you make changes, these are reflected in the Animation
 Window displaying theframes as theyare recorded.
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 Producer dialog box. This is most easily explained with exercises. In the following example, we will work with a copy of the animation that we created in the previous section.
 ➤ Prepare for the exercise
 1 Open the design file animation_02.dgn.
 2 If necessary, open the Animation Producer dialog box (Utilities > Render > Animation).
 3 In the Animation Producer dialog box, select Settings > TreeView.
 The Animator Tree View dialog box opens.
 4 Click the Bentley logo in the dialog box.
 Further items appear below the logo.
 What you see here are the elements that can make up an animation. In our animation we have keyframes, so let’s look at that item.
 ➤ Inspect KeyFrames
 1 In the Animator Tree View dialog box, click the “+” sign for KeyFrames.
 Our three keyframes appear — DOWN, REBOUND and UP.
 2 Click the “+” sign for DOWN.
 Further items appear for the DOWN keyframe — Elements and Key Times.
 3 Click the “+” sign for Key Times.
 The Animator Tree Viewdialog box.
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 Frame 15 and Frame 25 appear below Key Times. Looking at the Animation Producer dialog box, we can see that these coincide with the two entries for DOWN; that is, frame 15 and frame 25.
 We could go on expanding the entries for our other keyframes but there is a more convenient method.
 ➤ Expand all Key Times together
 1 In the Animation Tree View dialog box, click the Tree Expand Options button.
 The Tree Expand Options dialog box opens.
 2 In the Options group, set the options menu to Expand to Frames.
 3 In the KeyFrames group, turn on Key Times.
 4 Click the Execute button.
 The tree is expanded to display the Frame numbers for all keyframes.
 Working in the Animator Tree View dialog box, we can right-click on an item and choose an action from a pop-up menu. This can include editing the script entries.
 Animator Tree Viewdisplaying the Key Times
 for DOWN.
 Animator Tree Viewdisplaying the Frame
 numbers for the keyframes.
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 ➤ Edit a script entry from Tree View
 1 In the Animator Tree View dialog box, right click on the entry Frame 40.
 2 From the pop-up menu, select Edit.
 3 The Edit KeyFrame dialog box opens for the selected entry.
 4 Change the Frame Number value to 50.
 5 Click OK.
 The dialog box closes and the change registers in both the Animation Producer and the Animator Tree View dialog boxes.
 Similar changes can be made graphically via the Timeline dialog box. First, we have to send the information to Timeline. Any item in the Animator Tree View dialog box that is colored green can be sent to Timeline. You can do this with via the pop-up menu (after right-clicking the entry). Alternatively, you can select several items and send them in one hit, using the Send to Timeline button. As we have several items to send, we will use that method. In fact, we can set the Tree Expand Options to select the items for us.
 ➤ Send the Key Times to the Timeline
 1 In the Animation Tree View dialog box, click the Tree Expand Options button.
 2 In the Options section, turn on Select Action Items.
 3 Check that Key Times in the Keyframes section still is turned on.
 4 Click Execute.
 The dialog box closes. In the Animator Tree View dialog box, all three Key Times items are highlighted.
 5 With all three items selected, click the Send to Timeline button.
 The Animator Timeline dialog box opens. Each of the items displays.
 6 Click the Show Velocity Key button to display a legend for the colored lines.
 Animator Timelinedialog box.
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 Looking at the legend, you can see that the green line denotes acceleration and the blue line deceleration. Currently, the keyframes are arranged in alphabetical order of the Action Items. We can rearrange the order in which items appear, simply by click-and-dragging them in the list. Another option is to use the Sort Mode menu and the Sort List button. Let’s reorganize our entries in order of frame numbers.
 ➤ Sort the list of items
 1 From the Sort Mode option menu, choose Frame Number.
 2 Click the Sort List button.
 The list is sorted in order of frame numbers.
 Using the Animator Timeline dialog box, we can make amendments to the script entries as follows:
 • To change the frame number — drag a frame marker (black “handle”) to its new value.
 • Copy a frame number — drag while holding down the <Shift> key.
 • Edit an entry — select while holding down the <Ctrl> key.
 Let’s make some amendments to our animation sequence.
 ➤ Change velocity settings
 1 While holding down the <Ctrl> key, select the frame marker at frame 50 for the UP entry.
 The Edit KeyFrame dialog box opens.
 2 Change the Velocity setting to Accelerate.
 3 Click OK.
 The dialog box closes and the blue line changes to green in the Animator Timeline dialog box.
 4 While holding down the <Ctrl> key, select the frame marker at frame 25 for the DOWN entry.
 5 Change the Velocity setting to Decelerate.
 6 Click OK.
 The green line changes to blue for the section between the two frame markers for DOWN.
 7 Click the Play button (>>) in the Animation Producer dialog box to view the new bouncing motion of the sphere.
 Now, we will change the frame numbers for the DOWN and REBOUND entries.
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 ➤ Change frame numbers
 1 In the Animator Timeline dialog box, check that the setting for Drag Precision is 1.00.
 This restricts any changes to be a minimum of 1.00.
 2 Click and drag the frame marker at frame number 25 for DOWN to frame number 35.
 The frame number has updated also in the Animation Producer dialog box.
 3 Click and drag the frame marker for REBOUND to frame number 25.
 Again the frame number has updated in the Animation Producer dialog box.
 As you can see, Animator Tree View and Timeline give you simple options for adjusting your animation sequence. If time permits, you might like to add another object to the design file and animate that, using the techniques that you have worked with in this chapter.
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24 Optional Exercises
 Exercise 1
 In this exercise, your task is to create a new 3D design file and construct the model (shown below). In constructing this model you are to use only the following drawing tools — Place Shape, Place Orthogonal Shape and Place Block, all 2D tools. Work in the Isometric view, using AccuDraw to correctly orientate the elements.
 Hints to complete the exercise:
 1 Place the base shape.
 2 Place the l-shaped sides (draw one and copy it to create the opposite side).
 3 Use these elements to define the points as you draw the remaining blocks and shape.
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 Exercise 2
 In this exercise, you will use SmartSolids tools to create two different bridge designs, based on the same profiles. The work flow for this model is:
 • Create the bridge deck.
 • Punch the access tunnel through the bridge deck.
 • Create the concrete median barriers.
 • Create the columns.
 Creating the straight (flat) bridge
 For this construction, you can use the Extrude tool to create the solids from the existing profile elements and the Cut Solid tool to create the access tunnel.
 ➤ Building the 100 meters long straight bridge deck
 1 Open the design file optional_02a.dgn.
 2 Extrude the green bridge profile 100 meters (to the left in view 1) using the Extrude tool.
 3 With the Cut Solid tool, create the access tunnel through the green bridge solid using the yellow shape as the profile.
 4 Construct the concrete barriers by extruding each of the four cyan shapes (100 meters).
 ➤ Constructing the columns
 1 Set the Active Level to 6.
 2 Attach the saved view Pillar to Window 3.
 3 Use the Extrude tool to extrude the yellow ellipse down 10 meters.
 Rendered view of thebridge deck.
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 4 Use the Cut Solid tool to create cuts in the yellow column, using the red shapes as cutting profiles.
 5 In the Left View (Window 4) use the Copy Element tool with AccuDraw to copy the column 60 meters to the left.
 Creating the curved bridge
 In the previous exercise you created a simple bridge. You can add a degree of reality to it by introducing an arc to the bridge deck. To do this, you can extrude the bridge profiles along a curved path element using the Extrude Along Path tool.
 ➤ Create the curved bridge deck
 1 Open the design file optional_02b.dgn.
 2 Using the Extrude Along Path tool, create a curved bridge deck with the green profile and the green path element.
 3 Similarly, use the Extrude Along Path tool to create the matching concrete barriers from the cyan profiles and corresponding path elements (use the green arc for the center median barrier path).
 Creating the curved access tunnel
 At this point, you should have a curved bridge deck. However, to duplicate the cutting of the access tunnel through the bridge as in the previous exercise, you need to use a different technique. If you were to use the Cut Solid tool as before, a hole would be bored straight through the bridge wall and out the other side.
 To solve this problem, you can create a curved access tunnel as a solid and then use the Construct Difference tool to subtract it from the bridge solid.
 The completed column.
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 ➤ Creating the curved access tunnel
 1 Use the Extrude Along Path tool to create a solid from the yellow profile and path element.
 2 Use the Construct Difference tool to subtract the yellow “tunnel” from the green “bridge.”
 Modifying the Support Columns
 If you look closely at the bridge you can see the curved bridge deck and the columns do not meet. This is because the curved bridge deck curves up and over the columns. You can correct this using the Modify Solid tool.
 ➤ Stretching the columns
 1 Make level 6 the active level.
 2 Turn off levels 1 and 3 in Window 3.
 3 Fit Window 3 so that you can see the tops of the columns.
 4 Select the Modify Solid tool, turn on Distance and set its value to 1.5.
 This takes the top of the column just into the floor of the access tunnel. You can trim that back later.
 5 Identify one of the columns and select its top face.
 6 Place another data point above the column to move the face upward.
 7 Repeat the process for the other column.
 At this point, you have a pair of columns that need to be trimmed.
 The curvedbridge deck.
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 ➤ Trimming the columns
 1 Select the Construct Difference tool with the following tool setting:
 Keep Originals: Enabled
 2 Select with a data point, one of the columns below the bottom of the bridge deck.
 This identifies the part of the column (the lower portion) that you want to keep.
 3 Select the bridge deck with a data point.
 4 Place a data point to accept.
 5 Repeat the process for the second column.
 6 Use the Delete Element tool to delete the “original” columns.
 Exercise 3
 In this exercise, your aim is to create the ball-valve housing shown below. The underlying 3D solids that form the basis of this model are cylinders and a sphere. To get you started, the sample file optional_03.dgn contains these basic elements that you can use to complete the model.
 Tools required to complete the construction are Construct Union, Shell Solid, Cut Solid and Fillet Edges.
 Hints to complete the valve-housing:
 1 Unite the two red cylinders and the red sphere.
 2 Thin shell the combined red solid using a wall thickness of 0.01.
 3 Cut holes in both the yellow flanges, using the cyan circles.
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 4 Use the front view to mirror copy the right flange to the left end of the main body.
 5 Unite the flanges to the main body.
 6 Add 0.01 fillets to the edges where the sphere and the cylinders meet.
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